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Lesson 00 

 Introduction

Getting to know TVPaint Animation Pro

TVPaint Animation Pro is a program compiled for graphic design and 2D animation. This program is 
intended for drawing and animation enthusiasts. With its bitmap approach, its objective is to cover the 
main needs of the artist. It offers a complete range of high-performance tools, the parameters of which 
may be set, whether for the layman or the professional artist and yet still offers the creative feeling 
provided by pen and paper.

TVPaint Animation Pro is the animator's home studio.

Based on TVPaint technology, which is renowned worldwide since its success on the Amiga in 1991 and 
constantly upgraded for ever better performance, TVPaint adapts to all production diagrams, whether 
traditional, fully digital or hybrid. 

Designed to work with all resolutions, it will delight all drawing enthusiasts thanks to its tools which offer 
limitless possibilities. Your creations are only restricted by the boundaries of your imagination !

Typographic conventions

In order to simplify understanding of the techniques described, this user guide uses the following 
typographic conventions :

- Italics : the names of menus, buttons, tabs, windows, commands, tools (all elements referring to one of 
the objects present in the program) are written in italics.
- [key] : designates a keyboard shortcuts.
- [key1+ key2] : designates a key combination. Keep the first key pressed and then press the second 
key.
- left click / right click (LMB, RMB) : these shortcuts refer to a click on the left or right mouse button. 

As you are advancing in the guidebook, you will encounter the following symbols: 

 TIP
A symbol representing a light bulb indicates tips and hints for using the program. 

 Remark
A symbol representing a warning sign emphasises information that requires particular attention and 
indicates an important comment.

 Reminder
The reminder symbol characterises any information the explication of which was already given in the 
guide book.

http://www.tvpaint.com/
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Lesson 1

First approach of TVPaint Animation Pro

In this lesson you will:

● Learn to open and close TVPaint Animation Pro.

● Discover the various panels and windows.

● Start a project.

● Access InLine help.

● Set your preferences.



First approach of TVPaint Animation Pro

After having followed the installation instructions in the Start-up guide, you may now start 
TVPaint Animation Pro. To do this, proceed as follows:
* Double-click on the desktop icon or use the start menu (for Windows users).
* Double-click on the applications folder icon or dock icon (for Mac OS X users).
The TVPaint Animation Pro program and most of the associated files are saved in the «program» 
directory of your operating system.

To use TVPaint Animation Pro, you may choose between the mouse or stylus.
The latter is more appropriate for persons wishing to have that « freehand » design feeling.

The various program panels

When the program is started, the following screen appears. This screen enables selection of your 
future workspace and managing all your configurations.

The various options available on this screen will be discussed in further detail elsewhere in this 
lesson. For the moment, simply click on OK.

Once the program has loaded, the following image illustrates what your screen will be like for a 
display resolution of 1280 x 1024 pixels.
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The various program panels

Here you will find a description of the various panels displayed on the screen.

The toolbar

The first icons on this toolbar concern the traditional functions found in all standard software 
packages: New (start a new project), Load (load an existing project), Save (save a project), Close 
(close the current project).
The following icons are used to open or close various TVPaint Animation Pro panels (display 
coordinates, light table, timeline, etc.).
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To move the toolbar, click and hold the left mouse 
button, then slide the cursor as required. The 
toolbar then appears in the form of a panel.



The various program panels

Main panel

Color picker

Toolbox
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This panel is used to draw segments, ellipses, rectangles, 
curves,... Brush selection and cutting options are also 
available here.

This panel is used to select the color in which you wish to 
work. Distinction is made between the A color (always 
referred to as main color) in the left rectangle and the 
B color in the right rectangle.

The toolbox contains a wide choice of buttons 
corresponding to traditional drawing tools: airbrush, brush, 
pencil, wet brush, etc.

Various parameters may be set: size, power, opacity, etc.



The various program panels

Current project window

The layers window

This window is also referred to as the «timeline» by many users. It is used to manage your layers 
and insert keys for your effects (we will discuss this point in subsequent lessons).

Main menu

TVPaint Animation Pro has numerous menus located just above the toolbar in windows (they are 
located at the top of the screen on Mac OS-X) : File, Edit, Project, Layer, Image, Effects, View, 
Windows, Help.
Each of these menus offers specific options all of which will be described in detail in this guide.
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The current project window is the 
one in which you will be able to 
express your artistic talents and 
create a wide variety of animated 
sequences.



Some useful tips

Some useful tips

Move a window

If for some reason you wish to move a window, this is done by simply clicking on the title bar and 
then sliding it to the required location while keeping the mouse pressed.

Close, minimize or maximize a window

These three buttons, on PC :  and on Mac : , are present on many of the panels 
and windows, in the top right-hand corner for PC and top left-hand corner for Mac. 
* The buttons  /  close the window (keyboard shortcut [Shift+W]). 
* The buttons  /  place the current window in front of or behind other windows.
* The buttons  /  are used to minimize the window.
Once minimized, this icon changes to  and may be used to maximize the window again (note 
that this icon does not change on Mac).

The size of some windows, the timeline for example, may be adjusted: it is possible to adjust their 
size with precision by clicking on one of the edges.

Sliders and mini-sliders

                          

The element above on the left is referred to as a slider. It is located horizontally under some 
windows (in particular under the current project window) or vertically next to these windows.
Click on the arrows with the left mouse button or slide the rectangle to view the content of the 
window with which the slider is associated, either up and down or left and right. 
As you have already guessed: the element on the right is a mini-slider which may be used to 
change the numeric value or percentage next to it with a left click and slide of the mouse on the 
double arrow.

When sliding the mouse on a mini-slider, press and hold the right button to 
accelerate movement.

Alphanumeric fields

   

Each time you rename a layer, project, effect or other element, you will be 
asked to enter a text in this type of window. Click on OK to confirm the 
name change or click on Cancel.

The standard keyboard shortcuts:
[Ctrl+X] (cut), [Ctrl+C] (copy), [Ctrl+V] (paste), [Ctrl+A] (select all), [Ctrl+Z] (cancel) are valid in all 
alphanumeric fields (note that these shortcuts are valid for PC and on Mac computers the user 
presses the Apple key instead of « Ctrl »).
When required they are accessible with a right click on the concerned field.
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Some useful tips

Progress bar

If required, the [Esc] key on Windows, [  ] on Mac OS-X or Stop button may be used to stop the 
operation in progress.

Working with projects

TVPaint Animation Pro works with Projects which contain the artist's creations. The notion of 
project is vast and further details will be provided during the firsts lessons.

Create a new project

The first thing to do when using this program is create a new project.
To do this, you may:

* Select the parameters of your new project as soon as the program is started when the start-up 
screen appears.
* Use the File main menu.
* Use the keyboard shortcut [Shift+N].
* Click on the first icon to the left on the toolbar.

 

The Template concept will be discussed in lesson 5.

    

Setting each parameter to create an animation in the 
format of your choice may proove long and arduous.
Therefore, a popup menu has been added to the 
panel to allow you to set the various numeric fields 
according to the most commonly used formats: PAL, 
NTSC, VGA, DTV, Film, etc.
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Sometimes application of an effect with 
TVPaint Animation Pro requires a certain amount of 
processing time. If your computer is carrying out such an 
operation, the progress bar appears to inform you of the 
progress of this operation.

A panel then appears (see opposite).
This panel is used to define:

* The name of your project 
* Its Width and Height in pixels
* The Aspect ratio
* The Frame Rate (Images/sec.)
* The Fields display mode



Working with projects

TVPaint Animation Pro uses all standard formats (even very high definition) both for image 
width/height ratios 4/3 and 16/9 as well as others.

Once all options have been selected, click on New  project.
A project window then appears on the screen (see below).
It is in this window that you will work and view your creations. 

  

View data relative to your project

  

Name a project

The default name for a new project is «Untitled-00 », 
« Untitled-01 », « Untitled-02 », etc ... To render these names more understandable, it is possible 
to rename them as you wish.
To do this, simply use the  Project>Rename main menu.

Working with several projects

TVPaint Animation Pro offers the user the possibility to work with several projects on the screen at 
the same time. The [Tab] key on your keyboard may be used to switch from one to the other.
It should be noted that the names of the projects present on the screen may be viewed in the 
Windows main menu. The checked name is the current project.
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TVPaint Animation Pro allows you 
to work on several projects at the 
same time.

The maximum number of projects is 
limited only by the capabilities of your 
computer. 

To view data relative to your current project (size, frame 
rate, ratio, etc ...), simply move the cursor over the title 
bar and hold it there.

A small yellow window then appears with all the 
information you require.



Working with projects

        

Working in fullscreen mode

It is also possible to work in Fullscreen mode by simply pressing the [V] key on your keyboard or 
by clicking on the toolbar icon indicated below.

When in Fullscreen mode, the keys of the numeric keypad may be used to move your project on 
the screen. In fullscreen mode, the [F12] key allows to hide all the tool panels.
Here again, the [Tab] key is used to switch from one project to another.
To return to windows mode, simply press the [V] key or the icon above again 
(these options are also accessible via the View main menu ).

Close a project

A project may be closed in four ways:
* Use the  /  buttons at the top of your project window.
* Use the fourth button from the left on the toolbar.
* Use the File > Close project main menu.
* Use the keyboard shortcut [Shift+W].

 

In order to avoid any mistakes, a confirmation 
message will appear (see opposite).

The    Help   main menu  

Each menu proposes specific options. At this stage we will take a closer look at the Help menu.

InLine support

At any time, a help function referred to as InLine help, is available in TVPaint Animation Pro.
Move the cursor over the icon for which you wish to obtain information (without clicking on it) and a 
brief description of the icon you are pointing at will appear together with any associated keyboard 
shortcut.
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The  Help main menu

   

Opposite you will find the description corresponding to 
the Floodfill tool.
If you wish to reduce the content of the InLine help or 
prevent it from appearing on the screen entirely, the 
corresponding options are available in the Help menu.

The About... window

This section provides information about the program :
* name of developers,
* beta-testers,
* date of creation,
* serial and license number,
* copyrights.

The Check for Updates option

This option allows to check directly on the TVPaint Développement website if there is an update for 
your software. If your version is outdated, you will be allowed to download the lastest version.
Lock and Unlock codes are needed to perform this operation.

To quit the program

We will now quit the program. To do this you may:
* Click on the Close button at the top of the screen  (PC) or  (Mac)
* Select main menu File > Quit.
* Use the keyboard shortcut [Shift+Q]

The confirmation window opposite then appears.

Save the configuration

At this point, if you wish to keep the current layout of panels on the screen for the next time you 
open  TVPaint Animation Pro as well as the effects, palettes and various settings used (this list will 
be completed as the lessons progresses …), tick the Save this configuration box.

You may then choose to:
* Leave TVPaint Animation Pro, or.
* Stay and return to the TVPaint Animation Pro interface.
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Managing the configurations

Managing   the configurations  

A configuration contains a lot of useful informations like the layout of panels, the interface colors, 
the palettes, etc ...
You certainly guess it : it is possible to create several kind of configurations :
For exemple : a configuration adapted to dual-screen computer, a configuration adapted to HDTV, 
another one with other interface colors, etc ...
The current configuration can be saved when you quit the program. The starting panel of the 
program allows you to manage the configurations.

When restarting TVPaint Animation Pro, the user may either create, copy or delete a configuration
(you can also select their storing folder).
* To create a new configuration, click on the dedicated button in the window which first appears 
when the program is started (see below).
* To duplicate an existing configuration, click on the Copy button in the same window. A text 
window will appear. You may enter the name of the duplicated configuration in the text field and 
then validate it by clicking ok.
* When a configuration is deleted, all effects, brushes, palettes, shortcuts… used previously will be 
lost. Of course, if you saved them in advance, you can reload and re-use them.

 By default, the configurations are located in the folder :
- C:\Documents and Settings\your_name\Application Data\TVpaint Animation\ 
  for Windows users
 - $ Home Directory/Library/tvpaint animation pro/default

              for Mac OS-X users

The from file popup menu allows you to start the software by loading one of the ten previously 
used project.
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The Preferences panel 

The   Preferences   panel     

The Preferences panel is accessible via the Edit main menu. This function is used to set various 
user options which enable re-organisation of the interface.

It comprises four tabs: General, Display, Interface, Memory & Cache.

The General tab 

The General tab indicated above comprises four sections for a PC and three for a MAC.
* The first is used to select the HMI language. At present, the user may choose between French 
and English.
* The second section is used to attribute keyboard shortcuts to almost all icons and menu options.

You have probably noticed that when the InLine help appears, many tools, options, drawing 
modes, etc. already have associated keyboard shortcuts.

◦ The left-hand column indicates all keyboard keys and key combinations with the associated 
functions when attributed.
◦ The right-hand column indicates all TVPaint Animation Pro functions which may be attributed to a 
keyboard shortcut.
◦ The Assign button is used to assign a function to a specific key or combination of keys (in which 
case you will create a shortcut for this function). The combination [Ctrl] + Assign is used to add a 
function to a key. The various functions will be executed in the order they were added.
◦ The Unassign button has the opposite effect (in this case it deletes the shortcut).
◦ The File popup menu is used to save the keymap on your hard drive, load an existing keymap, 
clear the current keymap or reset the default keymap.
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To create your own shortcuts, click 
on the Configure button in the second 
section.

The window opposite then appears.



The Preferences panel 

* The third section of the General tab is used to define a temp directory in which temporary 
TVPaint Animation Pro files may be stored.
◦ This directory may be modified using the associated text field or using the Set button (a file 
navigator window then opens).
◦ The temporary files contain data relative to the current TVPaint Animation Pro session. Data 
relative to your animations is also stored here (for example, the various stages of your work 
necessary for correct operation of the Undo and Redo options).
◦ Inexperienced users are advised not to change the default location.

The faster the data storage device on which your temporary files are stored, the 
faster TVPaint Animation Pro will work. Always ensure this storage device has 
sufficient available storage capacity.

* The fourth section of the General tab (specific to PC users) is used to enable or disable the Sub-
Pixel mode for future drawings. This is in direct relation with your hardware and, more precisely, 
with your graphic tablet if you are using one (we strongly recommend it!). 

All the latest models of Wacom tablets work in Sub-Pixel, i.e. the tablet precision is greater than 
one pixel on the screen. Enabling this function when suitable hardware is used will allow you to use 
TVPaint Animation Pro drawing tools with a precision greater than one pixel !

In the contrary case, if your hardware does not support this function, tablet management may be 
negatively affected (drift between the true position and the position of the cursor on the screen, for 
example) and will deliver results considerably different to those expected, in particular if you work 
with a platform of the TabletPC type or in double-screen configuration. 
We therefore recommend you check the compatibility of your hardware to benefit fully from this 
function. 

The Display tab 

The Display tab concerns brush display (the latter will be discussed in detail in lesson 4).
The Hide brush button is used to mask the brushes when they are used as drawing tools. Only the 
mouse cursor remains visible on the screen and a frame indicates the exact location of the brush.
This option is sometimes practical when working on a computer with limited resources: the use and 
display of large brushes may slow the computer down.
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The Preferences panel 

The Interface tab

* The first section of this tab may be used to modify the program interface colors.
The default colors used in TVPaint Animation Pro are light gray in order not to interfere with the 
colors used in your projects. However, you are of course free to modify these colors as you wish.
◦ The first popup menu allows you to select the element for which you wish to modify the color 
(buttons, text selected, sliders, etc.)
◦ Next to this field you will find a square box indicating the display color of the interface element 
selected. Simply click on this bx and then select any color on the screen to be assigned to this 
element.
◦ The Color scheme popup menu is used to quickly select a set of predefined colors or the default 
color scheme for this interface.
* The Highlight mini-slider, the Border and Mirror options allows to have a new gradient look.

            

     
* The Save and Load options allows to share the interface settings.
* The Reset button is used to return to the colors present when your configuration was loaded.
* The Apply button applies the colors selected to your current interface.
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The Preferences panel 

* The second section allows you to choose the Style of your cursor. The different possibilities are: 
cross, arrow, point or circle as illustrated opposite.

* The third section is used to Magnetize the various windows of your interface. This renders 
management of their movement more practical.
You may also choose to display the program without tool or title bars (for windows users), which 
increases the project working zone.

* The fourth section is used to select which type of file requester is to be used. Below you will find 
examples of TVPaint Animation Pro specific as well as standard Windows and Mac OS X file 
requesters. 

    
The TVPaint Animation Pro file requester is common to many software packages developed by 
TVPaint Développement and is present in your program regardless of your specific operating 
system.
It is the only one capable of displaying previews for files with extensions .TVP .MIR .AUR .DIP.

The Never confirm button, when ticked, cancels the confirmation request which normally appears 
when a file is deleted or rewritten.

* The last section contains a tick box used to place the current project windows behind the other 
interface panels.
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The Preferences panel 

The Memory & Cache tab

This tab first displays the physical memory available on your computer.
* Just below this field you will find a numeric field and mini-slider next to it. This field is used to 
attribute the amount of memory you require for the Undo option which allows you to «return» to 
and undo the previous steps when drawing on the screen. The higher this value, the «further 
back» you may go. However, this default value is largely sufficient.

* TVPaint Animation Pro uses the physical memory of your computer and one or several temporary 
files as discussed in the General tab. 
You may want to allow TVPaint Animation Pro to manage this function automatically or impose a 
maximum cache size to be used (this may be useful if you are working simultaneously with several 
programs demanding a large storage capacity).
With regard to this point, it should be noted that TVPaint Animation Pro manages operating 
systems using over 3 Gigabytes of physical memory.

To save your shortcuts, colors or other predefined preferences for later use with 
TVPaint Animation Pro, do not forget to save your configuration before quitting the 
program.

Some details

Creation of a new project requires some additional explanations which you will find below:

Working without the notion of DPI

You may already be used to the notion of DPI (dots per inch).
The DPI is a pixel density unit often used in imaging and printing software packages. The higher 
the DPI value of an image, the more pixels it contains and the sharper the printed image will be.

In the animation field, the measurement used is the pixel. The notion of pixels is more practical as 
it adapts to the specificities of both metric and non-metric systems.

For example: the European PAL format uses a resolution of 720 pixels in width and 576 pixels in 
height, whereas the American NTSC format uses a resolution of 720 pixels in width and 486 pixels 
in height. 

The global size of your animation in centimeters, meters or inches depends entirely on the TV or 
cinema screen used to view them.

The notion of pixel aspect ratio

The pixel aspect ratio is the multiplication coefficient which links the pixel width to the pixel height.
Depending on the video formats, the pixels may be either square or slightly rectangular.
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Some details

      

The pixel aspect ratio has a value of 1.067 for the PAL format and a value of 0.9 for the NTSC 
format.

 Avoid confusion between pixel aspect ratio and width/height ratio of a video (4/3, 
16/9, …). The ratio is the width/height ratio of the pixels.

Video fields 

Normally, a video image is composed of two fields which alternate at a speed which is too fast for 
the human eye, these fields are referred to as upper fields and lower fields. A field is a vertical half-
resolution image which contains every other line of the image. Interlacing of these fields is linked 
with the PAL, SECAM and NTSC standards. In PAL/SECAM, the upper fields appear first, whereas 
in NTSC it is the lower field which appears first.

This framing technique, even if twice as many images are required for the same video (50 instead 
of 25 images per second in PAL mode), has been adopted in order to improve the quality of image 
movement and precision. Taking advantage of the persistance of vision effect, it also allows the 
user to work with lower resolutions.

The use of video formats with fields is possible in TVPaint Animation Pro.
When creating a project, it is therefore necessary to indicate which of the two fields will be 
displayed first using the Fields popup menu.
The option None in this menu is used to create a project without using fields.
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Left: (pixel width) = (pixel height) x 2. 
The ratio is therefore « 2 ».
Right: (pixel width) = (pixel height).
The ratio is « 1 » and the pixels are square.





Lesson 2

Drawing basics

In this lesson you will:

● Learn how to handle the various tools: airbrush, penbrush, wetbrush, pencil, 
mechanical pencil.

● Discover the various facets of the color picker.

● Draw simple geometric forms and floodfill surfaces.

● Study the notions of opacity and transparence of a pixel.

● Study the notions of "colored background" and layers.

● Use the different drawing modes.



Drawing basics

It is very easy to draw using TVPaint Animation Pro.
In this second lesson we will draw a small house (very simple) using TVPaint Animation Pro's 
tools. In this way we can study the basics which will allow you to express your artistic talents.

Even if it is possible to draw with a trackball or mouse, it is strongly recommended to use a graphic 
tables equipped with a stylus. This tool requires getting used to for beginners but it is much more 
natural to use for drawing.

Your first drawing

The first geometric form: draw a rectangle

Once the program is started, proceed as follows: open a project in  « PAL square » format.

Click on the Penbrush icon on the Tools panel (as soon as the tool is 
selected, the icon turns yellow to indicate that the tool is chosen, see 
image opposite).
Then adjust the size of the penbrush to 1.5 pixels in diameter.

Select the Rectangle icon on the main panel by clicking on it once. 
Again, the color of the icon changes from gray to yellow once the 
selection is made.
This applies to almost all icons in this application.

Select the Bin tab of the color picker and choose a gray color  (if 
necessary, use the slider to get there).
After having clicked on the desired color (or pointed to it if you use a 
graphic tablet) this color will appear in the main panel and in the color 
picker as main color or A color.

Click on the center of the image and, without letting go of the mouse button, slide it towards the 
bottom right hand corner. Release the mouse button. A gray rectangle has now been drawn in the 
current project window (see diagrams below).

  >>  >>  >> 
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Your first drawing

The Floodfill option

We will now floodfill this rectangle with color.

Select the Floodfill option in the main panel.

Go the the Picker tab of the color picker panel and choose a color  as in 
the diagram opposite: a gray color with a slight yellow hue.
The choice of this color is important for the continuation, in particular for 
studying the drawing modes.
You will notice that the RGB information is indicated at the bottom of the 
panel, you can try to get as close as possible to them.

A right click on the same window enables the choice of other 
ranges, the colors of which vary according to hue, luminosity 
and saturation or according to the intensity of the colors red, 
green and blue.

Now click inside the rectangle in the project window and you will obtain 
the result shown opposite.

Recover a color from the screen

It is possible to recover a color among those present in the 
current drawing in order to work with it again.

To do this: either click on the A color (on the diagram opposite, 
the main color is marked with a circle) or on the Color Picker icon : .
The cursor of the mouse or tablet appears with a question mark. You 
may then point the cursor wherever you want, the color A will change 
into the color you point at. The shortcut for this action is the [;] key.

Redo and undo …

 

We will now draw the roof of our house. 
For this purpose you may use the Line tool and the Floodfill tool.
However, attention must be paid not to leave any "holes" before floodfilling 
in a surface (or the entire screen will be floodfilled!)
Your turn now! You should be able to draw the picture opposite without 
any trouble.
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Your first drawing

Notion of layers and colored background

   

Let's add a sun.
Change the tool by selecting the FreeHandDot icon 
in the main panel and then the Airbrush tool (set 
the size to 125 pixels radius and the power to 
100%).

  

Using the method described above, recover the 
yellow color in the Mixer  tab of the color picker, 
then click on the white part of the image to draw 
your sun.
You will obtain the result shown opposite.

At this point, it seems at first sight that the image is mainly composed of white... in fact, that is not 
the case !

  

If the layer window is not visible on the screen, click on the 
Timeline icon on the toolbar to make it appear (keyboard 
shortcut [0] on the numeric pad).

 

Now change the Color option (bottom left of the timeline) into None, 
then into Check and note the changes taking place in the current 
project window.

layer                                              layer                                             layer

              
background = Color                       background = None                       background = Check

Everything happens as if our house and sun were drawn on a glass plate, the latter resting on a 
colored background (see perspective diagrams above...).
What we will refer to as Image layer in all future lessons is the equivalent of a transparent glass 
plate placed on a colored background of your choice. You are drawing on this plate and not on the 
colored background.
It is possible to change the color of the backgrounds Check and Color in the same way it is 
possible to recover a color on the screen thanks to the color fields next to the menu.
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Nevertheless, if you do not like the result you can go back as many times 
as you want using the Undo option (keyboard shortcut [U]) on the main 
panel. Note that the Redo option (keyboard shortcut [Shift+U]) has the 
opposite effect.



Your first drawing

Zoom and View options

     

Stay in "check" mode, we will zoom in on the sun. 

 

To adjust the zoom, you can:
* Use the small « + » and « - » icons above as well as the mini-sliders.
* Use the keyboard shortcuts [<] and [>].
* Adjust the zoom numerically by modifying the percentage in the text field intended for this 
purpose.
* Use the Zoom button on the main panel: once enabled, this button may be used to increase or 
decrease the zoom at an exact point of the current image by simply left or right clicking with the 
mouse.
Note that there are other options in the project window which may facilitate your task :
* The button « 1 » enables re-initialization of the zoom to 100 %.
* A left click on the « F » button re-aligns the image in the project window.
* A right click on the  « F » button extends the project window to display the entire image.

These zoom options are available to make your task easier when working in detail. 
However, they do not modify the videos, photos and images themselves. 
Your will find them all in the View main menu.

Your project displays are anti-aliased when zooming-out (20, 25, 33 or 50% of the original 
project size) This very useful for people who works in very high resolution. (for exemple the 
HDTV format)

In lesson 1 we learned that it is possible to work with several projects at the same time.
It is also possible to open several project windows for the same project.
You may use the [M] key of the keyboard or select New project window in the View main menu to 
do this. This is recommended when working with large zoom values and to keep an  eye on the 
entire project.

   

Note that in this case, any 
modification made in one of 
the windows results in the 

same modification being made in all 
the other windows of the same 
project.

The   button of your project window also offers you several very useful viewing options 
depending on whether you use it with the left button of your mouse or the right button.
* A left click, without releasing the mouse button, followed by sliding the mouse, moves the image 
in the same way as the sliders located next to it.
* A right click without releasing the mouse button may be used to slide the current layer and only 
this layer to quickly view the enabled layer (see next lesson for the layer notion).
At the moment you release the button, the layer goes back to its initial position.
This is very useful when you are working with a large number of layers and you do not know which 
one is enabled.
This function is called Shaker and is accessible with the keyboard shortcut  [A]. A simple touch on 
this key will make your current layer shake and reposition it immediately with the aim to rapidly 
view the current layer.
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Your first drawing

Notion of pixel opacity 

   

After having zoomed to approximately 2000% it is to be noted that 
the pixels in the center of the sun are somehow   "yellower" than 
those on the outside.

In reality, the pixels making up our sun are all yellow. However, the 
pixels in the center are less transparent (or more opaque...) than 
those on the outside.

You will notice that the pixels of the sun let the colors of the check background through with more 
or less intensity while the pixels of the house are completely opaque: it is impossible to see the 
check background through the house.

R,G,B and H,S,L color systems

Open the Slider tab of the color picker.
It is possible to define a color from its components 
RGB : Red, Green, Blue or from the HSL system: Hue, Saturation, 
Luminosity. You may move the sliders to obtain the desired color or use 
numeric values.

(Select the color blue to continue the drawing).

   If the Sliders tab of the color picker is not selected (i.e. on each tab 
of the color picker except Sliders), a line referred to as Status bar is visible. This line is used to 
display the values in the RGB system of the A  color(click on this bar to make the color appear in 
the HSL or hexadecimal systems).

The drawing modes
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Some modes may not be used with all tools.

There are several drawing modes in TVPaint Animation Pro:
Color, Behind, Erase, Panto, Light, Shade, Tint, Colorize, Smooth, Grain, 
etc.
We will look at each of them in turn.

They are available in the popup menu located under the icons of the 
Tool panel (left click to access it).

If required, you may assign keyboard shortcuts of your choice to the 
various modes proposed (see lesson 1).



The drawing modes

The Color and Behind drawing modes

    

We will now draw a blue sky.
To do this:

* Select the Freehand line icon (in the main 
panel).
* Select the wetbrush tool
(size 100 pixels, power 100%, opacity 100 %). 

The red «1:4 » indicates that the tool is four times larger than the one visible in 
the white rectangle to the left.

Wetbrush in Color mode  

Wetbrush in Behind mode

Mechanical pencil and Pencil tools

The drawing above will serve as a basis to study the other drawing modes.
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You have already seen the Color mode (keyboard shortcut 
[F2]) as you have been using it since the beginning of this 
lesson...
When you use the Color mode, your line and color are applied 
over the already existing image.

When you select the Behind mode (keyboard shortcut [F3]), 
TVPaint Animation Pro will take into account the already 
existing pixels from the line as well as their level of opacity. 
When the option is chosen, the color is only applied to the 
transparent surfaces of the image.
The color is therefore not applied over the house or over the 
sun but is partially visible through the latter.
Floodfill in the entire image in blue using this mode.

A few words about the Mechanical pencil and Pencil  tools to 
finish off our drawing.
Select the Pencil  tool (in color mode) and one or several 
shades of green. They are used to add grass at the foot of the 
house.
For more precise drawing (e.g. a signature), the Mechanical  
pencil tool is the most suitable.



The drawing modes

The Erase drawing mode

Airbrush in Erase  mode (background=check)

The Shade and Light drawing modes

Airbrush in Light mode 

Airbrush in Shade mode

The other drawing modes will be studied in lesson 7.
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The task of the Erase mode (keyboard shortcut [F4]), as the 
name  implies, is to erase the pixels of the current layer by 
making them transparent.
Thanks to this mode, it is possible to correct possible faults in 
a drawing.
Opposite, the Erase mode is used on a check background.

As their names speak for themselves, these drawing modes 
require almost no additional explanation. They are used to 
brighten or darken the opaque areas of the image where you 
draw your line.

Just note that the higher the Power and Opacity of the 
drawing tool, the more the drawing carried out in these modes 
will approach opaque white or opaque black.

In this example, we used the Airbrush tool with a power of 
100 % and an opacity of 17 %.

If the chosen background is white or black, do not 
confuse the Erase  mode with these two modes : 
the modes Shade and Light modify the color of the 

pixels, whereas the Erase mode modifies their opacity.



Further details

Further details

A Color and B Color

   
A very good tip:
It is possible to invert the two colors A and B of the color picker using 
the keyboard shortcut [N] or the  button on the main panel.

Rotation of the workspace

One of the most useful tools for any artist is the tool that allows rotation of the work top as one 
would turn a piece of paper while drawing. There are several ways to turn your workspace.

The button  located in the project window is used to freely define an angle by left clicking 
and holding the button followed by a left / right movement of the cursor. You will see the workspace 
rotate in real time and you just release the button once the desired angle is obtained. This free 
adjustment may also be carried out using the keys [Ctrl+Alt] + left click.

   The free adjustment and its HUD in the form of a traditional drawing workspace

Note that Rotate +/- 15° will always be rounded off to the prior/next multiple of 15. For example, if 
you work at first with an angle of 25° and then decide to tilt the project by +15° using 
[Shift+PageUp], you obtain an angle of 30° and not 40° as 30 is the first multiple of 15 after 25. 
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You may also right click on the same button, which will open a menu 
(see opposite) in which you have the possibility to :

Reset the overall angle value (keyboard shortcut [Insert]), 
Rotate the view +15° (keyboard shortcut  [Shift+PageUp]), 
Rotate the view -15° ([Shift+PageDown]), manually define an angle 
value (Set option) or choose a pre-defined angle among 15 values 
all multiples of 15.



Further details

Management of palettes and mixers

The Mixer and Bin tabs in the color picker may be used to optimize your choice 
of color.
A right click under one of the two tabs enables display of a contextual menu 
which is specific to this purpose and offers many choices (see opposite the 
Mixer tab menu ).

At first you can choose to work with pre-defined mixer surfaces: blue, clouds, 
inks, dirty, nebula, etc. or pre-defined palettes: TVPaint Animation Pro 1, 2, 3, 4 
and gray.

If the mixer and palettes proposed are not what you want,
TVPaint Animation Pro also offers you the possibility to create, duplicate, 
rename and cancel your own palettes or mixers. These options are also 
accessible via the contextual menus (options New, Copy, Rename, Delete).

     

It is possible to modify the existing or newly created mixers : a left click on 
the mixer surface incorporates the A color to the visible mixer which can 
then be «spread».
If you are not satisfied with the color obtained, you can delete it with the 
Delete Mixer choice.

    

In the Bin tab you have some additional choices in the contextual menu: 
Replace, Swap, Spread and Delete.
These choices act directly on the current palette.
You may repectively: replace the color in one field by the current color, 
swap the colors of two fields, spread the colors from one field to another 
and delete a field.

Once you have created the mixers and palettes adapted to your needs, do not forget to save the 
configuration when you quit TVPaint Animation Pro. In this way you will have your color 
parameters at your disposal the next time you start the program.

You can import or export palettes and mixers at any time via the File sub-menu. This enables 
exchanges between users of the software.

It is possible to return to the default mixers and palettes of TVPaint Animation Pro using the 
Default palette or Pre-defined palette choices in the contextual menus.
The pre-defined palettes et mixers may be restored by resetting the TVPaint Animation Pro 
settings.

You should note, however, that the last two operations will delete the palettes and 
mixers that you have created yourself unless you have exported them previously.
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Further details

Colors History

   

When you draw with TVPaint Animation Pro, the history of colors 
you have used is accessible with a right click on the color square 
on the main panel or a left click on the   button (see opposite).

It is therefore very easy to re-use a color that you have recently 
used.

It is possible to shade the colors A or B by left clicking on the latter in the main panel 
or the color picker and then keeping the button [Ctrl] pressed when moving the 
mouse to another color on the screen.

The Color Variations panel

The Color Variations panel is accessible thanks to a right mouse click on the color box of the main 
panel or via the Window main menu.

      

It puts at your disposal several ranges of color, 
derived from the current A color.

Some luminosity variations based on the A color
Some saturation variations based on the A color
Some chromatic variations based on the A color
The Step option allows to adjust the chromatic 
variation

If the Lock button is not checked, the color boxes are automatically refreshed if you change the 
A color. (A simple click on a color of the Color Variation panel will change the A color into the one 
you have chosen)
If the lock button is checked, the color boxes will stay the same whatever you do.

Drawing splines, segments and circles

   This icon on the main panel enables the FreeHandDots tool.

   This icon enables the FreeHandLine tool for continuous lines.

   This icon is used to trace Straight Lines.
To draw a segment in your project window: 
* Left click on the first end of the segment,
* Keep the button pressed while sliding the mouse,
* Release the button when you reach the second end of the segment.

   At the beginning of this lesson we learned how to draw a Rectangle.

   This icon is used to draw Circles and Ellipses. 
In the current project window, point your stylus to the center of the ellipse to be drawn, then move it 
to create the ellipse you desire. Press the [Shift] key first to obtain a perfect circle.
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Further details

    This icon offers you access to more complex Splines. 
By default it is possible to trace multi-point splines. The latter are also referred to as Bézier Splines 
by mathematicians. By modifying the options in the Shape Settings window, it is also  possible to 
draw three-point splines (see following section).

To trace a multi-point spline in your project window: with a few clicks or presses with the stylus on 
the current project window, you can construct a broken yellow line interspersed with knots.

This line is not directly integrated in the drawing: The option Apply spline or the 
keyboard shortcut [Enter] is required to obtain a result (a right click calls up the 
contextual menu shown opposite).

The advantage of this tool is that it allows to work on the knots.
* A left click on one of the knots followed by a movement of the stylus allows you to move or edit 
the spline line of the broken line at this point. In the latter case, the tangental lines of the spline 
appear (see the red spline in the diagram below).
* For more precision: the [Ctrl] key allows you to work on the line of your choice without influencing 
the position of the second.
* You may also move the spline globally by pressing [Ctrl]+ left click outside the spline.
* Finally, it is also possible to close the spline via the option in the contextual menu.

The form of the circles, rectangles, splines … obtained using the procedure 
described above, depends on the tool chosen: penbrush, airbrush, pencil, etc. (see 
above).

 
         circles   /  segments /  Bézier splines (applied using different tools)
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The Add to bin option allows to keep in memory the current spline. It is often 
very usefull, especially if you need to re-use it later. (Once the Add to Bin option 
is selected, the software asks you to name your spline)
Re-using a stored Spline can be done by choosing its name in the menu.
You can also delete a stored spline thanks to the Delete menu.

Your splines will be kept in the bin after restarting the software only if 
you saved the current configuration.
Please remember that if you delete or reset the configuration, all your 

Splines will be lost.



Further details

Adjust the Shape settings

* In the first popup menu you can define two methods of drawing circles. You may choose to:
◦ draw your circles fixing a centre and then a radius.
◦ draw your circles defining three points on the screen (geometrically, there is only one circle 
passing through three non-aligned points in the drawing).
* In the second popup menu you can modify the nature of the splines you will draw using the 
Spline tool studied previously. You may choose to:
◦ draw Bézier splines (multi-point splines).
◦ draw  three-point splines. 

To draw a three-point spline in your project window: 
◦ left-click on the first end of the spline,
◦ keep the button pressed while sliding the mouse,
◦ release the button when reaching the second end of the spline,
◦ slide the mouse,
◦ left click when satisfied with the spline.

* The section named Panto enables adjusting the vector of the Panto mode studied in the following 
sub-chapter.

The Panto drawing mode

The Panto mode is used to reproduce, by translation of the vector of the X,Y coordinates, all 
sections of the layer (the X,Y values being those present in the Shape settings panel).

It is possible to interactively define the X,Y values using the Adjust button 
(keyboard shortcut [Shift+P]) of the Shape setting panel (tracing a segment on the 
screen will determine the X and Y values).

E.g. for X= -360 and Y= -238  you will obtain, after having used the penbrush to draw a line at the 
height of the sun in the final image (corresponding to the diagram below) :

         

Here are the steps to use the panto mode correctly :
1) first, use the RMB on main panel tools and set the vector X and Y (set values or click on the 
'Set' button and draw the vector on your project). 
2) choose a drawing tool like Airbrush and set drawing mode Panto in the popup menu under the 
drawing tools icons. 
3) on your project you have two cursors. One simple for the source and an other with preview for 
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The panel shown opposite is accessible in the Windows main menu or 
with a right click on one of the seven drawing tool
(dot, freehand, segment, spline, rectangle, ellipse and floodill).



Further details

the destination. Pixels under the first one are moved under the second one with the settings of the 
current tools.

Setting the tools

You have numerous variables at your disposal to set your drawing tools. We will describe them in 
detail except for Drying and Gradient which are explained in lesson 3.

    

* The variable Size defines the tool radius in pixels.

* The variable Power defines the color quantity applied by the tool.

* The variable Opacity defines the global tool opacity.

The opacity defines a maximum opacity threshold which the drawing tool 
cannot exceed.

* The variable Aspect enables flattening of the current tool.

* The variable Angle authorises rotation around the tool Z axis.

* The variable Step, if enabled, manages the waiting time between two 
applications of the same tool.

 In the little window to the left, it is possible to view the effect of the modification of 
each of the first five variables on the tool.

Some examples to help you understand the notions mentioned above:

   

See opposite, a straight line traced with, from top to bottom, the 
percentages  300%, 100% and 0% for the Step variable.

   

TVPaint written with the airbrush tool :
Angle = 90° and Aspect = 20%

   

Mechanical pencil tool left without Smoothing, right with smoothing.

If required, the Reset button resets the settings of the displayed tool.
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Further details

Drawing filled shapes

    

With the exception of the FreeHandDots tool, a second mouse click on 
one of the icons described previously enables the fill function. You may 
thus draw filled disks, rectangles and other filled splines. A second click 
on the FreeHandDots tool enables the SimplePoint tool which is used to 
draw only a single application of the brush.

This is an alternative to the Floodfill option in simple cases.

Setting of the brush profile

The right field in the tool panel provides a view of the drawing tool cross section.
Below you will find two profile examples for the airbrush drawing tool.

           
left to right: profile, three-dimensional view of the tool and its effect on the screen.

          

The  profile of brushes 
may be edited in the 
window shown opposite.
 
Right click on the profile 
of the tool you are using 
to make it appear.

You have the choice :
* to create or delete the points of the spline.
* to move the latter.
* to flip to the spline along the horizontal or vertical axis.
* to choose the method applied to connect the points with each other: Linear, Spline or Polynomial.
* to select a pre-defined profile, if required:
to do this, use the two arrow buttons to scroll the pre-defined profiles and then click on the profile 
of your choice to display the corresponding profile on the screen.
As for the palettes and mixers, TVPaint Animation Pro offers you the possibility to Load, Save and 
Reset the profiles (File popup menu).

The coordinates

Drawing basics 2-15

The Coordinates window is accessible via the Windows main menu 
or via the icon of the tool bar shown opposite.
* left you find the coordinates in pixels of the pixel pointed with the 
mouse as well as its RGB values.
* right you find a small zoom box with a central point.
* if you draw a rectangle, the two empty lines will indicate the height 
and width of the latter in pixels.
There you will also find the length of the two half-axes if you draw an 
ellipse.



Further details

The Re-apply option

  >   >   > 
This is a situation that is often encountered:
you have drawn an ellipse on your screen…
But, you have used the wrong tool: you used the Oilbrush instead of the Penbrush. The Undo 
option allows you to go back (the ellipse drawn with the oilbrush will disappear), but you may have 
trouble drawing the ellipse again with the same precision…
Even when having noted the exact coordinates of the ellipse (center coordinates and length of the 
two half axes), it may be tiresome to reproduce exactly the same drawing on the screen.

The Re-apply option (keyboard shortcut [Enter]) was developed to counter this type of problem and 
facilitate your task…
When your ellipse is deleted, change the tool and adjust the parameters and colors. Then select 
the Re-apply option in the Edit main menu.
A new ellipse is drawn.

You may even do more than that as, before using the Re-apply option, you have the following 
choices : change the layer, select several layers, change the type of line to work with filled 
shapes… (see the examples above…)
It is even possible to define selections or cut animated brushes from the original drawing !

Use the Grid

The grid is, in fact, a kind of plotting paper the parameters of which may be set and the basic unit 
of which is the pixel.

    
As you have probably guessed, this option is also accessible in the Tool bar and the Windows 
main menu. Once enabled, it does not affect your project itself, but the way you will draw (just 
disable the option to make the red grid disappear…).
* The Grid panel which is accessible with a right click on the Grid icon in the Tool bar or via the 
Windows main menu is used to set the width and height of the boxes (use the numeric fields of the 
same name or the mini-sliders). 
* The Start-X and Start-Y numbers will help you shift the grid on the surface defined by the work 
area.
* If required, you may adapt these four values in such way as to recover the image using the 
current brush and the Brush size button.
* The Set button is used to interactively define the grid parameters by drawing a dummy rectangle 
in the current project window.
* The Show box displays the grid when it is checked.
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Using a grid is very useful when :

* drawing parallel lines, 
* placing a brush at regular intervals 
on the screen,
* aligning a text along a vertical line, 
* etc.



Further details

* The Snap box renders the grid magnetic. This option imposes that the user may only use the red 
pixels at the intersections of the horizontal and vertical lines. This works as if the cursor on the 
screen were magnetically attracted to the grid intersections.

Use the guides

The purpose of the Guides of TVPaint Animation Pro Pro is to create customized and magnetic 
marker points in the current project window.
When using the guides it is very easy to draw concentric circles or parallel lines.
To display the latter, left click on the Tool bar button shown below (a right click will open the 
window for guide parameter setting).

     
The following options are available in the guide parameter setting window:
* Once the Set button is selected, any click with the mouse in the current project window will 
generate a horizontal and a vertical line. It is therefore possible to create « a grid with irregular 
graduations » and to impose the line intersection points as the only points to be used.
* The Reset button is pressed to go back to a project window without guides.
* The Show box, when checked, displays the guides.
* The Snap box imposes the yellow pixels at the intersections of the horizontal and vertical lines as 
the only pixels to be used. This works as if the cursor on the screen were magnetically attracted to 
the guide intersections.
The Files popup menu enables saving and loading of your guide positions.

The Safe Area 

The safe area may be displayed in the current project window: it may be enabled via its Show 
popup menu (see below).
It is therefore possible to recover the markers normally used in the film industry:
the action and text safe areas allow viewing of what will effectively appear on the TV screen (i.e. 
the Safe Area).
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Further details

Display settings

     

The Display Settings window is accessible via the Windows main menu 
and is used to choose the color and opacity of the guides, stencils, 
safe area, animation disk, etc.

You may also enable display of the stencil, paper and selections when 
using the latter.

The safe area has some additional parameters: position of the action 
and text safe areas may be set in percentages.
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Lesson 3

Layers spatial management

In this lesson you will learn to :

● Use the paper.

● Create a Color Gradient.

● Study the notion of the layer with its multiple aspects.

● Name, move and select layers.

● Assign a color to a layer.

● Manage the global opacity of a layer.



Layers and timeline

Layers and timeline

When starting the program, select the template TVPAP – Image Layer  so that the newly created 
project only contains one Image layer.

The Oilbrush tool

    

We'll start by drawing a little man in 
the center of our image.
To do this, use the Oilbrush tool, 
select FreeHand and the red color
(R=255, G=0, B=0).

Now display the Timeline if it is not displayed yet (shortcut [0]). The following window will appear :

   

This window shows that our little man was drawn 
on a layer named «Untitled 1». Indeed, every 
layer has a name.

Rename a layer

We will now rename the layer. You have the choice to :

Select Rename layer in the Layer main menu.
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Call up the popup menu by clicking on the layer name in the Timeline 
(here : « Untitled 1 »).

Once the popup menu is displayed, select the name of the layer at the top 
of the menu and release the mouse.



Layers and timeline

   

Independent of which method was used, a text window will appear. You 
may now enter the name (« Character ») in the text field and then validate it 
by clicking on OK.

Create a New layer

TVPaint Animation Pro offers the possibility to work with several layers. With a bit of practice, this 
will make your work much easier.
To create a new layer you can :

   

Use the keyboard shortcut [Ctrl+N], 
select New Layer Image in the Layer 
main menu or select New Image Layer 
in the New menu of the timeline (see 
example opposite).

   

Our timeline now comprises two layers: 
the «Little man » layer and our newly 
created layer, referred to by default as 
« Untitled 1 ».

You may also rename this layer. We will 
call it « gray blob ».

The current layer

The  « white » layer in the timeline is called Current layer. When you draw in the work window, the 
modifications are only applied to this layer. The « gray » layers remain unchanged, independent of 
their position.
To change the current layer you can: 
* Use the arrow keys [ ↑ ] and [ ↓ ] on your keyboard.
* Click on the layer of your choice in the Timeline.
* Select Current in the popup menu which is accessible with a right click in the timeline.
* Use the shortcut [ , ] to select the layer by clicking on it. Press [ , ] then the layer you wish to 
select. If there is a multiple choice, a menu will appear.

The advantage of working with several layers

 

Now draw a gray blob in the center of the image on the new layer using 
the penbrush tool (radius: 50 pixels,
power : 100%, opacity : 100%, mode : color) 
At first sight, the gray blob seems to cover the little man.
But in reality this is not the case...
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Layers and timeline

  

When looking at the thumbs in the 
timeline, we see that the gray blob and 
the little man are on two different layers.
We have thus superposed two layers on 
our white background, as illustrated in 
the diagram below.

« Gray blob » layer

« Little man» layer

White background

The gray blob therefore does not delete the little man.
If you use the same tool in Erase mode on the same gray blob, you will note that the little man will 
reappear!

Flip layers

Before continuing with our work, we will flip the two layers. This is how it is done:
left click on the small frame representing the gray blob in the timeline, then slide the cursor on the 
timeline until it is under the « little man» layer. Release the mouse button.

       >>                                            
before flip                                      after  flip                                                            no flip (merge)

       

« Little man » layer

« Gray blob » layer

White background

                              position of layers after flip

We now have the configuration as shown in the diagram above. In the current project window, the 
little man is positioned on top of the gray blob.

When trying to flip two layers, a frequent mistake made is to move one layer on 
top of another. This is the process of merging two layers (which will be described 
in detail later in this manual).

The case being, click on Cancel in the merge options window to return to the original 
layer disposition.
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Layers and timeline

The Undo option in the main menu may be used for the modifications made to the 
project as well as for those applied to the timeline.

Erase the contents of a layer

Use of a Paper

With TVPaint Animation Pro it is possible to accelerate drawing certain repetitive shapes such as a 
brick wall. Proceed as follows: 

* Floodfill in the current layer (« gray blob ») with a 
dark gray color.

* Open the Paper  window which is accessible in the 
Windows main menu or with a right click on the 
Papers icon on the tool bar.

* Select any type of wall in the papers window. 

* Change A color for a light color, close to white.

* Floodfill in the « gray blob » layer using this color.

You will note that the paper you have chosen is used as a pattern to paint the layer surface (see 
drawing above). Our brick wall has been created and the « gray blob » layer may now be renamed 
« brick wall ».
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It is possible to erase the contents of a layer without using the 
Erase mode.
To do this, just click on the icon of the main panel opposite or use 
the shortcut [Shift+K].
This option has no effect on the layer named  
« little man» which is not our current layer.



Layers and timeline

Soften the contours of a surface

* Draw a rectangle in the center of the image. The effect of the prior manipulation is immediate: the 
edges of the rectangle are less sharp.

* To finish, flip the two layers again.

   >>  
before flip                             after flip

Apply a color gradient

   

Our little man is now behind the 
brick wall.
We will add a tinted glass between 
the little man and the wall.

* Start by creating a new layer, name it « glass » and place it as shown in the Timeline above. 
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Let's continue our drawing:

* check that the « brick wall » is the current layer,

* deselect the function Paper on the tool bar, 

* select the Rectangle Fill shape in the main menu, then the 
Mechanical Pencil icon in the tool panel.

* enable the Erase mode,

* in the option window named Filling shape which appears in 
place of the tool panel, set the value in the Smooth numeric 
field to 20 pixels.



Layers and timeline

   

* Select the color cyan for A color then a blue color for B color.

* In the Filling shape panel, change the Erase mode for the Color mode 
and tick the box Gradient.
The gradient from A color to B color now becomes visible.

* Draw a Filled rectangle in the layer named « glass », paying attention that 
its dimensions correspond to the size of the « hole » in the brick wall.

    

* The cursor shown opposite invites you to choose the Orientation and Extent of 
the gradient. 
The gradient will be applied along the segment you will draw, from A color to B 
color.

   

You will thus obtain the result shown opposite in the current project 
window.
The perspective diagram and the timeline hereafter confirm the 
presence of three layers although only two are visible on the screen.

      

Brick wall layer

Glass layer

Character layer

White background

Modify the global opacity of a layer
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You may modify the global Opacity of a layer:

* by left clicking on the white bar on the timeline.
* by right clicking on the same bar to call up the numeric field shown 
opposite.
* via the contextual menu of the layer.



Layers and timeline

Global Opacity of the Glass layer with various values:

            
               0%                                 20 %                             40%                              60 %

    
           80%                             100%

Gradients and Opacity mapping

The parameters for the pixel opacity of our glass may be entered as soon as the gradient is 
established:

1st method: the opacity gradient.
Erase the contents of the layer named « glass » and set its global opacity to 100%. Open the 
Color gradients window (right click on Gradient in the Filling shape panel or access it via the 
Windows main menu).

* The first horizontal bar represents the aspect of the  gradient as 
it will be displayed on the screen.

* The second bar displays the colors chosen for the gradient. In 
our case, the two keys at the end indicate the A color on the left 
and B color on the right. 

* The third bar indicates the opacity chosen for both colors.

Click on the left key of the opacity bar and modify its opacity using the Alpha mini-slider to adjust 
the percentage to around 20%.

The keys are symbolised by a colored rectangle .

The first horizontal bar changes and its left section becomes transparent (presence of a check 
under the cyan color).

   

Now draw the rectangle that represents our glass and you will note that 
the cyan section is transparent while the blue section is opaque.

Note that no modification was made regarding the global opacity of the 
layer named « glass ».
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Modification of the « glass » layer's global 
opacity will vary the opacity of all  pixels 
making up the layer.



Layers and timeline

2nd method :

  

You may also use the Opacity mapping option in the Filling Shape panel.

If you draw a single-colored rectangle after having enabled this option, 
the opaque and transparent areas are respectively layered on the black 
and white areas shown in the frame below (see below).
For those who wish to know how to edit your own mapping, this is 
explained on page 16 of this lesson.

  >>  

 

Show and hide a layer

   

It is possible at any time to only show the layers of your choice.
The layers visible in the project window are those ticked in green in the first 
column of the timeline.
The hidden layers are those which are ticked in red in the same column and 
the name of which is displayed in gray (click on the color fields to toggle a layer 
from visible state to hidden state and vice versa).
Whatever the displaying options are, once the icon H is ticked, only the current 
layer is displayed.

 You can draw only on a displayed layer.

Merge layers

When it is no longer useful to work with several layers, you have the possibility to merge the layers.

The Merge popup menu in the timeline offers you three options for this purpose.

These options are also available in the Layer main menu.

* Merge selected layers : the non-selected layers are not merged.
*  Merge visible layers : in this case, the hidden layers remain intact.

*  Merge all layers : the layer resulting from this operation contains the current image.
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Layers and timeline

To select an additional layer (multi-selection): press the [Ctrl] key on the 
keyboard and left click on its thumb. You may also use the [Shift] key to select all 
layers between the last selected and the one you are clicking on.

Another possibility is to slide one layer on top of another and call 
up the merge options shown opposite.

If you tick the Stamp field, the merger is made according to the 
opacity of the layer moved and the A color.
You may choose to cancel or keep the original layer as well as 
apply one layer on another in color, erase, behind mode, etc.

Further details

Delete, duplicate a layer

* It is possible to delete a layer, an option which is quite different from erasing its contents…
To do this, select  Delete selected layers then click on Confirm in the contextual menu of the 
timeline (to do this, you may also use the Layer main menu).
* To duplicate a layer, proceed in the same way using the same menus.

Lock a layer

To lock a layer  may be useful under several circumstances.
Click on the little padlock located in the timeline in front of the layer to be locked.

Once a layer is locked you may neither draw on it, nor delete it or modify its global opacity, nor 
select it as current layer. 
Click again on the padlock to unlock the layer.

Reduce a layer

   

It is practical to reduce a layer when 
there are too many of them to be 
displayed on the screen. 

A left click on one of the arrows in the 
black circle on the diagram opposite 
increases or decreases the size of a 
layer in the Timeline.

The layer itself is not changed in any way but only its name and global opacity are visible in the 
timeline.
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Further details

Assign a color to a layer

   

Another operation that does not affect the layer itself is to 
assign a color to a layer.
This operation allows you to simply organise and mark the 
layers using pre-defined colors.
Click on the « C » icon in the first column of the timeline to 
modify the color of the chosen layer.

The color gradients

As for the mixers and palettes, there are pre-defined color gradients which you may Copy, 
Rename, Delete. These pre-defined gradients are accessible in the popup menu indicated in the 
image below in the Gradient window.
It is also possible to create your own gradients according to your color and opacity criteria:

* A right click on one of the keys of the color bar enables you to 
either delete the key, to assign the A color or B color to it or to 
recover a color.
* A right click on one of the keys of the opacity bar enables you to 
either delete the corresponding key or to set its opacity (or alpha 
value).
* The spread number field mixes the pixels within the current 
gradient.

* The Dither numeric field works in the same way as the Spread numeric field but uses colors 
which are not necessarily among those you have chosen, although they are quite close to them 
(this process is often used in the video sector).
* The Invert option flips the current gradient.

* The ∇ cursor enables calibration of the transition zone from one gradient to another.
* The File popup menu enables you to load or save your gradients on a memory support. You may 
also choose to recover the pre-defined gradients of TVPaint Animation Pro if required.

Here again, it is necessary to Save the configuration to recover the 
gradients you have created using this program.

Color gradients and drawing tools

Color gradients are also useful when working with drawing tools :

      

Assigning a color or opacity gradient to a drawing 
tool provides a wide variety of interesting visual 
effects (see example opposite…).

The more power applied to the tool or the more 
repetition on the screen, the more its color will 
cover the gradient chosen.
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Further details

The different types of gradients

Whatever your choice may be, you will have to draw a vector on the screen to determine the 
direction and extent of the gradient (see below).

         

From left to right: the gradients Linear, Spherical, BiLinear, Radial and Rectangular.

Another use of papers

Apart from reproducing a given pattern, the papers may be used to simulate drawing on a real 
paper. The combination of papers with different drawing tools provides very realistic results and 
enables imitation of different drawing styles: charcoal, painting on glass, lithography, etc. (see 
below)

        

Some images are constructed using many papers.

The image opposite, for example, which is 
available on the CD was compiled using 10 
papers.

Numerous options are available in the papers window. You may:

* Modify Hardness, Size and Angle of your papers.

                    
hardness 33%                                 hardness 66%                            hardness 100%

3-12 Layers spatial management

When the gradient field is ticked on the Filling shape panel, 
several types of gradients are available to you (click on one of the 
five buttons on the panel…).



Further details

                    
size 200%                                     size 100%                                       size 50%

                    
angle 0°                                         angle 60°                                        angle 120°

* Invert the papers (Negative option).

                   
  original paper                           inverted paper

* Create a symmetry along the horizontal axis or vertical axis before application (options Flip X and 
Flip Y).

                 
                                                 original paper                                symmetry along vertical axis

Create and manage your own papers

   

* Right click on one of the papers in the papers windows to either 
choose the latter or delete it.

* Right click on the part of the window that does not contain any papers 
to create a new paper from the current image.

Note that your choices are only saved after closing the program if you 
have saved your configuration previously.

Layers spatial management 3-13



Further details

The Papers and the Oilbrush tool

       

As indicated above, 
the Oilbrush drawing 
tool also interacts with 
the various types of 
papers available
(see opposite).

But the Oilbrush tool also offers many other functions...

   

It offers a Light parameter which gives volume to 
the paint (see opposite).

Various light parameters possible

     

By default, the oil paint is not deposited on top of 
the oil paint already on the layer : it melts into it. 
However, if you click on the Drying option, the 
former will be the case.

 
         without Drying                  with Drying

Note that there are different Grain modes available which are shown below:

         
            silk                             soft                           medium                         hard

Using the mask

Using the mask is very handy when handling the layers.
It enables you to draw, on the layer of your choice, the opaque pixels of another layer in exactly the 
same place.
In this way it is possible, for example, to modify the « texture » of a drawing without changing its 
shape (see below).
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Further details

       >> (1)   (2)   (3)

How to proceed :
* First of all, create two layers in the timeline, then draw the little red man shown above in one of 
them.
* Then enable the Mask for this layer :
to do this, click on the little gray rectangle in the second column of the timeline on the current layer. 
The little gray rectangle must turn yellow.
* Hide the layer with the little red man, then move to the empty layer.
Any drawing will then be limited to the opaque areas of the layer containing the little red man.

For example, drawing a filled rectangle with color gradient and use of a paper on the screen will 
display image 1, drawing with drawing tools, gradients, papers and specific modes will obtain the 
results 2 and 3.

It is possible to flip the mask and only draw on the transparent areas of the layer containing the 
initial little man (examples 4 and 5 below).
To do this, proceed as described above and click on the button Invert the mask indicated in the 
following diagram (this must then turn black).

        (4)     (5)

The S button on the timeline enables disabling of all masks or inverting of 
all masks according to your choice in the menu. 
It is possible to work with several masks divided into different layers: in 
this case, the masks are added up.

When a pixel is partially opaque, it may only be partially modified when using a mask. For 
example, a pixel with 80% opacity can only be painted with maximum 80% opacity when the mask 
mode is used (if the mask is inverted, it may only be painted with maximum 20% opacity).
Finally, you should understand that, when pressing the Erase button while using a mask, only the 
part of the drawing corresponding to the mask will be erased.
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Enable the mask  - >

Invert the mask  - >



Further details

Displaying masks and papers

It is possible to display masks and papers on the screen to give a better idea of the project areas 
on which you are currently working.
To do this, just use the popup menu Display in the current project window (see below).

        

Opacity mapping

    

This window is accessible with a right click on the 
corresponding field of the Filling Shape panel and enables 
precise definition of the opacity and transparency areas 
when applying a filled shape.

You may trace the spline of your choice on the X and Y 
axes by placing points at your convenience. Three types of 
interpolation are available to connect the points with each 
other: Linear, Spline or Polynomial.
In accordance with your settings, a new opacity mapping 
will be defined.
The two red splines define the opacity of each point of the 
card as indicated in the dotted example.

The File popup menu enables saving, loading or resetting the opacity mapping.
As required, you may swap the two splines corresponding to the X axis and Y axis of the mapping 
(Swap button) or flip each spline vertically or horizontally (Flip X and Flip Y buttons).
The Copy button is used to copy the current spline (the one that has a point selected thus yellow) 
on the other axis. On the image above, the current spline is the Y spline.
At the bottom left of the window, pre-defined opacity mapping are at your disposal.
You may also adjust the mapping by clicking on the image and sliding the mouse.

Here again, you have pre-defined parameters at your disposal. (Press the ↑ 
and ↓  buttons at the bottom left of the panel, then click on the pre-defined 
mapping of your choice.)
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Further details

The icons at the bottom of the window have a special function.
They enable you to choose how the opacity mapping will be applied in the filled shape you will 
draw.

    

Let's take for example the opacity mapping (left) in order to floodfill 
a shape created using the spline tool (see below).

Depending on the options chosen at the bottom of the panel, the opacity mapping will be applied:
* without modifications (1)
* adapting to the shape you will floodfill (2)
* according to a vector of your choice (3)
* in a circular fashion along a vector (4)

   (1)    (2)    (3)

For case (3), you must draw a vector on the screen, as you have done 
for drawing a gradient.

 

 For the fourth option, modify the X 
spline as shown in the example 
opposite.

 (4)
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For case (4), you must 
draw a vector on the 
screen.

Note that the option on the Y 
axis is disabled.



Further details

Some remarks for using the Opacity function

The Gradients and Opacity mapping functions combined for use in a layer are very useful for 
creating effects of lighting or transparency independent of the background color or scenery (as 
they are not part of it).
This is the case for windows, tinted windows, lamps, projectors, etc … 

   

Above, the opacity gradients were used on a layer to create car headlights. They must no longer 
be modified when the background color changes, which results in considerable time saving.
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Lesson 4

 Temporal management of layers

In lesson 3, we handled the layers using the timeline. However, the notion of time 
did not come up at all. 
This lesson deals with the notion of time.

In this lesson you will:

● Study the concept of the animation layer.

● Work with brushes and animated brushes.

● Handle the commands for project viewing.



Animation layers

Animation layers

Start by reproducing the image of lesson 2 in a project with square pixels (Aspect Ratio equal to 1), 
not using fields (see lesson 1 for an explanation concerning fields and ratio). The Image below has 
been drawn thanks to the Oilbrush tool.
Don't forget  to place the house, sun, sky and grass on four different layers.
You should have the following timeline on your screen :

          

Creation and concept of an Animation Layer

   

Everybody knows how a film is projected in a movie theater:
a film roll is placed in front of a powerful projector, enabling display of the 
pictures on a screen located a few metres away.
The images are projected at such speed that they give the illusion of 
movement to the spectator.

TVPaint Animation Pro works with the same principle: it is possible to create 
your own virtual film rolls and project them onto your television screen.

In TVPaint Animation Pro we refer to this roll as:  Animation Layers.

As we will see hereafter: the advantage of TVPaint Animation Pro resides in 
the fact that it is possible to superpose several rolls (for example: one with a 
background scenery, another with a character and another with a 
foreground scenery.)

   

It is possible to create animation layers using the New 
menu in the timeline.
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Animation layers

    

An animation layer is represented by an 
icon in the timeline. An image layer only has 
a gray icon  (see encircled area shown 

opposite).

Add images

   

We have just created a single image (empty…). To make our first 
film, we have to increase the number of images in our roll.
To do this, you can use the keyboard shortcut [Shift+I] or choose 
Insert Images before current image in the Layers menu to add 
frames to the current layer. 
Now you just have to enter the number « 9 » in the numeric field.
This will give you a total of 10 frames.

Movement and orientation within the timeline

Use the [↑] and [↓] keys to change the current layer. 
When you are in an animation layer, you can move between the images of this animation using the 
[←] and [→] arrows on the keyboard.

You may also use the mouse to move inside the timeline, by clicking on the 
space-time location of your choice.
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Some layers may be reduced for future 
timelines (see lesson 3).

Create an animation layer and name it « cloud ». Place 
it in front of all the others. You then have the timeline 
shown opposite.



Animation layers

The white square with two red bars enables you to identify the image of the animation layer viewed 
in the window of the current project.

The title bar contains several indications. From left to right :
* The name of the project you are working on.
* The time code of the first and last image of the project (TimeCode, or image number).
* The total project duration.
* The name of the current layer.
* The time code of the first and last image of the current layer (TimeCode or image number).
* The total duration of the layer.
If working with time data provided in time units seems difficult to you, click on the TimeCode button 
at the bottom of the timeline. All prior values and time codes are then converted to image numbers.
To simplify future lessons, we will from now on work in this way (later, you are free to work as you 
wish with your own animated sequences).

Create a brush

    

Go to the first image of the animation layer named « cloud » and draw 
a gray cloud using the tools of your choice.

Then reduce viewing to the current layer (icon H in the first column of 
the timeline or shortcut [=]).

We will create an animation in which the cloud will move from left to right. To do this, we have to 
make our cloud into a brush.
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Select the icon shown opposite from the main panel. This option is used 
to carry out Rectangle CutBrush. But, what does this mean?



Animation layers

   

Let's take an example:
Draw a Rectangle around the previously drawn cloud. When this is 
done, you will note that your current brush is not one of the standard 
tools: the cloud itself has become your brush!
Press the stylus on your tablet if you doubt it: the cloud has turned 
into a paintbrush.
Don't forget to erase your tests before continuing!

Several CutBrush tools are at your disposal in the main panel to simplify 
your task when creating a brush : Rectangle CutBrush, Polygonal, 
FreeHand and Magic Wand.
See opposite:  

The first animation

The first image in our animation layer « cloud » contains … a cloud. The other nine images, 
however, are empty.
* Go into the second image of this animation layer and apply the brush in order to place the cloud 
slightly to the right of the cloud on the first image in our animation layer.
* Proceed in the same way for the third image of the animation layer, again moving the cloud 
slightly to the right of the one in the second image.
* Proceed in the same way to the last image of the animation layer.

You will note that the corresponding icons of the timeline display the cloud and when you move 
inside the layer using the [←] and [→] arrows on the keyboard, your cloud will move!

TVPaint Animation Pro and compositing

Now extend viewing to all layers. Sliding along the timeline again displays the complete scenery for 
the first image but on the nine following images…  there is only the cloud.

We learned how to stack our image layers like transparent glass sheets on a colored background 
in lessons 2 and 3.

The image finally obtained is referred to as a « composite » image (composed of several 
images…)

In the case of our house and cloud, it is possible « to spread » the house and sun as fixed 
backgrounds or immobile backgrounds in time.
In other words, one of the transparent rolls may be composed of identical images.
The procedure is simple:
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In a way it is possible to do the 
same here and stack the 
« transparent rolls » in front of 
our projector. 
The white background is used 
like a  « white light » projector.



Animation layers

In the screenshot above, we selected background = none in order to have a better readability in 
the timeline.
Select one of the four image layers in the timeline and use the Insert frames option as described 
above.
Do the same with the other image layers, then move within the timeline again: this time, scenery 
and moving cloud are still visible.

 >  >  >  >  

Play an animation

Using the keyboard arrows to play an animation is not very practical. You have certainly noticed 
already: the most suitable options are available in the current project window.

Here are the functions of all buttons available :

 the traditional buttons Play and Stop as you will find on video recorders and 
camcorders,  etc.

 to advance or rewind one frame in the current layer.

 to go to the first or last frame of your current layer.

 to go to the previous key or next key (the notion of keys will be explained in the 
following lessons).

 to modify the Framerate when playing the animation. Note that this value is not 
necessarily used when exporting your sequences.

 Press this button to play the animation in a loop.

 If you have chosen a sound track to accompany your project  (see lesson 8 page 2), press this 
button to play it with your project.

 the Flip button, keyboard shortcut [W] offers you a quick look at your work.
It allows you to play your animation starting a few frames before the current image and stopping a 
few frames after the current image. Then you come back to the image you were working on just 
before pressing the button. 
The framerate used is the one selected in the project window popup menu. 
The number of frames played on either side of the current image may also be set in the preview 
settings (see the Preview Settings section of this lesson).
* The yellow rectangle located in the graduated line underneath the buttons indicates the image 
and the number of the image currently displayed on the screen.
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Animation layers

* The Mark in and Mark out buttons :
These are numeric or time values indicating the frame from which the animation will start playing 
as well as the frame at which it will be stopped.
In order for this function to be taken into account when playing your animation, you must enable 
the corresponding buttons.
Two red and green markers enable identification of the mark in and mark out points.

You may use the arrow buttons ↓ to assign your mark in or mark out point 
to the current image.

Now let's move on to field projects and/or projects with a ratio other than 1 :

* Button B enables display of both fields simultaneously when playing an animation or video. 
* Button 1 will display the field which you have defined as the first field.
* Button 2 will display the second field of the current image.

Note that the 1 and 2 buttons may only be used if your project is set to use 
fields. Furthermore, moving to the next image in a project containing fields 
will have the effect that the cursor of the current image does not move to the 
next image but to the next field (as an image is composed of 2 fields).

Button A of the current project window is used to enable/disable pixel Aspect Ratio display.

This does not modify the current project: only its aspect in the project window 
will be different.

The Remote Control

 

The       icon in the top right hand corner of the current project window is 
used to hide/display the viewing commands described previously. 
If required, it is possible to display some of these buttons in a separate 
window referred to as Remote control, which is accessible via the 
Windows main menu. The buttons containing numbers are used to 
define the play frame rate (in frames per second).

Other movement methods

You may use the timeline or project window to move within the project. To do this, just click and 
slide on one of the rectangles shown below :
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The buttons B, 1 and 2 of the horizontal bar are only 
available when you are working with a project containing 
fields.



Animation layers

If you use the left mouse button, you change the image.
If you use the right mouse button you return automatically to the original image when releasing the 
button.

The Navigator

   

The other buttons, specifically used for navigation on the project surface, 
are found in the Navigator  window which is accessible in the Windows 
main menu.
This panel also allows you to have a low quality preview of your 
sequence/animation which can be useful by pressing the  button.

* Button N shown above is used to open a new project window.
* The red rectangle indicates the current display area in your window relative to the full image.
* The Display popup menu is the same as the one described in lesson 3 page 16.

Transform an Image layer into an Animation layer

We will now make the sun move.
It is not necessary to create a new animation layer. TVPaint Animation Pro allows you to transform 
an image layer into an animation layer.
This option is again offered in the menus reserved for layer handling.
As soon as the sun image layer is transformed into an animation layer, its icon will appear in the 
timeline.

We obtained here an instance. This concept will be deeply studied in the lesson 6.
All you need to know here is that the first image is identically reproduced several time in the 
timeline.
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Animation layers

Select and erase the contents of the images in an Animation Layer

Select the sun as current brush. As with the cloud, it is now possible to make the sun move up in 
the sky and leave the screen.

However, before using the brush, the sun must be erased in every frame of our sun animation 
layer.

This may be done with the  button on the main panel for all images one after the other, but this 
may be too time-consuming when working on long animated sequences.

The trick is to select all images of the layer using the option Select all  in the contextual menu 
(keyboard shortcut [Ctrl+A]). Your timeline must be displayed as shown below: a light yellow 
rectangle is present underneath the selected images.

   

Pressing the  button 
will erase the contents of 
all selected images in the 
layer.

It is possible to only select a part of the layer by clicking on and sliding from 
the first image to be selected to the last.

Our instance has been replaced by empty images. you may now make your sun move, as you did 
for the cloud.
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Animation layers

Flip the images of an Animation layer

Some options may speed up your work considerably.
The option named in the title of this paragraph is used to flip the images of a layer in time. It is only 
available in the layer menu after having selected the images to be flipped in an animation layer of 
your choice.

   

This is what happens to our cloud layer: 
the last image is now first, the last but one is 
second, and so on …

The cloud now moves from right to left.

Move the layers in the timeline

As with the image layers in lesson 3, it is possible to move the animation layers in space. For 
example, you may move the cloud behind the house or the sun in front of the cloud  (in case of a 
very high cloud, obviously), etc.
But this is not all: image layers and animation layers may also be moved in time.
Increase the image layers to 20 frames and the following timeline will appear :

Now click on any image of the «cloud» layer and slide the mouse to the right before releasing the 
button.
You have now moved your layer in time. Do the same with the «sun» layer.
In the screenshot below, the «cloud» layer will only be shown starting from the tenth image of the 
animation and the «sun» layer starting from the fourth image.

The range in number of frames (or in seconds, if you are in TimeCode 
display mode) located at the top of the timeline offers a global 
identification system, enabling location of each layer in relation to the 

others within the current project.
The ranges under the frames of a layer (in number of frames or Time Code) only 
refer to these layers.
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More details

More details

Show, hide the icons

It is possible to show or hide the icons of an animation layer in the timeline. You will find this option 
in the contextual menu of the animation layer (the first and last image are, however, always 
displayed).

Similarities with Image layers

Many of the details regarding the image layers discussed in lesson 3 are also valid for the 
animation layers:
locking, duplication, reduction of layers as well as assigning a color work exactly in the same way 
for the animation layers.
The reference images for the masks are those located in the same temporal position as your 
current image.

The Auto Fit option in the timeline

When using a very long animation layer, it may be discouraging having to use the sliders 
continually to only view a section of the timeline.
Fortunately it is possible to modify the timeline scale :

Click and hold the Z button of the timeline to 
modify its display (stretch or increase the icons 
from the current image depending on the left or 
right movement of the mouse or trackball).

The Auto Fit popup menu may be used to adjust the size of the icons in the timeline in order to 
view the entire project, current layer, current image, current selection or keys.

Start frame, negative images

   

If you take a closer look at the timeline, you will see that our project starts at 
image 1 or the time: 
0 hour, 0 minute, 0 second, 1 trame (in Time Code mode).

It is possible to modify the start values for our project using the Start image option in the Project 
menu (enter the value required in the corresponding numeric field).
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You will note that it is possible to place your layers before image 0 in the timeline 
using the [Shift] key while dragging the layer to the left. You will therefore obtain 
«negative» images in the timeline or time values close to 23 hours, 59 minutes, 59 
seconds.

Using the Bookmarks

    

It is possible to place Bookmarks on the images of your  animation 
layer (circled in black above) using the corresponding option in the 
Edit main menu.
Once the Bookmarks are placed, the keyboard shortcuts 
[Shift+Ctrl+←] and [Shift+Ctrl+→] enable you to move to the 
closest Bookmark to the left or right of the current image. Finally, 
the keyboard shortcut [Shift+Ctrl+↑] creates a Bookmark for the 
current image or deletes the Bookmark if the current image already 
contains one.

This option provides fast access to key images in your animation without having to modify the 
zoom factor of your timeline and/or use the sliders.

The Preview settings

The preview settings are used to configure the way your computer and program interact to play 
your animations.

You may open the preview settings  panel shown opposite via the 
Windows main menu or by clicking on the preview progress bar in the 
tool bar.

Three pre-view modes are available in the Preview popup menu :

* The Real time mode respects the duration of your animation when viewing it. It depends on the 
processing power of your computer. If the computer is fast, all images will be displayed at the 
framerate chosen by you. In the contrary case, some images are not displayed in order to respect 
the framerate. In real time mode, the progress bar displays No proxy.

* The Proxy mode uses periods of less activity in the program to carry out a pre-calculation for 
viewing. If, for example, you spend ten seconds without drawing and without using any program 
options, this time will be used to prepare some of the images for viewing.
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* The Render mode does not carry out the calculations required for viewing during viewing. It pre-
calculates the viewing in advance, just before playing. This compensates the inconveniences 
encountered in Real time mode for slower computers (jerking, image jumps, etc.) but requires a lot 
of disk space and time for this calculation.

The progress bar below shows how many images may be viewed within the project.

   >>  

If you modify several images at the same time in Proxy mode (for example by erasing a layer), the 
viewing calculation will be re-started for the number of images concerned.

If you start viewing before the calculation process is completed, only some of the 
images may be viewed in Proxy mode. The other images will be viewed in Real 
time mode.

In TVPaint Animation Pro, the preview ratio quality is automatically set, depending on the data rate 
of your temp drive. 
In other words, the data rate automatically change the size ratio of your preview to play it as well 
as possible regarding the playback frame rate of your project.

The temp drive is the drive containing the temp  folder that can be chosen in the 
preference panel. (See lesson 1.)

You can use the test  button to determine the data transfert rate of your temp drive.
The quality ratio will be reduced if you decrease the data rate value.

It is not advised to set a higher value than the one TVPaint Animation Pro 
computes when you click on the Test button. If you do so, the quality ratio will be 
increased  but the sequence won't be played fluently anymore.

The Show TC button is used to display the time code during pre-viewing.
The Play all  button forces the program to display all fields and images during viewing even if this 
affects the display rate of the chosen images.
The Flip Book text field enables adjustment of the number of seconds to play on either side of the 
current image when the  button is pressed in the project window (see page 6).

The CutBrush tool options

If you select one of the four brush creation icons in the main panel, the 
Cut Brush panel appears in place of the tool panel.

You may:
* Create a brush by deleting at the same time the area in which it is located on the screen (Cut 
option in the popup menu).
* Smooth the cut brush (see lesson 3: smooth the contours of a surface).
* With the Keep option you may keep the previous brush handle (refer to the following section to 
study the various handles available).
* Remove as many transparent pixels as possible around the brush (Optimize option).
* The Display option is used to cut your brush through the visible layers. This is referred to as deep 
cut.
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Below, the sun, cloud and sky are placed on three different layers. The current layer is the cloud 
layer:

                            
Area to be cut                                  Brush obtained                                           Brush obtained

                                                      without deep cut                                          with deep cut

Edit brush options 

Once a brush is cut, it is possible to use it as such. Numerous parameters are available. You may :
* Use the brush in Color mode. In this case the color of the pixels is not modified.
* Use the brush in Alpha Stamp mode: only the opacity of the brush pixels is taken into account, 
their color becomes the A color.
* Use the brush in Luma Stamp mode: the color of the brush pixels varies from A color to B color 
depending on the original luminosity of the colors of the brush pixels.
* Use the brush in Hue stamp mode: in this case, the hue of the brush pixels becomes that of A 
color (the luminosity of the pixels is preserved).
* Use the brush inthe Alpha Stamp and Alpha Max Stamp modes (see lesson 7 for details about 
those modes)
* Modify the global Size of the brush.
* Modify the Jitter of the brush. 
* Modify the Opacity of the brush.
* Modify the Angle of the brush.

    

* Modify the Step between two applications of the brush on the screen. 
This option enables drawing in a discontinued manner.
* The SubPixel option is used for more precision during drawing.
* Use the Shift option. It allows to distort the current image in the direction 
of your stroke. It is often used with the opacity parameter set to 0%. (see 
below)

 When using the Shift option, the Alpha Stamp and Alpha Max 
Stamp modes are not available.

* Use the Drying option (see end of lesson 3).
* Optimize the brush: i.e. re-align the brush to conserve less transparent 
areas around the brush.
* Change the Handle of the brush: in other words, change the position of 
the cursor in relation to the brush which is centered by default.
* Reset the brush settings.
* The Anim option will be discussed later.

The state of the SubPixel option shown above will be kept if the Keep button is 
enabled when the brushes are cut.
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The illustrations below show the various concepts described on 
the previous page... 
Let's take a look at the colors A (R = 5, G = 255, B = 8 ) and 
B (R = 255, G = 183, B = 11) below :

An example of the various brush application modes :

                Color mode      Alpha Stamp mode     Luma Stamp mode     Invert Luma Mode       Hue Stamp mode
             (original brush)

The  brush application modes will also be studied in lesson 7 in the chapter : 
« Use of the brush as a drawing tool »

          
 shift = 100 / opacity = 100                  shift = 100 / opacity = 0                   shift = 100 / opacity = 15    

             
                          Normal brush                       Non-optimized brush                         Optimized brush

            
                        Centered handle                    Handle top right                            Handle custom-placed
 
Traditional drawing modes are applied to the brushes and sometimes provide interesting results:

                                      
Original brush  Image on which the                    Application in                       Application in
(the white pixels                brush will be applied                   Multiply mode                     Screen  mode

              are opaque)
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Let's talk about the Edit button: it is used to display the panel shown 
opposite.The various buttons from left to right and top to bottom have the 
following functions:

* double the size of the brush.
* double its width or height.
* turn the brush +90°.
* flip brush on X axis.
* optimize the brush.
* cut brush size in half.
* cut brush width, height in half.
* turn the brush -90°.
* flip brush on Y axis.
* replace the transparent areas with B color.
* lock the width/heigth aspect ratio.
* modify the size of the brush numerically or in the project window.
* rotate the brush to an angle of your choice.
* add a border to the brush (you may choose the color and thickness of 
the border).
* anti-aliase the brush when modifying size and angle.
* use the opacity map (see lesson 3).
* reset all settings to zero and recover the original brush.
* validate the modifications and use the new brush.

It is possible to obtain all the configurations shown below and many more !!!

Floodfill using a brush

The Filling shape panel appears when you decide to draw a filled surface or floodfill a surface on 
the screen. This panel enables the use of the brush as a floodfill pattern. The Brush Wrapping 
button enables this function. There are several methods available. Following the horizontal and/or 
vertical axis, you may :
* apply the brush while adapting its size (width and/or height) to the surface to be filled, without 
distorting the brush (if necessary, the whole brush will not be visible) (Stretch option).
* apply the brush at regular intervals without distording it (Tile option).
* distort the brush so that it takes the shape of the surface to be filled (Wrap option).

       
Standard brush        Stretch                         Tile                   Wrap

Note that for this example we used a brush created with the Text tool which will be discussed in 
lesson 7 but the example applies to all types of brushes.
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The notion of Animated Brushes

Using the Deep cut option which was displayed during the brush cut, we saw that it is possible to 
cut a brush in space, several layers deep …
It is also possible to cut a brush in time: this is referred to as animated brush.
We will study this notion in detail using examples.

Example 1: We'll put a finishing touch to our animation by adding birds.

* Create an Animation layer of 10 images, then create a bird with a different wing position in every 
image of the layer (see timeline below).

* Select all the images of your layer.
* Carry out a rectangular brush cut in a size similar to that of the image.
* TVPaint Animation Pro will ask you if you wish to cut an animated brush via a small window.
* Answer yes.
You have just created your first animated brush. We will soon be able to use it:
* Delete the content of the layer you have just created.
* Use the Edit brush option to reduce the size of your animated brush.
* Let's now look at the short animation created previously (refer to the first chapter of lesson 5 
explaining how to save your projects) with the sun and cloud.
Check that you are working in color mode then click several times anywhere in the blue sky. This is 
the result:

The birds you have drawn before have become your brush  «each in 
turn» as you place them on the screen!

A few words on parameter setting for animated brushes:

* At the bottom of the Tool : Brush panel you will find the number of the 
image currently used.
* The Anim  popup menu of the Tool : Brush panel controls how the 
images appear.

The images in your animated brush may appear in various ways :
* None.
* Once.
* Start&Once,
* Loop.
* Pingpong.
* Random.
* Stylus pressure.
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* Stylus speed.
* Stylus direction.

All other options and parameter settings for the brushes studied 
previously (modification of size, opacity, direction) also apply to 
animated brushes …

Example 2 : Reproduce an animation.

Let's now look at the short animation created with our sun and cloud but without the birds.
* We start by merging all layers except the «clouds» layer and rename the new layer. You will 
obtain the following timeline:

   

* Select all images in your «clouds» layer, then cut a rectangular brush in roughly the same size as 
the red frame shown above. You just created a new animated brush.
* Place your « animated brush of the cloud » in the free sky area, just above the house.
* Press the Undo button: the cloud disappears.
* Check that the « animated brush of the cloud » is applied in mode Start & Once from image 5.
* Select all images of the « clouds » layer.
* Press [Enter].

You will notice that the images of the animated brush are applied in the given order to all images of 
the current layer: a second cloud now moves from left to right …

  

  >  >  >  >  
Did you understand these two examples ?  If yes, you can now easily make the wings of a bird flap 
wherever you want to  …
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Lesson 5

Handling TVPaint projects

In this lesson you will :

● Learn how to handle TVPaint Animation Pro projects: load, save, import, 
export, etc...

● Study the notions of Templates, Dependencies.

● Discover the Video Grabber Panel.

● Learn how to use the project management panel.



Introduction

Introduction

In lessons 3 & 4 we studied the concepts of image layers and animation layers as well as their 
temporal and spatial specificities.
What we refer to as a TVPaint Animation Pro project (or simply project), is all image, animation or 
Xsheet (see lesson 8) layers in a timeline (whether created by drawing, scanning or any other 
method) with all associated options: global opacity, pre- post- behavior, FX stack (see lesson 9), 
number of images per second, position in the timeline, resolution, etc.

Save a project

In lesson 1 we saw how to create a project with the parameters of your choice.
After having worked with tools and layers (lessons 2, 3 and 4), you may wish to save your project 
for later use. To do this, use the Save project or Save project as functions in the File main menu.
Save project (keyboard shortcut [Shift+S]) allows you to save the project under the current name, 
whereas Save project as asks you to choose a new file name for your project. This function allows 
you to easily duplicate your project as you progress with its creation.

Use the requester

A file explorer then asks you to select an access path and file name for your project. 

This window is laid out as follows: 
* The text field at the top of the window allows you to enter the name under which the file is to be 
saved.
* The second text field just below the first is used to select the type of files to be displayed in the 
right section of the window. 
* The popup menu to the right of this field is a shortcut used to select the file types of your choice. 
In the default setting, all file types are displayed (extension .PNG .BMP .JPG …). TVPaint 
Animation Pro projects have the extension .TVP.
* The left section of the window contains the directory path. When necessary, the sliders (and 
fingerwheel of your mouse) may be used to scroll through the list of folders available for storage. A 
right-click on an item in this list opens a contextual menu offering access to Open, Delete and 
Rename functions.
The  and    buttons are used to display or hide the content of your storage supports, folders or 
sub-folders.
* The  is used to return to the parent folder.
* The arrows  are used to scroll through the history of selections in the file explorer. In this 
way, you may quickly find the folders in which you last saved your work.
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Use the requester

* The right section of the window displays the files contained in the folder you selected on the left 
side of the window.
* You may choose to display thumbnails of your files (button Thumbs, button Scan) or display a list 
containing information relative to your files: type, name, count, resolution, time, size, date of last 
save (button List, then button Scan). Note that some data is not taken into account for all file 
formats.
* It is also possible to delete the selected file, rename it or create a new folder using the buttons 
Delete, Rename and New folder.
* Once you have selected the file or folder you require, click on OK.
* To quit the file requester and ignore all operations, click on Cancel.

   
When using the second text field, the question 
mark is considered a random number or letter, 
whereas the asterisk is considered a complete 

random word.

For example :
* Enter « *.jpg » to display all image files of the type jpg in the right section of the window.
* Enter « dessin003?.jpg » to display all files named dessin003 followed by another character and 
the extension « .jpg ».
Therefore files between dessin0030.jpg and dessin0039.jpg will appear whereas dessin0020.jpg or 
dessin0040.jpg will not.

Above an example of a file requester with projects displayed in the form of thumbnails.

Save a Template

      

A template is a blank project using a predefined resolution, speed, 
aspect ratio and number of layers and images.
It is possible to save a Template using the dedicated option 
indicated in the File main menu opposite (the template will have to 
be given a name).
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Save a Template

     
In this way you may select the template you just created when a new project is started (when 
starting up or using the program).
You may also use one of the many predefined models.

Load an existing project

To load an existing project from the data storage support, simply press the keyboard shortcut 
[Shift+L] or the Load option in the File main menu. The file requester will then ask you to select an 
access path and file name.
Now that you know how to use the requester, load the file « running kid_2.tvp » 
Folder C:/program files/TVPaint Developpement/TVPaint Animation Pro/ for Windows users.
Folder Applications/TVPaint Animation Pro for OS-X users.
If the project loaded is too big, too small, possesses too many images or has an incorrect pixel 
ratio, you may modify it.

Modify a project

The option Modify project is accessible in the Project main menu. 
The latter opens the panel illustrated below:

*  The project properties are indicated on the top left-hand side of the window and include: Project 
name, Width, Height, number of frames per second (frequency), Pixel aspect and Field options. 
Bottom left you will see the future size of your project, after modification.

*  Just below, a popup menu is available in which you may select the predefined format you 
require, corresponding to the format you will obtain after modification.
It is possible to modify a project originally in VGA format, to obtain a project in NTSC format.
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 A list of files previously loaded with TVPaint Animation Pro is available in the 
File main menu. Simply click on the name of one of these projects to load it 
again.



Modify a project

* The numeric fields located under the popup menu change according to your choice in the 
predefined formats menu.
Of course, you may modify your project for your own format (for example to create an animated gif 
on a website). All you have to do is modify each option manually: Width, Height, Frame rate, 
Aspect Ratio, Field (a mini popup menu is available for the parameters Frame rate and Aspect 
ratio). 

The Lock aspect button allows you to keep the width and height ratio of the original project.
The Rotation parameter is used to rotate the project 90, 180 or 270 degrees.

* Here you will discover the functions of the next five buttons:
By default, when the Modify project function is used, TVPaint Animation Pro keeps your original 
project and creates a new project which is modified according to the parameters you have 
selected.
- The Resize to new size button enables, when checked, the resizing of your original project to a 
new size.
- The Correct aspect ratio button forces the program to respect the original image aspect ratio (this 
avoids the creation of disproportionate images).

               

- The Stretch to new frame rate button, when checked, increases or decreases the number of 
images so that your new project has the same duration as the original project.
If, for example, your original project displayed 24 images/second and your frame rate is set to 
12 images/second, your project will last twice as long (the number of images is, by default, 
retained). If the button Stretch to new frame rate is checked, some images will be deleted so that 
the original project and modified project have the same duration.
In the opposite case: original project with 12 images/second, modified to a project with 
24 images/second, the modified project will be shorter than the original project. If the button 
Stretch to new frame rate is checked, intermediate images will be added to the modified project to 
make it coincide with the duration of the original project.
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Modify a project

- The two aforementioned examples are similar to the layer's contract and stretch section 
discussed in lesson 4. The Time interpolation button also refers to this function as it imposes layer 
stretching or contracting with interpolation when the button Stretch to new frame rate is checked.
- The Remove project button is used when the original project is not to be kept on the screen.

Use of the Remove project option is at your own risk as in this case the Undo 
function cannot be used to help you out…

* The right section of the project modification panel enables selection of the portion of the project 
which is to be modified. The mark in and mark out buttons as well as the associated numeric fields 
will help you select the first and last images of the project to be modified.
* The central numeric field and slider are used for navigation over the entire duration of the project.

Load an existing image or animation

It is sometimes useful, when working, to load an image, video or animation which has not been 
saved in a format which manages layers as well as their layout and opacity, etc… (in other words, 
an animation which has not been saved in one of the formats TVP, MIR or AUR)
In this case, a new panel, referred to as import footage panel, appears directly after selection of a 
file in the requester. This panel is as follows:

This panel is similar to the project modification panel.

Let's assume you have loaded a video file (AVI or MOV)
- On the top left-hand side of the import panel you will find all information relative to the file 
selected in the requester window (size, frame rate, aspect ratio, etc.).
- These are followed by a text field which indicates the path and name of the file you have chosen.
- The Browse button allows you, in case of error, to choose another file in the requester window.
- The Preload button will be discussed in the Dependencies section of this lesson.

Your video file may be modified when imported to suit your needs: project name, width, height,  
frame rate, aspect ratio, field, rotation may all be modified as we discovered in the previous 
section.
The Alpha popup menu, however, possesses specific options including: Guess, Premultiply, No 
Premultiply, Without alpha and Alpha only.
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Load an existing image or animation

* The option Guess will consider that the Alpha value is equal to the maximum RGBA values 
present in the sequence.
* The option Premultiply refers to the method of calculating each pixel. In this case, each pixel is 
multiplied by its alpha value which results in the fact that these pixels are calculated quicker than 
with the No Premultiply option.
* The option Without alpha will load your sequence without transparency if it had any beforehand.
* Finally, the option Alpha only will only load a mask of the sequence. This mask will be extracted 
from the alpha layer of the sequence.

Further down, three tabs allow you to choose the form to be given to your imported video: the 
imported video may be created either as a new project, a new layer in the current project or as a 
custom brush (these three options are mutually exclusive).

* When a video is loaded as a new project, two options are available: 

- The video sample loaded will be that located between the two time markers on the right side of 
the panel.  You may also choose to include sound with your video by checking the Import audio 
box in the import footage panel.
- The single frame check box, if checked, will create a project with a layer and a single frame: the 
frame selected in the right side of the panel.

* When a video is loaded as a new layer, a new set of options similar to those encountered in the 
Modify Project section becomes available. You may:
- Stretch your video file to fit the dimensions of your current project,
- Adapt the aspect of your video to that of the current project,
- Compensate for any possible frame rate differences between your current project and your video 
by stretching or contracting your video,
- Choose to stretch or contract with or without interpolation,
- Create a layer with a single frame (here again, a single frame or large sample may be imported 
between the mark in and mark out points).

       

* When a video is loaded as a custom brush, the same options are available with the exception of 
the Stretch to project size option.

When you load a file in PSD format, a new project is automatically created (no 
import footage panel is opened) and the image layers are all present in the 
timeline.
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Load an existing image or animation

The Import footage option in the 
timeline shown opposite returns the 
user directly to the import footage 
panel, New layer tab.

Dependencies

The Preload button present in the import footage panel is used to choose whether the video 
footage on which you wish to work is to be read directly from the computer storage support or if it is 
to be included in your current project.
This option is important for the following reasons:

* Let's assume your projects possess layers composed of non-preloaded video footage.
When loading the same project again, TVPaint Animation Pro will look for the data necessary to 
display the images, layers and timelines in the external video files. This function is interesting as it 
saves space when saving as your project does not contain all the images it comprises.

* To avoid having a project which is dependent on external videos, you may, when video footage is 
imported for the first time, preload it immediately. Your project will then be more voluminous when 
saved, but at least there will be no risk of loosing the data when the imported files are modified.
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If you forget to do this, it is possible to preload the files later via the main menu 
Project > Dependencies > Load all.
This menu also displays the path and name of files on which your project depends.

Attention however: if the video file to which your project refers is deleted, modified or 
renamed, this will have an incidence the next time your project is loaded (the layers 
and images concerned will not be found…).



Export files

Export files

Saving a project in TVPaint Animation Pro format with all associated layers may require a 
considerable amount of storage capacity.
Even if it contains specific data relative to your project (opacity, layers, etc…), the TVP format is 
not a practical solution if you want to share it with your friends at parties or on a website. Use of the 
dependencies function will render your project smaller, but it is not more practical in the 
aforementioned cases.
The option File > Export project to... is used to convert your project into a format of your choice: 
animated GIF, AVI or QuickTime file, numbered frames sequence, etc. You will find this very 
practical as you are able to save your work in smaller files.
This option is present in the File main menu. Once selected, the following panel appears:

Its layout should be familiar to you.
You may choose to export an image (or image sequence) from your project while retaining the 
layers or current brush (possibly animated).
These three possibilities are mutually exclusive.

To export the project image:
* A box on the top left-hand side is the first section of this tab and provides information relative to 
the current project.

* The second section deals with the export file format:
TVPaint Animation Pro allows you to export your projects in a wide variety of formats: DIP, AVI, 
GIF, QUICKTIME, FLI, PNG, PCX, SUNRASTER, PSD, TGA, JPG, ILBM, TIFF, FLYER CLIP, D1 
RTV, CINEON, SGI, SOFTIMAGE, VPB.
Each format has its own features which are explained in an appendix.
Some are configurable (for example AVI format), others are not.
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When the export file format imposes the choice and 
setting of a video and audio codec, click on the Config 
button to display the corresponding settings panel.



Export files

The codecs present in the popup menus and their configuration options are those installed in your 
operating system.

In order to save a TVPaint Animation Pro project in DVD format, you must have a 
MPEG-2 encoder codec installed in your operating system.

When required, and depending on the various formats of export, you may need to set the following 
option parameters:
- Mode
You may choose to export your work in the form of images or a video with a limited palette (8 
bits=256 colors), a large palette (24 bits=16.777.216 colors), a palette which takes into account the 
pixel transparency: 32 bits, a palette with no color data, but only pixel transparency (a mask).  

- The palette
In the case of a limited color palette, you may choose to use:
A gray scale palette.
The program palette located in the Bin tab of the palette panel
A global quantized palette to be used for all frames of your footage or animation. 
A local quantized palette which is modified for each frame of an animation.
- The number of colors
You may also choose a precise number of colors between 2 and 256 (to do this you must first 
choose one of the two quantized palettes).
- Dither
The Dither button is used to disperse the pixels of your animation in order to simulate use of a 
palette with a lot more colors (technically referred to as «Floyd-Steinberg dithering»).
- Alpha
Options relative to the Alpha function were discussed on page 7.

* The third section of the panel contains several options:
- The Browse button and an associated text field are used to enter the name and location of the file 
to be exported.
- The Single image button is used to save the image visible in the right section of the panel only.
- The Sequence button is used to save, one at a time, the images located between the Mark in and 
Mark out points. The images created in this way are numbered.
By default, the images are numbered as follows:
file_name_1.ext, file_name_2.ext, … … … file_name_123.ext, …

Including a « 0 » in your file name may help with numbering your images. For 
example if the first file name is « dessin_000 », the images will have the names 
dessin_001.jpg, dessin_002.jpg, … …dessin_354.jpg…

- The Animation button is used to save all the frames between the Mark in and Mark out points in a 
single file and is available for some file formats (deep, gif, quicktime, fli, avi).

* The fourth section of this panel manages the restrictions and attributes imposed on a file to be 
exported: width, height, frame rate, pixel aspect ratio, field.

* Several buttons are present in the fifth and last section:
- The Background button, when checked, renders all the pixels of your images opaque using the 
background selected (color, check or none) which is placed behind the transparent pixels of your 
images.
- The Correct aspect button is used to correct the pixel aspect ratio of the images to be exported in 
accordance with the setting made in the fourth section.
The Stretch to frame rate button, when checked, imposes a previously selected frame rate on the 
file to be exported while retaining the original duration.
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- If the aforementioned button is checked, the Time interpolation button allows you to decide 
whether the frame rate (or fields) correction should be carried out by interpolation (smoothing) or 
duplication (or deleting as the case may be).

To export an animated brush:
The options are the same as those available to export a project display.

To export project layers:
The options proposed are:
- Choose the path and file name
- Choose the file format: TVPaint or PSD  (both file formats retain the layers you have created).

Exporting in PSD format :
Earlier we saw that the Export panel contains three tabs: Project display, Project layers and 
Custom brush. The Custom brush tab does not concern us at this point in time as we are only 
interested in the differences resulting from the choices made in the Project display and Project 
layers tabs :

If you decide to export a project in PSD format in the Project display tab, you will export an image 
(or an image sequence) with all the layers of your project in a single image without transparency. 
The transparent areas will be replaced by the color black.
If you decide to export a project in the form of layers in the same way as your project .tvp, you will 
have to choose the Project layers tab for this export.

If you decide to export a project in PSD format in the Project layers tab, you will export an image 
(or an image sequence) with all the layers of your project in the spatial order, with transparency.
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The projects panel

The projects panel

We have already discussed the notion of TVP project in previous chapters.
Let's assume that some of them have been already loaded. If you don't have a dual-screen 
computer configuration, the situation can quickly become confusing on screen. (see below)

   

In the example opposite, five 
projects have been loaded and 
displayed on screen :
- milk.tvp
- city.tvp
- gazelle.tvp
- zoom.tvp
- mpc.tvp

(They are all supplied with the 
TVPaint Animation Pro CD-rom)

   

We will remedy to this situation, without closing any loaded 
project.
To do so, just begin by clicking on the Project tab, located near 
the well known Timeline tab.

The project tab is divided in two parts, as shown below :

* On the left part of the tab, there is a window displaying the current project. It displays the current 
image and the visible layers. The display is automatically updated when you move throughout the 
timeline.

  

Below the preview window, 
you can view datas relating 
to the current project :

- Name
- Size
- Frame Rate
- Pixel aspect
- Field

You can also add 
comments to your project.
( those comments are 
saved each time you save 
a project )
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* On the right part of the tab, the thumbnails of the opened / loaded project are visible.
You can change the current project by clicking on the thumbnail of your choice.

For each thumbnails, you can use :
- The  button allows to hide the corresponding project
- The  button allows to displays the corresponding project
- The  button allows to close the corresponding project

A contextual menu is available for each thumbnail (see below). The options at your disposal are 
standard :

    

- Activate the current project.
- Hide the current project..
- Hide the other loaded / opened projects.
- Show all projects.
- Close the current project
- Modify the current project.
- Duplicate the current project
- Save the current project.
- Save the current project with an other name.
- Export the current project in an other file format.

You can also use the following shortcuts, instead of the contextual menu :
Hide other projects   :   [Ctrl + O]
Show All Project       :   [Ctrl + P]
Show the Timeline tab :   [Ctrl + 1]
Show the XSheet tab     :  [Ctrl + 2]
Show the Project tab    :  [Ctrl + 3]

Once you will have mastered the project tab, it will be easy for you to turn the situation described 
on the last page, into something clean, functionnal and ready to use :

   

At this state, you only have to 
click on a thumbnail in order to 
begin your work on the 
corresponding project.

The project tab is especially designed for those who need to use at the same 
time several sequences being part of a same animation. Each sequence is easily 
available.
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Video grabber

It is sometimes useful to refer to video footage to create the drawings necessary for an animation. 
For this reason, it is possible to enter a video directly into the software. TVPaint Animation Pro is 
compatible with WDM standard equipment without having to install specific drivers or plugins. For 
information, WDM devices are Windows Device Manager devices (used by most WebCam and DV 
format camcorders). On Mac OS X, TVPaint Animation Pro is compatible with QuickTime devices.

To grab video footage, you must first ensure your peripheral device is correctly installed. Then, you 
must right-click on the V button located on the bottom right-hand side of your project window. This 
action opens the Video grabber window:

          

The value of the Mix parameter defines the video footage opacity percentage. This will allow you to 
continue viewing your project whatever happens.
Finally, the Apply in menu allows you to define whether the video grabbed by your peripheral 
device should be automatically inserted into a new layer or simply added to the current layer. 

The Length option defines the number of frames to be grabbed. If this value is set to 5 and you 
grab a video, the resulting video will be duplicated on 5 frames of the destination layer. This is very 
useful as it allows you to monitor the rhythm of your animations.

The last menu is the Field menu which is used to define management of your video fields. Four 
options are available: As is keeps both fields, +Upper first and +Lower first will only use one of the 
fields, interpolated to correspond to your project window. The Mix option is useful for non-
interlaced frames and enables reduction of frame flicking.
Finally, this panel is completed by the Grab input button which grabs the video each time it is 
pressed.

A detailled example of animation created with the help of the video grabber and a 
Canon camera is available in the lesson 18 (chapter « plug-in Canon ») of this 
manual.
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In the Video Intput tab :

* The first Device menu allows you to select the type of 
peripheral device you intend using to grab the video footage. 

* The Input menu displays a list of the peripheral devices 
available and allows you to select the device to be used.

* The Format menu allows you to select the resolution with 
which your peripheral device will grab the footage which in 
turn depends on the capabilities of your equipment. 

* The Settings button allows you to automatically open the 
options panel of your equipment and define in most cases 
certain parameters such as luminosity, frame rate, contrast, 
etc.

If your device is correctly connected to your computer, 
opening this window will show what is presently «seen» by 
the device in the preview window. If you wish to view this 
video in the project window, left-click on the same V button  
you used to open the Video grabber panel.



Video grabber

  

* The Enable Out button allows to activate the visualization through your external device.

* The Refresh button allows, if possible, to obtain a realtime display on the external device. (by 
default, the display is refreshed after each stroke)

* The Keyer button allows to improve the management of the transparent pixels with some external 
devices.

* The Fit button allows to adjust the dimensions of your current project in order to obtain a better 
result on the external device.

Please read the appendix of this manual to obtain the complete list of external 
hardware compatible with TVPaint Animation Pro.
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The Video Input tab of the Video Grabber panel allows to 
manage the visualization of the project window through an 
external hardware such as television, overhead projector, ...

* The popup menu allows to select the device you will use to 
display the content of the project window.

* The Activate button allows to start the selected external 
device.





Lesson 6

The steps to create animated graphics

In this lesson you will : 

● Learn, one by one, the various stages involved in the creation of an animated 
drawing using this application. (the scan cleaner, light table, rotative drawing 
disk and inking options will be introduced)

● Use the Animator Panel.

● Use the scan and print options of the software.

● Learn how to use instances.



The steps to create animated graphics

Introduction

The aim of this section is to sum up the various steps involved in creating a cartoon using 
TVPaint Animation Pro and to deal with frequently asked questions. Some steps will be explained 
in more detail when studying the corresponding effects.

Working with hand-made drawings

Scan and print your images

You may choose to create the images for your future cartoon either traditionally on paper with PEG 
holes (see below) or more directly in TVPaint Animation Pro.

TVPaint Animation Pro works with Twain standard scanners in Windows.
* The File > Twain > Select option is used to choose the scanner you intend using.
* The File > Twain > Acquire option displays the Twain interface of you scanner in order to begin 
working with the latter.

On Mac OS-X, TVPaint Animation Pro works with ICA standard scanners. Use the File > ICA > 
Acquire option to display the acquisition interface.

In this way, when you scan a set of images, you may either import these images directly after the 
current animation layer, or in a new animation layer, or simply in a new project.

Inversely, it is also possible to print the content of an animation layer.
The File > Configure printer option displays the options available on your printer,
The File > Print option opens a new window:
- At the top of this window you will find the name of your printer.
- The Setup button displays the options available on your printer.
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Working with hand-made drawings

 

Cropping a project

The Crop tool is used to define a rectangular area in the current 
project and to transform the content of this area (including all layers) 
into a new project.
This is very practical when cropping your animations due to badly 
defined edges (see example opposite).
The variables Start X and Start Y are used to define the top left-hand 
corner of the rectangular area, whereas the next two variables adjust 
the Width and Height.
Lock aspect retains the current width/height ratio.

         
before cropping                                                     after cropping
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- The Single tab opposite is used to print the current image.
You may adjust the size and position of your image on the future sheet 
of paper using the click and slide function as well as the Scale field.
The Center button places your drawing in the center of your future 
sheet of paper.

- The Anim tab offers the possibility to print several images of your 
animation (merged layers) on the same sheet of paper.
In addition to the image size and position setting options, you may:
Choose the number of columns for your images.
Display the position of each image on the timeline.
Choose every second, third, fourth, etc. image in the Steps field.
The two buttons in the bottom right-hand corner of the panel are used to 
scroll through the various pages to be printed.



Working with hand-made drawings

Clean-up the sequence

Once the drawing has been scanned, it is possible to :
* Delete white or gray pixels to imitate the use of a true animation overlay (this operation is 
necessary for later coloring as well as for use with a background).

  or     will give :  

* Clean up your drawings in order to correct rough pencil lines.

            (zoom)     >> 
Those who have worked with earlier TVPaint Développement software packages use the Lumakey 
effect followed by one of the color effects to remove the (light) gray aspect of the semi-transparent 
pixels.

New users will no doubt prefer the new Scan cleaner effect specially designed to accomplish the 
two aforementioned operations in a few clicks (even the veterans should give it a go). To use this 
function, simply open the FX stack (discussed in lesson 9) and add the Color > Scan Cleaner 
effect.

Once all drawings have been scanned, many users wish to delete, add or duplicate images. 
Sometimes, they also have to transfer complete images or layers from one project to another. It is 
this traditional, and yet vital, aspect that we will now examine in more detail.

Flip an image

It is possible to flip your images around the horizontal, vertical or both axes. 

            
       Original image                        Horizontal flip                           Vertical flip              Horizontal and Vertical flip

To do this, simply use the main menu options Image > Modify > Flip (Horizontally, Vertically or 
Both) an image or the selected images.
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Working directly with TVPaint Animation Pro

Working directly with TVPaint Animation Pro

The Sketch panel

The Sketch panel comprises some useful preset tools which will allow you to create and clean 
sketchs, as if you were drawing by hand.
The Sketch panel tools are designed for users who work with both computer and graphic tablet and 
who want to keep their old drawing tools. (pencil, eraser, ...)

Here is a detailled description of the panel :

    

* The pencil  icons allow to draw sketchs as if you had real pencils. Three colors 
are available : black, orange and blue. The blue and orange pencils draw with 
Behind mode though the black pencil draw in Color mode.
* The paintbrush icons allow to paint any pre-existing line into the color. You can 
turn any line blue, orange or black.
* The flask icons allow you to turn your image into blue, orange or black.
* The first serie of erasers allow to erase only the color that is displayed on the 
icon.
* The cross icons delete the color(s) : orange, blue, orange and blue, black while 
leaving the other colors intact.
* The eraser icons allow to ... erase a portion of the image. The first eraser is 
small. The second eraser is bigger and smoother.

Now, let's study how to draw and clean a sketch step by step :

* Firstly, erase the content of the current project or open a new project window.
* Use the blue and the orange pencils to rough out your drawing.
The two colors, orange and blue, can help you to differenciate the portions of the image (here, the 
head and the legs are in orange, the arms are in blue.)

               
* If you need to do so, use the two erasers at your disposal to refine on our image.
In the example below, the first eraser was used on the head of the character, the second eraser 
was used on the legs. (the colored eraser will only delete the corresponding colors)

               

The steps to create animated graphics 6-5



Working directly with TVPaint Animation Pro

Either you draw or erase, don't forget that the rotative drawing disk can help you 
work with more precision.

* Once the sketch with orange and blue colors is finished, use the black pencil to clean up the 
drawing.

                
* Now use the blue cross  icon : you now have deleted the blue construction lines of the arms : only 
the black lines of the arms are now visible.
The orange and black areas of the image (head and legs) are still visible.

                

When you use the two colors blue and orange to draw, it is easier to choose 
whether part of the image should be erased or kept.

* If you use now the orange cross icon, only the black lines will stay on the screen. The sketch is 
more precise than at the beginning.

                

* At this state of the process, you can stop here or continue to have a better result.

* We have turned here the lines into orange by using the orange flask icon. It is still possible to add 
some lines or to clean the image with the erasers.
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Working directly with TVPaint Animation Pro

                

* If you want, you can turn the arms of the character into blue by using the blue paintbrush icon.

               

* Here again, we draw with the black pencil on the colored construction lines.

               

* Now we can delete the orange and blue construction lines : The image is not rough anymore. (if it 
is not the case, you can return to the previous steps)

                

This method is not the only one that can be used with the Sketch panel : you can 
use three colors in a different way or you can use only two colors.
Some artists uses one color for the characters and another color for the 
background landscape ...
It should be easy for you to adapt the Skech panel to your workflow.
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Managing the images of an animation layer

Managing the images of an animation layer

Regarding the images management, it is now clearly advised to use the 
new instance system. (see the next chapter of this lesson)
The instances features are available since version 8.1.5 of the software.

- - - - - - - - - - - - - - - - - - - - -

Insert, duplicate or delete one or several images

To duplicate or delete an image, simply go to the image of your choice in the timeline:

   

A right click on the timeline opens a contextual menu which allows you to duplicate or delete your 
image (above).

When duplicating, you will be asked to indicate the number of copies of the current image you wish 
to create. When deleting, you will be asked to confirm the operation.

To insert one or several empty images in your animation, simply call up the same contextual menu. 
It should, however, be noted that the new empty images inserted will be placed just behind the 
current image. The other images of your layer will be shifted accordingly.

image 18 duplicated

images inserted from image 18

The Insert, Duplicate, Delete images options are also available in the Image main 
menu.
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Managing the images of an animation layer

It is possible to select several consecutive images of a layer with a simple click 
and slide of the left mouse button under the timeline icons. The images selected 
are then marked in yellow (see below).

It is therefore possible to duplicate or delete all images selected in the same way as 
described above.

Cut, Copy, Paste images

When using the method described above, it is also possible to cut, copy and paste your images 
anywhere you wish.
This may be in the same layer, from one layer to another, or even from one project to another if 
you are working on several projects.
Once you have created a selection within the layer of your choice, the contextual menu displayed 
with a right click on the timeline allows you to cut or copy the images selected.
Finally, to paste your images, you must:
- select a current image which will be directly in front of the images you wish to paste in.
- select Paste images in the contextual menu of the timeline.

Cut, Copy, Paste layers

The method employed to cut, copy and paste an image or animation layer from one project to 
another is the same as that used for images.

To select several layers, simply left click on these layers while pressing the [Ctrl] or [Shift] keys as 
explained in lesson 3. The layers selected then appear in yellow. 

The layer's contextual menu is located in the left section of the timeline, the image's contextual 
menu is on the right side of the timeline (see below).

The Cut, Copy, Paste layers options are also available in the Layers main menu.

Before transferring the layers from one project to another, always ensure the 
resolution is correct, otherwise your images may be distorted. 
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Working with instances :   ( new ! )

In this chapter :
* The blue images are the new ones.
* The grey images are those which have been drawn in one of the previous steps.
* The green images are here to show the global render of the animation, once it is 
finished.

Introduction

In traditionnal paper animation, the animators are often using the following method :

1 

2 

3 

4       =      final
This simple process needs some successive subdivisions along the animation layer of the timeline.
That's not always easy because the images duplication, creation or copy are not always 
convenient to use. Adjusting the timing of the whole animation usually needs to duplicate and/or 
delete some frames and can be time consuming.
That is the reason why the use of the images instances is clearly advised.

What is an Instance ?

    

An instance is simply an image in an animation layer, an image which 
duration can be adjusted. It is the new animator dedicated tool.
Each icon (or cell) of the timeline has now a small colored square which 
allows to use this feature.
To do so, simply click on this little handle (it becomes yellow) and move 
it as shown opposite.
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* Firstly the key images are drawn. The purpose is to 
get a handle on the global movement, on the required 
number of images, on the timing to schedule, etc ...
In the exemple opposite, the kid is running from the 
left to the right of the screen. Two key images are 
drawn.
* The second step is to locate and draw the most 
important frames. In our example, this is when the kid 
is jumping (the two feets are not on the floor).
* Finally, the inbetween pictures are added :
To begin, an image is drawn between each picture 
already visible on the timeline.
After this, new inbetweens are added among the 
previous one. this usually helps a lot to obtain a good 
quality of animation (in other words a smooth flow of 
movement)
* The subdivisions are repeated until the animator is 
satisfied of the rendering. 



Working with instances :   ( new ! )

You have just increased the duration of the current image.
Any image of an animation layer can be considered as an instance.
The use of the instances allows to save a lot of time when following the previous steps. It also 
allows to manage more easily the timing.

Some vocabulary

Here is the name of each new element visible on screen :

  

Opposite, we have an Instance containing four Cells. 
The first cell is called Head Cell or more simply : Head.

The following cells (when existing) are called Exposures 
cells or Exposures.

The tail of our instance is the little handle 
ending the Instance which you can drag to adjust the 
number of Exposure Cells.

The content of the cells

Whatever the size of the instance could be, the exposure cells are an accurate reproduction of the 
head cell. At the first sight, all the cells of the instance have then the same content.
You should however take into account that all the cells of an instance does not have the same 
function : Indeed, if a modification of the head cell has a repercussion on the exposure cells, it's 
clearly not the same if you decide to modify an exposure cell directly.

Spliting an Instance into two smaller Instances

  

Once an exposure cell is modified, the current instance is broken 
into two smaller instances.
For example (opposite), our instance contain the letter “A”.
Modifying the third exposure cell by deleting the letter “A” and 
drawing the letter “B” will create two different instances, the first 
one containing the letter “A”, the second containing the letter “B”.
We will then see the following images when playing the sequence: 
A  A  A  B  B.

How to use the Instances for animating

Now, let's study a new example :
In our animation, the elephant falls from the top of the screen, then gets up, and finally leaves the 
screen by walking on the left direction.

        
1 > 2                                                        2 > 3                                                  3 > 4
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We can already and easily distinguish four key images from which the inbetweens will be drawn.
Let's re-use the method introduced earlier in this lesson, but with image instances : 
* Firstly create a new animation layer and duplicate the current frame three time. You must have 
four empty instances on the timeline.
* We need then to draw the four key images in each instance.

* Just after this operation, you can adjust the timing by choosing the appropriate number of 
exposure cells in each instance.

If you need a quick preview of the animation when drawing, it is advised to use the 
FLip-Book option. (see lesson 4 for more details)

* Once this task is finished, we can break the four existing instances in order to draw the first 
inbetweens. (the inbetweens are drawn in blue for more readability)

You can use the Lighttable option to help you during the drawing process. It will take 
only the head cells into account. (please read the lighttable section further in this 
lesson)
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* Now we can break, move and resize again the existing instances in order to draw the second 
series of inbetweens. Below, you will find the begining of the resulting timeline.

At any moment of this process, you can, by only few mouse clicks, change the 
number of cells of your instances, and then improve the whole timing of the 
animation.

* Continue the process by breaking again the existing instances and by adding inbetweens. Stop it 
once you are satisfied with your animation.

- - - - - - - - - - - - - - - - - -

   1 > 2       

To finish, here is a quick overview of the steps which were 
needed to create the animation from the first to the second key 
image : 

The blue « I » below shows where the last instance was broken 
(ie : splitted) into two instances.

   

Here are the two key 
images, at the 
extremities of the 
animation

A first instance is 
created in the middle 
of the layer.

Two new instances 
are created for the 
inbetweens.

The instances are 
moved and resized.

Two last instances 
are created for the 
last inbetweens.
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How to change the colors of a rough

  
You can use the option opposite of the tool bar in order to draw only on the 
opaque or semi-transparent pixels of the screen.

It allows, for example, to change the colors of your drawings.

 >  >  >  > 

How to transform an Image layer into an Animation Layer

    

If you need to transform an Image layer into an 
Animation layer, you can use the Transform into 
Animation layer option of the layer main menu. (it is 
also located in the contextual menu of the image 
layer)
Note that an image layer with several images will be 
transformed into one instance with several exposure 
cells.

Drawing outside the existing layers

 
Once you try to draw outside a layer in the timeline, TVPaint Animation Pro will ask 
you if you want to stretch the current layer, in order to make it reach your position.
If you are using an image layer, the number of images of the layer will be increased.
If you are using an animation layer, a new empty instance will be created.

 > 

 > 

Erasing the content of an image instance

Using the erase button  of the main panel on the head cell of an instance makes its content 
deleted.

  >  

Using the erase button  of the main panel on an exposure cell of an instance always breaks the 
instance into two smaller instances.

  >  

Using the erase button  of the main panel on several cells and/or instances turns each cell into 
an empty single instance.

  >  
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Remove cells from an instance

Once several images from a layer have been selected (see lesson 4, if necessary), it's possible to 
delete them. To do so, just select the delete option in the contextual menu of the layer or the 
appropriated button in the animator panel. (see below) 

      
Deleting the exposure cells of an instance will make all the images of the layer move to the left. 
The head of your instance stay the same.

  >  

Deleting the head cell of the first instance of the current layer will make  the images of the layer 
move to the left and will also delete the content of the instance.

  >  

Deleting the head cell of an instance in the middle of the layer will make its exposure cells be 
linked to the previous instance.

  >  

Split a layer

It is possible to subdivide an image or animation layer into two separated layers.

To split a layer in two parts, you first need to go on to the image in front of the point at which you 
wish to place the split.

Then select Split layer in the layer's contextual menu to obtain the result shown below :

      
     For an animation layer

      
   For an instance

       
    For an image layer
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Merging layers

We already saw in lesson 3 how to merge the image layers. It is not really different if you decide to 
merge animation layers with instances. You can use the merge menu of the timeline or drag'n drop 
a layer on another layer.
TVPaint Animation Pro will always try to create instances in the merged layer.

   

Opposite, four layers :
A, B, C and D are going 
to be merged.

(we used the option 
Merge all Layers)

The resulting layer at 
bottom use the 
instances system.

Please note that if you merge an image layer containing more than one image, it will be 
transformed into an Instance with the adequate number of cells. See below :

  

Opposite, two image 
layers : A and B are 
going to be merged.
In the resulting layer, at 
bottom (we called it 
« A+B »), the A and B 
layers are replaced by 
two instances.

The empty space between the two original layers is replaced by an empty instance. 

Stretch a layer

We have described how to increase the number of images of a layer by inserting some new 
exposure cells in the instances. There are, however, other methods to increase the number of 
images in a layer.

Click and slide to the right on the tab encircled in black (see next page) to call 
up the panel shown opposite.
The example below gives you an idea of the effects produced by the various 
options.

Interpolation is nothing but a fade effect calculated and applied by 
TVPaint Animation Pro to fill the intermediary images which will be inserted 
between the original images.

It is possible to stretch a layer to the left by repeating the operation 
described above with the left tab.
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Original layer to be stretched to the 
right.

Stretch without interpolation.

Stretch with interpolation.

Repeat: Loop.

Repeat: Ping-Pong.

Repeat : Hold.

Repeat : Exposure.

Add empty Images.

Add empty Exposures.

Shrink an Animation layer

It is also possible to reduce the number of images in a layer using an 
analog method.
Click and slide to the left on the encircled tab below to call up the 
panel shown opposite. 
The example below gives you an idea of the effects produced by the 
various options.

The original layer which will be contracted in time.

Move the tab to the left.

Option Shrink without interpolation.

Option Shrink with interpolation.

Option Cut images.

With interpolation, the numbers « 1,2,3 » are mixed in the same image, the numbers « 4,5,6 » in 
the next, then « 7,8,9 » etc …
Without interpolation, the intermediary images between images 1, 4, 7 and 10 are deleted.

It is possible to shrink a layer to the left by repeating the operation described above 
with the left tab.
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Pre- and Post-behavior

  

Did you notice the small triangles on either side 
of the layers?

A left click on the triangles offers you access to the options regarding pre- and post-behavior of the 
layers.

Let's take the case of post-behavior as an example (pre-behavior works in the same way). You 
may choose between the options: None, Repeat, PingPong (the last option only applies to 
animation layers), Hold.
These options have the same effect as those offered when stretching a layer. However, in the 
present case, the layer is not stretched and the post-behavior will be taken into account until the 
end of the animation..

These options are also present in the contextual menu of the layer.

How to use several layers at the same time

If you use instances when working, it could be sometimes helpful to use several layers at the same 
time (for instance, if you want to stretch a drawing and its colors).

  

You can select one layer by using the left mouse button on its main thumb. 
If you want to select more than one layer, you can use the [ctrl] key and 
select the needed layers by using the same method. Of course, you can 
also use the layers contextual menu.

Once a layer is selected, its main thumb is yellow encircled. (see below)
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Let's imagine we have 
selected the two layers 
opposite. We are currently 
located on the fourth image 
of the timeline.

If you stretch the instance on 
the Edges layer by moving 
its tail, the corresponding 
instance on the Colors layer 
will be stretched in the same 
way.

If you stretch the Edges 
layer by movig the right tab, 
the Colors layer will be 
stretched in the same way.
(we chose here to add 
empty instances)

If you click and slide a 
selected layer on the 
timeline, the other will follow.



Working with instances :   ( new ! )

The Recompute Exposures option

This option of the Layer main menu will try to transform the images of the current layer into heads 
or exposures cells. This option will only work if there are several indentical images in your layer. 

The Animator Panel

The   Navigation   icons  

 : These two buttons offer direct access to the first and previous frames of the current 
layer.

 : These two buttons allow you to move from key to key (if your project has keys) by 
passing respectively to the previous or next keys.

 : These buttons are used to move to the last or next frame. 

 : Run a fast preview of the current animation. 

 : Play the animation.

 : These buttons are workspace rotation shortcuts with respective angles of -15° and +15°.

 : Layer Shaker.

 : Shortcut to select either the layer above the current layer or the one below it.
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We have not yet discussed these windows which appear when the 
program is started. They comprise a wide variety of functions 
which will help you save a great deal of time when you start to get 
the hang of using the program. You would have noticed that many 
of the functions already discussed are present in the Animator 
Panel. It was, however, important for us to start by explaining the 
fundamentals of the program before introducing you to some 
shortcuts!

Amongst these, you will find the possibility to add images before or 
after the current image, split a layer (after the current image), 
delete an image or layer, convert an image layer into an animation 
layer and vice versa, define bookmarks (add/delete), etc.
Now we are going to take a closer look at these functions...

The first thing you will notice is that the panel is sub-divided into 
several sections: Navigation, Image, Layer, Project and Misc. 

Everything in relation with the creation or 
modification of custom panels will be discussed in 
lesson 18.



The Animator Panel

 : Bookmark shortcut buttons used to go to the previous bookmark, next bookmark, or 
to Activate/Deactivate a bookmark in the current image.

The   Image   section  

 : These buttons are used to create an empty image in the current layer in front of the 
current image (first button) or after the current image (second button).

 : These shortcuts are used to duplicate the current image by placing a new image before 
or after the current image.

 : Delete the current image.

The   Layer   section  

 : Buttons used to either convert an image layer to an animation layer, or to convert the 
current animation layer image into a single image in an image layer (If you select an image 
sequence, this button will create as many Image layers as the number of selected images).

 : The first button is used to split the current layer into 2 separate layers after the current 
image. Working similarly to the previous button, if you select a sequence, the Split action will 
create 3 layers : one with the images before the selection, one with the selection and a last one 
with the images after the selection.The second button, as you may have already guessed, is used 
to join 2 layers to form a single layer. Ensure you select the layers to be joined correctly.

 : These two buttons both open the same window in which you will be asked to enter a 
number of empty images to be inserted. The first button will increase the size of each instance of 
the current layer by adding exposure cells. The second button will insert empty instances between 
each instance of the layer. The number of images or cells inserted depends on the number you 
enter in this window. 

The   Project   section  

 : These buttons are used to move the current layer up or down a notch in the layers 
window.

 : The first button simply deletes the current layer whereas the second automatically 
selects all frames in the current layer.

 : These shortcuts are used to justify all layers selected either right or left. 

 : The first button is used to link the previously selected layers. The second button is useful 
when you wish to split your current project into 2 distinct projects after the current image.

The   Misc   section  

 : These 2 buttons enable the use of a virtual stack in which you will store the current 
image with the first button. This image may then be used by simply pressing the second button. 
Note, on the one hand, that the last image added to the stack is always the first to be removed 
and, on the other hand, that the number of images stored in this virtual stack depends on the hard 
drive space available.

 : This button opens the Tool Bin panel seen in the next lesson.
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The classical tools of the animator

The classical tools of the animator

Rotate workspace

When working with pencil and paper, you often have to rotate the page in order to touch-up the 
lines drawn.
This is also possible with TVPaint Animation Pro thanks to the workspace rotation function.

    

This is done by left clicking on the button illustrated opposite in the current 
project window and then moving the mouse.

A right click on this button offers access to predefined workspace rotation values.
You may also use the keyboard shortcuts [Ctrl+Shift+PageUp/PageDown].

       

Above to the right you will find all information relative to your project (including the workspace 
rotation angle) which is accessible by placing the cursor on the project title bar.

 It is possible to play your animation with a tilted workspace! 

   

Note that workspace rotation always takes 
place from the center of your project window. 
If necessary, you may use the bottom and 
right-hand sliders of your project window to 
position the latter (see opposite).

 

While the workspace is rotated, it becomes visible in the form of an animation 
disk. If you do not need this function, it may be disabled in the Display popup 
menu of the current project.
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The classical tools of the animator

Animation artists who prefer to use the Animator fields may use the same menu to select this 
option.

          

Using the light table

The light table is a familiar tool to cartoon and animation artists. It simplifies drawing of the current 
image by offering a tone-down view of the images before and after the current image.

   
It is accessible with a left click on the light bulb icon in the tool 
bar or via the Windows main menu.

This is the way it looks :

    
* Load the animation « Running Kid 2 » and display only the current layer.
* Start by choosing the color option in the popup menu on the left-hand side of the Light table 
panel to display all frames behind the current frame in the color indicated (default color red).
* Then disable all the frames in front of the current frame that you do not want to see by clicking on 
the corresponding frame number.
* Go to the frame in the center of the animation.
* To enable the light table in your layer, click on the LT icon in this layer.

The following image will appear in the current project window:

The light table is an extremely practical tool as it is also possible to display all frames after the 
current frame in time and for a given layer.
If you configure your light table as indicated below (choose the gradient option in the popup menu 
on the right-hand side of the Light Table panel), the frames after the current frame «in time» are 
displayed in a colored gradient, with more or less opacity depending on their position in relation to 
the current frame.
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The frames in our animation layer which precede 
the current frame are displayed on the screen. 
The frames closest to the current frame « in time » 
are the most visible and those furthest away « in 
time » are the most transparent.



The classical tools of the animator

     

Now that you understand how this tool works, let's go back and take a closer look at its control 
panel:
* The two popup menu allows you to display the images after and before the current image with : 
their original colors, a color or a gradient of your choice.
* The two colored boxes near those popup menus allow you to select the colors on the screen or a 
gradient in a preset list to view the frames before and after the current frame.
* The use of colors in this viewing mode is not mandatory. If you wish to keep the original image 
colors, select the option none (See below).
* The sliders are used to manage the opacity level of frames displayed (the Link button avoids 
having to move each slider individually by linking them to one another).

     

* The numbers are used to select the frames to be displayed.
For example: in the panels shown as an example above, the number 5 to the right of the zero is 
selected and its slider is set in the center of the scale.
This means that the fifth frame after the current frame will be visible with medium opacity.
* The Front button allows to display the light table images in front of the current image.
* The buttons All and None allow to display all the images of the light table or no images.

The number zero enables or disables the light table, its slider manages the 
global opacity of the table.
If you use instances, only the head cells are taken into account by the 

lighttable.
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The inking process

The inking process

The fllodfill tool

When using the traditional Fill option you choose a pixel in the current project window and then 
click on it. We refer to this pixel as the origin pixel. 
The Fill option changes the color of neighboring pixels until it is prevented from progressing by the 
«border» pixels.

    

Opposite, the «border» pixels in black and 
the color dispersion from the origin pixel in 
blue.

The options indicated above allow you to choose the type of pixels to be used as a «barrier» for 
the Floodfill function (i.e. pixels which will not be modified after choosing this option).
Depending on your choice made in the Fill popup menu, the pixels considered to be «barrier» 
pixels will be those with:
* a different color to the original pixel color
* a different density
* a different color and density
* a different luminosity 
* a color identical to the B color.

Depending on your choice in the Source popup menu, the pixels considered to be barrier pixels are 
located:
* on the current layer (by default)
* on all layers behind the current layer
* on all layers in front of the current layer
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Our running kid is drawn on an animation layer. 
We will now fill in the background with the Floodfill tool.

Once the Floodfill tool has been selected, various options are proposed in 
the Filling shape panel shown opposite:

- The color modes were discussed in lesson 2,
- The Smooth, Opacity, Gradient and Opacity mapping options were 
discussed in lesson 3.
- The Wrapping brush option was studied in lesson 4.

We will therefore only take a closer look at the second section of the Filling 
shape panel.



The inking process

* on all layers displayed on the screen

It is therefore possible to color our running kid on a layer independent of its contours.
Let's take a look at the timeline below:
(in this case, the white pixels are transparent following a clean up of the animated footage)

Go to the «coloring layer» located behind the «Running Kid» layer and choose the layer placed in 
front of the current layer to color the running kid in the «coloring layer» using the outline of the 
«Running Kid» layer. 
It is then possible to obtain the following result:

        

* The Range option enables you to numerically adjust the tolerance threshold for the 
aforementioned criteria (Fill shape  menu).

For example, opposite, a green shape is drawn with an airbrush on a 
transparent surface with a checker background.
The floodfill option applied in the center of the circle with the color blue 
provides the image results shown below.
fill = color and opacity, expand = 0  (in all cases below)

                          
        range = 0      range = 50                 range = 100                  range = 200                  range = 255

Progressively, it is noted that the tolerance to «border» pixels  becomes less and less.
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The inking process

* The Expand option increases the size of the floodfill area to the number of pixels of your choice.
This enables you to limit the number of border pixels.

For example: you draw a green line with the airbrush. A left click with the 
Floodfill tool and the color blue and you will obtain the following results:

Floodfill = color and opacity, range = 0  (in all cases below)

             
 expand = 0    expand = 5     expand = 10    expand = 15   expand = 20    expand = 25    expand = 30   expand = 40

Combine the two options Expand and Range to avoid the result indicated below left and to obtain 
the result below right.

  >>  
* The Gap option allows you to avoid «overspills» when you try to fill a surface which is not 
completely closed.

Low values are used in the case of «small gaps», whereas high values are used for larger gaps (it 
is worth noting that higher values sometimes result in a lower floodfill quality).
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Image with «a gap»

Floodfill the character without Gap 
closer



The inking process

   

The Auto Pick Color option

Finally, you have noticed that there is also a box called Auto pick color:
This option will save a great deal of time as it allows you, when checked, to pick a color when you 
click and to place it when you release the button. Combined with a Light table which only displays 
the previous frame, you may pick the color from the previous frame and place it in your current 
frame.

Create shadows

Once you have finished coloring your running kid, you may add shades to the latter using the 
toonshading effects discussed in lesson 12.

        
toonshading                                     toonshading                                  Drop Shadow
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To finish the animation

To finish the animation

Camera movements

Now that your running kid is animated, it is possible to add a scenery behind him and to add 
camera movement (see below).
Two effects will help you with this: Keyframer and Multiplane camera (go to lessons 14 and 15 for 
details of these effects).

Add music

The graphic design side of your project is now complete. If you wish, you may now add a sound 
track in order to give it that final touch. (see lesson 8 for more details about this subject)
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Lesson 7 

Other TVPaint Animation Pro drawing tools

In this lesson, you will: 

● Finish studying the drawing modes.

● Use the clipboard.

● Use the spare image.

● Learn how to use animbrushes as drawing tool.

● Use cutouts and selections.



The others drawing modes

The others drawing modes

We studied in lesson 2 several drawing modes : color, behind, erase, shade, light and panto.
We are now going to study the other drawing modes at our disposal.
The drawing and the photography below will serve as a basis in this chapter.

        

The Saturate and Unsaturate drawing modes

These two modes are used to increase or decrease pixel saturation.
A highly saturated color is a very bright color whereas a less saturated color is rather dull and 
closer to gray. Here, the Penbrush tool was used with an opacity and power of 100% for a radius 
of 30 pixels.

        
                                 Penbrush tool in Saturate mode              Penbrush tool in Unsaturate mode

The pixels of the house are gray with a light red hue.
The Saturate mode will therefore increase their red components and render them more vivid. 
The Unsaturate mode will have little effect on the same pixels as they are already close to gray.

The pixels of the sun and sky are very saturated.
The Saturate mode will therefore change the yellow hues only a little.
The Unsaturate mode will modify them according to different shades of gray.

          
                                Penbrush tool in Saturate mode               Penbrush tool in Unsaturate mode
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The Smooth and Sharp drawing modes

The Smooth mode attenuates the contours of elements in the image and creates a blurred effect 
while the Sharp mode will accentuate them.

        
                                Penbrush tool in Smooth mode                Penbrush tool in Sharp mode 

        

The Colorize and Tint drawing modes

These two modes modify the color of the pixels:
* The Colorize mode adds the A color while respecting the pixel luminosity of the source image.
* The Tint mode also adds the A color but respects the saturation as well as the luminosity. The 
more a pixel is close to a gray, white or black color (with all the shades they contain), the less 
effect the color change will have.
This is visible in the drawing areas corresponding to the cloud : they are less affected by the Tint 
than by the Colorize  mode.
Here the A color is red : R=255, G=0, B=0.

         
                                 Airbrush tool in Colorize mode              Airbrush tool in Tint mode
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The Negative and Solarize drawing modes

The Negative mode inverses the value of the pixels in the source image (the yellow of the sun 
becomes blue, the black text becomes white, etc.).
The Solarize mode gives a slightly different result than the Negative mode. 
It mixes the negative of the source image with the source image itself and thus imitates the 
photographic solarization procedure.

        
                               Airbrush tool in Negative mode                 Airbrush tool in Solarize mode

          
     

The Grain and Noise drawing modes

The Grain mode adds a multi-colored grain to the current image. This creates a texture imitating a 
light photographic grain.
The Noise mode adds a single-colored grain, the color applied is the A color. 
The Grain and Noise modes themselves also depend strongly on the power and opacity of the 
drawing tool. Here the A color is a gray color.

         
                                Penbrush tool in Grain mode                   Penbrush tool in Noise mode 
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The Emboss drawing mode

       
Airbrush tool in Emboss mode

The Emboss mode accentuates the image contours by  adding a shadow.
Once the tool is used on the image, it appears to have more volume.

The Add and Sub drawing modes

The Add mode adds the R,G,B,A values of the current tool with the color A to the R,G,B,A values 
of the source image pixels. The result is the image shown on the left.
The Sub mode subtracts the R,G,B values of the color A from the R,G,B values of the source 
image pixels. The result is the image shown on the right. 
Here the color A is purple: R=128, G=0, B=128.

        
                                Airbrush tool in Add mode                        Airbrush tool in Sub mode

        

These last four modes : Add, Sub, Multiply and Screen are more useful when 
they are used with brushes or with certain effects. 
We will come back to them in further lessons.

The Multiply and Screen drawing modes

The Multiply mode multiplies the individual values of the R,G,B channels of the source image 
pixels with the sum of the R,G,B values of the A color pixels. The Screen mode inverses the values 
previously used.
Here again, the A color is purple: R=128, G=0, B=128.
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                                Airbrush tool in Multiply mode                  Airbrush tool in Screen mode 

          

The Healing drawing mode

The Healing drawing mode is an image-editing tool. It will certainly interest some users who want 
to improve their photography.
I works like an enhanced pantograph : it allows to reproduce the texture and the global illumination 
of a reference area, and preserve the color data.

The reference area can be set in the shape setting panel (we 
already talked about it in the lesson 2). It is accessible in the 
Windows main menu or with a right click on one of the seven 
drawing shapes (dot, freehand, line, spline, rectangle, 
ellipse and floodfill).

In the examples below, two wounds of a photographied hand have been corrected by using the 
Healing mode with the airbrush tool.
The pantograph mode on the right doesn't give good results, with similar settings.

 > 
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Opposite, the source 
picture and two 
fingers that will be 
retouched.



The others drawing modes

    
Source picture with                                Corrected picture                                   Corrected picture
the reference area (red cross)               with the Healing mode                           with the Pantograph mode

    

With a bit of practice, it could be easy for you to remove the dimple of your photographs.

  >  
  The face with dimples                                                   The same face with the dimples removed

Please note that the reference area can be located on a different picture than the current one. The 
reference area can be the background, the displayed picture, the current image, the previous 
image, a paper or an image copied into the spare.

It is therefore possible to fake your photographs : here below, some scars have been added to the 
skin by using this fissured wall picture as reference layer.

   
 The same face with scars added                              The reference picture for the Healing tool
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Clipboard and spare

The clipboard

The clipboard menu is located in the Edit main menu and comprises four useful options which, in a 
way, serve as an interface between TVPaint Animation Pro and your other software packages.
* The Copy brush to clipboard option makes the current brush available for other software 
packages installed on your computer.
* The Copy image to clipboard option makes the current image displayed in your project (including 
the background) available for other software packages installed on your computer.

Wordprocessors, spreadsheets and digital creation software packages generally 
use a function referred to as Paste buffer content or Paste which you simply 
have to call up in order to use your brush or image.

When you use the [print screen] key on your keyboard or when you use the Copy option (to be 
understood «copy to buffer») in the program, it is possible to recover the image stored in TVPaint 
Animation Pro :

* The Get brush from clipboard option makes the current image stored in the buffer memory of your 
computer available as current brush.

* The New layer from clipboard option creates a new image layer from the clipboard.

For the latter option, ensure the size of your current project is adapted to that of 
the image stored in the buffer memory, otherwise the image may be cropped.

The Spare image 

It is possible to virtually store an image of the current layer displayed on the screen in order to use 
it at a later time (mixing options) or to use specific drawing modes (Merge or Impressionist modes).
This image is referred to as spare image. 

Above you will find the options available in the Edit > Spare main menu.
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The following examples will provide 
a better understanding of this 
notion.



Clipboard and spare

              Spare

      Current image

                  

* Finally, the option Delete spare is used to delete the spare image.

If you are working with several projects at the same time, note that each project 
has its own spare image.

When you save a project, the spare page is also saved with this project.

The Merge drawing mode 

The Impressionist drawing mode 

This drawing mode will be discussed in the Special brushes section of this lesson. It also requires 
the use of a spare image.
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Save the TVPaint logo opposite as a spare image (main menu 
Edit > Spare > Copy to spare or shortcut [Shift+J] ) 
Delete it from the current layer (standard delete tool:  ), then 
draw an ellipse with an opacity of 75% in its place.

* The option Swap spare (shortcut [J]) returns the TVPaint logo to 
the screen and replaces the spare image with the ellipse.
Using this function again will redefine the TVPaint logo as spare 
and will display the ellipse in the center of the window.

* Depending on your selections in the popup menu, the Spare 
mixer option offers the following results:

The Merge drawing mode is only available once a spare 
image has been defined.
It may only be used with theairbrush, penbrush, mechanical 
pencil, pencil and wetbrush tools.

It is used to draw the portion of the spare image 
corresponding to the area traveled by your stylus on the 
screen.



To perfectly master the drawing tools.

To perfectly master the drawing tools.

The two tools indicated below are very useful to warp the images and give the appearance that 
they were hand-drawn.

The Warpbrush

The Warpbrush may be used to give the impression that a drop of water has fallen on the image. 
Combined with certain types of paper, it gives the impression that you are looking at the image 
through a window. There are two types of warps: warp out and warp in (see below).

          
          Warp in at top                                   Original image                               Use of this tool on an image
       Warp out at bottom

The Special brush

The special brush functions differently according to the drawing mode selected.
It shifts the image pixels:
* uniformly in Shift mode, 
* degressively in Smear mode,
* by adding color in Mix mode ,
* by taking into account the spare image pixels in Impressionist mode.

Below you will see the results of the first three modes from top to bottom.
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In each case, a line was drawn from left to right.

* Mix mode (the A color is red)

* Shift mode 

* Smear mode 



To perfectly master the drawing tools.

As indicated above, the Impressionist mode requires a spare image in order to work. When 
drawing a line in this drawing mode, the current image is deleted in order to make place for a spare 
image and the latter is smeared in the direction of the line traced. 
This creates quite an eye-catching effect when working with a small tool and with « dotted » 
Profiles and a Ratio close to 0% (see Special brush panel below).
When required, the current image used as spare image may also provide a very original artistic 
effect.

       

Opposite an illustration in impressionist 
mode with parameters panel together 
with the current image = Spare image.

 

The Text tool

The Text tool is used, as its name implies, to generate text brushes.

   

Here you will find a general introduction into how to add a text to your images: 

* Enter the text of your choice in the text field at the bottom of the panel.
* Select the font of your choice.
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* Select Letter mode or Word mode depending upon whether you wish to display the entire content 
of the text field or simply one letter at a time.
* Modify the parameters as you require.
All changes to the numeric fields or using the mini-sliders will be taken into account and displayed 
interactively on the screen for several seconds in order to allow you to view the result of changes 
and settings made. 
* Now all that is left is to apply the text to the layer in the location of your choice.

Below you will find a detailed description of the parameters at your disposal for this tool:

* The first popup menu is used to select the font best suited to your project amongst those installed 
on your operating system. The two arrows  are used to quickly scroll through the list of fonts 
available.
* The popup menus Script and Style are used to select the character type to be used (occidental, 
oriental, Greek, etc.) and their style (bold, italic, underlined …).

The fonts used by TVPaint Animation Pro are of the « .ttf » (True Type Font) 
format for PC.

* The Size variable defines the font size in pixels.
* The XScale variable manages the font width.
* The Space variable defines the space between characters (a negative value overlaps the 
characters).
* The Italic variable modifies the inclination applied to characters.
* The Rotate variable is used to increase or decrease the angle formed between the text and the 
horizontal axis. 
* The Track variable adapts the space between characters, but this time, in proportion to the size 
of each letter in the text field.
* The Opacity variable defines the text transparency.
* The Outline variable creates an outline of varying thickness around the letters, but renders the 
interior of the letters transparent.
* The Smooth variable applies a blur to the letters.
* The Border variable creates an outline of varying thickness around the letters.
* The Glow variable creates a luminous halo around the letters.
The border and glow may be of any color of your choice.
* If the Letter button is selected, an Anim. (Animation) popup menu is present: you may then 
choose to apply the letters in the text field once only, in a loop, randomly or in ping-pong.
* If the Word button is selected, a Step variable is present: this variable functions in the same way 
as for standard drawing tools (see lesson 2).

* The Reset button resets all settings.
* The «▼» button provides access to the last phrases or words entered in the text field.
* The B button opens a larger text field in order to work with longer texts.
* The number in the bottom left hand corner of the panel represents the text width in number of 
pixels (a width which is dependent on your settings).
* The Create brush button allows you to transform your text into a custom brush and switch to the 
brush settings in the tool panel. 

In addition to the settings via the mini-sliders, do not forget to tick the boxes 
to take these variables into account.
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The connections

   

Throughout this lesson, we have modified the size, power, opacity, etc. of our 
tools and you have certainly noticed the letters located in a box left of the 
corresponding numeric value.

These are the Connection parameters. The corresponding contextual menu is 
accessible by clicking on the box.

Most graphic tablets available on the market are sensitive to pressure, stylus 
travel speed and inclination, etc …

TVPaint Animation Pro takes all these advantages into account and it is 
therefore possible to imitate the specific aspects of drawing by hand.

Here are some examples:
* If you connect the Size of the pen tool with the stylus Travel Speed, the thickness of the line 
drawn will be thicker the faster you move your stylus (to do this, select Speed in the Size 
connection menu).
* If you connect the stylus Pressure to the airbrush tool Power, the more you push down on the 
tablet with the stylus, the brighter the color will be on the screen.
* If you connect the Opacity of the wetbrush tool to the Altitude of the stylus, inclining the stylus will 
render the aquarelle almost transparent.

A wide variety of setting combinations are available. Below we will describe each of them. It is then 
up to you to make the connections according to your needs and creative spirit, don't hesitate to 
experiment!

The first set of connections applies to pointing peripherals (mouse, trackball, stylus) :
* None: no connections.
* profile Editor: it will be explained in the next chapter.
* Invert: invert the effect of the connection chosen.
* Speed: the parameter connected to the Speed will change at a speed proportional to the stylus 
travel speed.
* Direction: the parameter connected to the Direction will change according to the direction of the 
stylus.
* Orientation: the parameter connected to the Orientation will change according to the stylus 
orientation. 
* Fade: the parameter connected to Fade will decrease its values as the line drawn progresses.
* Random: the parameter connected to Random will vary randomly.

The second set of connections applies only to stylus and graphic tablets:
* Pressure: the parameter connected to Pressure of the parameter connected will vary 
proportionally to the pressure applied to the stylus on the tablet.
* Altitude: the parameter connected to Altitude will vary proportionally to the angle formed by the 
stylus inclination on the tablet.
* Azimuth: the parameter connected to Azimuth will vary proportionally to the angle formed 
between the stylus projection on the tablet and the vertical plane.
* Rotation: the parameter connected to Rotation will vary when you roll the stylus between your 
fingers. (you need a 6D Art pen from Wacom to use this connection)
* FingerWheel: the parameter connected to FingerWheel will vary according to these options when 
using the Wacom airbrush fingerwheels.
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Opposite you will find a summary diagram of the 
connections indicated above.
Note that some tablets do not offer all these 
options. For optimum results, TVPaint 
recommends the use of Wacom Intuos 3 tablets !

The speed, fade, orientation and direction connections are 
adjustable.
Orientation angle, direction angle, speed curve and fade speed 
may be modified in the Connection Settings window (select 

Option in the connections contextual menu shown on the previous page).

Below you will find some examples to illustrate the effects:

Size connected to Fade for various fade values.

Size connected to Orientation (right drawing).
Size connected to Direction (left drawing).

Size connected to Speed using various curves.
All three lines were obtained by increasing the stylus travel speed (i.e. 
with progressive acceleration).

The Text tool with Rotation connected to the stylus Direction.

7-14 Other TVPaint Animation Pro drawing tools



To perfectly master the drawing tools.

The connections Profiles

      

A Profile Editor option is also available in the connection menu. Once selected, 
it opens a new window with a profile curve.
This profile curve allows to adjust the interaction between the parameters (size, 
power, opacity, ...) and the connection you have just chosen (fade, pressure, 
random, ...)
A lot of profile curves are then available. For instance, the airbrush tool has 4 
parameters which can use up to 10 connections. There are then 4 x 10 = 40 
potential profile curves.
The applications of the profile curves are numerous, and we will only study here 
the most important examples.

• Size and Pressure

If you connect the stylus Pressure to the Power of the Pencil tool, the more you push down on the 
tablet with the stylus, the thicker your line will be.
In the example below on the left, the size of your tool will be bounded between 0 pixels and 
30 pixels. (In this exemple, we want to focus on the size parameter behavior, so we will choose 
connection = none for the power parameter.)
Now if we change the profile curve as shown below on the right, the minimal size value for your 
tool will be 15 pixels.

• Size and Fade

Let's admit that we draw a straight line on the current picture, from right to left with the oilbrush 
tool. If the profile curve stays unchanged, the line thickness is smaller and smaller.
In our example :
The horizontal axis of the Connection profile panel shows the chosen connection from the maximal 
value to the minimal value.
The vertical axis of the Connection profile panel shows the values of the Size parameter.
As a consequence, if we change the profile curve as shown below, you will obtain the following 
results :
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• Angle and Random

   

Let's admit that you are using an animbrush with four images in order to 
add some colored flags on a picture. (see below, the handle of the 
animbrush is on the red cross or red line and the anim behavior is set to 
Random)

  1  2  3  4         
                                                                                                                          handle

Here is the result if you draw a straight line with the settings opposite :
(Don't hesitate to modify the Step parameter if you need to change the 
distance between the flags)

   
If we choose an angle of 90°, the result is monotonous ...
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If we connect the animbrush Angle parameter to Random, the flags will 
be arranged in every directions. It is completely disordered ...

Now let's modify the profile curve as shown hereafter :
The angle of the animbrush will be randomly chosen 
between 80° and 100° compared to the horizontal 
axis. The general aspect will be less monotonous.
(each gradation represents 90°)

The minimal and maximal angular values on the vertical axis 
of te profile curve are the same as the one you have chosen 
in the tool panel of the current custom brush.

For instance, if you select an angle of -50°, the gradations will then be :

  >>>  

• Size and Random

We will now continue to work on the same example :

    

The purpose is now to make all the flags have a different size.
Of course, we can connect the Size parameter of the brush to Random.

   

Nevertheless a problem persist : we can have too small flags.
To remedy this, we only have to select a minimal size for our 
animbrush in the profile connection window.
Opposite and below, some randomly selected values between 75% 
and 100% of the original size will be used.
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Use of the brush as a drawing tool

The use of predefined brushes and the connection parameters described above may produce 
spectacular results: 
* Tree leaves (Luma stamp mode with green A color and black B color and a randomly selected 
brush angle).
* We used the same brush with the same mode but with red colors to draw the blood below.
* Clouds (Alpha stamp mode with blue A color, Angle randomly selected and Opacity of the 
animated brush connected to the stylus pressure).
* Smoke (Size of the brush chosen in Random mode, Opacity connected to Fade ...).
* Ink (Luma stamp mode with A and B colors of your choice, Size connected to stylus Azimuth, 
Angle chosen in Random mode).

    
* An animbrush using the Add mode can be applied directly on an empty layer and can be also 
shifted thanks to the shift option (see lesson 4). It could give very good result if you need to use 
some Oilbrush or Watercolor :

How to use the brush modes

As explained in lesson 4, it is possible to use the brush modes to modify their colors. This is very 
useful to create your own drawing tools. In the example below, the A color is red and the B color is 
Yellow.

             Color mode      Alpha Stamp mode     Luma Stamp mode     Invert Luma Mode       Hue Stamp mode  
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The brush modes Stamp Alpha and Stamp Alpha Max

Thanks to the simple brush below, it is possible to 
create a powerful drawing tool. (We used the jitter 
and rotation parameters and connections to obtain 
better results)
However, some overlappings can become visible 
during your drawings. For example, if you go 
several time on the same place with your stylus.
The Stamp Alpha Max mode records the maximum 
opacity value of your brush pixels and uses it as a 
limit not to be exceeded during the drawing.
In other words, it remedies our overlapping 
problem.

                    (our brush)

    
      Color mode

                
   Alpha mode          Stamp Alpha Max mode 

The Shift parameter does not work with the Alpha et Alpha Max modes.
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The drawing tool panel : Bin tab

The numbers next to the brushes indicate the number of animated brush 
images or size of the brush.

Right click on the brush in the tab to:
* Add the current brush to the bin
* Get the brush you just clicked on as current brush
* Swap the current brush with the one you just clicked on
* Export the brush
* Delete the brush from the bin

Your settings will be saved if you click on Save this configuration when you leave 
the program. If you reset TVPaint Animation Pro's configuration, your settings will 
be lost.

      

Opposite you will find an example of the 
predefined animated brushes available in 
TVPaint Animation Pro.
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Two tabs are available for each drawing tool: 
The Options tab you have already seen and the Bin tab.

Regardless of the tool you are using, you may save the settings applied 
(Size, Power, Opacity, Angle, Profile, Connections, Gradient, Mode, etc.) in 
order to use them again later.

Right click on the Bin tab window to check whether any predefined settings 
exist and to use them or create new settings if you feel they are required.

At this point we will study the Bin tab of the custom brush (the same applies 
to all other tools).

Right click on the empty area of the Bin tab to:
* either Add the current brush to save it.
* or Get a brush of your choice to be saved.
In both cases, a miniature of your brush appears under the tab.
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The Tool Bin panel 

The Tool Bin panel is the third custom panel present when you start the program for the first time. 
Located under the Animator Panel, it has the following form: 

     

Although relatively basic at first sight, this panel is also very useful to 
store your brushes thanks to the first two buttons it contains.

The  is used to grab the current tool and place it in the panel under 
the two buttons. An icon is automatically created according to the tool to 
be used. 

The second button  fulfils the same function as the first except that it 
grabs the tool together with the A and B colors active when the tool was 
grabbed.

Now all you have to do is click on the icon of the tool grabbed in order to use it again. This proves 
extremely practical when you have specific drawing habits !

Please refer to the end of lesson 4, in order to learn how to cut your own 
animbrushes, and as a consequence create your own drawing tools.

Once you grab a tool with or without its colors, the current paper, the parameters and the 
connection profiles are taken into account. It is then possible to create and store more realistic 
drawing tools.
Furthermore, you are also free to create new panels for each type of tool and to save your favorite 
brushes which are easily identifiable !

Load and save the custom panel

  
A right click on the icon opposite of the Tool Bar allows to choose the 
custom panels which you want to be displayed.

It also allows to display and load new custom panels.
A lot of thematic custom panels (manga, pixel art, chinese brush, ...) are available in the Contents-
Sharing section of our online forum. http://www.tvpaint.com/forum/

Be carreful : when you save a custom panel, the papers linked to your tools are not 
saved. In other words, if you decide to save a custom panel, only the brushes and 
their settings will be saved on your harddrive.

This doesn't matter if you used the papers that are given by default with the software.
However, if you have created and used your own papers, you will have to save and load them 
separately. Your custom papers are located in the Papers sub-directory of your configuration. 
Here is the path for Mac and PC users :
C:\Documents and Settings\your_name\Application Data\TVpaint\your_config_name
$ Home Directory/Library/tvpaint animation/your_config_name

The options relative to the custom panels are numerous : Create a new panel, a new button, grab 
a tool with colors, call a George script, import and export a panel, use a Plug-in, use the TVPaint 
commands,  etc ...
They are all described in lesson 18 of this manual.
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Selections and cutbrushes

Use the magic wand cutbrush

   

In lesson 4 we saw that it is possible to cut a rectangular, polygonal or 
freehand brush. It is also possible to use the Magic wand cutbrush.

Let's take a closer look at this function: don't worry, it's no sorcery!
When using the Floodfill tool, the boundary points (not filled in) are defined and the other points are 
colored (see lesson 6: adjustment of shape settings).
The same applies to our magic wand except that the «floodfill» area of the image becomes the 
current brush.
The current brush may therefore take all kinds of shapes.

For example, by adding the Expand and Range parameters, it is easy to obtain the following two 
brushes.

     >>         
                    Original image                                   Brush cutout                     

Working on a specific area on the screen

Selecting an area of the screen will allow you to work without changing anything in the area of the 
screen not selected.
For example, in the image below we have selected the cloud. Any drawing with your stylus will 
affect only the cloud.

                     
           Original image                                           Images with selection      

You may also select an area of a layer and then make the modifications in another layer, for added 
safety.
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If you have selected an area, using the Delete image icon in the main 
panel will only delete the selection.
The choice of a color channel for working also affects only your selection.

The various types of selections 

  Five icons in the main panel are used to enable these selections. 
From left to right: 
* Rectangle select
* Circle select
* Freehand select
* Spline select (refer to lesson 2 for further details about this type of spline)
* Select with Magic wand

Regarding the function of the magic wand, refer to the section Inking 
Process in lesson 6.
In the present case, we create selections instead of filling surfaces, 
otherwise the mode remains identical…

Complex selections and brush creation

That's not all, the Selection tool window opposite extends the range of possible actions. 

* The Smooth option works in the same way as that presented in lesson 3 to draw a filled 
rectangle.

* When checked, the Anti-Aliasing box smoothes the contours of the future selection. 
* The Invert button inverts the current selection.

* The Clear button deletes it.
* The four buttons which follow are used to copy or cut the pixels contained in the selection and 
incorporate them in a new layer or new brush (animated brush or animation layer, if several images 
were selected previously).

* The Crop button is used to create a new project containing only the contents of the selection. 
Your new project will contain an image or animation layer depending on whether you have selected 
one or several images in the current layer. If your current project contains several layers you will 
find the same number of layers in the new project.
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From the popup menu:
* The Add and Sub options may be used to create complex selections: 
the Add option allows you to add a new selection to the previous 
selection while the Sub option, as the name implies, will remove the new 
selection from the previous selection. You may obviously combine various 
Selection tools with each other in order to obtain the required selection. 

* The effect of the Replace option is that drawing a new selection will 
automatically replace the previous selection.



The transformation tools

The transformation tools

The Panning tool in the main panel

* If you check the Apply to image box, the current image will be taken into consideration when 
shifting (see below).

       
                          Original image                       Shift option                           Wrap option

* If you check the Apply to selection box as well as the Apply to image box, the current selection 
will be taken into consideration when shifting (see below),

         
Original image                        Wrap option                            Wrap option                            Shift option
with selection                         without selection                    with selection                         with selection

* If only the Apply to selection  box is checked, the image will not change but only the selection.
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The Panning tool is used to shift an image or a selection on the screen 
with a left click + slide of the mouse.
The Wrap option enables you to « wrap » the image (see below).

It is possible to transform all or part of several images using the three 
tools shown opposite: Panning, Transform and Wrap.



The transformation tools

      
                         Original image                         Wrap option                           Shift option

* If the AAliasing box is checked, the image contours are smoothed.

The Transform tool in the main panel

The Transform tool in the main panel is used to shift, increase or 
reduce the image.
Below you find a detailed description of the options proposed in this 
panel:
* The popup menu allows you to either Shift  the image or to Fill the 
screen with the current image.
* As with the Panning tool, it is possible to shift the image and/or the 
selection (see examples below).

* The Panning X and Panning Y variables are used to translate the image on the screen. The 
Center button is used to re-center it.
* The Scale variable is used to modify the size of the image (increase or decrease).
* The Angle variable is used to rotate the image.
* The Reset button resets the settings.
* The Preview box enables interactive viewing of the previous parameters on the screen.
* Once satisfied with the settings, the Apply button is pressed to finish the operation.

      
         Original image                       The Transform tool in Shift  mode        The Transform tool in Fill mode
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You may also work directly on the screen using the mouse:
* left click and slide to modify panning.
* right click and slide to modify size.

  Panning tool applied to
  image and selection.

To shift all images of a layer, first select them all. Use the keyboard shortcut 
[Ctrl+S] or the contextual menu in the timeline.

The Wrap tool on the main panel

                  
     Original image                     Wrap tool in Shift mode                             Wrap tool in Fill mode 
     with selection     
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As the name implies, this tool is used to put the image or current selection 
into perspective. 

A modification of the four corner coordinates of the image is sufficient to 
obtain a convincing effect.

You may or may not fill the screen with the current image (see examples 
below).

Here again, the same system as above is used (Preview then Apply).

Use the Reset button to reset the settings.



The transformation tools

  

The blue line that appears on the screen during setting is 
the horizon line. You may move the two vanishing points 
as you wish to set the perspective.

   Wrap tool applied to the 
   image and the selection
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Lesson 8

The XSheet panel and layers

In this lesson you will :

● Add a sound track to your project.

● Learn to use the XSheet layers.

● Learn to use the Spreadsheet panel.

● Make a Lip-Sync.



How to add an sound track to your project

How to add an sound track to your project

The audio options are available in the Project main menu or in the Sounds menu of the timeline 
(encircled cursor ▼ below on the right).

          

Note that the  button in the current 
project window is used to play a sound 
track when the project is viewed.

Here are the various functions proposed by TVPaint Animation Pro :
* Load a sound track to be included in your project. 
On the left of the timeline, the name of the loaded sound file will appear and another triangle ▼ will 
allow you to change the size of the track display :

   

Optimised display

Reduced display

* Delete a sound track from your current project
* It is possible to move the audio track along the timeline with a click and slide on the former. This 
function allows you to adjust synchronization of your animation and sound track.
* The Offset option enables synchronization using a numeric value 
* The Lock  option prevents all movement of your sound track with a click and slide. Once you 
have completed your settings, this option will allow you to avoid any risk of handling mistakes.
* If the jog audio is in None position, no sounds will be emitted when you move along the timeline.
* If the jog audio is in Scrub position, the sounds will only be emitted if your movements along the 
timeline is carried out with a mouse or stylus.
* If the jog audio is in Always position, the sounds will always be emitted when you move along the 
timeline, regardless of whether you use the mouse, stylus or keyboard arrow keys.
* If a sound is emitted each time you change the current image in the timeline, the option Enter the 
scrub audio duration allows you to define the duration of this sound.
* The Notes option is available when using the RMB on the sound area. It allows to add text in the 
TimeLine. Each cell of the Timeline can receive a note.
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The XSheet Layers and XSheet Panel

Introduction and principle

Maybe are you not familiar with XSheet layers and Lip-Sync notions. Here are some informations 
regarding their origin :

The word XSheet comes from eXposure-Sheet or dope-Sheet.
It comes from the days of traditional animation when the XSheet was a paper list that numbered all 
frames of a scene and in which the animator could write down his drawing numbers with the right 
timing. (see below)
It helped the animators to plan their animations and also functionned as a guide for the 
cameraman to know how to shoot the scene. 
For instance, synchronising the lips of a character with a recorded soundtrack (in other words 
doing a Lip-Sync) was possible with the XSheet.

The XSheet panel, commonly called XSheet tab in TVPaint Animation Pro (see next pages) is the 
numeric transposition of the classical paper XSheet. 
The reason XSheet panels were included in TVPaint Animation Pro is to make easier to time and 
synchronise the animations, thanks to the XSheet layers.
It is also a very usefull tool for people who uses to scan their drawings. The main advantage of the 
XSheet layer is that a frame that is used multiple times in a scene need only to be adjusted or 
colored once and all instances of this image in the XSheet layer will change accordingly.
It saves a lot of time since the process of copying and editing frames is much simpler and easier to 
control through the XSheet panel. (This is much simpler than the old way in which you'd have to 
manually copy and paste frames in the layers of the timeline.)

For example, let's assume that the coloring and the shadows of a character are on separate layers: 
If you need to re-arrange your animation in time, it is always very tedious to edit a layer in the 
same way twice or more ...  Fortunately, with the XSheet panel this can be done really easily and 
quickly.
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All those notions may seem abstract at first, but you can relax. We will quickly study some concrete 
situations and examples.

The projects used in this chapter
 
To make the XSheet layers easier to understand, we will need to load the project file (Running-Kid 
.tvp) from your TVPaint Animation Pro CD-Rom.
Those who have downloaded the (30 days trial) demo version of the software will find this file in the 
content sharing section of the TVPaint forum (www.TVPaint.com/forum/)
Once the project is loaded, you should obtain the following animation and timeline.

      
Five layers are visible: an image layer called « background » and four animation layers called « 
shadow », « colors », « Running Kid » and « Toonshading ». Each layer has its own assigned 
color.
Please note that your project does not have any XSheet layer at this time. 

First approach of the XSheet panel

To swap between the Timeline and the XSheet panels, you only have to click on the corresponding 
tab (see below)

   >>   
Let’s study firstly the left part of the XSheet panel. (the right part will be the subject of a further 
chapter).
The left part of the XSheet panel is in a way the mirror of the Timeline. (see next page for the 
screenshots) :
* Each column of the XSheet Panel corresponds to a layer of the Timeline, with its colour. The title 
of a column is the name of the corresponding layer.
* Each line of the XSheet panel is numbered. This numbering is the same as the one you can find 
on the top of the corresponding timeline (see below)  
* The image layers contain an unique image repeated through the time, so they are not subdivided 
in the XSheet panel.
* As the animation layers contain differents images, they are subdivided.
* The bookmark located here and there on your timeline are also visible and modifiable in the 
XSheet panel.
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The thumb button allows to swap between the classical XSheet 
display and the thumbnails display. (see next page on the right)
You can also use the sliders or the arrow keys of your keyboard to 

navigate through the XSheet panel.
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The project tab above allows to manage the opened project. It is discussed in lesson 5.

A few simple options of the XSheet panel

 
_  _  _  _  _  _  _  _  _  _  _  _  _

    
         Timeline tab  

   
                           XSheet tab

Before enabling the lightable for the layer of your choice, 

Don’t forget to enable the global lightable by clicking on the button : 
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A lot of option regarding the layers are 
both available in the Timeline tab and the 
XSheet tab.
A right click with your mouse button on a 
layer inside the XSheet panel opens a 
contextual menu comparable to the one 
encountered via the timeline.

You will find in this menu some options 
already encountered in the lessons 3 
and 4:
* Insert, Duplicate, Delete, Rename, 
Copy, Paste…one or more images.
* Set Post or Pre behavior.
* Set Opacity,
etc ...

* The (green or red) coloured square, once you click on it, allows to 
display or hide the corresponding layer.
* The small lock button allows to manage the locking of a layer. 
* The (LT) button manage the activation of the light table. 
* The black triangles allows to reduce or increase the size of the 
columns in the Xheet panel.
* The current layer is lighter than the other layers.

Opposite and below :
- The « background » layer is hidden
- The « Toonshading » layer is locked
- The Lightable of the « Colors » layer is activated
- The « Shadow » layer is reduced
- The « Running-Kid » layer is the current layer

In the XSheet tab opposite :
* The letter « A » indicates that the column represents 
an animation layer.
* The letter « I » indicates that the column represents 
an image layer.
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At the ends of the column, it is still possible to set the pre and post behaviour of your layers. (see 
below)
In the example below, a few pictures from the thrid layer are selected. They are enlighted in yellow 
in the Timeline and also in the XSheet tab.

 < > 
Timeline tab                                                                         XSheet tab

After selecting several layers, the option Align left and the option Align right allows to 
align your layers on either side of the current image in each tab (Timeline or XSheet)

How to create a XSheet layer

Let's now open a new project and come back to the Timeline tab :
You already know how to create an Image or an Amination layer. Creating an XSheet layer can be 
done using the same way, using the New popup menu of your Timeline or using the Layer  main 
menu.

     

     
At this state, the Rename, Duplicate, Delete, Copy, Hide and other classic options of the software 
are still available. But you certainly noticed that you can't shrink or stretch this new layer. There are 
no thumbnail icons too.

      

The  +  and  –  buttons of the XSheet tab can also be used to 
create or delete a XSheet layer.

The letter « X » indicates that the column represents an XSheet 
layer.
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Managing the content of an image of the XSheet layer or managing the position in time of its 
images have to be done in the XSheet panel.

Once your XSheet layer is created, you have to specify in the XSheet tab one or more sources. 
Otherwise, it will be not possible to use it, because you can’t draw on a  XSheet layer. The images 
of the choosen sources will constitute the elements of the XSheet layer.

How to create and manage the sources

The source management can be done in the right part of the XSheet panel.
In order to add a source column, you have to use the “+ src” button encircled below.
The “- src” button allows to remove a source column from the right part of the XSheet tab.

       

The choice of a source for your column can 
be easily done thanks to the popup menu 
located at the bottom right of the XSheet 
table.

Your source can be :
* an animation layer in the current project
* another opened project

It’s also possible to change the names of 
your source layers, for a better readability. 
You only have to use the popup menu name 
opposite.

   

If more than one project or layer is open, a new menu will allow you to 
choose which one you want as source. (see opposite)
Image layers are not available as source.

The width of both sides of the XSheet tab can be adjusted by dragging the middle 
separator. The thumbnails options and the position of the separator are also saved 
with your project.

Do not confuse the source columns on the right part of the XSheet tab and the 
layers columns on the left part of the XSheet tab. The source columns are used to 
manage the content of the XSheet layers and are not visible in the timeline whereas 

the layers columns are also visible in the timeline. (see below)
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A concrete example

If you have followed this lesson from the beginning, you should have two projects on the TVPaint 
Animation Pro screen. The project Running-Kid.tvp and a new project called Untilted-01 containing 
an XSheet layer.
You can take a look at the Project tab to check it.
The project Untitled-01 has an XSheet layer. (see below)

    
In the project called Untilted-01 we added the project Running-Kid.tvp as source, as shown below. 
Now we only have to add some images from our source into the XSheet layer.

Here again, the thumb button allows to swap between the XSheet display and the 
thumbnails display.

If you selected a project as source, its layers are considered as if they were 
merged.

How to manage the content of a XSheet layer

We are now going to modify the content of our XSheet layer.
*Before beginning, you must know that it is possible to stretch a XSheet layer by doing a drag'n 
drop at one of its extremities. So you can obtain several cells, as shown next page.
*After this operation, you have to enter in the cells the references from a source image.
To do so, you have to use the following syntax : Source Column : Source Line
(The cells containing the character « -  » doesn't have any reference.)
* The cells manually filled have their reference image written in black.
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* By default, all the cells following a manually filled cell are written in pink color and have the same 
reference image. Those images are also called keyframes.
* Once finished, each cell from the XSheet layer correspond to an image choosen into the Source 
columns. (For a better readability, you can use the thumbnail view in order to replace each cells by 
its correponding image)

       

Opposite, here is how to stretch an XSheet 
layer. 

Opposite :
* The first three cells of the exposition layer are 
empty.
* The fourth cell of the XSheet layer is the 26th 

image from the source column called Kid.
* The four last cells have the same reference as 
the fourth cell.

 With thumbnails        Without thumbnails

          XSheet Layer with its cells                    Source images and columns

If you selected an opened project as source, the source project will be stretched to 
fit the XSheet layer.

In order to fill in the cells of an XSheet layer (in other words, to add images in a 
XSheet layer), you can also drag’n drop thumbnails and cells from the source 
columns into a XSheet layer.

Select several images in a XSheet layer.
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If you want to select several images in a XSheet layer, hold the [shift] 
key pressed and do a drag'n drop with the LMB on the cells or 
thumbnails of the XSheet layer.
Use the mouse button to cancel the selection.
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The icons of the XSheet tab

Each icons below has a specific action regarding the XSheet layer or the XSheet tab. We will now 
explain each of them separately in the next page.
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This button allows to copy the selected images / cells. It can be either source images or 
images / cells from a XSheet layer.

This button allows to cut the selected images / cells from a XSheet layer.

This button allows to shuffle the selected images of a XSheet layer.

This button allows to paste the cut or copied images / cells from a XSheet layer into 
existing images / cells. This action delete the selected images and insert the new ones.

This button creates a new XSheet Layer.

This button deletes the current XSheet Layer.

This button toggle the thumbnails / cells view.

For a better readability, the icon opposite allows to display / hide the columns of the image 
and animation layers in the XSheet panel.
This option is only working with the XSheet tab and does not interact with the timeline or 
the project display.

This button allows to add a source into the XSheet tab.

This button allows to delete a source from the XSheet tab.

This button allows to add one tween to each selected frames.

This button allows to delete one tween from each selected frames.

This button allows to add multiple tweens to each selected frames. A popup panel will 
appear to set the number of tweens to add.

This button allows to delete multiple tweens from each selected frame. A popup panel will 
appear to set the number of tweens to delete.

This button allows to invert the order of the selected frames.
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You can also use : 
the LMB and drag to « move » (cut and paste) a selected range of frame. 
Ctrl + LMB to « move » (copy and paste) a selected range of frame

Here is a small recapitulative diagram :

The options that allows to cut, copy, or paste the cells can be applied from an 
XSheet layer into itself or into another one. (however, it is not possible to cut 
source images)

Select a default source.

      

When you click on the name of your XSheet layer, a popup 
menu called default source appears at the bottom of the 
XSheet tab.
It is then possible to assign a source column by default to 
your XSheet layer : all the references of the cells will only 
need a number of picture in order to be taken into account.

This is very convenient to create new XSheet layers 
synchronised with the current one.
You only have to duplicate the current XSheet layer and 
change the default source of the duplicated XSheet layers.

About the projects

When a project needs some images to be repeated several times, it’s advised to use XSheet 
layers. It allows to decrease the size of the project when you save it on your harddrive, because 
each repeated image is saved only one time.

When you save a project in TVPaint Animation Pro, the related XSheet tab and 
layers are saved too. (Your project will still be available / usable with previous 
softwares from TVPaint. But, the XSheet and sound quotes layers will not be 

viewable nor usable.)
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The steps to create a lip-sync

In this section, we will learn how to synchronize the facial 
movements of a character (especially his mouth) with a 
preloaded audio track.

The main idea is of course to give the impression that the 
words come from our animated character and not from a 
recording that has been added over an animated sequence.

     
The files used in this chapter

The project Lipsync.tvp and the audio track voice.mp3 will be taken as a basis to study the lipsync 
steps. You can find them on the software CD rom. Those who downloaded the evaluation version 
of TVPaint Animation Pro can find those files in the “content sharing” section of our online forum. 
(http://www.tvpaint.com/forum)

Here is the timeline of the project Lipsync.tvp

  

Layer  “eyes”

Layer  “pupils”

Layer  “brows”

Layer  “face hair”

Layer  “hair color”

Layer  “mouth 4”

Layer  “mouth 3”

Layer  “mouth 2”

Layer  “mouth 1”

Layer  “jaw”

Layer  “face-color”
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We have choosen the following colors to have a better readability through the timeline:
-the layers relative to the mouth movements are in red.
-the layers relative to the jaw and face are in blue.
-the layers relative to the eyes movements are in purple.

If you play now this project, the result will not be really interesting. But we will quickly remedy this 
situation.

Calibrate the options relative to the audio track

Now that the project is loaded in TVPaint Animation Pro, let’s import the audio track called 
voice.mp3.

Once your audio track is loaded:
* Begin by setting the offset parameter with accuracy
* Lock your audio track in order to prevent unwanted changes
* Select “movement” or “always” as parameter for the audio jog, with a duration of 2 or 3 seconds. 
(see first chapter for more details)

The option called: ”Enter audio scrub duration” allows to specify the duration of the 
sound that you will hear after each movement throughout the timeline.
(This option is functional only if the “jog audio” parameter is not in “none” mode.)

At this state of the process, your movements throughout the timeline should be followed by one or 
several sounds.

Positioning syllables and phonemes

It is now advised to display the XSheet panel in order to continue our work. (Although all the next 
coming steps can be done directly in the timeline.)
When you move your cursor (ie: change the current image) through the timeline, try to find 
syllables and phonemes.
Then, add an annotation on the corresponding place. To do so, use the option Notes which 
appears in the audio track contextual menuor in the Images main menu.
You should obtain a XSheet panel like the one below :
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If the text that you want to 
synchronize with our character is 
long, try to add bookmarks to the 

images from which a syllable or phoneme 
starts. It will be easier to find again those 
images later.

You can already hide the animation 
layers. Those layers will not be 
visible when the project will be 

finished.
They are only here in order to be selected 
as source for the XSheet layers.
However, you can set hold as post-
behavior for the Image layers. (they will 
stay visible until the end of the lip sync 
process)
You should obtain the image below :

   

Create some source columns

As explained on page 8, you have now to set your sources images and columns in the right part of 
the XSheet tab. Here below, the source columns are created from the existing animation layers of 
our project. (the column fcolor is linked to the layer face color)
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Create some XSheet layers

Now, let's create some XSheet layers.

For each sound of the audio track, the jaw and the face skin should move accordingly, as our 
character is talking. (see below)

  >  >  >    

The movement of the 
character's jaw

  >  >  >    

The movement of the 
face's skin

Two synchronised XSheet layers will be needed here to do the job. Only their default source 
column will be different. (fcolor and jaw)

Each sound of the audio track can be broken down into separated sequences :

  >  >  >   
opposite, the « O » sound

  >  >  >   
Here the « A » sound

  >  >  >   
The « I » sound

  >  >  >   
The « E » sound

Each time that the « O » « A » « I » or « E » sound will be encountered on the timeline, you will 
then have to reproduce the correponding configuration.
A XSheet layer derivated from the two last described XSheet layers will be used here. However, it 
will not have a default source, because it will use the four source columns (mouth1 mouth2 mouth3 
mouth4)

Finally, you will have to make the character blink periodically in another XSheet Layer.

  >    >    >    >  
The movement of the brows will depend on the context of the scene. It can express astonishement, 
neutrality, fatigue, etc ... It will also need an XSheet layer.
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Here is the result with the XSheet tab :

Let’s assume that our character comes from an animated TV serie. It will be 
possible to re-use the same images for the face, XSheet layers constructed with 
the method,…etc…

- - - - - - - - - - -

You can always transform an XSheet layer into an Animation layer with Instances 
by using theTransform into Animation Layer option (use the layer contextual menu 
in the Timeline).
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Lesson 9 

 Working with the FX stack

In this lesson you will:

● Use the FX-Stack.

● Discover the concept of the animation keys.

● Create our first 'real world' animation.



 Working with the FX stack

In lessons 2 to 8 we have, amongst other things, studied the TVPaint Animation Pro drawing tools 
and discovered the timeline and its functions. You are now able to produce « frame by frame » 
drawings.

TVPaint Animation Pro also offers you a wide range of effects. This has been specially designed 
for working on animated footage.

The effects categories comprise:
* Blur : to alter the existing pixels of the animation.
* Colors : to rework the colors of an animated footage.
* Distortion : to distort the images of a footage.
* Keying : to cut out a part of the current animation.
* Motion : to manage camera movement.
* Paint : to repeat a line on the screen.
* Rendering : to create lighting and particles effects.
* Stylize : to rework the pixels of an animated footage.

The effect stack or FX stack

Initial study of the FX stack

Load the project named « house » which you have created in lesson 4. Merge it and spread the 
layer over thirty images. The resulting layer will be named « house ». 

9-2 Working with the FX stack

These effects or composition 
tools are available in the Effects 
main menu (see opposite).

They are arranged according to 
categories. We will study them 
progressively in the subsequent 
lessons.

The popup Add FX menu contains all the effects indicated above: the menu 
is identical to the Effects main menu.

It is possible to set the parameters for your effects in a special 
window (for example : the power of a blur, the luminosity of the 
animated footage, the speed of a fade …), this is the FX stack.

You call up the FX stack by clicking on the FX icon in the tool  
bar or by selecting FX stack panel in the Windows main menu.



The effect stack or FX stack

We obtain the following timeline and screen:

    

   

Our effect stack is presently empty.
Select the effect Stylize > Mosaic  from the menu. The 
effect stack must looks like the one shown opposite.
Now modify the parameters Width and Height by setting 
the values to 20 and 30.

The result is immediately visible on the current image: the image is cut in blocks of 20 pixels in 
width and 30 pixels in height (the color of a block is equal to the average of the pixels making up 
the block in the original image).
The Smooth button enables blending between adjacent blocks, the image obtained is therefore 
closer to the original image.

            

                         Original image                                                      Image with preview of the effect 

That said, the right image above is, in fact, for the moment only the preview of our mosaic effect 
(disabling the Preview button allows you to return to the original image).

To validate your settings and apply them into the current layer, all you have to do is apply your 
effect : click on the Apply FX stack button at the bottom of the FX stack window. Your current layer 
will be modified according to your settings (if required, use the Undo option to undo the 
modification…). Don't forget that all images of the layer must be selected if required.

Working in real time

Almost all software packages on the market impose a preparation stage and then an effect 
calculation stage. Viewing the final result on the screen is only possible after completing these two 
stages. In the best case, you have a window for a low-res preview of your effect at your disposal.
TVPaint Animation Pro does not adhere to this model and employs a much more interactive 
method. You have the possibility to view the results of these effects in real time!
Once the Preview box is checked, it is possible to play your complete animation using the 
Play  button on the control panel. It will then be shown with all the modifications you have 
chosen in your stack.
In other words, any modification of the parameters within the effect stack is immediately visible on 
the screen, in full size and full resolution whether your project is a simple image or an animation.
Sliding along the timeline using the keys [←] and [→] also allows you to view progress frame by 
frame.
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The various viewing modes

For the moment we will stay with our Mosaic effect. 
There are several types of viewing: they are available in the 
popup menu at the bottom left of the FX stack window (see 
opposite).

You may view the effect on the entire image, its left half, its right half, the top or bottom… you may 
even modify the viewing area to your convenience by sliding the border line on the screen (to do 
this, left click on the line and slide it).

         
Here again, the Play  button is pressed to preview your effect in real time but only on a given 
region of the screen.

Some operations

* If you have applied the Stylize > Mosaic effect, click Undo to cancel the effect and return to the 
unmodified animation.
* Go into the Options popup menu of the FX stack and choose Delete all.
Your stack is empty again.
* Select the Colors > Fade effect from the available menu.
* Add a second layer behind the current layer and name it « 
Flowers ».
* Import the project « Flowers », merge it and spread it over 30 
images.
* Copy all the images of the layer obtained into the layer named 
« Flowers » in your project.
* Finally, go to the first image on the timeline, on the layer 
named « house » (see timeline below).
* Modify the value of the position parameter to 50% then apply 
the FX-Stack.

  

The « Flowers » Project
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The effect stack or FX stack

You obtain the following image:

  >     

You have certainly understood that this effect creates a fade between the image of the current 
layer and the image on the lower layers.

Indeed, but this effect is applied to the current image (the first) and not to all the images of the 
layer, … so let's remedy this.

Click on Undo to find the layer named « house » intact.
Now select all the images of the layer and apply the FX stack.
The effect now applies to the entire layer.
This is not yet perfect: the fade effect is locked at 50% of its progress for all images of the layer… it 
does not evolve in time.

To obtain a true fade effect on the screen, one has to apply the FX stack with a position value : 0% 
for the first image, 1% for the second, 2% for the third … and so on all the way to the last image…
(assuming that our animated footage has a total length of 100 images… If not, complicated 
adjustment calculations must be made!).
At first sight this seems like a long and complicated process. Fortunately, TVPaint Animation Pro 
offers tools which reduce this fastidious process to a few seconds: the Animation keys.

Working with animation keys

It is possible to set the parameters for our fade effect to 0% for the first image in our layer, then to 
100 % for the last.
In this way TVPaint Animation Pro takes charge of calculating the progress of the effect on the 
intermediate frames. 
This is what we refer to as working with Animation keys.
Once this concept is understood, you will no longer work frame by frame.

Proceed in this way for our current project:

* Go onto the first image of the « house » animation layer. Set the effect to 0% 
then click on the button shown opposite.

* A symbol        appears in the timeline (see 
opposite) under the first image.
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Working with animation keys

The name of the Fade effect is written to the left of the timeline.
* The Fade effect is now set to a value of  0% for the first frame of the timeline. At this stage, 
application of the FX stack has no animation effect. Indeed, the value of this key will be repeated 
for all frames after this one.
It is necessary to create a second key before applying the FX stack in order to obtain an animation 
effect.
* Go on the last image of the « house » animation layer, create a key using the  button 
of the FX stack.

You may now immediately set the effect to 100%. In this case it is not 
necessary to click on the button « C » as before and the key represented 
by the symbol  will be created automatically.

The timeline is modified as below: 

* Note that by sliding along the timeline using the [←] and [→] keys of the keyboard or pressing the 
Play  button allows you to view the progress of the chosen effect from the first to the last 
frame.

* Now select all frames of the layer and apply the FX stack. This time, application of the effect 
stack will modify progression of the fade effect in time (see following images).

        

TVPaint Animation Pro has calculated an effect with a progressing position parameter for the 
intermediate frames.

To sum up, an animation key is a sort of adjustable time parameter lock which sets the value 
chosen by the user to a precise point in the timeline.
However, the drawing tool parameters vary dynamically according to the user's direct action on the 
project and may therefore not be assimilated to animation keys.
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Working with animation keys

Manage the effect's progress

You have probably noticed the Progress  button under the name of each effect. This button is used 
to manage the speed at which the chosen effect will be carried out.

The Progress profile editor will then appear.

This being the case, the progress profile editor has a very specific function within the effect stack:
* The abscissa in the graph represents time,
* The ordinate in the graph represents the progress of the chosen effect.

Let's go back to the fade effect in the « house » layer:
* Use the Undo option to recover the layers intact.
* Choose the same keys as those indicated in the chapter above.
* Draw the spline above before applying the FX stack.
After playing the project you will note that the effect is first carried out slowly and then at top speed 
(see timeline below). This corresponds to our spline : it rises slowly first and then very fast.

In the same way, if we choose the spline shown below before applying the FX stack, the Fade 
effect will be fast at the beginning and slower at the end.

 

If the spline rises and then falls off again, progress of the effect will change accordingly:
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Click on the Progress button and then on the small black 
section appearing on the screen (see opposite)

The interface of this window is identical to the one presented 
for brush profile setting in lesson 2.

The File and Spline menus, the Flip X, Flip Y and Delete 
buttons are the same as the ones you have studied before.

Choosing a horizontal straight in the profile will stop progress in time of the 
effect.



Working with animation keys

Managing effects with several parameters

Now close the « house » project and load the « prehistoric » project.
* Merge the layers of this project.
* Stretch them over thirty frames.
* Delete the content of the FX stack.
* Choose the Blur > Center blur effect.
The following timeline appears :

    

To make it easier we have deliberately chosen to work with an animation 
layer always containing the same image. Everything that follows also 
applies to an animation layer.

You will see that there are three parameters which may be locked with an animation key:

* the position of the center,
* the power of the blur,
* the radius of the circle in which the blur is not applied.

The position of the circle in which the blur is not applied as well as its center are shown in the 
preview (see image above)

The parameters directly adjustable on the screen (handles, circles, spline) are referred to as HUD 
(HUD stands for Head Up Display).
The Hide HUD of the FX stack is used to hide the latter. 

Now let's take a look at the timeline: 
* As soon as an animation key is created, a left click on the Center Blur triangle in the Timeline 
below displays the name of the parameter which have been set with the animation key.
* To the right of the parameter names, corresponding key lines will be displayed as you create your 
keys.

It is possible to create animation keys for each parameter, for the image of your choice along the 
timeline.
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Some parameters may be adjusted directly on the screen by clicking and sliding 
the mouse on the color handles (shown opposite).
When the effect is applied, circle and handles will, of course, have disappeared.



Working with animation keys

A separate set of keys may be created for each parameter (Center of circle, Power, Radius). This 
means that the parameters may progress in time independently of each other. For example: the 
power of the centered blur may decrease slowly while its radius may increase rapidly, all at 
different times …

Thanks to several keys, the parameters can be adjusted in time. This is the case for the Center 
parameter in the timeline above : three animation keys are placed on the key line associated with 
the Center parameter.

Below, the effect produced using these three keys.

      

The first key line in the timeline has the name of the effect in the stack and 
displays all its keys.

The path

When position parameters progress in time, there must be a path taken by the parameter in 
question.
For example, three animation keys were created at the images 1, 6 and 30 for the Center 
parameter above.
The center of the Center blur effect consequently follows a path as time progresses.
In our example, the path is visible via the HUD and looks a bit like a red « V ».

It is possible to choose an interpolation mode between the key 
points which define your paths.

You may choose to connect the points in a linear, spline or smooth manner using the first menu of 
the effect (the Tools menu will be studied later in lesson 14).
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The path

                            
           Linear                                                     Spline                                                   Smooth

When using Spline, it is possible to use handles. The [Ctrl] key + mouse click on a 
handle are used to move only this handle.

Moving from key to key

The contextual menu for the keys

When using animation keys:
* The layer contextual menu offers the possibility to select the frames 
corresponding to the keyline.
* The Auto Fit menu is used to adjust the zoom of the timeline in order to view 
the keys.

Contract, stretch a key line

In the previous lessons we learned how to contract or stretch an animation layer. This is also 
possible for key lines (see below).

         Stretch
                                                         Contract

  

If required, it is possible to move a key 
from one place to another in the 
timeline (click and slide with the left 

mouse button).
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It is not always easy to place yourself on a key within the timeline, 
especially when the project contains many images. 
The «  triangle » buttons in the effect stack or in the current project 
window (see opposite) are used to move rapidly from one key to 
another without having to use the [←] and [→] keys or the mouse.
If they are in black, they indicates that there is an animation on the 
left or the right of the current position. Otherwise, there is no more 
animation key.

A right click in the timeline on a « keyline » (see opposite), calls up a 
contextual menu.
You may :
* create or delete keys (which requires confirmation),
* select one or all keys (they will then be displayed in yellow...),
* cut, copy, paste keys (a process already used for images and layers: 
see lesson 6).



The path

Use the selections

When you make a selection on the screen and then apply an FX stack, the latter is only applied to 
the selected area (whether you apply the stack to one or several images makes no difference).
This is very useful when you apply your effect to a precise area in your image or animation.

    

More details about the FX stack

A more complex effect: the Rendering > Lighting effect

 >>      
This effect is used to light up the image or sequence of your choice as if using an exterior light 
source  (light, projector…).

By default, nothing is present in the list. The Lights menu may be used to create one or several 
lighting effects among the following categories: Spot, Omni and Ambient.
As soon as a lighting effect is created, you may duplicate, delete or rename it. 

The Lights menu displays the name of the light whose parameters are shown in the stack. If you 
work with several lights you may go from one to the other by selecting their names in the Lights 
menu.
Here an overview of the different lighting types:

*  Ambient lighting lights up the scene globally in the color of 
your choice. Values under 100% will darken the image, values 
higher than 100% will brighten it. 

* Omni  lighting lights up a circular area of your choice similar to 
a projector located on an axis perpendicular to the image. The 
parameters to be set are color, lighting intensity, center and 
radius of the circular area, as well as altitude of the virtual 
projector.
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More details about the FX stack

          
                    Omni projector diagram                Omni HUD                          Omni lighting     

* Spot lighting lights up the image similar to a tilted projector. Two position parameters are 
available for this mode, which allow you to adjust the position of the light source as well as its 
direction.

         
                    Spot projector diagram                Spot HUD                            Spot lighting                              

Spot and Omni lighting have a profile editor which works similarly to that of the drawing tools  (see 
lesson 2 for more details).

               
                 Omni                                        Spot                                         Profile

With the Light popup menu it is possible to use 
several light sources (regardless of type), as well 
as to rename, duplicate or delete them.

This is how our cave may be lit up in various 
ways !
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For many of the parameters described above, the settings may be made 
directly on the screen (don't forget to display the HUD).



More details about the FX stack

This Lighting effect only applies to the opaque pixels of the current layer. To 
obtain the examples above it is therefore necessary to first merge the layers of 
our project.

Single effects, multiple effects

Up to now we have only used a single effect in our stack. 
TVPaint Animation Pro also offers the possibility to use a 
succession of effects.
For a better understanding of this notion, we will use the 
merged « prehistoric » project that we have used before.

Using the parameters below, place a Center blur effect in your FX stack.
You now have the following preview:

     

   

May be you noticed the options Multiple FX and Simple FX in the 
Effects main menu or in the Add FX popup menu of your stack.

If you select a new effect in the popup menu:
* When Multiple FX is checked, the chosen effect is added to the present effect.
* When Simple FX is checked, the chosen effect will replace the present effect.
Check Multiple FX in the menu and choose the Rendering > Lighting effect explained above: this 
effect will automatically position itself over the current effect.
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More details about the FX stack

Result of the FX stack above

Current effect, preview and collapsing of effects

* One of the effects in your multiple FX stack is always selected. This effect is referred to as 
« current effect » (the one which seems to appear « brighter » while the other effects are « gray »).
The keys visible in the timeline are always those of the current effect.

* When several effects are used, it is possible to collapse them using the   buttons top left.

* The boxes close to the arrows indicated above are used to enable or disable the effect they 
belong to. 
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Set the parameters for the two effects as shown 
opposite. 

To simplify our example, there is only one type of 
lighting used and our effect applies only to one 
frame (so no key is required …).
This said, everything that follows still applies if 
you use keys and animation layers.

Once the preview is enabled, you see the 
following result:
lighting is applied « above » the center blur of the 
previous page!

The advantage of our stack with two effects is that 
it is possible to modify any of the two effects at 
any time during the preview.

Modifications of this kind would indeed be very 
fastidious if you used a single effect at a time: 
application of the FX stack twice in a row for two 
different effects followed by the Undo option twice 
in a row, change the first effect, reapply the two 
effects one by one, undo option again, etc.

It is also possible to accumulate the number of effects of your choice 
or even several times the same effect if you need it!
Remember the Play    button to view the effect on the animation 
layers … 



More details about the FX stack

Opposite,

The Lighting effect is enabled and reduced.

The Center blur effect is disabled and visible.

The current effect is the Lighting effect.

If the FX stack above is applied to our initial frame, we obtain the 
image shown opposite:
Only the Lighting effect is taken into account. There is no Center 
Blur applied before it.

Swap two effects

The effects contained in the stack are executed 
from bottom to top during preview or application. 
There is a kind of chronological order for the 
effects …

The results may therefore vary if two effects are 
swapped:

* In the left image below, the FX stack applied is 
the one illustrated opposite.
The center blur is applied after lighting.

* In the right image below, the FX stack applied is 
the one illustrated on the previous page.
The center blur is applied before lighting.

              
Preview of the FX stack above                   Preview of the FX stack of the previous page
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More details about the FX stack

 It is also possible to swap the effects by clicking on and sliding its name. 
The process is identical to the one used to swap the layers in lesson 3.

Reset and rename effects 

  

Saving the settings of the FX stack

We have learned how to create and save our own graphic palettes, our settings of custom tools, 
our pre-defined gradients, etc. It is therefore only natural to proceed in the same way for our 
effects:

The Bin FX menu for each effect offers several options:
* The Add option allows you to store your effect for later use (you will first be asked to name this 
effect).
* The Export option saves the current effect to a storage support.
* The Import option recovers an effect from a storage support.
* The Delete option deletes an effect.

The effects added may only be re-used when re-opening the program if you 
save the configuration when quitting.

  Resetting the latter will delete all the effects of the user.

The Bin FX menu for the entire stack works in the same way, but may be used to add, import, 
export or delete an entire stack.

When you add an effect to a pre-defined effect stack, all keys and profiles 
relative to the progression of each effect you have created are also saved.

FX stack and TVPaint Animation Pro projects

We may be repeating ourselves, but it is important to remember that it is indispensable to Apply 
the FX stack so your effect is taken into consideration and affects the current layer (if not, all you 
do is preview it…).
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A left click on the right triangle above calls up a contextual menu which may 
be used to: 

Rename the current effect in the FX stack, Create or Delete an animation 
key, Reset the effect parameters to their initial values, Duplicate or Delete 
the effect from your FX stack.

The Options menu of the effect stack may be used to delete or reset the 
values of all your effects.



More details about the FX stack

Also note that, when you save a project, as well as saving the layers, their position and the 
associated parameters (Position, Duration, Pre-Post- Behavior, etc.) you also save the current 
effects stack.
This makes it possible to keep a complete and intact animation and the effect stack necessary for 
your finishing touches. Useful, isn't it?

When you work with several projects at the same time, note that each 
project has its own effect stack.

Introduction to the video effects

A lot of notions here need a good understanding of the multiple FX and FX-stack concepts.
So it is advised to read the last chapters before beginning with this one.
Please note that we will only mention here the function of the effects and their place in the FX-
stack.
The parameters and options of the effects will be described deeply from lesson 11 to lesson 17.

In this section, we will create a small opening sequence for a weather report .
Do to so, we have several video sequences at our disposal :
The first one with a forest, another one with a sunset and the last one with some clouds

 > >  > > 
* Begin by importing those sequences in your project. Resize them if it is necessary. (note that the 
sequences can be directly imported from your camera into the software by using the Video 
Grabber panel). Don’t forget to use a project with fields if your video sequences are fielded.

* Move them inside your timeline as shown below and import the music. A color has been added to 
the layers to make them more recognizable.

You should have three overlapped layers (look at red areas in the timeline above). This will help us 
to use the transition effects. Above, a transition effect has been applied on the first animation layer 
of the timeline. The zoom factor of the timeline has been increased to make it more visible.
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Introduction to the video effects

Here is the resulting transition :

> > > >
* To add a personal touch to our weather report, it is possible to use several effects : 
Below, the Blur > Radial Blur effect was used. Therefore, the animated sequence appear 
progressively on screen.

  >   > 
* You can easily make butterflies fly in front of the trees and make them follow the paths of your 
choice, as explained in the lesson 14 :
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We used the butterfly animated brush (supplied on the TVPaint 
Animation Pro CD-Rom)  with the Motion > Keyframer effect 
and a pre-recorded path for each butterfly.
Of course, our two butterflies can be added on a new layer : it 
will allow you to keep the «trees» animated layer unchanged.
By using a new layer, you will also be able to change the 
moment when the butterflies have to appear : you only have to 
move the whole layer through the time axis of the timeline.



Introduction to the video effects

* We will now work on the “Sunset” animation layer : It is possible to distort the pictures to stay 
close to the weather report thema. This can be done by using the Rendered > Waves studied in 
lesson 13. Below we imitated two water waves, as if two rocks were thrown into water.

  >   > 
* We have afterwards to manage the transition between the «Sunset» and the «Clouds» animation 
layers. Below, the Transition > Classic effect with the circle option has been used. Here is the 
timeline and the rendering :

> > > >

It is possible to modify the timeline scale thanks to the Z button of the timeline. (see 
lesson 4)
You can also use bookmarks to navigate easily through the timeline. (see lesson 4)

* Let's now add a raimbow in the cloudy sky :

            

To do so :
* Create a new layer (the clouds 
animation layer will remain intact)
* Draw a rectangle filled  with the 
spectrum gradient, as shown 
opposite.
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Introduction to the video effects

       

After this, you have to use a multiple FX-stack  with these 
effects : (in order, from the first to the last)
* Colors > Color Adjust : the red area should be on the 
outside of the arc and the violet area on the inside.
* Blur > Radial Blur : this effect will allow you to create the 
arc itself. The center of the radial blur must be located far 
from the colored rectangle (out of the viewable area, to be 
exact).
* Blur > Gaussian Blur  will merge the colors a little.
* Transition > Fade  will make the rainbow fade in as time 
progresses.

Here is the result :

  >    >  
* Now, you only have to add a title to this sequence, thanks to the Rendered > Simple-text effect.

        

We used here the effect Rendered > Simple-Text (you can fill in 
the text, adjust the font, the border, the shadow, their colors or 
gradients ...)

This effect is very convenient because it allows to keep all the 
colors, border, font and shadow settings and to re-use them 
with another text line ...  (for exemple if you need to do a 
translation )

* For the final touch, we need the Rendered > Lens-flare effect :

        
        Lens-Flare effect on the check background                    Here on a new animation layer     
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Introduction to the video effects

Here is the resulting timeline with the text, the rainbow and the Lens-Flare on separate animation 
layers.

And the animation itself : 

> > > >
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Lesson 10

The effects of the Blur and Transition group

In this lesson you will:

● Discover the various Blur effects at your disposal.

● Discover the various Transition effects at your disposal.

● Learn how to increase the transition possibilities by using the FX-stack.



The Blur group effects

The   Blur   group effects  

The blurs are often used to hide faces in recorded animations. Sometimes, they are also used to 
create artistic effects.
In order to study the effects of the Blur group, we will use the two pictures below : a photo and a 
drawing.
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Independent of which blur effect you will choose, don't forget it will be controlled by 
the animation key system.
A recorded video sequence can also become gradualy blurred in time.



The Blur group effects

Some details regarding the Blur effects of TVPaint Animation Pro :

The Blur > Cubic Blur effect
This is the most standard blur: the more you increase its size, the less the sharp and angular areas 
of the source image will be visible. It may also be applied only to the transparency channel of the 
image (alpha channel).

    

The Blur > Gaussian Blur effect
An image with a Gaussian Blur may be compared to an image seen through a camera that is not 
set correctly. 
The Gaussian Blur is more precise than the Cubic Blur.

    

The Blur > Chroma Blur effect
The Chroma Blur takes only the tint and saturation pixel informations into account. The dark and 
light areas of the picture are not affected by the Chroma Blur. Only the chromatic component of the 
picture is affected by the blur.
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The Blur group effects

The Blur > Center Blur effect
We studied the Center Blur in detail in lesson 9 about the FX-stack concept . The parameters are 
the position of the center, the power of the blur and the radius of the circle.

    

The Blur > Radial Blur effect
This blur is applied in a circular manner around a point  the position of which you have chosen on 
the screen.The second parameter to be set is the power of the blur.

    

The Blur > Directional Blur effect
This blur is applied only in the direction (angle) of your choice and the spread of your choice. You 
may set the vector parameter directly on the screen.
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The Blur group effects

The Blur > Median Blur effect

When using the Median Blur, the color of the pixels obtained after application of the blur depends 
on the colors of the adjacent pixels in the initial image.
The Median Blur comprises all kinds of modes, the effects of which you may admire below :

Median Blur in Smooth mode effect

    

Median Blur in Light halo mode effect

    

Median Blur in Dark halo mode effect
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The Blur group effects

Median Blur in Light mark mode effect

    

Median Blur in Dark mark mode effect

    

Median Blur in Double edge mode effect
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The Blur group effects

Median Blur in Impressionist mode effect

     

The   Transition   group effects  

All transition effects in TVPaint Animation Pro have a position parameter which requires the use of 
the animation key system (as described in lesson 9).
As well, we chose to make this parameter vary between 0% and 100% for each transition effect in 
order to show you their specifications. A setting of 0% will leave the picture intact and a setting of 
100% clears the picture (100% transparent). 
In order to study the effects of the Transition group, we will use the picture below.

Be careful that the transitions are made between the frames and a full transparent 
image.
Transitions are not transformations between two pictures.

   

The Transition > Block effect

In this effect, you can adjust the number of rows and columns which will create blocks. To set the 
number of blocks, you just have to increase these two values. You can also select the way 
these blocks will appear or disappear on screen : random or in a direction you want.

  >  >  >  >  > 
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The Transition group effects

The Transition > Blind effect

This transition hides progressively a part of the current image. The numeric field value represent 
the number of division on the screen.
There are three types giving different results : crop, slide and stretch.

  >  >  >  >  > 

  >  >  >  >  > 

  >  >  >  >  > 

The Transition > Classic effect

Classic transitions makes the current image appear or disappear by moving a frontier. This one 
can have different shapes (circle, line, rectangle), as well as the color you want or even be faded. 
In case of circles and rectangles, you can adjust the position of the center of the shape.
The linear and tools menu will be explained in the lesson introducing the Motion group effects.

  >  >  >  >  > 

  >  >  >  >  > 

  >  >  >  >  > 

The Transition > Fade effect

The Fade transition is the most common transition ever used and does not need any other settings 
than Position. It was also introduced in lesson 9.

  >  >  >  >  > 
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The Transition group effects

The Transition > Slide effect

The Slide transition moves your video in a predefined direction you have to select. You just have to 
select the direction in the Direction menu.

  >  >  >  >  > 

  >  >  >  >  > 

The Transition > Rotary effect

This transition clears the image following the movement of a clock's hands. The checkbox allows 
you to select the direction of movement and the menu is used to select the center on which the 
effect will be applied.

  >  >  >  >  > 

The Transition > Page Turn effect

This transiton effect acts as if a paper sheet was removed from the screen.
You can choose to turn the page from the window border you want thanks to the Direction menu.

  >  >  >  >  > 
There are three modes : image, color and gradient as shown below :

       

Increasing the transition possibilities by using the FX-stack
You can easily create new transitions possibilities by using multiple effects in a same FX-stack.

For example, using the Classic Transition effect with the Rotary Transition effect in the same stack 
can give this result :

  >  >  >  >  > 
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Increasing the transition possibilities by using the FX-stack

Below, the Classic Transition, the Blind Transition and the Gaussian Blur effects were used in the 
same stack :

  >  >  >  >  > 

       

Of course, we can't show you here all the possible 
combinaisons because they are too much ...

But we guess you will certainly try some of them.
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Lesson 11 

 The effects of the Color and Keying groups

In this lesson you will learn to:

● Touch up the colors of a video sequence or an animation.

● Handle the effects of the Keying group.

Unless indicated otherwise, all images in this lesson have only one layer.



Color channels

Color channels

Based on the additive color principle, all colors are a mixture of red, green and blue (more or less 
dark) in exact proportions. 

TVPaint Animation Pro enables the independent modification of each of the components described 
above, for all pixels on the screen. 

  

Click on the icon shown opposite in the Tool bar to modify only the red 
component of the pixels :

The blue and green pixels are not affected by your work.
The yellow and purple pixels, which are partly composed of red, are partially affected.
This is what we refer to as Enabling the Red channel of the image.

You may proceed in the same way to enable the Green and Blue channels.
The left icon is the toggle to enable the Alpha channel. When it is enabled all pixels are locked in 
their current opacity, while the other channels can still be changed for these pixels, this makes it an 
ideal tool for recoloring the lines of a drawing.

The effects in the   Color   menu  

 

The Color > Black & White converter effect

The Black & White Converter effect has three parameters that may be locked using an animation 
key. By default, it transforms the images by deleting the color data. We therefore obtain the same 
effect as photos taken with a black and white film.
Increasing the value of the Red parameter will make the red pixels of the original image lighter 
when changing over to gray. Reducing the value will make them darker (see next page).
The same principle applies to the Green and Blue parameters.
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The color of a pixel therefore has a darker or lighter Red component, a 
darker or lighter Green component, a darker or lighter Blue component 
and a last component which indicates the pixel transparency level.

This last component is referred to as Alpha component.

Let's take a look at the image 
opposite: the various colors were 
spread and mixed on a wooden 
palette.

All colors of the chromatic circle are 
present on this palette (red, orange, 
yellow, green, blue, purple).

This image will allow us to study all the 
color modifications available in 
TVPaint Animation Pro.

To do this, load the project « palette ».
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    Default settings                                    Parameter Red at value 0                    Parameter Red at value 255

Below, a zoom on the red area of the image :

                     
      Default settings                   Parameter Red (value 0)       Original image                      Parameter Red (value 255)

The Color > Color Adjust effect

We'll keep the image from the beginning of this chapter and 
study the Color Adjust effect shown opposite in detail.

This effect uses the traditional notions of color modification 
for drawing and photo touch-up software packages:

* The Brightness parameter is used to increase or decrease the global brightness of the current 
image or video (use negative values to decrease lighting).
In other words, all the pixels present are either changed over to the black color or the white color.

      
  Brightness + 75%                            Original image                                Brightness - 75%
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* The Contrast parameter, if increased, will accentuate the luminosity differences between the light 
and dark areas. When decreased, it will reduce them.
A setting close to 100% will only make the primary colors appear, as well as black and white. A 
setting close to −100% will make the image or footage almost entirely gray.

      
    Contrast + 75%                                     Original image                                     Contrast – 75%

* The Saturation  parameter accentuates or reduces color vivacity. A setting close to 100% will 
reduce the number of pixels close to the gray colors while reviving the colors, a setting close to 
−100% will produce a gray drawing.

      
    Saturation + 75%                                 Original image                                      Saturation – 75%

* The Gamma setting is often used for photo touch-up but also enables lightening or darkening an 
image without leaving the impression that a dark or light sheen was placed over it. Its value may 
vary between 0.01 and 5.

         
  Gamma = 2                                             Original image (Gamma =1)                 Gamma = 0.5 

At first sight, the Gamma  parameter seems to have the same effects as the 
Brightness parameter. This is true, with the difference that the Brightness 
parameter affects all pixels on the screen whereas the Gamma parameter affects 

the light and dark pixels only marginally.
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Below you will find an example of the difference between a gamma reduction and a reduction of 
the brightness : 
Reducing the Gamma by half only slightly affects the pixels making up the paint and the 
background: the latter remain bright and clear. 
Modifying the Luminosity to −50% gives the same pixels a darker hue.

        
  Original image (Gamma =1)           Gamma = 0.5                                    Luminosity - 50%

* The Angle parameter enables rotation of colors at the angle of your choice around the color 
wheel (see below).
For example: going from angle 0° to the angle 90° will transform the orange colors in the image to 
green, blue to purple,…etc.

        
     Original image                                  Rotation of colors of 90°                The color wheel

* The Rotation parameter reflects the number of turns around the color wheel before arriving at the 
chosen angle. This allows you to make the colors vary in a time cycle, which is sometimes useful 
for colored logos.

In the example below, we start with a blue TVPaint logo (R=0, G=0, B=255), placed on each image 
of an animation layer comprising forty-eight.

An animation key is placed at the first image of the layer, locking the value « 0 » for the Rotation 
parameter. A second key is placed at the last image of the layer, locking the value « 2 » for the 
Rotation parameter.

When the FX stack is applied, you see the following result:

The logo changes color in cycles, going twice in a row through the colors of the color wheel.
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The Color > Color eraser effect

Let's assume that we want to delete the green and blue colors in our image. This is easily done 
using the Color eraser effect.

By erasing the color we understand erasing the data relative to the color 
composing the pixels and not modifying the opacity of the pixels. In other 
words, we unsaturate the pixels with a precise hue.

         
                                                                 Original image                                         Image with green and blue 

 hues erased                     

Start by selecting a color in the green area of the image in the Color box of the panel above. Part 
of the green pixels will then be unsaturated and turn to gray. To obtain a better finish, you may 
increase or decrease the tolerance or softness thresholds.

To select the pixels according to their hues, the color bar of the panel as well as the 4 mini-sliders 
will help you.

  non-unsaturated hues,

  progressively unsaturated hues,

  completely unsaturated hues,

The Invert button is used to invert the final result: saturated pixels become 
unsaturated and vice-versa. If necessary, the popup menu Display enables recovery 
of source image viewing.

The Color > Color Replacer effect

    

The Color Replacer effect is based on the same 
principle as the effect Color Eraser, with the difference 
that you do not unsaturate the colors.
Indeed, using Shifting values enables progressive 
modification of the hue, saturation and luminosity of the 
chosen color range. You may thus easily toggle one 
color range to another.
The Shifting values are calculated as being « gap » in 
the H.S.L system between the two colors of the panel 
(blue and yellow in this example).
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                              Original image                                  Yellow colors changed to blue

The Color > Curves effect

Each pixel on the screen is defined by its components: 
* The so-called R.G.B.A generates the color of a pixel with four components: red, green, blue and 
alpha. In this system, the values of the four components vary between 0 and 255.
* The H.S.L.O system generates the color of a pixel using four other components: hue, saturation, 
luminosity, opacity. In this system, the values of saturation and luminosity may vary between 0 and 
255, the hue may have a value between 0 and 359 (thus the previously used concepts of angle 
and color wheel).
Inversely, any pixel on the screen may be broken down in each of the two coordinate systems. 
Modifying the color of a pixel therefore means you modify the values of its components.

The Curves effect enables precise management of these 
modifications: the Mode popup menu offers a choice between the 
two systems described above.

Let's go, for example, into the H.S.L.O system and take a look at our 
image. Next to the name of each component we find a miniature 
profile, comparable to those we encountered when studying the 
drawing tools and acceleration of an effect.
Click on the luminosity miniature profile to call up the edit profile 
window.

The options proposed are traditional: flip the curve along the « X » 
or « Y » axes, use pre-defined curves, save the settings, modify 
interpolation of the points… 

Now we just have to study the meaning of the curve:
* The horizontal axis represents all luminosity values that may be contained in a pixel on the 
screen (values between 0 and 255)
* The vertical axis (also known as LUT: Look Up Table) represents all luminosity values of the 
pixels once the Curve effect has been applied.
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Let's take the curves below as examples:

We have just studied the luminosity curve in detail. Now it's up to you to work with the other curves 
and use them to the advantage of your projects. 

The Color > Histogram effect

We have just seen that it is possible to work on pixels using curves. 
TVPaint Animation Pro also offers the possibility to work on the colors on a more «statistic level» 
thanks to the  Histogram effect. 

The first function of the histogram is to provide information about the distribution of colors on the 
screen.
Let's take for example the images below and select the Master tab in the first row of tabs and 
Luminosity in the second. We will obtain the following graphs :

 >        > 

The Log box enables use of a logarithmic scale instead of a proportional scale. For the moment, 
pay attention that this box is not checked …

* The more dark pixels the image on the screen contains, the more dense the graph is to the left 
(this is the case for our red planet).
* The more light pixels the image on the screen contains, the more the graph is concentrated on 
the right (this is the case for the image of the tree).

For a luminosity value given in the abscissa, the graph proportionally represents the quantity of 
pixels of the image having this luminosity value on the ordinates axis.

The blue curve represents the percentage of pixels having at least attained the luminosity value in 
the abscissa, the vertical red line represents the pixels the luminosity of which is the most 
represented on the screen.

The second function of the histogram, as you may have guessed already, is to modify the color 
properties of the image or video of the current layer (here again, the animation keys lock the 
parameters for a given position in the timeline).
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* In this example: the luminosity of every pixel is divided by two after 
application of the effect (for example, a luminosity value of  50 changes to 25 
after application of the effect).

* In this example, the luminosity of every pixel remains unchanged.

* In this last example, any pixel with a luminosity value between approximately 
64 and 192 will turn black, the others remain unchanged.

The tabs Red, Green, Blue and Alpha work according to the same principle 
and  image analysis is reduced to the channels of the corresponding colors.
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To do this, we have to use the slider system of the histogram. You may use two, three or four of 
them. The latter enable re-calibration of the histogram by stretching or contracting it.
Let's again take a look at the pixel luminosity component. Below, you see the example of 
luminosity modification using the three sliders:

      
    Before application of the FX stack      Settings                                               After application of the FX stack 

The section of the histogram between the abscissas 25 and 128 will be contracted to fit between 
the abscissas 0 and 51. The section of the histogram between 129 and 255 will be stretched to fit 
between abscissas 52 and 255.
This means that the dark components of the pixels in the image will be reinforced and contracted 
whereas the light components of the pixels in the image will be redistributed, spread and therefore 
reduced.

The first row of tabs contains four tabs: Master, Shadows, MidTones and HighLights.
* Clicking the Shadows tab limits the impact of the slider modifications to the dark colors, gradually. 
* Clicking the MidTones tab limits the impact of the modifications to the medium tones and will 
reduce them progressively and finally cancel them out for the dark and light colors.
* Clicking the HighLights tab limits the effects of the histogram modifications to light tones, the 
latter waning progressively then cancelling out for the medium and dark tones.
* The Master tab affects all color ranges in the same way.

Look at the following graphs for a better understanding:

= + +
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The tabs Red, Green, Blue and Alpha make the other graphs relative to the 
current image appear. Each of them may be modified independently of the 
others.

The principle of contracting and stretching is the same, regardless of how 
many sliders are used. Only the number of contracted or stretched intervals 
changes..
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Three curves are represented:

* The black curve represents the impact of the modifications in the histogram on the dark tones 
(Shadows tab)
* The gray curve represents the impact of the modifications on the medium tones (MidTones tab)
* The white curve represents the impact of the modifications on the light tones (HighLights tab)

The tones concerned are located on the abscissa.
The impact power is represented on the ordinates axis (the higher the curve for a given range, the 
higher the influence of the histogram modification on this range).

The Color > Sliders effect

In addition to the effects affecting the color on a 
« geometric » and « statistic » level, there is a last color 
correction effect which is more complete and is applied 
using sliders (as the name implies …).

* It also has four tabs: Master, Shadows, MidTones and 
HighLights  which have the same task as those in the 
Histogram tool: used to choose whether you wish to 
work on lighter or darker color ranges.

* The following four tabs: Gamma, Contrast, Gain, 
Brightness control how the LUT curves will be modified 
when a slider is moved.
* The seven lines correspond to seven LUT curves (see 
above) which may be modified: Temperature, Magenta, 
Luminosity, Red, Green, Blue and Alpha. 

When the Gamma tab is selected, moving the slider to the right increases the height of the L.U.T 
curve (and therefore increases the values of Temperature, Magenta, Red, Green, ...) for the range 
selected (Shadows, MidTones, HighLights). The ends of the curve are less affected by the slider 
modifications (the modifications take place progressively).

When the Contrast tab is selected, moving the slider to the right increases the height of the L.U.T 
curve in its high sections and decreases the curve in its low sections for the chosen range. This 
means that the strong values of (Temperature, Magenta, Red,…) will be reinforced and the weak 
values reduced for the range of your choice (moving the slider to the left produces the opposite 
effect).

The Gain tab functions in roughly the same way as the Contrast tab, but the ends of the curve are 
gradually less affected by the slider modifications (the modifications of the values of Temperature, 
Magenta, Red,… are the same as with the tab Contrast but work in a more subtle and progressive 
manner).

The effects of the Brightness tab are similar to the Gamma tab but the modifications are not 
applied in a progressive fashion due to the identical attribution from one end of the curve to the 
other.
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The circled sliders in the graph opposite are used to move, contract 
or stretch the three curves and, consequently, modify the effect of 
the tabs.
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The Color > Scan Cleaner effect

This effect is used to clean up a scanned image drawn by hand. 
Let's take a look at the sketch below to the left. This effect will not only make the light pixels of the 
image transparent and color the remaining pixels black (1)
but will also remove unwanted pencil marks (2)

      >>    (1)

          >>   (2)
The diagram below illustrates the role of the profile curve present in this effect :

The Colors > Image Source effect

It is necessary to know a few effects of the Stylize group (like Drop Shadow, Add 
Border or Lumix, ...) in order to master the Image Source effect perfectly. So it will 
be studied at the end of lesson 12.
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The effects of the   Keying   menu  

The Keying menu contains all effects which are used to make a color on the screen transparent. 
These effects are sometimes called cut-out and incrustation effects.

The Keying > Luma Keyer effect

The Luma Keyer effect is used to render pixels transparent according to their luminosity.
When you have scanned an image on a white background you obtain a completely opaque layer. 
With the Luma Keyer  effect is is therefore possible to make the white pixels of this image 
transparent:

  >        

Let's take a look at the drawing on real paper above. Application of the Luma Keyer effect set with 
correct parameters will render the light pixels transparent (independent of their hue and saturation), 
progressively increase the opacity of the medium tone pixels and leave the dark pixels intact. This 
gives us the image shown to the right.

These are the functions of the Keying > Luma Keyer effect:
* The Display popup menu is used to choose between viewing the source image and viewing the 
result.
* The color box is used to choose the color the luminosity of which you wish to render transparent 
directly on the screen.
* The buttons + and –  are used to adjust the tolerance and softness of pixel cut-out.
* The mini-sliders allow adjustment of the following, depending on the luminosity and with the help 
of the diagram below:

It is recommended to combine the Luma Keyer effect in a multiple FX stack 
with the Colors > Histogram or the Colors > Slider effects to be able to 
precisely adjust pixel transparency (use the parameters relative to the alpha 

component) and remove the gray aspect (light) of semi-transparent pixels.
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At this point, it is possible to re-color the image, if desired : 
simply place a layer under the image obtained and spread the 
colors of your choice on it (see example opposite).

You may also use the shape floodfill tools studied in lesson 6.

The type of pixels which remain opaque

Those which are progressively made transparent

Those which will be completely transparent
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The effects Keying > Luma Keyer and Colors > Scan Cleaner change the opacity 
of the pixels differently : the Luma Keyer doesn't remove the unwanted pencil 
marks. The Scan Cleaner change the color of the pixels, and the Luma Keyer 
doesn't.

The Keying > Color Keyer effect

    

The Color Keyer effect uses the same principle as the Luma 
Keyer effect. It deletes the selected color on the image or 
video footage of your choice.
It is no longer required to concentrate on pixel luminosity but 
on the entire color.

Two types of parameters may be locked with a key: Tolerance and Smooth.
In the FX stack above we see: the higher the value of the Tolerance parameter, the more colors 
close to « blue » will be deleted.
The higher the value of the Smooth parameter, the less abrupt the transition between opaque and 
transparent pixels will be.

       

Opposite, most of the bluish colors of the sky 
and cloud become transparent.

The green and dark colors of the tree are 
further away from blue and therefore opaque.

These two keying effects may, of course, by applied to a complete footage, 
which makes work easier when using a scanner with loader or a recorded video 
sequence.

Let's take another concrete situation :

        

The character nearby was shot on front of a blue screen. We are going to explain how to remove 
this blue background and to replace it by another background.
It's a technique often used for animation : weather reports are shot with a single-colored 
background which is removed and replaced by a weather chart.
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Let's go back to our character : the purpose is to make transparent all the blue pixels and to 
display a new background on another layer. To do so, let's load a landscape background nearby 
and put it as an Animation layer, under the layer containing the character.

       The blue color is called key color (that's why the effect is called keying).

You should have a timeline looking like this :

    

  

The same method is also used to create a weather report (see below)

              

          

There are other keying effects, more complex, which have to be used in some specific situations.
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Now select the Color Keyer effect in the FX Stack.
Choose a blue pixel from the background and adjust the 
tolerance and softness parameters.

Apply the effect to the whole image sequence, and here it 
goes, the blue background has disappeared and is replaced 
by the landscape.
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The Keying > Chroma Keyer effect

The Keying > Chroma Keyer effect is used to make pixel transparent depending on their tint and 
saturation.

         

The panel and the buttons of this effect look very similar to the ones of the effect 
Color > Color Eraser. That's why we will not explain each parameters in details...

Let's take for example the video sequence above with orange and red flowers. The background of 
this sequence is a blue-gray shutter (more or less dark blue-gray tints).

If you use the Keying > Color Keyer effect by selecting one of the dark shutter colors, it will not 
remove all the shutter pixels but it will remove some pixels of the flower's stalk too. (see below (1))

If you use the Keying > Color Keyer effect by selecting one of the light shutter colors, it will remove 
all the pixels of the shutter but it will remove the light pixels of the flower's too. (see below (2))

    (1)        (2)

The results above, obtained after the use of the Keying > Color Keyer effect, are imperfect.

The Keying > Chroma Keyer effect will help us to obtain better results.

   

* The Tint parameter bar will make transparent the blue pixels in a wide range : light blue or dark 
blue will not change change the result. The orange-red pixels of the flowers and the green pixels of 
the stalk will stay unchanged.
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* The Saturation parameter bar permits to make green pixels more or less transparent depending 
on their saturation. As a consequence, we will be able to make transparent all  the blue-gray pixels.

Here is the result : we finally succeed to keep the the pixels of the flowers visible and made the 
pixels of the shutter transparent.

    >>  
To finish our work, we can easily add a landscape on a layer and put it behind the flowers layer. 
(see the timeline below)

      >> 

Let's go back to our blue-screened character :

Although we used the Keying > Color Keyer effect with the our blue-screened character in the last 
chapter, you certainly guess that it is also possible to use the Keying > Chroma Keyer effect.

When characters are shot with blue screen, there are sometimes some undesired light effects, 
especially little blue reflections colorizing some part of the image (see image below on the left).

It is of course possible to remove the blue tint to these pixels by making them grey. That's the 
function of sliders and buttons from the Spill Removal section of the panel.

    >>   

The Keying > Alpha Control effect

Let's take back the example of our flowers. The Keying > Chroma Keyer has been already applied 
and the landscape background is visible behind the flowers. If you look at it in detail, you will see 
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that some imperfections remain : a black borderline, more or less visible, is still remaining, small 
lines or points are not fully transparent and stand out from white clouds.
The Alpha Control effect can fix these errors.

     > 

The Shrink parameter can trim the opaque pixels of the image. That is the best to remove the black 
borders around the flowers.

The Erode parameter erase progressively the opaque pixels of the image by starting from its 
borders. It permits to soften the transition between transparent pixels and opaque ones, and even 
to improve the superimposition effect.

Both Blur parameters can reduce and soften the shapes borders between opaque pixels and 
transparent ones.

The Gain parameter permits to turn opaque and to darken pixels which are almost transparent. 
This is very useful to stand out the little imperfections, especially the ones that have not been fully 
removed when using some Keying effects.

On the opposite, the Lift parameter can turn opaque the pixels which are almost transparent.

      
    Use of the Erode parameter               Use of the Shrink parameter           Use of the Gain parameter set to 1000% 
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Here is how the effect appears in the FX Stack : 

* You can first notice the presence of a histogram, a 
tool you are now familiar with. This one represents 
the quantity of pixels displayed on screen depending 
on their luma (in percentage).

* In the bottom of the panel, there are some numeric 
fields and mini-sliders at your disposal :
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The Keying > Advanced Keyer effect

The Advanced Keyer is the most complex and the most powerful Keying tool in TVPaint Animation 
Pro. Experienced users often use it for very accurate keyings.

We have already seen that each color can be broken up in various ways depending on the color 
system (RGBA, HSLO, YUV) while each system defines color channels. (the YUV system is used 
by the NTSC and PAL video formats)

The Advanced Keyer effect permits to cut-out on each color channel which allows you to do very 
accurate keyings. (see below) 

        

* The Key tab lets you adjust the keyer in the different color systems.

* The Matte tab has the same function as the previously described Keying > Alpha Control effect 
so you can just adjust the cutout process better.

* Finally, the Spill Removal  tab is also available and works the same as the Keying > Chroma 
Keyer one.

        

Working with the Hue and Saturation component of the HSLO system is the same 
than working with the Keying > Chroma Keyer effect.
Working with the Luma component of the HSLO system is the same as working

with the Keying > Luma Keyer effect.
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The Keying > Cross Keyer effect

          
The Keying > Cross Keyer effect works in a different way than the other keying effects :
It doesn't require to select a range of colors in a color system like RGB, TSL, YUV, etc ...
In this effect, you only need to define a first region whose colors will be kept, and another region 
whose colors will become transparent.

Selecting those two regions can be easily done thanks to the two dedicated Region buttons :
* To select the colors you want to keep after applying the FX, just use the left mouse button on the 
Keep button. After this you will be able to select an area directly on the HUD. (your cursor will be 
changed into a lasso)
* To select the colors which will become transparent, you can use the same method with the Drop 
button.

When selecting a new area on the HUD :
* Use the left mouse button to add it to the previously selected area.
* Use the right mouse button to substract it from the previously selected area.

To visualize the render of this effect, use the right mouse button on the current activated button 
(Keep or Drop). Of course, the result depends on the two areas you have just selected.

In the example below :
On the left image : there are two areas located on the sky and on the pathway. They indicate the 
colors (red and cyan) that will be kept on the whole picture.
On the right image : there is one area located on the grass and on the trees. It indicates the colors 
(orange and green) that will be dropped.
The picture in the right shows the result after applying the effect :

      >  
    Keep region                                         Drop region                                              Final result

      

* The swap keep and drop regions button allows to swap the 
Keep and Drop regions.
It is then possible to obtain the opposite result.
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* The Mix parameter allows to extend or restrict the number of colors located in the transparent 
area of the resulting image.

        
     Mix = 0%                                                Mix  = 50%                                            Mix  = 100%

* The Edge parameter allows to adjust the mixing level between the transparent and opaque 
pixels.
The lower the value will be, the less the two regions will differentiate. The higher the value will be, 
the sharper the edges will appear.

        
      Edge = 0%                                            Edge = 50%                                         Edge = 100%

* The Spill Removal parameter has the same function as the Spill Removal parameters 
encountered in the effect Keying > Chroma Keyer : it unsaturates the undesired light reflections.
In the example below, we zoomed on the frontier between the grass and the pathway.

        
     Source Image                                       Spill Removal  = 0%                             Spill Removal = 100% 
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Lesson 12

The effects of the Stylize group

In this lesson, you will :

● Discover some effects of the Stylize group dedicated to the animation.

● Discover some effects of the Stylize group dedicated to the video-editing.



Introduction

Introduction

The effects of the Stylize menu are often used to work on logos, drawings or video footages. We 
will take the images below as reference images for our examples:

        

The Stylize > Glow effect
It is possible to create an aura around a text or any other image containing transparent pixels … 
The Width, Height, Color and Opacity of this aura may change in time thanks to the key system.

      

The Stylize > Grain effect

This effect adds a noise (polychromatic or monochromatic) to the image or video footage of your 
choice. The Size parameter is used to set the size of the grains, the Range parameter controls 
their distance. 
It is also possible to adjust their color using the parameters Red Variation, Green Variation and 
Blue Variation as well as modify their transparency.

If a logo is placed in front of a filmed sequence, application of a light noise on the logo helps 
integrate it into the sequence and minimize the « computer » look of the latter. The noise effect 
may also be used to smudge an image or drawing in a different way than a blur effect.

          
 Original image                Monochromatic noise            Polychromatic noise
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The running kid and the TVPaint logo are 
located over different background layers.



The Stylize > Grain effect

    
       Original image                                   Blue polychromatic noise                  Noise with larger grain size

The Stylize > Bevel effect

This effect is used to give volume to your logos or drawings.
The Mode popup menu is used to choose between creation of an inner or outer relief. You may 
also use both effects at the same time, which gives a relief effect to the contours of your image.
To give an image relief you must set the Size of the bevel as well as its Lighting using the following 
parameters: Force, Altitude, Direction, Color and Power. 
The Smooth parameter enables attenuation of rough contours by applying a slight blur.

    
Inner bevel                                               Outer bevel                                             Inner and Outer bevel

            
                  Inner bevel                                    Outer bevel                                  Inner and Outer Bevel   

The Stylize > Drop shadow effect

This effect is useful to add a shadow to a logo or any other image that is not entirely opaque. 
Color, Direction, Distance and Opacity are parameters that may be set using keys at your disposal. 
In this way you can make the shadow of your logo move as if a light source were moving above it.

          
various shadow distances and directions 

            
Traditional shadow and blurred shadow

(the background and the running kid are located on different layers)
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The Stylize > Drop shadow effect

The Shadow only option of the Toonshading and Drop Shadow effects will be 
studied later in the chapter called « the Color > Image Source effect » 

The Stylize > Toon Shading effect

This effect differs from the drop shadow as it enables creation of a shadow inside an image. The 
transparent pixels are not affected by the creation of your shadow (see below).

                 
                  Toon Shading                                                      Drop shadow

Let's take the shape filled with white below as an example to study this effect: 

              

     The panel of the toon-shading effect                     Our reference image                     The HUD of the effect

- The Color box is used to choose the color of the shadow you will create.
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The Stylize > Toon Shading effect

- The Intensity option is used to vary the power of the shadow in time:

          

- The Profile option is used to vary the nature of the shadow:

          

                          

- The Size in pixels sets the range of the shadow:

          

- The Angle parameter is used to choose the direction of you lighting/shadow. When using 
animation keys, the Rotation parameter reflects the number of complete rotations to be carried out 
before arriving at the chosen angle.

           

- The Spread parameter (in degrees) defines the angle over which the shadow will be spread (see 
next page).
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The Stylize > Toon Shading effect

          

- The Ray Count parameter refines the result when applying the effect. The higher this value, the 
higher the quality of your image, the lower the value, the more noise your shadow will contain.

          

- The Border box, if checked, is used to create a shadow from the borders of your project (see 
below).

                    
            Original image                            Border option not enabled          Border option enabled

Once you know how to use the Toon-shading effect, it is possible to create all kinds of shadows for 
your characters:

            

The Shadow only option of the Toonshading and Drop Shadow effects will be 
studied later in the chapter called « the Color > Image Source effect » 
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Using the HUD is very practical to adjust the angle, size and spread of your 
shadow.



The Stylize > Erode effect

The Stylize > Erode effect

This effect enables eroding the contours of an image or video footage.
This may create an interesting effect for the appearance or disappearance of images as well as for 
the attenuation of contours (see below…). There are two parameters that may be adjusted using 
keys : Width and Height.

            

The Stylize > Add Border effect

This effect is in a way the opposite of the Erode effect. It enables creation of a border of the 
thickness of your choice around an image. As TVPaint Animation Pro works with sub-pixel 
precision, it is possible to increment this thickness in steps of 0.5 pixel using the associated mini-
slider.
It is also possible to choose the color of the border.

  

Here again, the option Border only will be studied later in the chapter called « the 
Color > Image Source effect » 

The Stylize > Bloom effect

        
This effect produces a light blurred aura on the current image und may give an unreal aspect to an 
animated footage. Contrary to the Glow  effect this bloom is applied to the opaque areas of the 
image.
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The Stylize > Bloom effect

The parameters Width and Height are the same as those for the Glow effect.
If you wish, you may apply the bloom effect to the channel of your choice (Red, Green or Blue) and 
control Blur, Saturation and Luminosity of this aura.

The Stylize > Blender effect

        

This effect blends the original image in a certain way and then transforms it into a large puzzle, the 
pieces of which have distorted contours. The adjustable parameter enables random modification of 
the result.

The Stylize > Mosaic effect

              
This effect was already studied in lesson 9. It enlarges the pixels on the screen to the Width and 
Height of your choice.

The Stylize > Posterize effect

        

This effect is used to reduce the number of colors on the screen and simplifies the original image 
or video footage. The Number of colors parameter may be set using the mini-slider and locked with 
a key.

This Number of colors parameter does not represent the exact number of 
colors on the screen but the number of colors blended to obtain the effect 
required.
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The Stylize > Noise effect

The Stylize > Noise effect

        
This effect moves the pixels of the original image at a distance corresponding to your parameter 
setting. 
You may also choose the percentage of pixels of the original image to be moved.

Well applied, this effect gives the impression that one sees the image or video footage through 
frosted glass.

The Stylize > Print effect

        
Have you ever looked at a comic or cartoon strip through a magnifying glass? The color areas are 
made up of superposed round points of different sizes and colors.
The Print effect reproduces exactly this aspect.

You may choose to work in Color, in Black & White or work only on the non-opaque areas of the 
image…

        

The Size parameter is used to set the size (and therefore the number) of dots on the screen.
Opposite and on the page above you see the print effect applied with the Color channel and with 
the Black & White channel.
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The Stylize > Negative effect

The Stylize > Negative effect

        
This effect replaces the color of each pixel with its negative.

The Stylize > Solarize effect

        
This effect reproduces the photographic effect named solarization which consists of mixing the 
colors of an image with the colors of its negative.

The Stylize > Color Range effect

        
This effect substitutes the colors of one of the channels Red, Green, Blue, Alpha or Luminosity with 
those of the gradient of your choice (see lesson 3 for gradients).

In the example above: the gradient blue > orange > yellow was applied on the image's luminosity 
channel: 
the yellow pixels replace the light pixels of the image,
the red pixels replace the mid tone pixels,
the blue pixels replace the dark pixels.
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   These two effects have no parameters.



The Stylize > HalfTone effect

The Stylize > HalfTone effect

        

        

The Halftone effect reproduces the aspect of a « grid » on the current image and gives the current 
image the appearance of an «artist's canvas».

* You may set the parameters for the horizontal and vertical cells (H cells and V cells), Direction, 
Opacity of the grid as well as their type (Line, Dot, Cross, Checks, Blocks, etc.).

* There are also several application modes: Color on black, Color on white, Saturation, etc.

* Finally, you may use the Jitter parameters which will slightly modify the shape of the grid.

The Stylize > Lumix effect

This effect exchanges the luminosity values of the pixels in an image or source video footage with 
those of another image or footage, which gives the impression of seeing an image through the 
contours of another image (see below).

        >>   
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The Stylize > Lumix effect

    >>  

The Source Image notion

A source image or footage is used in the Rendering box of the Lumix effect and some other effects 
(in particular the Motion > Keyframer effect which will be studied later). Let's discuss this further:

TVPaint Animation Pro offers some effects which require the use of an image or footage other than 
the current image. These are referred to as source images or footages.
Several choices are available for the so-called source images or video footage: the project of your 
choice, the layer of your choice, the current brush or animated brush, the spare image, the paper, 
the current display, the FX stack.

* The choice FX stack will use the current image with the effects of the FX stack applied as Source 
Image before applying the parameters set for the Source Image.
* The choice Current layer allows you to apply the effect from the current layer.
* The choice Display allows you to apply on the current layer the effect from the footage viewed 
when playing your project (the effect will be that all layers appear to be merged, while the hidden 
layers are not taken into account).
* You may also choose to use the Spare Image or Paper if they are available.
* When choosing another project, layer or brush, you may adjust the Pre- and Post-Behavior, the 
position and the animation mode: the number « n » of the Position parameter corresponds to the 
image « n » of your project, animation layer or animated brush. 
The Animation mode controls the  « behavior » of your brush, layer or project: random animation, 
ping-pong, animation reduced to the image indicated in the position parameter, etc.
If the number of source images is lower than the number of images to which your effects are 
applied, you may adjust the Pre- and Post-Behavior for your source (random, pingpong, loop, etc.).
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The Source Image notion

As required, you may choose to flip your source vertically, horizontally or both, before using this 
source.

The Colors > Image Source effect

The Colors > Image Source effect allows you to display the image or the sequence of your choice 
on the current layer.
* The Source menu use all notions encoutered in the last paragraph. As a consequence, you can 
choose to display the current layer, another layer, a paper, the spare image, an other project, the 
current custombrush, etc.
* The Blend popup menu is used to choose the mode to be used when drawing the Source Image 
or Sequence on your current Layer (Color, Behind, Erase, ...)
* The Opacity parameter allow you to adjust ... the opacity of the displayed image or sequence.

This effect could seem simple, even obvious, but it has a lot of useful applications :

1  st    example :  

  >>  >> 
   Original image                                  After applying the effect                 After applying all the FX-stack
                                                              Stylise > Glow only                               
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On the unique layer of our timeline, a «TVPaint» 
logo has been drawn. We are going to replace it 
by its own glow.

Let's take a look at the FX-stack opposite :

1)  The first effect that will be applyed is the 
Stylize > Glow effect.

2)  The Colors > Image Source effect is the 
second effect that will be applied. The Source 
selected is Current layer and the Blending Mode 
is the Erase Mode.

In this way, the «TVPaint» logo will be removed 
just after the rendering of the glow on the screen.

This process works with other effects 
of the Stylize group like Add Border 
or Bevel (with Outer option selected). 

(For the Drop Shadow and Toonshading 
effects, please study the next example)



The Colors > Image Source effect

2  nd   example :  
In this example, we will create a shadow for the running kid thanks to the Stylize > Toonshading 
effect. This shadow will be rendered on an empty animation layer.

In this example, the Colors > Image Source effect allows you to define an image or an animation 
sequence as reference for the “following” toonshading effect in your FX-stack.

   

In this example, it is also possible to replace the effect Stylise > ToonShading by 
the effect Stylize > Drop Shadow. (the Shadow Only option is also present in this 
effect)

In that case, you will obtain a classical shadow. Of course, the character layers (colors and 
Running Kid) will stay unchanged.
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In the FX-stack opposite, the Stylise > 
Toonshading effect will be applied on the 
animated layer called “Toon Shading”. (see 
the timeline below)

The effect Colors > Image Source  allows you 
to specify the reference layer used to render 
the shadow. Here, the Source is the 
animation layer called “color”.

If we use the Erase blending mode as we did 
in the first example, the shadow will 
disappear. (the toonshadow is inside the 
running kid)

That's the reason why we will keep the Color 
blending mode and use the Shadow Only 
option of the Stylise > Toonshading effect.
It allows to create the shadow of the running 
kid without re-drawing it.

It is then possible to generate a shadow for 
our running kid on a separate animated layer.
As a consequence, the character is not 
altered by the rendering of the shadow.



The Colors > Image Source effect

Here is the 3D view of the layers you can obtain after using the effects Colors > Image source, 
Stylise > Drop Shadow and Stylise > Toonshading.

    

Toonshading Layer

Borders Layer

Colors Layer

Drop Shadow Layer

Backgroung Layer

 

                                         

The resulting image
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The Stylize > Convolve Effect

The Stylize > Convolve Effect

The effect Stylise > Convolve allows to modiffy the pixels of an image or an animated sequence by 
using a matrix (here above on the right).
For the neophyte, a matrix is an ordered set of numbers listed in a rectangular form. For the 
mathematicians, it is a powerful and convenient calculation tool used in algebra.
To open the matrix relative to this effect, just click on the Edit button of the panel.

    
The matrix of our effect contains 13 rows and 13 columns, and as a consequence 169 numerical 
fields. Each numerical value is usually called coefficient.
The grey boxes are located on the two diagonals of the matrix. It usually gives a better readability 
when you fill in the matrix.

We have already seen that each color can be broken up in various ways depending 
on the color system. For example, the Slider tab of the Color Picker panel gives the 
numerical values of the A color in the R,G,B and T,S,L color systems.

The Stylise > Convolve effect calculates a new value (and so gives a new a color) for each pixel in 
an image or an image sequence by using the values (and so the colors) of its neighboring pixels. 
In the mathematical point of view, each new value in the R,G,B color system will be calculated by 
taking the average of itself and the pixels surrounding it. It a weighted average using the matrix 
coefficients.
Well, you are an animator, not a mathematician, it doesn't help you a lot to get an idea of the 
internal working of this effect...

How to obtain convincing results by changing the numerical values of the matrix ?
The examples below should help you in this task.

1  st    example : How to create a Blur  

 
Using this 3x3 matrix (3 rows, 3 columns) will make each pixel modify itself according to its 
neighboring pixels.

The surrounding pixels will have more weight (or will be more represented) than the central pixel :
this is exactly the common process to render a blur effect.
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Let's take a look at the matrix opposite : each coefficient is equal to 3, 
except the central coefficient which is equal to 1. All the other 
coefficients are equal to zero (and not visible here)

Here is an example. In the TVPaint logo opposite :

* The white and opaque pixels outside the TVPaint logo are most often 
surrounded by opaque white pixels.
A weighted average of white pixels gives ... a white pixel.



The Stylize > Convolve Effect

 
 

                              
Below, two zooms on the « T » letter of the TVPaint logo :

    >   
 Before applying the effect        After applying the effect  

    >   
And here is the final result :

   >  
              Before applying the effect                                 After applying the effect  

2  nd     example : What happens with a bigger matrix ?  

 
Using this 5x5 matrix (5 rows, 5 columns) will make each pixel modify itself according to its 
neighboring pixels. We use here a larger radius than in the 3x3 matrix of the first example.
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From the result above, it is possible to deduce 
the result of the Stylise > Convolve effect on 
some pixels 

Here is the result on a wider area of pixels.

The TVPaint logo begin to get blurred ...

* For the pixels located at the frontier between the blue and white areas, the situation is a bit 
more complicated : a weighted average of blue and white pixels gives a more or less light blue, 
as shown below :

* The blue pixels inside the TVPaint logo are most often surrounded by 
blue pixels.
A weighted average of blue pixels gives ... a blue pixel.

Let's take a look at the matrix opposite : each 
coefficient is equal to 3, except the central coefficient 
which is equal to 1. All the other coefficients are equal 
to zero (and not visible here)

In this case, the principle is the same as the one enunciated 
above, but more pixels are taken into account to calculate the 
average
It gives a larger blur than the one obtained with the 3x3 matrix. 
(see next page)



The Stylize > Convolve Effect

Below, two zooms on the « T » letter of the TVPaint logo :

    >                  >     
 Before applying the effect        After applying the effect               Before applying the effect       After applying the effect 

    >    
           Before applying the effect                                      After applying the effect  

It is easy to understand that the bigger your matrix will be (the more coeficients equal to 3 in our 
example), the more pixels will be used to calculate the resulting colors. (the larger will be the blur in 
our example) Here is what you can expect by using bigger matrix, constructed in the same model 
than the one above.

 
 Above the source image. Below the blurs that you can obtain by using a :

                   
        3x3 matrix                                      5x5 matrix                                       7x7 matrix

                   
        9x9 matrix                                     11x11 matrix                                    13x13 matrix

The execution speed of the Stylise > Convolve effect depends on the number of 
coefficients which are different from zero inside the matrix. In oher words, the more 
zero coefficients you will have in the matrix, the faster the effect will be applied.

3  rd   example : How to have a sharper image :  
Obtaining a sharper image is the opposite as obtaining a blurred image.
The surrounding pixels will have less weight than the central pixel : in other words, they will be less 
represented than the central pixel.

Now we can apply this effect to our logo :

     >     
          Before applying the effect                                        After applying the effect  
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Let's take a look at the matrix opposite : each coefficient is equal to -2, 
except the central coefficient which is equal to 22. The central 
coefficient is really higher than the coefficients surrounding it.



The Stylize > Convolve Effect

As seen above, the weighted average of the blue (or opaque white) pixels gives ... a blue (or white) 
pixel. That's is not always the case, as we will see later.

 
It results a sharper image ...

4  th   example : how to draw the edge of a picture :  

In order to obtain the edges of a picture, you need to have a sharper image and you need also to 
make the pixels surrounded by same color pixels become black.

In this case, the pixels surrounded by pixels with the same color will become black. The weighted 
average of the values (or colors) is equal to 0.

The pixels at the frontier between the blue logo and the white background will be strengthened.
Here is the result :

     >     
           Before applying the effect                                       After applying the effect  

5  th   example : How to emboss an image.  

Adding relief to an image can be done by strengthening the pixels colors in a given direction and 
by reducing the impact of the pixels colors in the opposite direction.

     >     
Before applying the effect                 After applying the effect  

Now, let's study a few notions :

* We saw that our effect was modifying the color of the pixels on the screen. It is also possible to 
modify the pixels transparency by using the Use alpha button.
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To do so, we will use a matrix which coefficients are close from those we 
used in the last example. Please note that the sum of the surrounding 
coefficients is equal to the opposite of the central coefficient.

The matrix opposite allows to emboss the image as if a light source 
was added at its right. (all the layers have been merged before 
applying the effect)

For the pixels located at the frontier between the blue and white areas, the 
situation is a bit more complicated : they will become more visible than the 
blue and white pixels surrounding them.
In other words they will become a little darker.



The Stylize > Convolve Effect

In this case, the calculation of the weighted averages is applied to the alpha component of the 
pixels too.

* The Border popup menu allows to choose how the pixels at the border of the image will be 
calculated. (The pixels located at the border of your image don't have neighboring pixels ...)
You can choose to use as neighboring pixels :

- Black pixels (none option)
- Pixels resulting from a symetry of your image (mirror option)
- Pixels resulting from reproduction of the image (tile option)
- Pixels resulting from reproduction of the last (first) line (or column) of pixels (repeat option)

* The multiplying coefficient allows to multiply all the coefficients of the matix by the same value. 
It does not change anything to your picture if all non-zero coefficients of your matrix are the same.
Otherwise your convolution effect will be more or less pronounced.

Some preset examples :
Now that you have some basis about the convolution matrix, you can try to modify the numerous 
matrices at your disposal in the bin menu of your effect.

Above, you will find the results obtained with the matrix :

                      
Blurred Image                             Splitted  Image                         Only the edges

                      
Embossed Image                       Special lightning                        Other Results       

12-20 The effects of the Stylize group







Lesson 13

The effects of the Distortion group

In this lesson, you will:

● Manage the symmetry effects: Flip, Mirror, Kaleidoscope, ...

● Manage the Wrapping effects: Bump, Waves, Tornado, ...

● Create a shadow in perspective.

● Animate with the Wrapping Grid effect.



The Distortion > Flip effect

The Distortion > Flip effect

This effect permit to flip horizontally and/or vertically images in the current layer (see the examples 
below). This effect does not use or require animation keys.

      
      Source Image                          Vertical flip                          Horizontal flip                   Horizontal and vertical flip

The Distortion > Mirror effect

This effect allows you to do a symmetry in relation to an axis in the current layer.
* The Pivot X, Pivot Y and Angle numeric fields allows you to define the axis the symmetry will be 
applied to.
* When using animation keys, the Rotation parameter reflects the number of complete rotations to 
be carried out before arriving at the chosen angle.
* The Opacity parameter allows you to adjust the transparency of the reflected image.

  >>>  
 Source Image                                                 Mirror effect,  opacity 50%

If needed, you can move the axis through the HUD interactively in the current 
project window.
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The Distortion  > Kaleidoscope effect

The Distortion  > Kaleidoscope effect

As the name implies, the effect imitates the view through a kaleidoscope. In the following 
paragraphs, the projects will be considered as having the layers merged.

     >>  
  Original image                                                    Use of the Kaleidoscope effect

The number of segments is the number of symmetric axes used to obtain the final image (see 
below).

      
Original image                      One horizontal symmetric    Two symmetric axes            Three symmetric axes
                                                axis                                        (horizontal and vertical)
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The Distortion  > Kaleidoscope effect

      
   Four symmetric axes            Five symmetric axes            Six symmetric axes             Eight symmetric axes

                 And so on ...

The value of the first angular parameter varies the axis formed between the symmetric and the 
horizontal axis.

The grayish diagrams indicate the area in the original image which will be duplicated by the 
symmetry.
In black, the rotation angle applied before symmetry in relation to the red axes.

Here for one symmetric axis :

         

                                

Here for two symmetric axes :
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The Distortion  > Kaleidoscope effect

The Source coordinates define the position on the screen of a point at which the symmetry axes 
cross each other (see the various examples hereafter).

      

                             

      

                           

The value of the second angular parameter is used to vary the global angle of the image obtained:

      

                

The Destination coordinates define the position on the screen of an image centre obtained after 
application of the effect (see the various examples hereafter).
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The Distortion  > Kaleidoscope effect

      

      

When the Fill option is disabled, the kaleidoscope effect is calculated according to the current 
image. When it is enabled, the calculation is also carried out on all reproductions of the current 
image.

Below, the area inside the white rectangle represents the current project window.
All areas inside and outside the white rectangle represent the space used to calculate the effect.

In the 1st case, the option is disabled, the effect is calculated from the current image.
In the 2nd case, the option is enabled, the effect is calculated from the current image and its 
reproductions.

        

In both cases the original project is represented with the result after the effect is calculated and the 
other showing the result obtained when the destination parameter is set to another point.
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The Distortion > Perspective : 4 points effect

The Distortion > Perspective : 4 points effect

This effect is constructed in the same way as the Perspective tool  from the main panel, except that 
the position of each point can be moved along a stored path. 

   > 
Source Image                                  Current Image                               Result after applying the stack

* The Position tab allow you to manage the coordinates of the four points used for this effect (the 
four corners of the H.U.D)
* The Render tab permit to select the type of image, called Source Image, which will be put in 
perspective (current layer, FX-Stack, other project, brush, etc.).

Associated with the Pixel Tracker (this option will be explained in details in the next 
lesson), this effect can wrap a video sequence or a picture onto a moving shape.

 This could be the case if the cameraman was moving his recorder while filming  the 
computer screen above.

Here below, a shadow was created for our character. The two effects Color > Source Image and 
Stylize > Drop Shadow were used in order to have the shadow drawn on an empty layer (go back 
to the last chapters of the last lesson for more details).
This shadow was put into perspective thanks to our effect. We succed to imitate the projection of a 
shadow on the floor.
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The Distortion > Wave effect

The Distortion > Wave effect

This effect imitates water waves, as if a rock was thrown into water. (look at the images below). 
* The Center parameter defines the center of the effect, the position where the rock hits the water.
* The Radius parameter defines the maximal distance the waves will go. 
* The Wave parameter defines the number of visible waves.
* The Amplitude parameter defines the maximum height of the waves.
* The Angle and Rotation permit to animate the waves in time.

    

    

Once again, these parameters can be partly adjusted in the project window through 
the H.U.D.

The Distortion > Tornado effect

We will take advantage of this image which show clouds to study the Distortion > Tornado effect. 
Have you ever noticed how a whirlpool behaves in a washbasin for example ?
The Distortion > Tornado effect produces the same kind of effect, distorting the image or the image 
sequence (look at the images below).
* Like the Wave effect, you will need to define a Center and a Radius (which can be locked with 
animation keys if needed…).

  >>    >>
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The Distortion > Tornado effect

>>    >>  
* The Angle parameter allows you to define the power of the applied distortion.
* When using animation keys, the Rotation parameter reflects the number of complete rotations to 
be carried out before arriving at the chosen angle.

The Distortion > Bump effect

   

The Bump effect allows the creation of a relief, which 
will be provided by a source image, over the current 
layer.

The more luminous the source image is, the more 
important the relief of the pixels in the current image is. 
The darker the source image is, the less visible the 
relief is.

On the right below, the source image and the current 
image are the same. It gives a feeling of relief on the 
whole screen.

     
                   Current image                                              Source image = Current image

     
                   Source image = TVPaint logo                     Source image = paper
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The Distortion > Bump effect

* You can adjust the depth of the relief and soften the borders using the numeric fields Depth and 
Smooth.
* A relief requires a lighting to be visible : thanks to the Apply with menu, you can define a centered 
lighting thanks to the Center option, or a directionnal lighting (Direction option) whose angle will 
have to be adjusted.

The Distortion > Displacement Mapping Effect

   

The Displacement Mapping effect works the same way 
as the Distortion > Bump  effect : the panel and settings 
are the same.

Regarding the Displacement Mapping : the pixels from 
the current image which correspond to the pixels from 
the source image will be replaced by different pixels 
from the current image.

That means : the software makes a translation of the 
current image pixels along a direction or a center, only 
in the opaque areas of the Source image. 

     
     Current image                                                            Source image  = TVPaint logo

The more luminous the Source image is, the more important the displacement of the pixels in the 
current image is. The darker the Source image is, the less visible the Displacement Mapping is.

           
                     Source image = paper                                                               
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The Distortion > Wrapping Grid effect

The Distortion > Wrapping Grid effect

      

The wrapping grid is an extremely useful animation tool and is capable of distorting the images in 
time according to the criteria of your choice.

The Wrapping grid effect, when correctly used, can produce quite spectacular results: wave 
movement, 3D rotation of faces, movement of hair blowing in the wind, etc... (below, you will find a 
summary overview of the possibilities proposed).

 >>  >>    (project skull.tvp)
1st image                                Movement                              Last image

Once the effect has been placed in the FX stack, a grid is displayed on the current image.

Some hints for beginners:

* The use of two grids will be necessary for your effects to work correctly: these grids are referred 
to as Source and Destination grids.
The Display popup menu is used to select on which of the two grids you intend to work. 

Depending on your choice, the HUD will be modified accordingly: the letter S appears when the 
source grid is displayed and the letter D appears if the destination grid is displayed.

     
                      Intersections in the Source grid                        Intersections in the Destination grid

In the HUD, when the source grid is displayed, the destination grid is always visible behind in a 
less bright color. When the destination is displayed, the opposite case applies (see next page).
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The Distortion > Wrapping Grid effect

           
Display of Source and Destination grids (the current grid is green, the other is blue)

* Modification of an intersection in the Source and/or Destination grid distorts the current image 
accordingly.
The image is distorted, stretched or contracted over a narrower or wider area on the screen so that 
the points on the source grid of your initial image are moved to the same location as the points on 
the destination grid.
Below, source and destination points on a grid with the resulting distortion.

      >>  

* The Point menu is used to edit each grid point present on the screen. The latter may be identified 
by their position on the grid (see below).

     

* The first two numeric fields are used to select the number of intersection points on your grids 
(Source and Destination grids have the same number of intersections). You may increase or 
decrease the height and/or width of these grids.

          
4 x 4 grid                                  8 x 4 grid                                   8 x 12 grid
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The Distortion > Wrapping Grid effect

* The five buttons  present in this panel are used respectively to:
- Edit grid points.
- Distort the grid as a whole.
- Copy the source grid to the destination grid.
- Copy the destination grid to the source grid.
- Swap source and destination grids.

 Edit grid points

* When this option is enabled, each intersection point of your grid (source or destination grid) may 
be moved in space along three axes (width, height and depth) the effect of which will result in 
immediate distortion of the current image. 
You may also use the predefined paths to manage intersection movement.

            

Above, from left to right, the initial image, movement of the destination intersection along the X and 
Y axes, movement of the destination intersection along the Z axis.

* It is possible to select several intersection points when the HUD is visible by drawing a rectangle 
inside the HUD. Once this has been done, it is easy to carry out all movements with a single click 
and slide on an intersection.
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The Distortion > Wrapping Grid effect

* It is possible to choose an intersection interpolation mode (linear, spline or smooth) in the first 
effect popup menu (see below).

                     
      Spline interpolation                         Smooth interpolation                     Linear interpolation

If the interpolation mode chosen is Spline, use of the [Shift] key when moving the 
handles enables movement of one handle at a time.

 Edit grid bounding box

When the second icon is selected, it is possible to distort the current grid as a whole by rotating it 
or by modifying its dimensions (see below).

      
Original grid                                            Grid with 30° rotation                             Grid with height divided by two

 Swap the source and destination grids

This option is practical when creating a distortion opposite to that of the current distortion.

Below, the rear end of the arrow represents the Source point of the grid and the arrow tip 
corresponds to the Destination point.

        
Distortion:      Source => destination                                   Distortion:     Destination => Source
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The Distortion > Wrapping Grid effect

Distortion of the current image in time.

We just saw how to distort an image in space using the source and destination grids. To distort the 
current image in time as was done for the «skull.tvp» project, you must:
* Duplicate the latter along the entire layer.
* Unactivate the previsualisation of the effect (use the menu at the bottom left of the FX-Stack)
* Set the display option on Source.
* Pay attention to place intersections of the Source Grid at all strategic points on the image : eyes, 
teeth, etc … and ensure the grid covers the lines of your drawing.
* Copy the Source Grid to the Destination Grid.
* Reactivate the previsualisation of the effect.
* Set the display option on Destination.
* Make the Destination Grid slightly different from the Source Grid for at least the first and last 
frames of the animation layer and then create the corresponding keys.
The result is a distortion, and consequently, a movement which takes place over a period of time.

 

The method described above is not the only way of using this effect. Many others 
exist. You should try them out and share your impressions in the on-line forum.

The Distortion > Optical Flow effect

The purpose of this effect is also to distort the current image or animation, but in a different way 
than the Distorsion > Wrapping Grid effect. It uses a vector field instead of a grid. This vector field 
defines a flow that will be followed by the pixels of the current image.
This effect comprises four tabs :

• The Edit tab

          L'image source

* The first button allows to set the size of the vector field. More exactly it allows to set the number 
of vector that you will use on both the horizontal and vertical axis.
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The Distortion > Optical Flow effect

Once you have chosen the size, you can edit the current vector field itself.
To do so, display the H.U.D and draw directly on the screen (to be exact : on the H.U.D) with the 
purple circle, as shown below.
If you have a picture behind the vector field, you should see the render of the distortion.

      
  Vector field                                                               Modified image

     

The left mouse button allows to increase the tension of the 
vectors in a chosen direction.
The right mouse button allows to decrease the tension of the 
vectors in a chosen direction.

The red points are the source points of your vectors, (they can't 
be moved)
The green points are the destination points your vectors, 
The blue segments are the vectors themselves.

For a given picture in your timeline, modifying the vector field creates an animation 
key.
If more than one animation key is created in the timeline, it means that your vector 

field and thus the distortion will evolve in time.

* The Reset Current Key button reset the vector field of the current picture in the timeline. If this 
picture does not have an animation key, a new one will be automatically created.
* The button :  allows to modify all the vectors of the field in only one operation. This tool is 
perfect if you need to distort, move or pivot an image entirely.

          

The more vectors you will use, the more time you will need to render the effect.
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The Distortion > Optical Flow effect

* The button :  allows to change the parameters of your H.U.D brush (i.e : the purple circle)
Like the common tools (airbrush, etc ...) that you use to draw, you can set its profile, size and also 
power.

     

Let's admit that we will always choose the direction opposite 
when editing our vector field (i.e : the red arrow) :

The pictures below shows the impact of the different settings at 
your disposal.

             

             

• The Selection tab

       

* In this tab, you can select the vectors of the field that you want to edit via the previously 
discussed tools.
By default, all the vectors are selected. The two buttons Select All and Clear Selection allows to 
reset the selections.
As in the main panel, you can use one of the three selections icons :  Square, Freehand 
or Circle selection.
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The Distortion > Optical Flow effect

   

When doing a selection, if a vector is selected, it appears 
in yellow instead of blue. (if you want to select a vector, 
just select its source)

If a vector source is not selected, its H.U.D color becomes 
lighter.
The tools available in the Edit menu will only apply on the 
selected vectors.

The circle selection use the same parameters as the H.U.D brush (the purple circle) so you can 
select your vectors by “drawing on the H.U.D”
It allows to have source points only selected in part and thus to have nice effects when editing the 
vectors.

Note that if you reset the size of the vector field, all the settings that you have done 
(vectors, animation keys, selections, ...)  will be lost.

• The Render tab

    

The Render tab allows to choose :
* The calculation algorithm of the distortions (Blackman 
or by default)
* The distortion mode of the image borders
(The example below illustrates the three modes at your 
disposal.)

                      
                                       Source Image                                               Vector Field

                         
                  None Image Mode                          Mirror Image Mode                        Loop Image Mode
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The Distortion > Optical Flow effect

• The Display tab

   

The three buttons: Show Src, Show Dst and Show 
Vector allow you to select exactly what you want to 
see on the H.U.D : the red source points and/or the 
green destination points and/or the blue vectors.

The button Show Only Selection allows to see only the 
vectors located inside the current selection.
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Lesson 14

The effects of the Motion and Paint groups, 
management of the paths

In this lesson, you will :

● Study the AutoPaint effect.

● Learn how to use paths.

● Study the Motion > Keyframer effect.

● Study the Stabilization effects.



The Paint > AutoPaint effect

The Paint > AutoPaint effect

Have you ever watched a weather report?

When the program is over, you often see the signature 
of the speaker(s) displayed on the screen.

It is possible to reproduce this effect in 
TVPaint Animation Pro, using the effect 
Paint > AutoPaint.

This is the perfect way to dynamically sign your future 
animated works of art!

* First, you have to record the stroke which corresponds to the signature:
go onto an empty animation layer, click on the Record a stroke button in the AutoPaint effect and 
then draw your signature on the screen.
* When this is done, click on the Stop button or press the [Escape] key.
You have now recorded the signature in the program memory. A long series of keys is visible in the 
timeline (see below).

   

* Delete the current image on the screen (i.e. the signature).
* Select the tool of your choice and adjust its parameters for the future stroke of the signature.
* Stretch your animation layer so that it covers all keys of the timeline.
* Select all its images and then apply the FX stack.
When you play the project you will note that the signature is “drawn” progressively on the screen.

       > > >

To ensure that your stroke is carried out on the number of images of your 
choice, two methods are availabe:

* You may stretch or contract the set of keys right after recording the stroke as 
indicated above.

* You may create an animation layer with the number of images desired and select all 
images before recording the stroke.
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The Paint > AutoPaint effect

Let's now study the AutoPaint effect in detail: 

* Recording the stroke generates a large number of key points on the timeline each of which stores 
the position of your stylus at a given moment. When the stroke is recorded, you may modify the 
position of the stylus on the screen for the key of your choice thanks to the numeric fields X and Y.
* For a given key, the Draw button indicates if the stylus was in contact with the tablet or not. If it is 
not enabled for a given key, there will be no stroke for this key (e.g. this is the case if you lifted the 
stylus during recording).
* Recording a stroke with the AutoPaint effect allows for other recordings, too : in particular the 
data relative to Pressure, Altitude, Azimuth and Fingerwheel  available on the tablet. It is also 
possible to choose whether this data will be restored or not when applying the FX stack by 
checking or unchecking the corresponding boxes.
* The section Stroke mode offers several choices : Normal, Size, Full and Last.
These are results obtained using these modes:
- The Normal mode progressively reproduces your stroke on the screen. This is the one we have 
been using since the beginning of this lesson.
- The Size modes requires adjustment of the parameter with the same name and will erase the 
stroke progressively in time.

> > > > >

- The Last mode is a kind of Size mode parameter set to value « 1 », which only draws one 
« point » of the stroke at a time.
In Complete mode the complete stroke is drawn on the screen, independent of the circumstances.

   

* The last is the Noise parameter: it defines a possible deviation from the 
original path and is used to obtain less regular curves (see opposite, the 
TVPaint logo is slightly distorted, as if written  with a trembling hand).

The AutoPaint effect is in a way similar to the Re-apply option as the result depends on the 
drawing tool selected just before application of the FX stack.
Here, two interesting examples :

   

Opposite, after recording a simple stroke in the shape of a semi-
circular arch, the AutoPaint effect was applied using the  TextBrush 
tool in Letter mode with the rotation parameter connected to the stylus 
direction.

The text seems to follow the defined path in time, each letter having its own rotation depending on 
its position on the path.
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Management of Paths

Management of Paths

    

In lesson 9, when studying the Center Blur effect, we already discussed 
the idea that an effect may make use of the Position parameters which 
will then define a path on the screen.

We will now discuss this Path notion in more detail.

    
When an effect authorizes use of a path(s) for one or several of its 
parameters, you have access to the Tools menu in the panel of the 
corresponding effect as shown opposite.

This is what it contains:
* You may use the Pixel tracker to create a path.
* You may also record a stroke on the screen, to create a path. 
* The third option of the Tools menu allows you to re-use a path you have already created 
previously in your effects stack and use it with the current parameters.
* As is the case for the palettes, the tool settings, the effects, etc, a path may be renamed, saved, 
etc. The option Path Manager is used for all these tasks.
* The option Add to bin allows you to save the current path under a name of your choice for later 
use (we have already done the same for customized palettes, mixers, tools ..... ).
* The Copy from path bin allows you to re-use a path saved in the Bin for your position parameter.
* The Center option replaces the position values for the current key with those of the center of the 
image.
* The option Reset deletes all the keys of your effect.

The Path recorder 

Path recording may also be carried out in any other effect to create a path. The option Path 
Recorder in the Tools menu relative to the position parameter(s) of your effect will help you to do 
this. The steps described above for the AutoPaint effect are still applicable in this case.

  >    >  

Using the standard Path Recorder allows you to generate a large number of 
keys containing position parameters, however, contrary to the AutoPaint 
effect it does not allow to restore pressure, azimuth and altitude.
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The Path manager

The Path manager

The Path Manager mentioned above, has four tabs:

  

 

  

               
    1st path                                                    2nd path                                                   Path average

* The Smooth tab allows you to smooth the values associated with the animation key of the path 
chosen (the higher the numeric value, the more the paths will be smoothed after application).

      >>  
                                                   Basic path                                                Smoothed path
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* The Manage tab allows you to choose a path amongst those 
already saved in the Bin, and then to rename, copy, delete or 
even invert it, (the path will in this case be taken in the reverse 
direction when used).

When you use an effect of the Paint or Motion group, the 
Constant Speed option move the keys of the path to keep the 
same speed along your path for your strokes or animations.

This is notably useful when you work with the Motion > 
Keyframer or Motion > Multiplane Camera effect.
The speed of the moved images or the speed of the camera 
movement will be directly linked to the Progress Profile of 
those effects.
The speed control will then be optimised.

* The Average tab has four popup menus for you to choose the 
Bin paths. It allows you to set the values for each animation 
key of the current path as an average derived from the keys of 
every chosen path.



The Path manager

* The Size tab allows you to modify the size of the complete path on each of the three axes 
(horizontal, vertical or depth).
This may be useful if you wish to transfer a path from one project to another with a different size.

      

                                                    Basic path                                  Path reduced by 50% on the horizontal axis

Using a value of -100% on one of the axes allows to completely flip your path.
To move the entire path on the screen, you simply select all its keys in the HUD and 
then click-slide using the mouse.

Save paths

We explained above that it is possible to save paths to be used later for an effect of your choice 
(option Add to Bin). However, a path saved in this manner may not be recovered after closing and 
re-opening TVPaint Animation Pro.

Three methods are available to solve this problem:
* Save your configuration before quitting the program.
* The effects of the FX stack and their parameters may be saved in a Bin FX menu (see lesson 9). 
This save mode offers the advantage that it also stores the path(s) associated with your effect so 
that they may be recovered when re-starting TVPaint Animation Pro.

   
* You may also save your paths before closing TVPaint Animation Pro, then reload them after re-
start thanks to the File menu of the Path Manager. You can also export a path into Lightwave 
Motion format
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The saved path is that of the Manage popup menu, a loaded path will be added 
in the path bin and available in the popup menu of the Manage tab.



The Pixel Tracker

The Pixel Tracker

There is also another way to create paths: follow the movement of the pixels in an animation in 
time. To do this, you use the Pixel tracker panel.
This panel is accessible in the effects requiring use of paths, in the Tools popup menu or directly 
via the Windows main menu (see the corresponding window below).

We will now try to create a path from an eye movement of the Running Kid or the blue-screened 
character. (see below)

When a path is created, we may, for example, re-use it with the AutoPaint effect and the pen tool in 
smooth mode to create a blur on it.
It is also possible to use a lighting effect to create a luminous spot following the movement of 
Running Kid, etc.

               

Pixel Tracker with the Running Kid                         Pixel Tracker with the blue-screened character

  >>  
                      original animation                                       path created from pixel tracking at eye level
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Opposite, the path of the eye was 
re-used with Omni lighting.



The Pixel Tracker

This is how to use the Pixel Tracker panel :

* In the first section, you must define the layer on which the character whose movement you wish 
to follow (or any other element) is located. Two time or frame markers determine the section of the 
layer that will be taken into account for pixel tracking (the entire layer, by default).

* In the second section, you must define a focus area within the current image. The Pixel Tracker 
will try to find this in the following images of your video in order to create a path. To « follow » a 
human face, i.e. to create a path from the face, the eye is often used to define the focus area.

The values Ref X and Ref Y are used to choose the center of this focus area and the values Ref W 
and Ref H to set its width and height.
The parameters Track W and Track H will limit search in the focus area to the number of  pixels in 
length and height of your choice, around the focus area of the first image (see diagram below).

If HUD display is enabled after having clicked on the Set tracker button, you 
may modify these parameters directly with the following combination : 
[Ctrl+right click+slide the mouse] or [Ctrl+left click+slide the mouse].

If, for example, you select the right eye of our blue-screened character as «focus area», and the 
values for the parameters Track W and Track H are too small, this will make it difficult to find it in 
the following images (as our character is moving).
Inversely, high values for these parameters may define the left eye of the character as « focus 
area » during the process and this will falsify the path obtained.

* The third section contains three popup menus:
The Reference popup menu is used to choose if the reference « focus area » for the process is 
always that of the first image selected or will be updated as tracking progresses.
The Channel menu will, depending on your choice, restrict the channels to which analysis of 
movement tracking will be applied.
The Accuracy popup menu allows you to define the complexity of the concordance test. If you 
choose 1-1, the test is carried out at pixel level. The tracking is then fairly rough. If you choose
1-64, the pixels determined by the 1-1 test will be moved 64 times by a 64th of a pixel in order to 
fine-tune tracking.

* The fourth section is a zoom on the focus area you have selected.

* The fifth section contains two buttons:
The Track button starts the process of creating a path with the chosen parameters whereas the 
Rev. Track button has the same effect but reverses the path.
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When the pixel tracker tool passes from one image to 
another, it will memorize the focus area of the first image 
and try to find it in the next image in the tracking area. 

This enables creation of the position keys necessary for 
path creation.



The Motion > Keyframer effect

The Motion > Keyframer effect

The Keyframer is doubtlessly one of the most used effects in TVPaint Animation Pro.
It is found in the Effect > Motion main menu.
It is used to move all kinds of drawings on the screen.
To use the Keyframer, you must define the following :
* The object to be moved on the screen: brush, layer, spare image, paper…
* The path taken by the object on the screen using animation keys or pre-defined paths.
* The rotations to be applied to this object using keys.
* The motion blurs and, if required, pre- and post-behavior.

In some of the images hereafter, the background chosen is gray so that 
you can see the white pixels of the HUD.

• 1st example : movement, zoom and motion blur

We will now move the « TVPaint » brush on the screen.
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To start our study of the Keyframer, we have created a «TVPaint» 
brush (320*100 pixels) as shown opposite. The word TVPaint is written 
in black on a transparent background.

* Go to the Render tab and select the custom brush as source.

* Go back to the Position tab.

* Place the TVPaint brush outside the current project to the left 
using the HUD (see below) and then create an animation key for 
the position variable at the beginning of the layer. 

* Now create an animation key for the Position variable at the end 
of the layer and place the TVPaint brush outside the current project 
as before but this time to the right.

* As needed, you may adjust the position of the movement key 
points using the numeric fields and mini-sliders (use the values 
shown opposite). The X and Y fields represent the position of the 
brush center on the screen.

Playing your project in Preview mode allows you to check that your 
brush appears on the left of the screen and disappears to the right.



The Motion > Keyframer effect

To create a path you may position a brush outside 
the area zone: the brush then appears hidden and 
only its outline is visible as HUD (see opposite …).

Do not immediately apply the FX stack. Did you notice the Z position numeric field? This is used to 
set the depth of the object moved on the screen.
Let's now modify the second key we created: enter the parameters for the following positions : 
X= 540, Y= 240, Z= -800
A fast slide along the timeline allows you to see that our logo moves from left to right but, in 
addition to that, zooms towards the viewer ! (see below)

  

A positive value in the Z numeric field would have resulted in the logo moving 
away.

It is possible to generate even more subtle movements as our logo may follow the pre-defined path 
of our choice thanks to the Path Recorder or Pixel Tracker. 
You may also curve the paths thanks to the HUD and the keys of your choice (Linear, Spline or 
Smooth).
For example, in the trajectory below, the logo follows a spline on the screen while zooming lightly 
towards the foreground.

  >>  
Now we will make it a bit more complicated... It is possible to leave a trail behind our logo, a trail 
that depends on its speed and trajectory.
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Go to the Render tab :
the Blur step value defines the number of logos which will 
make up the « trail ».
The Blur Size is used to set the parameters of the trail length 
(see opposite).



The Motion > Keyframer effect

The settings of the progress profile (lesson 9) come into their own here: the 
movement is accelerated or slowed at your discretion !

• 2nd example: Pitch, Heading, Bank and Pivot

    

In this second example, we  will pivot 
our «TVPaint» logo using the pitch, 
heading and bank parameters.

Reset the values of the Keyframer effect to zero, select the «TVPaint» logo as source again and 
modify the Bank angle using the slider. The logo then turns along the blue axis represented on the 
diagram (see below).

    

Reset the values of the Keyframer effect to zero and proceed in the same way with the Pitch 
parameter. The logo now turns along the green axis represented in the diagram.

    

With the Heading parameter, the logo turns along the red axis represented in the diagram.

     

The combination of these three parameters gives a wide variety of results. It is now up to you to 
use these rotations in your animations and videos.
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Note that a low value generates a slight blur in the 
movement direction which is ideal for creating blurs 
generated by fast object movement.

A zero value will eliminate the trail.



The Motion > Keyframer effect

The logo may carry out several rotations around an axis: you simply modify the value of the 
Rotation parameter when creating the animation keys to increase the angle to 360°.
In the examples above, our logo always turns in relation to its center: the axes the logo turns 
around cross each other in its center.
The Pivot parameters may be used to modify the position of the rotation axes in relation to the 
brush.
Modifying the pivot X coordinate by increasing it by 100 pixels and decreasing the Y coordinate by 
100 pixels will generate other types of rotation when modifying Pitch, Heading and Bank, as the 
rotation axes are outside the logo.

Below you will see the effects of the Heading modification for our new pivot.

         

Modifying the Z coordinate of the pivot allows even more complicated 3D movements:

            

Each of the buttons Bank Align., Heading Align., Pitch Align., when enabled, allows modification of 
the brush angle depending on the path it follows. 

Below: the angle of the Heading parameter varies according to the logo trajectory.

      

Some words regarding the Rendering tab:

   

* The Fill option is used to fill the screen with the current source. In this 
case, animating the source will also animate all its copies.

* The Opacity parameter is used to adjust logo transparency as time 
progresses.

* The Z camera parameter represents the distance between the « virtual camera » and your image 
in pixels. The smaller this distance, the larger the opening angle of our  « virtual camera ». This 
enables you to use the « wide angle » effect well known in cameras by using the parameters for 
Pitch and/or Bank.
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The Motion > Keyframer effect

                       >   

Above, the pitch parameter was set to 45° for our merged image of the tree. The image at the top 
was obtained with a Z-Camera equal to 1000, the one below with a value of 210.

                                     > 

• 3rd example

This is how to scroll the list from bottom to top:
* In the Rendering tab, select the Projects list as source and then the name of the project 
containing the list of participants,
* Place two keys at the beginning and the end of the animation layer with the position parameters 
close to the illustration on the following page.
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This third example will allow us to work with different sources 
(Rendering tab) in the Keyframer effect.

Let's go back to our « planet » image used in previous lessons.
We'll assume that your cartoon is finished. 
Now you want to scroll the list of participants in the form of end credits 

We'll assume that this list is contained in another project much 
«higher» than the one of your planet (opposite).

Pay attention that the text is written on a transparent background, 
then select (Background = None) in the timeline of this second 
project.



The Motion > Keyframer effect

  >>    >>  

* Apply the FX stack.
It's done ! … The list moves from the bottom to the top as intended.

Below, our butterfly lands on the tree before flying off again and leaving the screen.

           
When using animated brushes or animation layers as source images, additional settings will be 
required. In this case, you have two popup menus at your disposal: Before and After.
They may be used to define how the images of your animated brush or animation layer would be 
applied by the Keyframer effect if their number were lower than that of the sequence you are 
working on (application of the brush or animation layer images with Loop, Pingpong, Random, 
etc.).
For our butterfly we have chosen the Loop mode.
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Thanks to the Keyframer anything may be moved on the screen: a 
brush, another project, the layer of your choice, the spare image, 
the current image, etc…
You simply choose what you want in the Source popup menu of 
the Rendering tab.

For example, exchange the current brush with the « butterfly » 
animated brush in the Bin tab.
This animated brush may also be moved as you wish and, why not, 
follow one of your pre-recorded paths.



The Motion > Keyframer effect

Please note that the H.U.D displays the splines followed by the four corners of the 
source and also the edges of the first and last frames. (see below)

                

• 4th example

This example will help you understand the Blend menu in the Rendering tab. Load the video 
footage of your choice and then create an animation layer containing only black and opaque 
frames just in front.
You should then see the following timeline:

    

     

   

It is as if our logo had been applied with the Eraser color mode. The Mixer mode refers to that 
encountered when using a spare image.
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Create any type of movement for the object of your choice using the 
Keyframer tool. Here, we are taking a red « TVPaint » logo brush. Its 
trajectory is of no importance.

Our red logo will, after application of the FX stack, be placed on each 
black image. So far, nothing new. 

If, before applying the FX stack, you select the Erase mode 
(described in lesson 2) in the Blend popup menu (Rendering tab) you 
obtain the result shown opposite.
Our « black » layer was erased at the logo passage areas which 
made it possible to see the layer underneath.



The Motion > Stabilization effects

The Motion > Stabilization effects

Imagine that the video sequence you just have loaded is slightly shaking. It's a common situation 
when you're using cameras fixed to a mobile support, for examples hand-held video footages, 
video sequences shot on a boat, etc...

    >   
Source Image                                                  Slight shakes

It is possible to avoid these undesired shakes by adjusting each images as the sequence goes 
along. If you proceed image after image it can be quickly tiresome.
Fortunately, the Motion > Stabilization 1 point and 2 points effects will take it in charge. 

The Motion > Stabilization 1 point effect

This effect works as follows : 
For each image from the sequence, you have to define an Origin point and a Destination point. The 
effect will make a panning of the image in order to bring the Origin point onto the Destination point, 
which will stabilize the sequence.
Now let's take an example :

Let's take the background below : the cameraman has shaked a little bit while shooting the 
sequence. We can define one of the yellow points below as the Origin point, and estimate that this 
it should be at the position of the Destination point (at the extremity of the yellow arrow) if the 
camera had not shaked.
As soon as these points are defined, the Stabilization effect will do a panning that will bring the 
Origin point onto the Destination point. The footage will not shake anymore.

  

      
Origin point                      Horizontal and Vertical camera  movements           Destination point
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The Motion > Stabilization 1 point effect

You can argue that each positions of the Origin and of the Destination points are different for each 
image, which make the process tiresome.
That's why, at this stage, using a path for the Origin and/or Destination points can speed up the 
process, especially paths created with the Pixel Tracker...

As soon as the effect is applied and that the image is stabilized, you could 
have to crop it to remove the white borders due to possible pannings. 
You can also use the fill button to remove the borders by tiling the image.

The Motion > Stabilization 2 points effect

This effect is similar to the previous one regarding its principle and its working. However it requires 
two Origin points and two Destination points.
The Stabilization 1 point permitted to adjust horizontal and vertical camera shakes.
Using the Stabilization 2 points tends to fix not only the shakes on X and Y axis, but also the slight 
rotation or zoom movements there can be on Z axis (The effect considers the distance and the 
angle between the Origin points which improve the process and make it more efficient…).

 

Below, the cameraman has rotated a little bit the camera while shooting the sequence.
If you define two origin and two destination points in the Motion > Stabilisation 2 points effect and 
check the Rotation box, the effect will then calculate the x° rotation angle of the image and makes 
the Source and Destination points coincide. (see below at the extremity of the arrows)

        
                2 Origin points                          Rotation moves of the camera                      2 Destination points

If the camera has zoomed a little bit while the sequence was recorded, you will have to use the 
same process and check the Scale button.
As we did for the effect Motion > Stabilisation 1 point, you can check the fill button to remove the 
borders by tiling the image.
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Lesson 15

The Rendering > Multiplane Camera Effect

In this lesson, you will :

● Study the concept of a Multiplane Camera.

● Learn how to use the Multiplane Camera effect (we will discuss various 
examples).



The concept

The concept

With the multi plane camera effect you may control movement of several planes with background 
scenery. Each plane has a specific depth and consequently, its own speed in the eyes of the 
observer.

In the image above, the following are placed one over the other in the order of furthest away to 
closest:
the starry sky, the mountains, the forest, the first row of trees, the running kid and finally the 
second row of trees much closer.

When the animation is complete: 
* The trees in the front will move from right to left very quickly as they are closer to the viewer.
* The mountains at the back will also move from right to left, but much slower.

The blur caused by focusing

This effect can also take into account the fact that the human eye cannot focus on all elements of 
the scenery at the same time.
Just like in traditional photography, if you focus on a object close to you, the objects further away 
will be blurred and vice versa focusing on a distant object will result in blurring of closer objects.

             

In the photos above, the tree is a long way from the rose. In the left photo, the camera has focused 
on the rose and the tree is blurred. In the right photo, the camera has focused on the tree and the 
rose is therefore blurred.
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Editing table and computer multiplane camera

Editing table and computer multiplane camera

Below on the left you will see the schematic diagram of a traditional multiplane camera setup often 
referred to as editing table. Each plane is placed on a sheet of glass and is moved progressively 
while filming.

Our computer multi plane camera effect, seen below right, does not function in the same way: 
In this case, it is the camera which moves progressively while filming and the scenery is 
automatically duplicated horizontally (the starry sky background does not move and is always 
placed in front of the virtual camera).

      

The project used in this chapter

The drawing shown on the previous page corresponds to the MPC.tvp project which will be taken 
as a basis to study the multi plane camera effect.
Here, you have the corresponding timeline: 

    

Layer where the effect is applied

Layer «character»

Layer «distant trees» (near)

Layer «distant trees» (far)

Layer «forest»

Layer «mountain»

Layers «sky» and «stars» which 
do not move

The layers «mountain», «forest», «distant trees 1», «distant trees 2» and «character» will be used 
to reproduce the desired animation.
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3D views

3D views

This effect has an Open stage button which allows you to view the multiplane camera from various 
angles. These 3D views will make adjustment of settings much easier.

The default settings are as follows:
* A perspective view (window bottom left)
* A left side view (window top left)
* A front view (window top right)
* A top view (window bottom right)

The following buttons are available in each panel to simplify viewing:

* The  button allows you to zoom with a click and slide on the left mouse button.
(shortcut : [alt + right click] + move your mouse.)

* The  button is used for panning with a click and slide on the left mouse button.
(shortcut : [alt + left click] + move your mouse.)

* The  button when selected, ensures the zoom and panning options are only applied to the 
current view.

* The  button is used to reset the view to its default values.

* The  button displays the camera and the «viewing angle»

* The  button displays the focusing plane. In other words, the plane on which the image  is 
focused. This plane is seen as a red dotted line in the left and top views.
The focusing plane is also visible in the perspective and front views in the form of a gray rectangle. 
This will be studied in greater detail at the end of this lesson.
* The  button displays all the planes in the perspective view. (see page #10)

The popup menus of each window allow you to customize your viewing options: left, right, top, 
bottom, front, back, camera and perspective.

The front and back views are not in perspective. If you choose to use 
them, remember that you are viewing the various planes «orthogonally 
projected» on the Oxy plane (see next page).
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Positioning in space

Positioning in space

Of course, we will not be working in the same way as with a 3D software, but it is still important to 
know your position in space when working with this effect.

Compliant with the diagram below :

* The crosses visible on the 3D view represent the coordinate point (X=0, Y=0, Z=0) which will be 
used as our reference point when positioning our camera and objects (mountain, forest, etc.).

* The indications X+, Y+ and Z+ indicate the direction of the orientation of the camera in space.

The View tab

The coordinates X, Y and Z of the Camera are in fact the coordinates of the virtual camera filming 
our scene in accordance with the space dimension described in the chapter above.

If, for example, you change the Z coordinate from 1000 to 1500 units using the mini-slider, the 
center of the camera will be moved further away and the image you see will be changed 
accordingly. 
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 The multiplane camera effect has two tabs:

* The View tab relative to the camera and its setting 
parameters

* The Planes tab relative to superimposed planes 
making up the final animation.



The View tab

It is possible to move the camera directly from the window of your choice in the 3D 
viewing mode: simply click and slide with the left mouse button on the gray line or on 
the camera icon.

* The Angle and Rotation parameters rotate the camera around the Z axis (To simplify matters, 
these two parameters are not taken into account in the 3D view).

 >> 
* The Field of view parameter represents the camera viewing angle.
The wider the angle, the greater the number of objects illustrated on the screen.

 >> 
Wide field of view                                                       Narrow field of view

* The Depth of Field effect and Focusing Distance parameters will be discussed at the end of this 
lesson.

The Planes tab

Now that you have placed your camera in space and chosen a viewing angle, we will now place 
our planes one at a time using the Planes tab.
If you have not used the Wizard, this tab is empty.
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The Planes tab

       

The Planes popup menu is used to create, rename, duplicate or delete planes. The header of this 
menu contains the name of the plane for which the options are displayed in the panel.

Create an animation with the multiplane camera effect, part 1

* Begin by loading the project «MPC.tvp»
* Go to the «multi plane camera» layer
* Open the FX stack and delete its content
* Select the Multi plane camera effect in the Add FX menu 
In the View tab :
* Set the camera position parameter to (X=0, Y=0, Z=1000) and leave the angle at 0°
* Select a field of view of 30°, a Depth of Field effect 0 and focusing distance 1000.
In the Planes tab :
* Create a new plane and name it «character». A panel similar to that indicated below will appear.

  

At this point, you must:

* Choose a Source image to create the plane. 

As was the case for the Keyframer effect, the source 
may be of various types (project, layer, paper, spare 
image, etc...) and you may set the pre-, post- behavior, 
animation mode settings, etc...

We will select the «running kid» layer for our project.

* Choose a tile mode: Choose « none » in tile mode for 
our running kid.

* Set the Pivot and Position parameters. These 
parameters have the same functions as those discussed 
in the Keyframer effect, but don't worry, we will be taking 
another close look at them.
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The Position, Pivot and Size parameters

The Position, Pivot and Size parameters

* When the Pivot parameter is zero, the Position parameter represents the distance between the 
coordinate point (X=0, Y=0 and Z=0) and the center of the source image chosen.

* The Pivot parameter allows you to use a reference point other than the center of the source 
image to adjust the position and size of your plane. 
This is very useful when you decide to modify the Size of your source image: Size modifications 
use this pivot point as origin point (below in orange).

                                 
        Increase a plane's size with pivot at bottom                                Increase a plane's size with pivot centered

Once you have understood this concept, positioning planes becomes much easier. All you have to 
do is:
* Position your pivot,
* Place your plane at the bottom of your project,
* Adjust the size of your plane.

Let's go back to our «running kid» plane and apply the aforementioned procedure using the 
following settings:

* Position parameters : X= 0, Y= 246, Z= 0
* Pivot parameters : X= 0 ,Y= 130
* Size parameters: 75% of initial size

 Create an animation with the multi plane camera effect, part 2

* Now that your position, pivot and size parameters are correctly set, you may, if you wish, modify 
the angle and opacity of your plane as well as adjust the blur to be created with the focusing 
parameter (we will discuss this again later).
It is also possible to select a color mode to be used for drawing the plane (color, tint, add, screen, 
etc…).
For our «running kid» plane, we have chosen Angle zero, Size 75%, Opacity 100% and Blur 100%. 
The Blend mode is Color.
* The HUD color box allows you to choose the HUD color for the current plane. This will help avoid 
any confusion when several planes are present on the screen (we have chosen a reddish orange 
color for our «running kid» plane).
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 Create an animation with the multiplane camera effect, part 3

 Create an animation with the multiplane camera effect, part 3

We just created our first plane named «running kid».
We will now create a second plane «deeper» than the first. To do this:
* Create a new plane and name it «forest».
* Choose the «forest» layer of our project as source.
* Our plane shows the forest located behind the running kid. We must therefore give it a position 
value Z<0 (as our «running kid» plane also has the position value Z=0). In this case we choose Z= 
-1500.
The 3D view is adapted immediately: You will notice that the «forest» plane is green (or any other 
color you may have chosen previously) and «character» plane is orange.

* You may now adjust the Pivot parameter (X=0, Y=210) and the remaining position parameters 
(X=0, Y=850). The plane must then be «stuck to the ground»
* All that is left is to choose the Size (300%).
The « forest » layer was created with the Panning tool in the main panel (refer to lesson 7 for 
further details). You may therefore duplicate it horizontally to avoid having to create too many 
planes. To do this …
* Use the Tile mode popup menu.

      
Without tile mode                                                     With horizontal tile mode 

Now that the second plane has been created, all that remains to be done is create the remaining 
planes in the same way: «close trees», «distant trees», «mountain», with the only difference being 
that the «close trees» plane will have a Z value greater than 0.

If necessary, the FX stack corresponding to the parameters we wish to obtain is 
attached to the MPC.tvp project. You must therefore close it and load it again in 
order to go to the next stage quicker.
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Creating movement: move the camera

Creating movement: move the camera

Do not confuse camera movement and possible changes in the position of your 
planes.
The use of animation keys with plane position parameters is only useful if the latter 

effectively move (if the camera is fixed: mountain, forest and trees are fixed).
In such a case, this method would be justified if we had created an additional plane to 
illustrate movement of the moon in the sky (if the camera is fixed: the moon still makes an 
arc across the starry sky).

Create and manage focusing blurs

During our animation, all the planes seen in the 3D view on the previous page are in focus.
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Now everything is ready to move the camera and 
obtain the desired result.
To do this:

* Return to the View tab,
* Go to the first frame of the «multiplane camera» 
layer in the timeline,
* Create an animation key for the Camera value 
with X = -700,
* Go to the last frame of the «multi plane camera» 
layer in the timeline,
* Create an animation key for the Camera value 
with X = +700,
* Use the Play button in your project window to 
view the result.

That's it!



Create and manage focusing blurs

However, to create a more realistic effect, you may wish to create a camera focusing blur effect 
(refer to page 2 of this lesson, section Focusing blur).

You will therefore have to go back to the View tab and adjust the Focusing distance (i.e. indicate at 
exactly what distance the camera will be focused).
If you have followed all the steps of this lesson, your running kid will be at a distance of 1000 units 
from the camera and your focusing distance is also 1000 units.
The running kid is therefore in focus. In order to blur the other elements (mountain, forest, trees…), 
the Depth of Field parameter will need to be increased (when at 0, no blur is applied).
This is illustrated by the creation of a red cone in the 3D view (see below) and a blur on the screen.

The further the objects are away from the apex of the cone, the more blurred they will be.
Inversely, the closer they are to the apex of the cone, the slighter the blur will be.

If your focusing distance is now 3000, your camera is located at 1000 units from the center point 
and the mountains are 2000 units on the other side of the center point (1000+2000=3000), the 
mountains will be focused and the other planes will be blurred. 

Considering the position of the cone in the 3D diagram, it is also safe to say that the closer the 
camera comes, the more the image will be blurred (see next page).

The focusing plane is also visible in the perspective view and in the front view in the 
form of a gray rectangle. 
In the case of the perspective view, you will see a gray «viewing angle» at the 

focusing distance.
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Create and manage focusing blurs

In the diagram above, the blur is applied to your plane either inside or outside the 
red cone. The width of the cone only indicates the blur amount.

The Blur parameter present on each plane of the Plane tab is used to adjust the blur 
for each plane individually. It is expressed as a percentage of the blur generated by 
the Depth of field effect parameter.

Make the kid run

Now that the various elements of our scenery move correctly and the focusing blur has been 
adjusted, we may, for example, decide to move our red running kid using another animated source 
at the «running kid» plane level.

* You may choose to use the «Running_Kid_1.tvp» sequence studied in lesson 6 by modifying the 
position parameters of the «running kid» plane using animation keys (in this case he is not running 
on the spot).

* You may also use the «Running_Kid_2.tvp» project studied in the same lesson (*). In this case, 
you will probably not need to modify the position parameters with animation keys as the running kid 
moves from left to right.

(*) This project was created using the Keyframer effect with the «Running_Kid_1.tvp» sequence as 
source.
 
The multiplane camera wizard

You have certainly noticed the  button to the right of the Open stage button. This 
button will help you quickly place the various planes in order to create a sequence using the 
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The multiplane camera wizard

Multiplane camera effect. Naturally, it was important to first study the global functions offered by 
this effect before introducing you to the latter function. 
So now click on the Wizard button. The window which then opens asks if Wizard should create 
planes using external projects or from the layers of the current project. These are the 2 most 
common cases. 

Create planes from projects 
Choosing option 1 implies that you have first opened the projects you wish to use for the planes of 
your animation. Ensure the projects you intend to use are open before validating this window. 
Once validated, each project will become a plane in our Multiplane camera effect. The next window 
to appear invites you to stage these planes. This staging may be adapted to meet your specific 
needs. 
This is how the window looks: 
The animation plane is created as the first plane and the other planes are listed in a column below 
it. Each plane has a check box which allows you to choose whether or not this plane should be 
used in your animation. The planes order is inverted compared to the order in which you opened 
your projects (the last project opened is the first plane, the first project opened will be the last 
plane). You will have noticed that each plane has a Z axis position value. With the default settings, 
each plane is given a Z value which is a multiple of -100: 0 for the first plane, -100 for the second, 
-200 for the third, etc... Therefore, all you have to do is define the Z values for each plane as you 
require and then validate your choice. All your planes will then be incorporated into the effect with 
the Z values defined above and all that remains is for you to animate them.

Create planes from the layers of your current project
Assuming the project MPC.tvp supplied on the CD is open, check the «layers from current project» 
box and then validate your choice. 
The Wizard will then take each of the layers of the current project and incorporate them in each 
layer as a plane. The planes staging window, corresponding to stage 2, appears and displays each 
layer with the associated Z value: 

In this window, you have the possibility to define whether or not each plane is to be enabled 
together with the customized Z axis position value (or not) for each plane.
You may also modify the HUD color.
Now all that remains is to click on OK and the Wizard will automatically create all your planes using 
the layers.
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Other situations

Other situations

We have now learned how to use the multi plane camera effect with a simple example.
Our Multiplane camera effect may also be used in other situations:
Below  you will see the transversal movement of the two planets with a fixed sun and Lens Flare 
effect (it will be studied in the next lesson).

 >  > 

The multiplane camera can also be used to zoom between the planes you have created :
* After you have created the planes with the wizard, go in the View tab and on the first frame of the 
«multi plane camera» layer in the timeline.
* Create an animation key for the Camera  with a negative value for the Z axis.
* Go to the last frame of the «multi plane camera» layer in the timeline, create another animation 
key for the Camera with a positive value for the Z axis,
* Apply the FX-Stack to the whole layer.
* Use the Play button in your project window to view the result : the first planes should disappear 
smoothly as shown in the exemple below.

    >>   >>

   >>    >>  

Now you try it!
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Lesson 16

The effects of the Rendering group

In this lesson, you will:

● Study the rendering effects relative to the light : Lens-Flare, Volumetric Light, 
Healing Tracker, ...

● Study the rendering effects relative to the text : Simple text, Multiline text,  
Time Code Generator, ...

Note : The Particle Generator effect will be the main subject of the 17th lesson.

 



The Rendering > Lens Flare effect 

The Rendering > Lens Flare effect 

   
The Lens Flare is an over-illumination effect seen through an optical lens.
Generally encountered in the world of photography, it occurs when the image framed is 
excessively illuminated and when a non adequate lens is used.
Several types of lens flare are encountered: ring, streaks, circles, … 
They are located along the straight line from the light source to the camera lens used. Sometimes 
the lens-flare effect obtained takes the shape of blades used as the lens diaphragm (see drawing 
below).

  >         
Diagram of a camera with a                Examples of the resulting            Photo with a true Lens Flare effect 

        6-blade diaphragm                          Lens Flare effect (hexagonal effects)

The larger the lens, the more the Lens Flares will be visible and the size is proportional to this lens 
(when using the zoom, for example).
We will now take a closer look at the various options proposed for this effect in order to allow you 
to obtain results similar to those illustrated in the image above.
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The Rendering > Lens Flare effect 

When you choose the Lens-Flare effect in the Rendering effects menu, the first parameter to be 
entered is the Position of the light source and the lens.
The first four numeric fields are used to adjust these positions.

The Lens radius is measured in pixels and is used as a reference for the size of future light 
interference effects you wish to create (ring, streaks, circles...).
The Luminosity parameter controls the luminosity of all light interference visible on the screen.

           

The Lens Flare popup menu creates various types of lens flare effects: they may be of the 
Generic, Streaks or Image type.
It is also possible to rename, duplicate or delete these effects at your convenience.

   

• Lens Flares of the generic type

 

- Change the Size of the Lens Flare: this value is a percentage of the lens size (the size that you 
have implicitly chosen when setting the lens radius).

- Change the Offset of the Lens Flare : in other words, modify the position of the lens flare in 
relation to the center of the lens and light source.

An offset of 0 places your Lens Flare at the same level as the light source.
An offset of 1 places the effect at the same level as the lens center.
An offset of 0.5 places your Lens Flare in the middle of the two aforementioned points.
It is also possible to use a negative offset or an offset greater than 1.

-  Choose single-color or gradient color artifacts (see below).
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Once a type of lens flare has been created, its name appears in 
the Lens Flare popup menu.

In the header of this menu you will find the name of the lens flare 
the parameters of which are visible on the screen.

Here are the various Lens Flare parameters of 
the generic type.

You may:

The position of the light source, lens and lens radius may also be adjusted with the 
HUD 



The Rendering > Lens Flare effect 

   

- Modify the profile of your artifact using the profile curve.
This effect is constructed in the same way as we have already seen in lesson 2. Correctly setting 
the profile parameters is essential if exceptional results are to be obtained (see examples below).

      

  

   

The Blade mode indicated above enables adjustment of all Lens Flares of the generic type 
according to the diaphragm blades of your virtual camera (see diagrams on page 2 of this lesson).
It is very important to set its parameters correctly if realistic results are to be obtained.

You may choose a Blade mode of the Circle type (images above) or a user defined Blade mode 
(see next page).
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The Rendering > Lens Flare effect 

 - You may choose the Blade count for your virtual camera lens (see examples below, based on 
the various profiles described above).

- You may modify the Form factor:
With a factor of 0, the points are linked to form a circle.
With a factor of 1, the points are linked by straight segments.
With a factor of 2, the points are linked by incoming arcs.

- You may modify the Angle of your lens flares:
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From left to right: 

The lens diaphragm of your camera is circular, 
with three blades, five blades and seven blades.

From left to right: 

Form factors 2, 1, 0.5 and 0.

From left to right: 

Angles  0°, -15°, -30°, -45°, -60°, 
-75°.

 When required, each Lens Flare of the generic type may 
be given its own Blades mode different from the Global 
blades mode described above. 

The latter is located at the bottom of the generic Lens Flare 
parameters and offers the same options. 



The Rendering > Lens Flare effect 

• Streak type Lens Flares 

- The Angle and Rotation parameters are used to rotate light interference effects.

   

- The Spokes parameter is used to select the number of spokes in the streaks

 

- The Minimum parameter is used to adjust the contrast between the spokes.
If this parameter is set to 0, maximum contrast is obtained.
If this parameter is set to 1, minimum contrast is obtained .

- The Noise parameter is used to adjust the sharpness of the spokes:
If this parameter is set to 0, the  spokes are less sharp.
If this parameter is set to 1, the  spokes are more sharp.

- The Seed parameter is used to randomly vary the streaks layout.
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Even if the Lens Flares of the Streaks type offer a 
completely different effect than the Generic lens 
Flares  (see examples below), the parameters are 
nonetheless quite similar. 
You may therefore set the Size, Offset, Color(s) 
and Profile in the same way as described on the 
previous pages.

There are, however, several specific options 
which we will now take a closer look at :

(opposite from left to right  with 
contrast values 1, 0.5 and 0)

(opposite from left to right the 
Spoke parameter with the values 
200, 50, and 20)

(opposite from left to right with 
noise values 1, 0.5 and 0)



The Rendering > Lens Flare effect 

• Lens Flares of the Image type

Lens Flares of the Image type allow, as the name implies, selection of the image of your choice to 
create a lens flare.
* This image, referred to as source image, may be a default image, a project displayed on the 
screen or even a file for which the access path must be given.
* You may set the Size, Offset and Angle parameters as indicated for the lens flares discussed 
previously.
* Your image will be applied as a lens flare on the current layer. This is possible in the various 
Drawing modes (color, behind, erase, etc.) studied in lesson 2.

• The Render order for lens flares

The Render order popup menu offers the following four options :
* Creation: your light artifacts are calculated and drawn by the program in the order they were 
created (i.e. as they appear in the lens-flare popup menu, from top to bottom).
* Invert. creation: your light artifacts are calculated and drawn by the program in the inverted order 
of creation (in the lens-flare popup menu, from bottom to top).
* Lens to light: your light artifacts are calculated and drawn by the program according to their offset 
in the direction Lens => Light.
* Light to lens: your light artifacts are calculated and drawn by the program according to their offset 
in the direction Light => Lens.

Take the image type artifacts illustrated below, for example.
Based on their position in the Lens Flare popup menu opposite, they were created in the following 
order: blue, then green, then red. 
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Combined use of several types of lens flares and light 
interference applied to the same point in your project 
may create a very realistic effect.

Opposite you will see two generic lens flares and one 
streaked lens flare to create a sun surrounded by a light halo.



The Rendering > Lens Flare effect 

Here you have the effect obtained (for application in color mode) in the various cases:

       
   Creation                                 Inverted creation                  Light to lens                          Lens to light       

• The Lens Flare Obscuration layer 

Let's assume our drawing is animated as indicated below:
When the planet moves and the sun becomes visible, the Lens Flare effect becomes visible at the 
same time.

 >>  >>  

In general, if an object of any kind passes in front of the 
light source, the lens flare tends to disappear.

The Obscuration layer parameters above allow you to manage this phenomenon.

* To do this, you must first define what is going to block the light source. This may be an image or 
animation in a layer, project, brush, etc... (Pre, Post Behavior, Animation Mode, Position will also 
be defined if necessary).

* The Type of obscuration to take place when the effect is applied must be indicated here:
- The Alpha option will block the lens flare when an opaque object passes in front of the light 
source.
- The Invert alpha option will block the lens flare when a transparent object passes in front of the 
light source.
- The R.G.B option will modify the lens flare color so that it becomes identical to that of the object 
passing in front of the light source.
- The R.G.B + A option functions in the same way as the R.G.B option but also takes into account 
the opacity of the pixels in the same way as the Alpha option. 

* We generally obtain a Lens Flare effect when the lens of your camera is pointed towards a very 
small and very bright light source.
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The Rendering > Lighting effect

The Rendering > Lighting effect

  >    
This effect is used to light up the image or sequence of your choice as if using an exterior light 
source  (light, projector…).

By default, nothing is present in the list. The Lights menu may be used to create one or several 
lighting effects among the following categories: Spot, Omni and Ambient.
As soon as a lighting effect is created, you may duplicate, delete or rename it. 

The Lights menu displays the name of the light whose parameters are shown in the stack. If you 
work with several lights you may go from one to the other by selecting their names in the Lights 
menu.
Here an overview of the different lighting types:

* Omni  lighting lights up  a circular area of your choice similar to a projector located on an axis 
perpendicular to the image. The parameters to be set are color, lighting intensity, center and radius 
of the circular area, as well as altitude of the virtual projector.

          

 Omni projector diagram                     Omni HUD                                 Omni  lighting         

The effects of the Rendering group                                         16-9

*  Ambient lighting lights up the scene globally in the color 
of your choice. Values under 100% will darken the image, 
values higher than 100% will brighten it. 



The Rendering > Lighting effect

* Spot lighting lights up the image similar to a tilted projector. Two position parameters are 
available for this mode, which allow you to adjust the position of the light source as well as its 
direction.

          

Spot projector diagram                     Spot HUD                                 Spot  lighting          

Spot and Omni lighting have a profile editor which works similarly to that of the drawing tools  (see 
lesson 2 for more details).

           
Omni                                          Spot                                           profile
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With the Light popup menu it is possible to 
use several light sources (regardless of 
type), as well as to rename, duplicate or 
delete them.

This is how our cave may be lit up in 
various ways !

This Lighting effect only applies to the opaque pixels of the current layer. To 
obtain the examples above it is therefore necessary to first merge the layers of 
our project.

For many of the parameters described above, the settings may be made 
directly on the screen (don't forget to display the HUD).



The Rendering > Volumetric Light effect

The Rendering > Volumetric Light effect

   

 

 

 

 

 

 
* You can also define one of the various blend mode for this color through the Blend menu. 

 

* The Channel menu gives several others possibilities :

Invert Alpha : Lighting comes from the image opaque pixels (see below for example).
Alpha : Lighting comes from image transparent pixels : that's what's happening in the example 
above. 
Luminosity : The more luminous a pixel is, the more lightrays it will let go.
Red, Green, Blue : The more red (or green, or blue) component a pixel has, the more lightrays will 
go through it.
In the source image on the left below, only the sky and the green tree will emit lightrays when the 
blue channel option is selected.  (The green tree color is partially composed of blue.)
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The Volumetric Light effect is in the same category as the 
Lighting effect but it works in a different way :

In this effect, the light source is located under the current 
layer and it gives the impression of volume to the light.

The substitute mode is only available in this menu, erasing 
the source image pixels (nearby a white opaque logo on a 
transparent layer with a black background.)

Here is an example : 

Create a new project et fill the current image with an 
opaque black color.

Set the background as Color in the Timeline. The 
background has to be white.

Now put a TVPaint Animation Pro logo in Erase mode on 
this Image layer with the TextBrush tool, then change this 
layer to an Anim layer with about  twenty images.

Make the Center setting move along a path from left to 
right.
You should get an animation similar to the one like the 
image sequence on the left.

* The Volumetric Light effect requires to adjust the 
position setting of the light source and possibly its Path, 
its Power and its Length.

* You can also define the light color, use a color gradient 
(like in the example on the left) or even have a color that 
depends on the source image. You can select one of 
these options in the Color Source menu.



The Rendering > Volumetric Light effect

    
                  Source Image                                                      Luma channel

     
                  Invert Alpha channel                                           Blue channel

                         

* The Shimmer section permits to generate interferences in the Volumetric light :
The Size setting is used to manage the distribution of these interferences. 
The Angle and Rotation make these interferences pivot and can give the feeling that the 
lightsource is rotating.
The Variation setting accents the contrast between rays.

           
Without Shimmer                                                           With Shimmer       

The Mask section allows you to limit the lighting in a circle whose radius has 
to be defined.
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The Rendering > RotoTracking effect 

The Rendering > RotoTracking effect 

• Presentation and concept

The RotoTracking effect is first of all a cut-out effect like the Chromakey, Colorkey or Lumakey 
effect. It can also be used to animate drawings in way comparable to those you can encounter in 
vector based animation softwares.

Here is the principle of this effect : the RotoTracking use one or several closed splines (called B-
splines) and allow you to change their shape in time, thanks to the key system of the FX-stack.
Once the effect is applied, the area inside or outside the spline becomes transparent.

• Two examples

This effect is very usefull when the other keying effects are unable to cut-out a picture or a movie 
sequence properly.
On the picture below, we see a red squirrel walking on red and brown leaves. As the leaves colors 
are very close to the squirrel color, the common keying effects will not allow you to cut-out the 
squirrel correctly. In that case, it is advised to use the rototracking effect 

        
  Original picture                                                     

   >   
  RotoTracking spline                                                       Applied result

The RotoTracking allows also to draw and animate quickly. The control points of the spline can 
evolve softly from a position to another one. As a consequence, the shape of the whole spline will 
evolve in time too.
In the example above, a dolphin has been drawn with the rototracking effect.
The control points are colored in red and the B-spline itself is colored in yellow.
Every key dot can be animated in time. So it is for the whole spline and thus the dolphin.
He can for example move his tail to swim.
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The Rendering > RotoTracking effect 

      
          RotoTracking B-splines created for the first and the last image of the animation layer.

      
       Resulting pictures once the effect is applied.

 Resulting animation once the effect is played.

• The control panel

Let's now study the control panel in detail :
Here is the control panel as it appears when you add the Rototracking  effect in the FX-stack. (see 
below)
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Here is the main difference between the rototracking and a simple selection 
created with the main panel tools :
Our B-splines can evolve and change their shape in time.



The Rendering > RotoTracking effect 

    

To close the spline that you just began to 
draw, you only have to click on the first point 
displayed on the screen.

Do you remind Bézier splines ? We encountered them in lesson 2 when we studied 
the drawing tools. B-splines and Bézier splines are mathematically linked.
Try not to confuse those two kind of splines : Bézier splines go through their control 

points while B-splines don't.

• Managing the opacity

Once the B-spline is closed, the opacity of the pixel area outside the spline becomes transparent 
after applying the effect. The pixel area inside the spline stay the same.

This being the case, the two opacity parameters allows you to modify the opacity of any of those 
two areas.
The numeric field on the top of the control panel allows you to set the opacity of the pixel area 
inside the B-spline. The numeric field on the bottom of the panel allows you to set the opacity of 
the pixel area outside the B-spline.
The invert button allows you to invert the effect : the area of pixels outside the B-spline will remain 
unchanged while the area of pixels inside the B-spline will become transparent.

      
                               Normal                                     With the invert button checked      
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At the top of the panel, the Spline popup menu is used to 
create, rename, duplicate or delete B-splines.
Once a first B-spline is created, some new buttons and 
menus appear. (The Point and Blending Mode menus)

The effect can use several B-splines at the same time. 
The header of the menu contains the name of the B-spline 
for which the options are displayed in the panel.

Enable the Head Up Display and check the Preview boxes of 
your FX-stack. Once the first point is drawn on the project 
window, new parameters related to the points drawn in the 
screen appear (position, edge, sharp)



The Rendering > RotoTracking effect 

     
  First opacity parameters set to 50%            Second opacity parameters set to 50%

• Let's now study the icons under the spline popup menu.

From left to right :

   The first icon allows you to place the control points of your B-spline at your convenience.
This icon is selected by default each time you create a new B-spline.
You only have to use the left mouse button on the project window to lay your control points.
Once a control point is created, the point menu displays its number and its coordinates.  (see 
below)

If you need to re-open a closed B-spline, you only have to select the « » icon : 
again.

  This second icon allows to move a control point interactively on the project window. (don't 
forget to display the HUD). To do this, just click and drag the control point.

This may also be done by using the numeric fields and associated mini-sliders shown above.

By clicking on the little padlock buttons, it is possible to « lock » your control points in space 
so that they cannot be moved along the axis (or axes) of your choice. This enables, in 
particular, avoiding untimely movement.

The locked points may be subject to animation keys and intermediate points in time may be 
created from the locked points.

The animation keys influence the position of the points in time and not in space.
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It is also possible to move several points at the same time :
To do this, simply use your left mouse button to draw a 
rectangle while pressing the [Ctrl] key. You will then be 
able to move at the same time all the points located in the 
rectangular area.



The Rendering > RotoTracking effect 

  The fourth icon allows to delete the control points of your B-spline. You only need to use the 
left mouse button on the point of your choice to do so.

  The fifth icon allows to modify the value of the edge of a point.
To do so, you only have to select this icon and drag'n drop a control point of your spline.
You can also use the numerical field of the edge parameter. (see below)

Modifying the edge parameter for a control point allows to change the frontier that the B-spline 
define.
An opacity gradient will follow the B-spline (see below). This is very convenient to cut a picture 
more softly (as the tail of the squirrel below)
The positive values create an opacity gradient outside the B-spline and the negatives values create 
opacity gradients inside the B-spline.

                
  Edge parameter equal to 0       Edge parameter negative        Edge parameter positive

  

  The sixth icon allows you to adjust the sharpness of each point. (the numeric field and the 
associated mini-slider can replace the interactive HUD)
Modify the sharpness is like changing the distance between the spline and the selected control 
point.
A value of 100 for the sharpness parameter will turn the spline into a pointed one.
The B-spline will follow the angle given by the vertex. (see below)
This allows you to adjust the curvature of the B-spline
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  The third icon allows to add new control points on the B-spline. Once 
activated, you will note that if you drag your mouse near the B-spline, a small 
cross appears. (see below) It means that you can create a new control point.

Once the edge parameter is changed, the HUD 
shows a blue spline. The opacity gradient is located 
between the yellow and the blue spline and follow the 
shape of those two splines.

On the opposite screenshot, the edge parameters was used to 
cut out the tail of the squirrel.



The Rendering > RotoTracking effect 

         

On the left picture, the sharpness 
parameter of the right-top point of the 
spline is set to 0.

On the right picture, the sharpness 
parameter of the right-top point of the 
spline is set to 100.

 The seventh and last icon turn on the display of a control box which allows to do a lot of 
modifications directly on the project window (see below)
You may contract, stretch, rotate or translate the current B-spline as a whole by using the handle of 
the box. (don't forget to activate the HUD) 

      

• The master controllers

    

You could find annoying to create animation keys for 
every spline and every point of a spline. (for example, a 
five points spline need almost  30 animation keys to be 
created if you want to move it from a place to another 
one.)
That's the reason why the animation key controllers have 
been added in the panel. They are black encircled in the 
picture opposite.

 

The animation key controller near the spline popup menu allows you to create an animation key for 
each parameter of the spline : points, opacity, ... by using only one mouse click.

The animation key controller near the points popup menu allows you to create an animation key for 
each parameter of the point : position, sharpness, edge, ... by using only one mouse click.

• Working with several B-splines

It is possible to use several B-splines.
To create a new B-spline, proceed in this way :

– Select New B-spline in the popup menu
– Display the HUD and check the preview box
– add control points on the screen and close the B-spline.
– set the position, edge and sharpness parameters for each points.
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Use the [Shift] key with a drag action to translate the whole B-Spline



The Rendering > RotoTracking effect 

• The blending modes

The last popup menu of the RotoTracking effect panel is called blending mode.It is usefull when 
you manage more than one B-spline
If you use two splines (this is also true for more than two splines) :
– The add mode will add the opacity of the two area of pixels.
– The sub mode will substract the opacity of the current shape from the second one.

         

         

• Some ideas to make your B-spline move on the screen

Let's take a common B-spline.
The coordinates x and y of a control point define its position on the screen.
Three options are available in the interpolation menu : spline, linear or polynomial. This affects the 
path of the control point in time.
If you use the tool menu, its coordinates may follow the path of your choice. You should of course 
use the pixel recorder, pixel tracker, etc ... which constitute an excellent way to manage the 
movement of control points in time.

Once the effect is applied, its shape and parameters will go from a location to another one.

The effects of the Rendering group                                         16-19

In those two last examples, the edge and sharpness parameters are taken into 
account.



The Rendering > RotoTracking effect 

The Rendering  > Healing Tracker effect

Maybe you recorded a video sequence which contains some faults : it could be a micro boom, a 
floor lamp or the vapor trail of a plane.
Any modifications to the video-sequence require a lot of work : each frame has to be corrected 
separately. Most often, you need to remove the unwanted areas of the sequence and finally you 
have to replace them one by one.

The Rendering > Healing Tracker effect allows you to apply this kind of correction really quickly :
It combines the use of the Healing mode (studied in lesson 7) and the B-spline notion encountered 
in the Rendering > Rototracking Effect chapter.

    

The Healing Tracker panel appears as illustrated 
opposite :
In the first section, several choices are available for the 
source image or footage needed for the healing mode. 
(FX-stack, current layer, display, paper, current brush, 
other project, ...)
When choosing another animated source, you may 
adjust the Pre- and Post-Behavior, the position and the 
animation mode (random animation, ping-pong, 
animation reduced to the image indicated in the position 
parameter, etc.)
As required, you may choose to flip your source 
vertically, horizontally or both, before using this source. 
(see lesson 12 for more details)

In the second section, you can manage your B-splines. 
This has been explained in detail in the Rendering > 
Rototracking Effect chapter.

Here is how it works :
on the image below, an unwanted floor lamp is visible. This effect will apply the healing mode 
inside the B-spline surrounding the floor lamp. So the floor lamp will disappear.
The healing source area can be recognized by its unique centered handle (the HUD should be 
enabled)

  >     
Note that the distance (offset) between the healing source area and the destination area of the 
effect (inside of the B-spline) can be modified in time by using the animation keys.
Thoses two areas have always the same shape for a given image of the footage.
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The Rendering > RotoTracking effect 

Take a look now at the video footage below : a plane is flying slowly in the sky, over the sea.

   >> 
  1st image of the footage                                                Last image of the footage

      
       Attached timeline

We will now examine in more detail how to suppress the vapor trail of the plane.
* Firstly, begin by selecting FX-stack as source sequence of the Healing Tracker effect.
* On the first frame of the footage, create a B-spline surrounding the vapor trail.
* Use the animation key controllers on the right of the spline menu to create a set of keys for each 
point of your B-spline.
* On the last image of the footage, change the shape of your B-spline in order to make it surround 
the extended vapor trail.
* Use again the animation key controllers on your modified B-spline.
* Move carrefully the healing source area by using the HUD : the vapor trail should not be visible 
anymore.
* If you slide along the timeline with the preview mode enabled in your FX-stack, the shape of your 
B-spline should progressively change.
* Then, you only have to select all the images of your layer and to apply the effect.

   >>  
    1st image of the footage                 (FX-stack preview enabled )                 last image of the footage
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The Rendering > RotoTracking effect 

It is also possible to suppress the clouds at the bottom of the footage :
In order to have a good result, the healing source area needs to be an even section of the screen, 
without clouds.

   >
  
Some other spectacular renderings can be obtained if you use another project as source in the 
healing tracker effect. With some training, you should be able to obtain those results :

         
        The healing source project                                   The picture on which the effect will be applied

         
          Above, one of the two B-splines we used.             Here is the final result :
                                                                                             The sea has been replaced by the clouds

The use of the edge parameter for the points of your B-spline is sometimes useful 
to have better results.
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The Rendering > Background Generator effect

The Rendering > Background Generator effect

The Background generator effect is used to create horizontal, vertical or four corner color 
gradients. These gradients are applied to the current image as described in lesson 2.
You may choose any color you like as well as the opacity and then have them change with time by 
creating animation keys.
Below, you will find four examples of gradients used in Color, Add, Tint or Subtract  mode.
It is also possible to change the colors of clouds, planet, or even place the planet within a bluish 
atmosphere…

                
     Source image                                        Gradient  in Color  mode                      Gradient applied in Colorize  mode

                
     Source image                                        Gradient  in Color  mode                      Gradient applied in Add  mode

          
    Source image                                         Gradient  in Color  mode                     Gradient applied in Tint  mode

          
    Source image                                         Gradient  in Color  mode                    Gradient applied in Subtract  mode
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The Rendering > Plasma effect

The Rendering > Plasma effect

The Rendering > Plasma effect is similar to the Wave effect because they produce both circles. 
However, this effect produces multicolored waves and can be adjusted with several parameters :

* The Linear 1, Linear 2 or the Smooth option in the Generator menu in the settings panel modifies 
the profile of the generated wave's shape (look at the examples below).

     
* It is possible to work with one, two, three or four circles (see below).

     

* You can choose the way these waves will mix together. Below you can find the modes :

          
    Add                                Sub                                 Multiply                           Divide

          
     Maximum                         Minimum                         Average                          Différence

 
     Distance

* Finally, some settings related to color channels are also available : Global phase, Red phase, 
Green phase, Blue phase and Alpha phase.
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The Rendering > Plasma effect

      

The Rendering > Perlin Noise effect
This effect generates shapes thanks to mathematical functions and is sometimes used to imitates 
water waves and other water effects.

            
You can : 
* adjust Width and Height of the generated shapes,
* mix these shapes to the current image thanks to the Colorize, Tint, Multiply (,...) modes,
* use a picked color, a gradient or the color from the current image,
* change the complexity of the shapes thanks to the Octave setting,
* Invert the effect colors or change its Opacity.

          
 Octave = 1                                           Octave = 2                                           Octave = 5

The Rendering > Text effect

We saw in lesson 5 how to create a Text Brush using 
the Text tool from the tool panel.
The Rendering > Text effect should not disorientate 
you. 
* The Text field is where you have to type the text, 
* The Font menu allows you to change the font,
* You already know the various settings like Size, Size 
X, Spacing, Italic, Tracking and Angle. However, these 
values can be keyframed now (which cannot be done 
with the simple Text Brush tool).
So you can make a text going bigger and bigger, make 
it switch to italic, or make the spacing change, etc... or 
all at the same time !

Let's take a look to the new settings : 

* You can make the text follow a path thanks to the Position settings (with a stored path or 
graphically through the HUD).
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The Rendering > Text effect

* The Angle setting permits to adjust the angle made by the text (in relation to the horizontal line), 
* The Rotation setting can increase the Angle value with a multiple of 360,
* The Align menu allows you to change the position of the HUD text handle : right, left, centered.

There are still 3 tabs left : 

* The Font tab manage the pixels of the text itself

     

* The borders tab manage the pixels of the borders of the text : you can adjust de thickness of the 
border).

      

* The Shadow tab can create a shadow for the text : the Angle and Distance settings give the 
position of the shadow). 

      

In each tab, blur settings can be adjusted and there are three filling types available : 

* fill with a picked color (you will be able to change its opacity). See the first example of this page

* fill with a color gradient (you will be able to adjust its angle).

      
* fill with a texture you will have to define (current image, spare image, brush, paper, etc...).
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The Rendering > Text effect

      

The Rendering > Multiline Text effect

 

After this choice, your text is displayed on the screen. Two kind of H.U.D are available for this 
effect. The parameters directly adjustable on the screen depends on the H.U.D selected :
* angle, size and position on the screen for the position H.U.D
* the text itself for the text H.U.D

      
  The position HUD                                    The text HUD

Several kinds of HUD handle alignments are available by using the nine buttons below :
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TVPaint Animation Pro can use non-occidental fonts like chinese, japanese, 
arabic fonts, ...

The effect Rendering > Multiline-Text is the most 
important titling tool of TVPaint Animation Pro.

The first thing to do when using this effect is import 
text lines. To do this you may :
* use text lines stored in an ascii .txt files
* use text lines stored in your clipboard.
(for example, if you have cut or copied some text from 
another software)



The Rendering > Multiline Text effect

Your text lines may be horizontally centered, left justified or right justified.

       

Your text lines may be vertically centered, top or bottom justified. (here below the text was firstly 
rotated at 90°)

         

The three last buttons allow you to set the horizontal and/or vertical offset between the text lines.
Note that the unit is the pixel. (It is also possible to use negative numbers of pixels.)

      

It is possible to set or animate each line of the whole text by using the same method than 
encountered in the Rendering > simple text effect. The framed area of the FX-stack below shows 
the font, position, border, shadow ... parameters discussed in the previous chapter.

At the top of the panel, the line popup menu is used to create, rename, duplicate or delete lines.
The header of the menu contains the name of the line for which the options are displayed in the 
panel.
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The Rendering > Multiline Text effect

It is possible to create animation keys for all parameters of every line by using the 
control key located next to the line popup menu.

Let's now study the animation popup menu :
* The roll option allows you to move your text lines from the bottom to the top of the project 
window.
* The crawl option allows you to move your text lines from the left to the right of the project window.
The progress of those options can be set by using the position parameter.
The extreme values : 0% and 100% makes the text lines disappear from the screen.
A value of 50% corresponds to the initial position of the text lines on the the project window.

The Rendering > Time Code Generator effect

           

This effect displays the time code of the current image in the current layer at the position of your 
choice.
Three modes are available:
* Current project mode duplicates the timeline data in number of frames or time code depending on 
the selections made (Frame or Time Code refer to lesson 4).
* Free run mode is used to define the parameters to be taken into account for the entire current 
layer independent of the timeline: You must therefore specify the position of the first frame, the 
number of frames per second and the display (frame or time code in hours, minutes, seconds and 
frame number). The Invert option is used to create a count-down effect.
* User defined mode works in the same way as Free run mode with the simple difference that all 
frames of the layer have independently set parameters thanks to the use of the animation key 
system.

Regardless of the mode chosen, the second section of the panel enables:
* selection of the Font of your choice,
* Size variation,
* setting of Position parameters for the current project,
* modification of font and background Color and Alpha.

The effects of the Rendering group                                         16-29



The Rendering > Time Code Generator effect

    

Opposite, an example of an application 
with the current frame number in black with 
a gray background.

The Rendering > Pattern Generator effect

   

The Rendering > Pattern Generator effect allows 
to display the classical video patterns on screen :

              
                Bar 100                              Bar 75    

                    
Bar + pluge                        Bar + red                               Bar SMTPE

                    
Grey step 10                     Grey step 5                           Grey ramp

16-30                                                                                                            The effects of the Rendering group







Lesson 17

The Rendering > Particles Generator effect

In this lesson, you will learn:

● To create a particles system.

● To modify a particles system.

● To use a particles system in order to add special effects to your videos or put 
the finishing touches to your animations.



Presentation and concept

Presentation and concept

Let's take the following elements into consideration: fog, smoke, fireworks, snow, fountains, 
sunshine, a tennis ball bouncing off the ground.
These natural phenomena and other objects taken from daily life don't seem to have anything in 
common except maybe that a lot of time is required to make a successful and correct animation of 
them.

      

Let's study them more closely:
- Fog and fountain are made of fine water droplets: they are suspended in the air and more or less 
opaque in the case of the fog; they are projected into the air by a source and fall back with the 
force of gravity in the case of the fountain.
- Sun and fireworks are respectively composed of helium, hydrogen and various chemical 
products. The latter are concentrated in a ball for the sun or expelled into the atmosphere in the 
case of fireworks.
- Smoke is also composed of various chemical products, generating different types of smoke. As it 
is very light it is not subject to the force of gravity and moves with the wind. The tennis ball, 
however, bounces several times before coming to a standstill and the wind has little influence on it.

In each case, we deal with « particles » in the broader sense of the word: water droplets, chemical 
products, tennis ball, etc. These particles move and are affected by the force of gravity, the power 
of wind or air resistance, etc. They may bounce or come from several places at once. 
The place or places where the particles come from are referred to as «emitters ».

TVPaint Animation Pro does not only make it possible to draw such particles but also to manage 
their movement using the parameters described previously. This offers considerable time saving 
when creating animations and other special effects (drawing and animating the particles one after 
the other would require months of work…).

You have understood already that it is the effect referred to as Rendering > Particles Generator 
which will help us succeed in this matter.

Learn by example

You will very quickly notice that the particles generator is an effect which offers a wide range of 
options.

Generally, you need to learn how to set :
* the parameters of the world (or universe) in which the particles will move: wind, gravity, 
collision…
* The parameters of the particle emitter(s): movement, angle, rotation… 
* The particle parameters: life span, velocity, number, opacity… 

The multitude of parameters is so vast that it may discourage the beginner. For this reason and for 
didactic purposes, numerous pre-defined examples have been included in this program to help you 
master this powerful drawing tool.

Many users use them as a model to introduce the particles into their own creations. These pre-
defined examples, sometimes referred to as presets, are accessible via the Bin FX menu.
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Presentation and concept

Choosing Browse opens a window that is specific to the particles generator (see below). 

 

Two boxes may be checked in order to improve the quality of the particle animation depending on 
the power of your computer: Full Quality and AAliasing.

If a pre-defined example is close to the result you wish to obtain for your project, you may choose 
to set the parameters of the particles generator according to this example. To do this, just click on 
the Copy to FX  button then close the window above. Now you study the example in detail and 
modify it to your needs.
We will come back to this process to illustrate some situations.

The tabs of the   Particles Generator   effect  

The Particles Generator works with various tabs and sub-tabs which are not necessarily all visible 
at first use. 
Below you will find a summary before starting a detailed description:

    

The names in the lower levels are sub-tabs.

For example, the particles tab has two sub tabs : 
Current and Shape.
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In the popup menu you may choose a pre-defined example 
from the following categories: cartoon, misc, nature, objects, 
party, pyrotechnic, sci-fi, text, water. 
(Using the▼ and ▲ buttons you may scroll from one 
example to another.)

When you have chosen an example, its name will appear in 
the header of the popup menu and you may observe the 
changes made to the particle system directly in the window.

The Bin FX menu appears as illustrated opposite:
You are already familiar with the functions Add, Load and Save: they are present 
for each effect available in TVPaint Animation Pro. However, the functions 
Browse and Presets are new.



The tabs of the Particles Generator effect

The World tab

The World tab is used to manage the parameters of the « world » in which our particles will move 
(see below).

Two preview options are offered in the World tab: the Bounding box check box and the Quick 
preview button.

- The Bounding box check box is used to 
display a colored rectangle around the 
particles present in the current project 
window when the preview button of the FX 
stack is enabled.

The particles going out of the project which 
are  susceptible to come back under the 
influence of certain factors (wind, gravity, 
etc.) are also framed.

     
Although this option may render the preview a bit complicated when many 
particles are on the screen, it is very useful to distinguish the position of 
low-opacity particles.

17-4 The Rendering > Particles Generator effect

- The Quick Preview button displays a window very similar to the 
one which allows you to choose a predefined set of particles.

Here, you cannot select a predefined example and any parameter 
modification within your effect will have a direct impact on the 
animation shown to you.



The tabs of the Particles Generator effect

This is very useful to interactively view and modify a particle animation before applying the effect to 
all frames of a layer. 
This button is present in all other tabs and sub-tabs of the particles generator effect.
The Seed parameter is used to generate a random particle emission using calculation algorithms. 
This parameter enables changing the rendering so that two effects which would be identical 
elsewhere are different.

The Gravity parameter is used to take the earth's gravity into consideration during particle 
movement.

                             

- When the gravity is increased to, e.g. a value of 10 , the water 
droplets  will fall to the ground faster, because the distance 
between the emitter (water jet origin) and the drop point is 
shorter.

                

- Decreasing the value to 0.5 will increase the distance traveled 
by the droplets.
The distance between the point where the droplets are emitted 
and the drop point is longer.

      

- When the gravity is set to zero, there is no gravity and the water 
droplets will follow a straight trajectory. 

      

- TVPaint Animation Pro offers the possibility to work with 
negative gravity values, which has the effect that the force of 
gravity may be inverted (the water droplets will then go up).

This is useful in certain cases, for example, to represent metal 
particles drawn by a magnet.
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Select the pre-defined example (water >water jet) and copy 
it to the particles generator (see left).

In this example, our particles are water droplets projected 
from right to left.

Open the quick preview window. We will be able to study 
the influence of the various parameters available in the 
World tab on the movement of the latter.



The tabs of the Particles Generator effect

In order for the force of gravity to have an impact on our particles, it is 
necessary to attribute a Weight to them. We will come back to this when we 
talk about the specific particle parameters.

Let's take a look at the pre-defined example (objects > popcorn):  the popcorn kernels are our 
particles and they move vertically to the top before falling back under their own weight.
The parameters Angle, Rotation and Wind strength allow you to simulate the impact the wind has 
on the particles (see examples below), and to make them more or less move in a direction of your 
choice (wind with a negative value affects the particles in a direction opposite to the one you have 
chosen).

                
Wind = 0                            Wind = 100                                       Wind = - 200                   

Note that using animation keys will allow you, if necessary, to change the direction of the wind in 
time as well as its strength (to avoid creating a wind that is too uniform).

The Alpha Collision menu is similar to the Source tab studied in lesson 14 when using the 
Keyframer. We will not go back to the concepts Source, Pre-Behavior, Animation, Post-Behavior 
and Offset.
There is, however, a functional difference: when the Alpha Collision box is checked, the particles 
will take into consideration the shape of the image(s) selected by you as source and, in case of a 
collision with one of them, bounce off them.
Draw a slope with an angle of approximately 30° with the horizontal line on all images of a layer 
with 120 images. In the particles generator, choose the pre-defined example: (objects > apples), 
check the Alpha Collision box and then select FX stack as source. To finish, apply your effect.

 >  >  > 

You will note that the apples bounce off the surface that you have just drawn!

This may be taken even further as the surface on which the particles bounce may evolve in time 
(for this, you have to choose an animated source).
It is even possible to modify the height of the particle bounce, as we shall see later.
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The tabs of the Particles Generator effect

Below, you find two summary illustrations for the trajectory of any object.

    

    

The Emitters tab

The Emitters tab (see below), as its name implies, is used to set the parameters of the sources 
emitting the particles.
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The tabs of the Particles Generator effect

The following emitters may be chosen :
A point (see pre-defined example sci-fi > galaxywarp), a line (see pre-defined example objects > 
tetris), a rectangle (see pre-defined example nature > lava or cartoon > eyes), an ellipse...

These are the various HUD displayed according to the chosen emitter:

         Point                            Line                                   Rectangle                                              Ellipse

The center of the emitters is shown in green, its shape is marked by red dots.
The purple handles describing the shape of circular arcs indicate the angle at which the particles 
are projected. We will study them in detail when discussing the Emitter > Current tab.
Below, the smoke coming from the steam engine was created using a Point type emitter.

    
                                                                    Above, a zoom on the HUD.

These particle emitters are, of course, virtual. If you use the particles generator effect for animating 
water coming out of a fountain or tap, or smoke coming from a steam engine, you just have to draw 
the fountain, tap, steam engine…
It is possible to work with several emitters, placed where you want. The Emitter popup menu will 
facilitate your task as it offers you the possibility to Create, Rename, Delete and Duplicate  emitters 
(note that the name of the emitter you are working on is displayed in the header of the popup 
menu).

Using several emitters may be useful when, for example, you wish to animate a building starting to 
burn: with several emitters, fire and smoke may come from several windows or chimneys with 
varying intensity (see below).
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The tabs of the Particles Generator effect

All these types of emitters have a center that you may place wherever you wish using the  X, Y and 
Z coordinates (the « Z » coordinate is used to set the depth parameter as you have already seen 
when studying the Keyframer).
The Tools and Interpolation (Linear, Spline or Polynomial) popup menus are used to define the 
path to be followed by your emitter source in time.
By clicking on the little padlock buttons, it is possible to « lock » your emitters in space so that they 
cannot be moved along the axis (or axes) of your choice. This enables, in particular, avoiding 
untimely movement.
The locked points may be subject to animation keys and « intermediate » points in time may be 
created from the locked points.

The animation keys influence the position of the points in time and not in space.

The Angle option is used to point the emitter in the direction of your choice. It is also possible to 
turn your emitter using the animation key system. The Rotation parameter is used to manage 
rotations of more than 360°.

Some settings, not shown above, are specific to the emitter you choose to work with. Depending 
on the emitter chosen these are: length of the line, length and width of the rectangle, size of the 
two ellipse axes.

You will note that, once the emitter is created, two tabs appear: the Current tab and the Particles 
tab.

The Emitters > Particles tab

The Emitters > Particles tab is used to manage the particles projected by the emitter.

The Particles popup menu enables creation of one or several sets of particles. Several types of 
particles may be emitted: see the pre-defined examples (sci-fi > galaxywarp), (party > magic 
candle) or (pyrotechnic > explosion-b) to convince yourself. 
You may also duplicate, rename or delete a set of particles via this same menu. The name of the 
set of particles you are working with appears in the header of the popup menu.
As soon as a set of particles is created, new parameters for setting the particles appear (see next 
page).
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The tabs of the Particles Generator effect

All particles appear, move along the screen and then disappear again. The time the particles move 
is referred to as the Life span of the particles.
The Life parameter is used to adjust the particle life span in seconds:
-  it is short for fireworks : party > magic candle
-  it may also be long: nature > fog.

The Number parameter contains the number of particles emitted per second: 
- if required, this parameter may be very high: pre-defined example  (sci-fi > galaxywarp) 
- or reduced : pre-defined example (object > dice)
A decimal number enables emission of a very small number of particles. For example, a setting of 
0.3 generates a particle every 3 seconds, a setting of 0.01 generates a particle every 100 seconds.

When the Single box is checked and one particle has been emitted, no other particle will be 
emitted before the last particle has reached the end of its life, whether it is still on the screen or not.
The pre-defined example (object > golf shot) is ideal for testing this option.

Let's assume that the Life span of our golf ball particle corresponds to the time it spends in the air 
(once the ball has landed, it is no longer possible to see it in the sky and it is too far away from the 
field of view to see it on the grass from afar).
If you check the Single box, a new golf ball will be shot only when the first ball has landed, 
independent of the fact whether the latter has left the screen on its trajectory or not (and even re-
entered it on the same trajectory … see below).

The Number of Points is only valid with the emitters line, rectangle and ellipse.
It is used to distribute the areas from which the particles are emitted along the contours of the 
emitter you are using.
Below, the particles of the pre-defined example (party > stage lights) are used with a Line type 
emitter then with an Ellipse type emitter.
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Shooting the second ball when the first has landed (i.e. 
at the end of its life …).



The tabs of the Particles Generator effect

                                        
A parameter referred to as Link to emitter is present in this tab: it is used to define whether the 
particles will follow an emitter or not when it moves along the path chosen by you.

1st example: a steam engine was drawn on the screen. The Keyframer effect was used to simulate 
steam engine movement from left to right.
A Pixel tracker was used to create a path which follows the engine's chimney. Therefore, when the 
train moves, an emitter following this path will always be at chimney level.
In the images below, the smoke particles are linked with the emitter which is the engine's chimney 
set at 100%. The movement of the smoke is not natural.

  >>  

In this drawing, the parameter Link to emitter is 25%. This time, the smoke movement is correct.

  >>  

2nd example: the beacons below, as they are particles, are necessarily linked to their emitter: the 
roof of the police car. They move at the same time as the car when it is driving. The Link to emitter 
is therefore 100 %.
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Line type emitter

From top to bottom :
Point parameter = 0 or 1
Point parameter = 3
Point parameter = 5

Ellipse type emitter

Point parameter = 9



The tabs of the Particles Generator effect

The Emitters > Particles > Current tab

This tab is used to manage the properties of the particles themselves.

     

The most simple are Velocity and Size: any pre-defined example may be used to study these two 
notions.

The parameters Weight and Bounce are more subtle :

- The Weight of a particle has an influence on its movement if the Gravity parameter in the World 
tab is not set to zero: the heavier a particle, the more the force of gravity will accentuate its 
movement. The lighter it is, the less effect the force of gravity will have. 
A Weight of zero has the result that the particle is not subjected to the force of gravity.
If you place the pre-defined example (nature > sun) in the stack and then modify the gravity 
parameter, you will note that this has no influence on particle movement.

- The Bounce parameter is used to set the particle bounce strength (the Alpha Collision box of the  
World tab must be checked and a collision source chosen…).
Below: the Bounce of a tennis ball thrown left to right for different parameter values: 85, 100 and 
115 (note that values over 100 cause unnatural bounces relative to the laws of physics…)

    

- The Friction parameter is set to slow the particles down. If the particles move through the air 
(which is most often the case), we are dealing with air resistance. The latter is low and a parameter 
set at a value close to zero will be sufficient. 
There are, however, other situations : let's assume that the balls are thrown at floor level. These 
balls will slow down and stop due to the friction of the floor. If the same balls are thrown on a lawn, 
they will be stopped even faster.
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The tabs of the Particles Generator effect

The pre-defined example (objects > dice) also provides an interesting case: by increasing the 
Friction parameter to 180, and due to the fact that the particles grow smaller in size during their life 
span, one gets the impression that the dice roll on a surface and, after a certain limit, fall into a 
void. 

- The Opacity parameter is used to set particle transparency. 
This is very useful, for example, when you are animating soap bubbles: these wouldn't be perfectly 
opaque…

- The Motion Randomness parameter controls the movement of imperfect particles and 
accentuates the realistic aspect of the particle jet. It is used, for example, to create an uneven fog, 
movement of bubbles in the air, smoke, etc. 
This parameter is used to avoid having to create too many animation keys which would be required 
to render a trajectory uneven. This parameter comes into its own with the Variation parameter 
described hereafter. The pre-defined example (party > popcorn) uses this method.

- The Spin parameter controls particle movement around its local axis (the latter is defined in the 
Handle popup menu of the Shape tab which will be discussed below…)
Its use may provide various results. As required, study the pre-defined examples (objects > dice) 
and (objects > tetris).

- The Align parameter, if enabled, acts on the rotation parameter and directly turns the particles 
according to their trajectory.
See below : two particle jets with and without alignment.

  With alignment     Without alignment

All parameters studied have the parameters Variation and Profile to their left.
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The profile preset is used to vary a parameter (Size, Velocity, 
Opacity, Bounce, etc. ) during the life span of a particle.

Click on one of the profile icons (circled in black in the 
example opposite) to open a traditional profile window.
We have already seen these when studying the drawing tools.



The tabs of the Particles Generator effect

 

   

The Variation represented by the V button is used to render the parameter with which it is 
associated more or less random. RMB click on the V icon to enter a numeric value in this field.

For example, if the particles Size parameter is set at 50, a Variation with a value of 25 means that 
each particle emitted will have a random size ranging from 25 to 75.

In the example given above (misc > plumefury), the variation function was used to attribute the 
particle Size, Spin and Life random values.

Combined with the Motion randomness parameter and correctly used, the 
Variation function provides excellent results. It is almost impossible to tell that a 
computer was used to create this effect!  
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Let's take the pre-defined example (pyrotechnic > smoketrail) shown 
opposite.
The three circled profiles below are those used in this example.
You will note that the particle behavior and profile size and opacity are well 
balanced:

* The smoke particles are small close to the emitter source 
and become bigger as the smoke dissipates in the air. 

* The smoke particles are opaque at the beginning (yellowish-
orange areas) and become transparent at the end (red-black 
areas).

A parameter with the profile indicated opposite does not vary during the period the 
particles are displayed and remains at the value you have chosen.



The tabs of the Particles Generator effect

The tab Emitters > Particles > Shape

This tab is used to define the type of particles to be used.

          
The Source popup menu is used to select either a default particle (circular with an opacity level 
decreasing towards the edges) or an image of your choice. When required, the image may be a 
brush, animated brush or current project. 
In the case of brushes, you may select it using the file requester. 

 

 

The Anti-aliasing option allows you to finalize the general aspect of the particles. We have already 
discussed this when studying the drawing tools (lesson 2 and lesson 7).

The Handle menu works in the same way as that encountered when studying the brush and 
animated brush tools. It defines the particle axis which is the reference axis when a spin is 
imposed on the particle.
You may choose a handle located in the center of the particle (more precisely, in the center of the 
HUD rectangle surrounding it) or in one of the four corners of the latter.
As a last resort, you may even place the handle manually.
The Handle is also used as a reference point when calculating collisions. Furthermore, if you need 
to calculate a collision, it may be wise to place the handle elsewhere than in the center of the 
particles in order to obtain better results (see diagrams below).
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Opposite, use of the 
default particle.



The tabs of the Particles Generator effect

         

When the Source chosen is an animated brush, the Animation popup menu is used to set the order 
in which the source images appear on the screen:
- The None option authorizes display of the AnimBrush's first frame only.
- The Once option is applied to each frame of the animated brush one after the other and stops at 
the last.
- The Loop option is also applied to each frame of the animated source one after the other, but 
starts a new cycle each time it reaches the last frame and so on until the particle dies (see 
predefined example: objects > coinfountain).
- The Random and Loop option randomly selects a start frame amongst the frames making up the 
animated source, then repeats these source frames in order starting from the selected frame. 
When the source footage has come to an end, it starts again (see predefined example: cartoon > 
eyes).
- The Ping pong option is used to first repeat the animated source frames in a rising order. Once 
the last frame is attained, it repeats the frames in a descending order and so on until the end of the 
particle lifespan.
- The Random option is used to display the animated source frames randomly.
- The Random at start option is used to display the animated source frames randomly for each 
particle, and then to keep it until the end of the particle life span (see predefined example: objects 
> tetris).
- The Particle age option varies the source frame displayed according to the age of its particle. All 
animated source frames are displayed once during the particle lifespan.
- With the Particle direction option the animated source frame chosen depends on the direction of 
the source in space. A coin thrown into the air, for example, will show one side on the way up and 
another on the way back down to the ground.
- With the Generator's direction option the animated source frame chosen depends on the angle 
formed between the particles generator and the horizontal plane (see above in the chapter 
Emitters tab page 7 with examples line, point, rectangle or ellipse).
- With the Emitter direction option the animated source frame chosen depends on the angle formed 
between the particles emitter and the horizontal plane (see below in the chapter Emitters/Current 
tab, page 18).

17-16 The Rendering > Particles Generator effect



The tabs of the Particles Generator effect

The Blend popup menu is used to choose the mode to be used when drawing the particles on the 
screen (color, behind, erase, etc…). Refer to the predefined example (nature > sun)  for an 
example of how to use the Add mode. 
In lesson 2 you were given a detailed description of the drawing modes available in 
TVPaint Animation Pro (the Substitute and Mix modes refer to the modes encountered when using 
a spare image).

The Color source popup menu is used to modify the particles' color:

- The Color option is used to give a tint of your choice to the particles (use the Color box and Alpha 
parameter).
An Alpha value of 100% will totally change the natural color of the particles.

- The Gradient option is used to modify the color of particles emitted based on a color gradient 
(refer to the predefined examples: party > fireworks or misc > worma).

- The Mode menu contains some of the options already seen in the Animation menu above. 
However, these options do not apply to all consecutive elements of an animated brush, but to the 
colors of your particles in accordance with the color gradient chosen. 
The color gradients chosen to be applied to your particles will depend on the choices you make in 
this menu.

In the example (party > fireworkscold) the particles' color covers the entire color spectrum of your 
particles for as long as they live.
In the example (party > stage lights) the particles' color is chosen randomly and kept as long as the 
particles live.

The Emitters > Current tab

Let's take a closer look at the Current tab:

            
The Active button either displays or hides the emitter named in the Emitters popup menu (of 
course, your particle settings are retained). This function will render your task easier when working 
with several emitters at the same time and a large number of particles are displayed on the screen.
In order to understand the way the parameters described below work, we recommend you make 
full use of the Quick preview window.

The Rendering > Particles Generator effect 17-17



The tabs of the Particles Generator effect

The Pre-Render parameter displays the particles on the screen after the number of seconds 
entered here have timed out. 
Let's go inside the framework of a typical set of particles (pyrotechnic > smoketrailc).
Setting the pre-render value to 10 seconds will ensure you do not see the outset of the flames as 
they will already be well developed right from the beginning of the animation.

Some examples:

Do not confuse Direction of emitter and Direction of 
the bundle of particles from the emitter.

In the example opposite: the emitter is a straight line 
at an angle of 45° (oblique) and the direction of particles 
emitted is -90° (to bottom right) with an opening angle of 1°.

The New first check box, when checked, ensures that newly emitted particles are displayed in front 
of the older particles.
The result obtained with the predefined example (text > titre1) is similar to this option:

                

                  

New first box not checked                                          New first box checked

All other parameters: Number, Life, Size, Velocity, Weight, Bounce, Friction, Opacity, Motion 
randomness and Spin are the same as those encountered in the Emitters > Particles > Current 
tab.
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The Range parameter is used to define the emitter 
opening angle. The particles bundle will then be 
emitted within the arc defined. 

The Angle and Spin parameters are used to define 
the Direction in which the particles are ejected (see 
opposite).



The tabs of the Particles Generator effect

However, in this case we are dealing with «master» controllers: they are set as a percentage and 
have a direct influence on all particles of the emitter at the same time.

This is extremely practical when you wish to increase or decrease the size of all particles at the 
same time without modifying the size value for each type of particle emitted. This also eliminates 
the need for numerous calculations for each operation.
The use of animation keys with the master controllers often allows you to save a great deal of time.

To finish off, you may have noticed the animation key controllers next to the Emitters and Particles 
popup menus.

These are used to create animation keys for all parameters of the emitter or particle named in the 
popup menu header at the same time.
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Lesson 18

The advanced functions of TVPaint Animation Pro

 In this lesson, you will learn to :

● Create customised windows.

● Use the plug-ins at your disposal.

● Use the macro scripting language « George ».



Customized windows

Customized windows

It is possible to create your own customized panels and icons in TVPaint Animation Pro to adapt 
the interface to your needs.
To access the customized windows of TVPaint Animation Pro, click on the button encircled in the 
Tool bar below.

        

The customized windows are similar to those shown 
opposite: numerous icons are represented and each of 
them has a specific function.

By default, when you create a new customized window, 
the latter is empty but we will explain how to fill it later 
on. 

     

A newly created panel is as shown in the image opposite and will be 
referred to as Tool Bar by default.

     

A RMB click in an empty area of a customized window will open 
the menu shown opposite.

The following options are available : 
* Grab Current tool  allows you to save your current tool with all its settings and connections: 
airbrush, penbrush, custombrush, etc ... This action creates a button in the current panel. The icon 
of this button is the one of the tool grabbed and it provides fast access to the previously grabbed 
tool. Note that the option to grab the current tool is also accessible by simply pressing the  
button of the Tool Bin panel which is present by default. 
* Grab the current tool with colors has the same effect as the previous operation except that the 
tool is saved with the A and B colors defined at the moment of grabbing. This option is also 
accessible via the  button of the Tool Bin panel.
* Add Action or series of actions.
* Add new line of icons to be filled.
* Add vertical and/or horizontal separators between your icons (click with the right button on the 
latter to remove them ...)
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Customized windows

Adding an action

Adding an action is done using the panel at the bottom left of this page :
* Using the first two text fields you may define a name and in-line help comment for your future 
customized function . 
* The buttons and menus List, Tool and A color allow you to choose the icon corresponding to the 
action you will create.

      

Opposite you find the list of icons supplied with 
TVPaint Animation Pro.
To create a new icon, you simply have to create a 
brush with its image and select the Tool button.

* The numbered lines are the actions to be carried out one after the other when you click on the 
icon corresponding to your function.

  

Above you find the example of 
an action which selects all 
images of the current layer, flips 
them and copies them all to a 
new layer.
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Customized windows

The actions at your disposal.

Several possibilities are available if you decide to create an action. You can :
* Select a shortcut in the numerous program functions. (see previous page)
* Select an FX-Bin file stored in the FX-stack to re-use it.
* Open Plug-in allows you to  place a button to fast-start plugins. (they will be introduced and 
explained in the next section of this lesson) 
* Open panel allows you to create dependencies between your panels, i.e. you may display 
secondary panels from the main panel, for example. This may be useful for organizing your custom 
brushes or the contents of your various Bins. 

For example, the button  at the bottom of the Animator Panel  is used to open the Tool Bin panel 
which is a default Bin in which your tools are saved. Nevertheless, it is possible to create a Bin for 
each type of drawing tool  (Airbrush, Penbrush, etc.) which may be opened from the Animator 
Panel  using other buttons of this type.

      

* Grab the A color.
* Grab the B color.
* Grab the current tool, with the A color, with the B color or with  those 
two colors.

* You may call up a George automation script.
* Select a script command (for example : TV_LayerAnim, TV_Circle, TV_Airbrush, etc ...)

George Scripts and commands will be discussed further in this lesson.

How to manage the created actions.

Once your buttons are created in the custom window, other options become available:
* With a simple selection in your custom window you may cut or copy the icons/actions that you 
have just created. You simply use the menu described above to « paste » your icons/actions later.
* With a right click on an icon/action in the custom window, you may edit, duplicate or delete it.

 >  >  > 
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Customized windows

How to manage the panels.

Now we will look at the options proposed in the panels themselves. In the sub-menu shown below, 
which is accessible with a right click in an empty area in your custom window, you may :

     

* Rename the current custom window .
* Show icon only  (without text).
* Dock your window under the tool bar (Dock). 
* Delete the current window.
* Duplicate the entire window.
* Import / Export the current window.

     

In the second sub-menu you may :
* New tool bar (you may create an unlimited 
number).
* Load a new tool bar from its .bin file.
* View the name of the custom windows 
visible on the screen.

     

This last sub-menu is used to:
* Save a customized window in order to re-use it later.
* Delete one of the customized windows that you have 
just saved.

If you save the configuration, your custom windows saved under the Bin menu will still 
be present when re-starting TVPaint Animation Pro.
This being the case, a reset will delete these settings. Remember to export the 
custom window you need the most.

You may also define a keyboard shortcut for each action created using the keyboard 
shortcuts panel !

The advanced functions of TV Paint Animation Pro 18-5



How to use the plug-ins

How to use the plug-ins

To use the plug-ins at your disposal, you have to :
* Open a custom panel
* Create a new button in this panel
* Select the plug-in you need as action to do for this button
The panel relative to the plug-in will then be visible once you click on the corresponding button.

The Canon Plug-in is available only if you have selected it during the installation 
process of the software. It is available only on PC computers at this time.

The Color Factory plug-in

The Color Factory plug-in allows you to modify the values of the R,G,B and Alpha channels the 
selected images, thanks to mathematical formulas. (ie : R,G,B and Alpha values of the pixels of 
your images) 

Based on the additive color principle, all colors are mixture of red, green and blue 
(more or less dark) in exact proportions.
Each color can be broken up in various ways depending on the color system. For 
example, the Slider tab of the Color Picker panel gives the numerical values of the A 
color in the R,G,B and H,S,L color systems.

Each text field of the Color Factory panel describes one component (R,G,B or Alpha) and can 
contain a mathematical formula. The new values of those components will be calculated regarding 
the formulas you have entered (the Alpha component indicates the opacity of the pixels).
The variables that you can use in your formulas are listed in the table below (all in low case) :

 The variables :
r Value of the Red component of the pixel 
g Value of the Green component of the pixel 
b Value of the Blue component of the pixel 
a Value of the Alpha component of the pixel 
x x coordinate of the pixel
y y coordinate of the pixel
w Width of the current project
h Height of the current project

And here are listed the arithmetic operators :

 Arithmetic Operators Examples :
+ add 18 + 3 = 21 
– substract 18 – 6 = 12
* multiply 18 * 3 = 54
/ divide 18 / 3 = 6

It is possible to use parentheses  (  )  in order to set priorities in your calculations. If you don't use 
them, the Color Factory plug-in will evaluate the operations from the left to the right.
For instance :      1+2*3 = 9        1+(2*3) = 7
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Here are a few examples using the Color Factory plug-in.
* Let's begin with a classic image without any modification :

       
* Here is a negative of the previous landscape :

       
* Below, the red and blue components of the landscape have been inverted : the sky turned into 
orange and the road turned from red to blue. The green component stay unchanged.

       
* The Color Factory plug-in can also be used to create nice color gradients. Therefore, the 
formulas on the right panel below are more complicated.

       
* Below, simple additions have been done with the red and green color channels inverted.
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* Here is the last exemple : An opacity gradient from the top right to the bottom left of the image.

       

The Canon plug-in (PC only)

The Canon plug-in allows the user to retrieve photos from a Canon digital camera and to put them 
directly into a TVPaint Animation Pro layer.
This plug-in is very convenient for the animator who want work in stop-motion directly with the 
software.
Here are the steps to use the Canon Plugin with TVPaint Animation Pro : 

* What is required : 
- The Canon driver of your camera must be correctly installed in your system. (Microsoft Windows 
only at this time)
- You should have a compatible Canon camera (see the list in Appendix) powered and plugged to 
an USB port of your computer.
- You have to set your camera in playback mode. Don't use the shooting mode as it does not allow 
to manage your camera via the computer.

How to make it work : 
- Launch TVPaint Animation Pro
- Open the Video Grabber panel. (It is accessible in the Windows main menu )
- In the device list, choose your Canon camera ( if other devices are listed )
- Hit the settings button to access the second panel, in which you have to adjust your grab settings.
- Choose Apply in current Layer in the menu : so it will append the new image just after the current 
one in the current layer.
- When you think it looks fine in the little preview, hit the Grab Input button.
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- A sound should ring out as soon as the picture as been transmitted. (see previous page)

Here are some useful tips : 

* To preview the next-to-shoot image (low-res. finder preview) over your last grabbed frame :
- Enable the [V] button of the project window,
- Change the mix parameter value. It is a percentage of visibility between the video and current-
frame. (see below)

It is advised to use the effects :
Key > ChromaKeyer to delete the colored background behind your characters.
Rendered > Healing Tracker to remove all the small imperfections of your images.
You can also shoot an empty background and put it as image layer behind the 
current animation layer. After this operation, you should be able, thanks to the erase 
drawing mode, to remove all the crutches, wedges, wires ... that you used.

* If you want to grab a picture inside an existing sequence of images :
- Begin by selecting the image that you want to change in the timeline.
- Enable the display with video parameter.
- Change the Mix parameter value in order to compare the existing image with the camera preview.
- Once you are satisfied, click on the Grab Input button.  
- The grabbed image is then replacing the selected image.
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* To preview your animation using the LightTable, set the Layer opacity to half (or a bit less), set 
the previous frame color to none, and tweak the level sliders of the 1, 2, 3, ...5, 6 previous frames 
to make them visible. (see below)

Of course, you can have a display with the video and the LightTable enabled 
simultaneously.

It is advised always to close your Video Grabber and Video Canon panels before 
quitting the software. 

The Direct Show plug-in

DirectShow is an application programming interface from Microsoft which contains a set of 
software librairies. It is a component of DirectX and allows to manage multimedia files. 
The DirectShow Plug-in provides support for USB, SCSI, FireWire, ... compatible hardwares.
(in theory all Windows Driver Mode (WDM) compatible hardwares)
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The WaveForm plug-in

Generally speaking, an oscilloscope is an electrical equipement which allows to control and 
measure periodic signal voltages. If it is calibrated in order to receive video signals, it is also called 
WaveForm monitor.
In the audiovisual environment, they are often used to check if the transmitted video signal has its 
characteristics in conformity with the applicable broadcasting rules.

      

Our WaveForm Plug-in allows the audiovisual professionals to use their classical tools.
Thanks to this Plug-in, it is now easy to check the integrity of a signal, manage calibration and 
colorimetric adjustments, control the validity of numerical signals, ...
The popup menu alllows you either to select :
* A Composite WaveForm monitor
* A Componant WaveForm monitor
* A VectorScope

The monitors at you disposal in this WaveForm Plug-in act as if all layers of the 
current picture where merged.

Here are some options relative to the different displays at your disposal :
* The VectorScope can use two calibration sets : 75 % and 100 %
* The component WaveForm monitor can use the R,G,B or Y,U,V systems.
* The composite WaveForm monitor can use luminance and/or chrominance signal(s).

Let's now explain the other options :
* It is possible to set the luminosity of the display thanks to a mini-slider.
* The reticule button allows to show or hide the different axis and channels.
* The apply button allows to copy on the current image the results obtained in the WaveForm Plug-
in panel.
* If the transparency button is checked, the black background will not appear when using the apply 
button.
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How to use the  « George » scripting language

Introduction: what is George ?

George is a programming language which allows to use the numerous tools of TVPaint Animation 
Pro. Every program written in this language is called “George Script”. Other softwares use 
sometimes the word “Macro” instead of “Script”.

A George Script allows to execute specific TVPaint Animation Pro command such as :
Create a new layer, draw a circle on this area, save the current project, add a bookmark, etc…

Those Scripts are usually created to save some time when executing a repetitive task is needed. 
Experienced programmers use TVPaint commands in order to create “.dll ” plug-ins

Some George Scripts are available as example with the software, but you can also create your 
own scripts and/or exchange them with some members of the TVPaint Community. (You can 
access to the TVPaint forum here: http://www.tvpaint.com/forum/index.php.)

Finding, Editing and Using George Scripts

After installing TVPaint Animation Pro on your computer, George Scripts are located in the 
directory:

C:/program files/TVPaint Animation Pro/George            For Microsoft Windows users
Application/TVPaint Animation Pro/George                    For Apple OS-X users

Those George Scripts are in fact usual ASCII text files and have a “.grg” extension.
It is possible to edit or create them with any text editor like Notepad from Microsoft Windows or 
Text Edit from Mac OS-X

The scripts are in theory working on the both standards PC and Macintosh, whatever the computer 
was used to create them.

 

 

Once a George Script has finished its programmed tasks, the Undo option of the
TVPaint Animation Pro main panel allows to cancel all the changes it has generated.
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To use one of the George Scripts at your disposal, just follow the 
steps below:
open a custom panel
create a new button on this panel
select the action:  -select a script-  for this button
select a file with a “.grg” extension in the file requester

Once finished, if you click on the just created button, the George 
Script will then be launched.

At every moment, you can stop the execution of a George Script by using the 
[Esc] key.
A window, indicating on which line the execution of the script was stopped, 
should popup.
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A few examples of George Scripts

Often, George Scripts need an action from the user in order to be launched. For instance : 
The George Script named “long.grg” waits for a segment to be drawn on screen and finally returns 
its length.
The George Script called “clock.grg” waits for a circle to be drawn on screen and finally draws a 
clock inside this one.
The George Script called “button Z.grg” waits for a rectangle to be drawn on screen and returns a 
bevelled button inside it
A few George Scripts don’t need any action from the user to be started: it’s the case with the 
George Script called ”Zsurface.grg”.

      
Above: the results of the scripts: button Z, Long, Clock, Zsurface and Polystar

A few George Script are more complicated and some requesters may appear.
It is the case with the George Script called Polystar.grg : during its execution, a first requester asks 
you to specify how many vertices should be drawn. If you apply your script on an animated layer 
(after selecting all its frames), a second and third requesters will ask you more informations (see 
below)

             

Programming in George language

George is a scripting language which can do the basics:
- Loops (do the same thing n times),
- Conditional testing (if this is true then do that),
- Calculations (a+b, sin(a),...).

The George language is not particularly fast, but it is flexible and very easy to use. On many 
points, George is comparable to the Pascal language or other well known programmation 
language.
However it’s not aimed at developing heavyweight applications as are for example the C or C++ 
languages. George is first and foremost a scripting language.

Instructions and Commands

George needs classical instruction to structure the scripts: tests, loops, calculation, conditionals 
events, etc… For a better readability,all the instructions will be written in green in this manual.
For example : 
If, Else, End, For, Do, Until, While, …      for conditionals tests
Cos, Sin, Tan, Rnd, …                             for calculations

You can also call in your scripts TVPaint Animation Pro commands, which call specific tools of the 
software.
They can be differentiated from the classical George instruction because they all begin with the 
« tv_ » prefix. (They will be written in blue color)
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For instance :
* The command tv_layerCreate allows to create a new layer.
* The command tv_SaveBrushAnim saves the current brush on the hard drive.
* It is possible to change the colors of the bin tab thanks to the tv_SetPalette command
* Etc… (You will find in appendix the complete instruction and command listings of the George 
Language.)

All TVPaint commands need their own arguments and return some values as answer.
For example, the TV-LayerCreate command needs a name for the layer that you want to create.
This command returns some information regarding your layer: opacity, number of pictures, place of 
the timeline,… So you can reuse or modify them.

It would be too long to enumerate here the arguments and the return values of each George 
command. All those parameters are fully explained in the developper kit (SDK) of 
TVPaint Animation Pro. The SDK is available on demand at the email address: tvpaint@tvpaint.fr

Make sure to differentiate George instructions (which often start with a
sharp : #) and George commands for TVPaint Animation Pro (which allways start 
with the « tv _ » prefix).

The commands act on the software itself and on your current display whereas George 
instructions are used to write the structure of the program (conditionnals, calculations,
loops, ...)

Since approximatively 10 years, all the softwares using the TVPaint technology offers 
a scripting language.
Here are some informations regarding the compatibility between those scripting 
language :  If you upgraded to TVPaint Animation Pro, your old scripts should still 
work.
However, some recent commands (for instance: TV_AddBookmarks) are not 
available in older products using the TVPaint Technology. (Aura, Mirage,…)

An example of program written in George.

The program on the next page comes from the file clock.grg. It allows to draw a clock displaying 
the current time on the project window.

We suggest you to create a button assigned to this script in a custom panel, as explained below.
After this operation, it should be easy for you to test this George Script in the project window.

Once this stage is passed, you can try to edit the George Script, to modify it and to test it again in 
TVPaint Animation Pro. This should help you to learn the basics of the George Language.

The best way to get used to George scripts is probably to try the example programs 
that come with TVPaint Animation Pro. 
Study them and make small alterations to them, then run them and see the effects 
of your changes. 
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The  clock.grg  script :

    

Param Circle
// TVPaint should wait for the coordinates of a circle before running the
// program. The user must therefore draw a circle to start the program.

Parse result command x y r button
// Fetches the coordinates of the user’s circle.

if cmp(command,"Circle")==0
tv_Warn "This program needs the coordinates of a circle !"
exit

// If there are no coordinates for a circle, warn the user and end the program.
End

t=time
parse t h m s

// Fetches the hours (h), minutes (m) and seconds (s) of the current time.
m=m+s/60

// The seconds can slightly alter the minutes arm of the clock.
tv_Pen r/30 // Selects a pen proportional to the clock size.
tv_Circle x y r // Draws the outline of the clock.
ang=360/12
d=r-(r/10)
#for i=0 to 360-ang step ang

// Loop to draw the 12 hour markers on the clock
#a=cos(i)*d
#b=sin(i)*d
tv_Dot x+a y-b 0

#end

i=h*360/12 // Draw in the hours
d=r/2
a=sin (i)*d
b=cos (i)*d
tv_Line x y x+a y-b

i=m*360/60 // Draw in the minutes
d=r-(r/8)
a=sin(i)*d
b=cos(i)*d
tv_Line x y x+a y-b

// End of the example

And below, a few clocks which were drawn with the script

The advanced functions of TV Paint Animation Pro 18-15



How to use the  « George » scripting language

Commands Description

Here are some information regarding the commands that you can find on the previous page :

Below, each command will be followed by the syntax of the variables it requires. 
For example, to draw a straight line from one point to another, you must give the coordinates of the 
start point then the end point.
The syntax to draw such a line would be:
tv_Line   x1 y1 x2 y2 [0/1]
The [0/1] parameter indicates that you can use either the left [0] or the right [1] mouse button. This 
is optional; by default, it’s always the left button that will be used.

To summarize :
[ ] Variables inside square brackets are optional.
/ The “/” symbol separates several options of which only one is used.
For instance, 0/1 means either 0 or 1.

tv_Circle x y r [0/1]
This command allows to draw a circle with a radius r and a center located on the pixel with (x,y) 
coordinates. The [0/1] parameter indicates that you can use either the left [0] or the right [1] 
mouse button.
Of course, the circle will be drawn on the current image on the current layer.

tv_Dot x y [0/1]
this command allows to use the current tool (airbrush, pen, custombrush,…) on the pixel with (x,y) 
coordinates, in the current image on the current layer.
The [0/1] parameter indicates that you can use either the left [0] or the right [1] mouse button.

tv_Warn text
This command displays a popup dialog box containing the caracter string text and an “ok” button.
The character string must be surrounded by quotation marks.

tv_Pen size
This command allows to select the pen tool with its current parameters (drawing mode, opacity, 
power, ...) and change its size.

You should always remember that a George Script will use TVPaint Animation Pro as 
it finds it, i.e. with the functions and options that are currently set. 
For instance, if you want to draw a red line with a George Script, the script needs to 
be told more than just the line coordinates. Unless you explicitly tell it to use a red 
color, your script will go ahead and use the current color when the script is run, 
whatever it may be.
Similarly, if when you run the script it is in the Behind or Colorize drawing mode, you 
won’t exactly be getting the clean line you were hoping for.
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A few useful options

It is now time to explain some programming conventions:

1°) A sharp caracter #  at the beginning of a line will not affect the execution of the script.
For instance, the line :

Pause 20

will pause the execution of your script during 20 seconds.
And the following script line will have the same result :

#Pause 20 

2°) You can use only one instruction or command on the same line. For instance, if you use the 
following  line in a script :

Print "wait a little" Pause 20

An error message will be returned.
The two lines below will not return any error messages :

Print "wait a little"
Pause 20

3°) Everything on a line that is after a double slash // is ignored. They are only
comments that have been put into the script to make it more understandable and readable by 
humans. For instance, the line :

Pause 20 // wait 20 seconds

makes TVPaint Animation Pro wait during 20 seconds.
However, the line :

// Pause 20

will not pause the execution of your script.

TVPaint Animation Pro sees no difference between uppercase and lowercase 
letters. For instance, TV_layercreate, tV_LaYeRcReAtE, tv_LAYERCREATE are 
all exactly the same command.

How to use the variables

It is not necessary to declare the types of your variables in a George Script.
For instance, you can write the two lines below in a script without declaring that the variable 
MyNumber is numeric or the variable Answer  boolean.

MyNumber=10
Answer=false
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As for commands and instructions, the George language sees no difference 
between uppercase and lowercase letters. For instance, MyNumber, mynumber, 
MYNUMBER, MyNuMbEr  are all exactly the same variable.

The George language use a few reserved variables in order to work correctly. You 
can use them as you wish, but it is not advised to modify them.
That is the case with the two variables « Time » and « Result » (encountered in the 
clock.grg script above) which contains respectively the current time and the control 
results of the last used George command.

The operators at your disposal

Opérateurs Arithmétiques Examples :
- negative 18  ->   -18
** exponent 18**3=18*18*18=5832
* multiplication 18*3=54
/ division 18/3=6
+ addition 18+3=21 
- subtraction 18–6=12

Opérateurs Logiques Examples :
&& et a&&b
II ou  exclusif aIIb

Opérateurs Apparentés Examples :
== equal x==6 x==x+2 
!= not equal to x!=5 x!=y-3
> greather than x>4 x>y-z

>= greather or equal than x>=3 x>=z/y
< less than x<8 x<-y

<= less or equal than x<=7 x<=x+5

The « = » operator is an assignment operator and allows to assign a given value to the variable of 
your choice. For example :

MyNumberOfLayers=5

The « == » operator is an comparison operator between two variables, usually used during 
conditionnal tests. For example :

if a==5

The comparison operator is not appropriated if want to know if two variables are equal. For this, 
you need to use the instruction cmp, as shown in the clock.grg  script above :

 if cmp(command,"Circle")==0

The Param and Parse instructions, the launching modes.
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The instruction Parse allows to split up a character string into smaller character strings

Rainbow="red orange yellow green blue indigo violet"
Parse  Rainbow color1 color2 color3
tv_warn  color1          //  displays « red »
tv_warn  color2          //  displays « orange »
tv_warn  color3          //  displays « yellow green blue indigo violet »

Usually, each George Script begins with the Param instruction. It allows to choose which action will 
have to be done by the user in order to start the script excecution : drawing a circle, a segment, a 
rectangle ...

* The script line :

          
     Param None 

allows the George Script to be executed without waiting for an user action.

* The two script lines :

          

     Param Single
     Parse result command x y button

allows to execute a George Script after a simple mouse click on the project window. 

      

- The character string « single» will be assigned to the variable called 
command if a point is drawn on the screen.
- The point coordinates will be assigned to the variables x and y.
- The button selected by the user to place the point will be assigned to 
the variable called button. (1 for RMB, 0 for LMB).

* With the following script lines :

          

     Param Line
     Parse result command x1 y1 x2 y2 button

The George Script will be launched only if a segment is drawn on the project window.

      

- The character string « Line » will be assigned to the variable called 
command if a line is drawn on the screen.
- The coordinates of the points at the ends of the segment will be 
assigned to the variables  x1 y1 and x2 y2  ( see opposite )
- The button selected by the user to place the point will be assigned to 
the variable called button. (1 for RMB, 0 for LMB).

* With the two script lines below :

          

      Param Circle
      Parse result command x y r button

The George Script will be launched only if a circle is drawn on the project window.
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- The character string « Circle » will be assigned to the variable called 
command if a circle is drawn on the screen.
- The coordinates of the circle center will be assigned to the variables x 
and y.
- The radius of the circle will be assigned to the variable r.
- The button selected by the user to draw the circle will be assigned to 
the variable called button. (1 for RMB, 0 for LMB).

* With the following script lines :

          

      Param Rectangle
      Parse result command x1 y1 x2 y2 button

The George Script will be launched only if a rectangle is drawn on the project window.

      

- The character string « Rectangle » will be assigned to the variable 
called command if a point is drawn on the screen.
- The coordinates of the points at the ends of the rectangle will be 
assigned to the variables  x1 y1 and x2 y2  ( see opposite )
- The button selected by the user to draw the rectangle will be assigned 
to the variable called button. (1 for RMB, 0 for LMB).

* With the two script lines below :

          

      Param Freehand
      Parse result command x y button

The George Script will be launched only if a freehand curve is drawn on the project window.

      

- The character string « Freehand » will be assigned to the variable 
called command if a curve is drawn on the screen.
- The button selected by the user to draw the curve will be assigned to 
the variable called button. (1 for RMB, 0 for LMB).

The character strings

It is important to know how to use the character strings because they usually plays a part in 
numerous situations.
For example, in the following script lines, a loop allows to load the projects :
D:\cartoon3.tvp, D:\cartoon4.tvp, ... ... ... D:\cartoon15.tvp, D:\cartoon16.tvp.

For number=3 to 16
  NameOfTheFile="D:\cartoon"number'.tvp'
tv_loadproject NameOfTheFile

End

As shown above, you will have to use simple quotation marks ('...') or double quotation marks (''...'') 
in order to differenciate variables from character strings.

In the example above :
number  and  NameOfTheFile    are variables
D:\cartoon  and  .tvp  are character strings
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The variable NameOfTheFile receive the concatenation of D:\cartoon,  number  and  .tvp
In other words, the character strings d:\cartoon and .tvp, the variable number have been joined 
end to end in order to create the variable NameOfTheFile.

It is possible to use the Concat instruction to join end to end character strings 
and/or variables. The following lines have the same effect :
NameOfTheFile=number'.jpg'
NameOfTheFile=Concat(number,.jpg)

If you need to use simple quotation marks ('...') or double quotation marks (''...'') in your character 
strings, you must surround them with the other quotation marks at your disposal, as shown in the 
example below :

Print  ' My prefered animation program is " TVPaint Animation Pro " '
// will surround the name of the software with double quotation marks.

Print  " My prefered animation program is ' TVPaint Animation Pro ' "
// will surround the name of the software with single quotation marks.

The arrays

As in other programmation languages, George can create and use arrays with one, two or more 
dimensions.

To create an array, you only need to add parentheses or square brackets after the name of a 
variable. You can use either parentheses or square brackets.

For instance,
MyArray(i) ou MyArray[i] represent the same array with one dimension.
MyArray(i,j) ou MyArray[i,j] represent the same array with two dimensions.
MyArray(i,j,k) ou MyArray[i,j,k] represent the same array with three dimensions.
And so on ...

With the George language, it is not necessary to indicate or declare the dimension 
or the number of elements before using an array.

In the exemple below, an array called color with one dimension was created.
It contains four elements : "Magenta", "Cyan", "Yellow" and "Black"
We used a loop to display its content.

color[1]="Magenta"
color[2]="Cyan"
color[3]="Yellow"
color[4]="Black"

For i=1 To  4

        tv_warn color[i]            //  displays each color : "Magenta", "Cyan", "Yellow"
          // and  "Black", in a dialog box.

End
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Functions and procedures

Let's assume that you are writing a script which needs some instructions, conditionnal tests, etc ... 
to be executed several times. (For instance, a script which tests the pixel's colors several time and 
acts differently depending on the obtained results. )

Reccopying the same lines several time in a George Script can quickly become fastidious. It 
doesn't  make the things easier when you need to check or modify your script.
That's the reason why writing procedures and functions is very convenient :

* A function is a set of instructions and commands which allows to execute a precise task inside a 
George Script. The functions are independent from the the remainder of the George Script and are 
located at the end of the script.
The part of a George Script which distincts itself from the function(s) will be called “main part of the 
script”. All the functions are available at any moment in order to be used by the Main part of the 
script. A function can receive parameters and always returns a result.

* A procedure is a function which does not return results.

Here is an exemple of a script using a function :
(Of course, using functions is really usefull when you have to create bigger and more sophisticated 
scripts )

Param Single
Parse result command abscissa ordinate button
tv_warn TestBlackColor(abscissa,ordinate)

//  Main part of the script ▲
// - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -  
//  Function ▼

Function TestBlackColor(x,y)
Local r g b alpha sum
tv_getpixel x y
Parse result r g b alpha
If alpha<>0

sum=r+g+b
If  sum==0

Return " the pixel's color is black "
Else

Return " the pixel's color is NOT black "
End

Else
Return " the pixel is transparent "

End
End

The line :
tv_warn TestBlackColor(abscissa,ordinate)
Can be replaced by the two following lines :

 Answer=TestBlackColor(abscissa,ordinate)
 tv_warn Answer

18-22 The advanced functions of TV Paint Animation Pro



How to use the  « George » scripting language

Here is the syntax of the instructions relative to the procedures and functions :

Function NameOfTheFunction (Variable1, Variable2, Variable3, etc ... )
This instruction declares the existence of a function or a procedure in a George Script. (there is no 
instruction called « procedure »)
This instruction is followed by the procedure or function name, and then by the name of the 
variables (from the main part) that are needed.

Functions and procedures must always be located after the main part of your script.
Calling a function or a procedure in the main part of your script can be done by 
writing its name and the needed variables between brackets, separated by comas.

Local LocalVariable1, LocalVariable2, LocalVariable3, etc ... 
This instruction allows to specify the variables which will be used solely inside your function or 
procedure.

Return Result
This instruction allows to specify the result of your function and to make it available in the main part 
of the script. It could be a character string, a numerical value, a boolean value, etc  ...
In the main part of your script, it is possible to save it into a variable, and after to re-use it.
This instruction is optional. If you don't use it, you have created a procedure instead of a function.

End
This instruction is needed to finish your function or procedure.

The functions and procedures written in George language can be recursive. In other 
words, a function can call itself. It allows to create more sophisticated scripts.
For instance, drawing a fractal curve can be done thanks to a recursive script
(see below)

  >    >  

How to create libraries of functions and procedures.

We have just seen in the last chapter that it was possible to create your own George functions and 
procedures.
This may be taken even further as you can store your functions and procedures in «.grg» files and 
you can re-use them in other scripts written in George.
In other words, you can create your own libraries.

To insert one of your libraries in a George Script, you only have to write the following line in your 
script :

     #Include "MyLibrary.grg"

The instruction  #Include will search the file called MyLibrary.grg in the directory containing the 
current George Script or in the root directory of  TVPaint Animation Pro

The following line allows to specify a more precise access path, from the basis directories :

     #Include "MyFolderOfLibraries/MyLibrary.grg"
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Please read the Initialization File section in the appendix of this user-manual if you 
want to change the root directory of TVPaint Animation Pro.

Two examples of libraries are availables in the directory :

C:/program files/TVPaint Animation Pro/George/Include       for Microsoft Windows.
Applications/TVPaint Animation Pro/George/Include             for Apple OS-X.

They are called Basic.grg and Advanced.grg and are related to character strings management.

To make them available in the George Scripts given with the software, you only need to add the 
following lines at the end of those scripts :

     # Include "include/basic.grg"
     # Include "include/advanced.grg"

The Startup.grg file

At startup, the first thing that TVPaint Animation Pro does (after displaying the main toolbox, but
before giving control to the user) is to run the Startup.grg script (which should be in the same 
directory as the other scripts). 
When there is no Startup.grg file, nothing will happen. Otherwise, you have at your disposal a 
startup file that gets run every time you load TVPaint Animation Pro.
If, for example, you rename the Logo.grg file to Startup.grg, it will load the TVPaint Développement 
logo to screen every time you run TVPaint Animation Pro.
You could also, thanks to a simple George script, define all your preferred parameters. For 
instance : load a project from your harddrive, change the current colors,  add some layers to your 
project, etc…

The TVPaint Animation Pro Plug-in developpement

As explained before, George is not the only program that can send commands to TVPaint Anima- 
-tion Pro.
Any other program could theoretically do so. Examples using an Excel script, a C program or other 
languages are certainly conceivable.
Besides, it is possible for experienced users or third-party companies to create Plug-ins that can be 
used with TVPaint Animation Pro.
Those Plug-ins allows to add customized tools to the software like effects on pictures, new drawing 
modes, new tools or new functions.
The Plug-in may be in the « .dll » (Dynamic Link Library) file format, which can be obtained thanks 
to a compiler. « .dll » files are not readable in a text editor, unlike the classical George Scripts.
For more details about this subject, please visit the TVPaint Developpement forum. You can also 
ask us the development kit (also called SDK) at the email address : tvpaint@tvpaint.fr
This kit contains source codes for interface functions, documentation and some detailled plug-in 
examples.

Adding arguments 

You can add arguments to the execution of TVP Animation Pro. These arguments are :
- images (just write the path and file name),
- scripts (syntax: script=PathAndFileName.grg),
- commandes george (syntax: cmd=GeorgeCommand).

For example :
TVP Animation.exe "MyImage" "script=MyScriptPathAndName.grg" "cmd=MyGeorgeCommand"
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The video cards compatible with TVPaint Animation Pro

The video cards compatible with TVPaint Animation Pro

For both video input and/or output, some video cards are compatible with TVPaint Animation Pro :
Here is the complete list, with all the features detailled (only for PC at this time) :

Hardware
Model

Native file 
format

Video Output Video Input

Possibility to 
view your work 

on TVPaint 
Animation Pro 
and the video 

hardware

Needs a 
rendered 
preview 

before being 
available on 

the video 
hardware

The current 
project 

window (with 
opacity 

values) can 
be keyed over 

a live video

Image 
grabber
option

Possibility 
to display 

the current 
video in the 

project 
window

Leitch
VelocityQ .dps

Leitch
Velocity HD Should be added in the next updates of  TVPaint Animation Pro

DPS
PAR
PVR

Hollywood

Matrox 
DigiSuite

DigiSuite LE
DigiSuite DTV

.avi

Newtek
VTNT
VT[2]
VT[3]

.rtv

DV
compatible

with OHCI 1394
.rtv

WDM
Web Cam

Digital Camera

Bluefish 444
quicktime

 avi
cineon

Bluefish 444 
HD Should be added in the next updates of  TVPaint Animation Pro

       = Available            = Not available

The hardware native file formats, if they are available, are used by TVPaint 
Animation Pro and your video card during the video import and/or export 
process.
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The digital camera working with the Canon Plug-in (PC only)

The digital camera working with the Canon Plug-in (PC only)

Please find below the list of theorically supported models regarding the canon SDK we used for 
this plugin (PC only at this time)

PowerShot A10, PowerShot A20, PowerShot A30, PowerShot A40, PowerShot A60, PowerShot A70, 
PowerShot A75, PowerShot A80, PowerShot A85, PowerShot A95 
PowerShot A100, PowerShot A200, PowerShot A300, PowerShot A310, PowerShot A400, PowerShot A510, 
PowerShot A520 
PowerShot S10, PowerShot S20, PowerShot S30, PowerShot S40, PowerShot S45, PowerShot S50, 
PowerShot S60, PowerShot S70 
PowerShot S100, IXY DIGITAL, DIGITAL IXUS 
PowerShot S110, IXY DIGITAL 200, DIGITAL IXUS v 
PowerShot S200, IXY DIGITAL 200a, DIGITAL IXUS v2 
PowerShot S230, IXY DIGITAL 320, DIGITAL IXUS v3 
PowerShot S300, IXY DIGITAL 300, DIGITAL IXUS 300 
PowerShot S330, IXY DIGITAL 300a, DIGITAL IXUS 330 
PowerShot SD100, IXY DIGITAL 30, DIGITAL IXUS II 
PowerShot S400, IXY DIGITAL 400, DIGITAL IXUS 400 
PowerShot SD10, IXY DIGITAL L, DIGITAL IXUS i 
PowerShot SD110, IXY DIGITAL 30a, DIGITAL IXUS IIs
PowerShot S410, IXY DIGITAL 450, DIGITAL IXUS 430 
PowerShot S500, IXY DIGITAL 500, DIGITAL IXUS 500 
PowerShot SD20, IXY DIGITAL L2 , DIGITAL IXUS i5 
PowerShot SD200, IXY DIGITAL 40, DIGITAL IXUS 30 
PowerShot SD300, IXY DIGITAL 50, DIGITAL IXUS 40 
PowerShot SD400, IXY DIGITAL 55, DIGITAL IXUS 50 
PowerShot SD500, IXY DIGITAL 600, DIGITAL IXUS 700 
PowerShot G1, PowerShot G2, PowerShot G3, PowerShot G5, PowerShot G6 
PowerShot Pro90 IS 
PowerShot S1 IS, PowerShot S2 IS 
PowerShot Pro1 

The EOS class of digital cameras are not supported at this time.

T  he   George instructions  

Here is the complete list of George instructions :

abs
acos
asin
atan
break
char
cos
cmp
cut

date
do...until
exit
len
for
if...else...end
max
min
param

parse
pause
print
rnd
sin
sqr
tan
time
trunc

version
while
concat 
for...to...end 
function 
local 
return 
while...end 
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The George language commands

Here is the complete list of George commands :

tv_airbrush
tv_alphaloadmode
tv_alphasavemode
tv_areadraw
tv_areainit
tv_areamove
tv_tvpaint2back
tv_tvpaint2front
tv_background
tv_blend
tv_bookmarksenum
tv_bookmarkset
tv_bookmarkclear
tv_bookmarktoggle
tv_bookmarknext
tv_bookmarkprev
tv_brushcut
tv_brushfromclipboard
tv_brushinfo
tv_brushpoly
tv_brushrestore
tv_brushtoclipboard
tv_bump
tv_circle
tv_circlefill
tv_clear
tv_colorfactory 
tv_crazyblur
tv_densitylinex
tv_densityliney
tv_densityx
tv_densityy
tv_display
tv_dot
tv_ellipse
tv_ellipsefill
tv_fastline
tv_fieldcopy
tv_fielddouble
tv_fileinfo
tv_fill
tv_filter
tv_firstimage
tv_flipimagex
tv_flipimagey
tv_fixmotion
tv_framerate
tv_gauge
tv_gblur
tv_getactivetool
tv_getactiveshape
tv_getapen
tv_getbpen
tv_getfield
tv_getheight
tv_getmouse
tv_getpalette
tv_getpath

tv_getpixel
tv_getpixeldisplay
tv_getpixellayer
tv_getprojectname
tv_getuser
tv_getwidth
tv_ghostline
tv_grab
tv_imagefromclipboard
tv_imagetoclipboard
tv_lastimage
tv_layeranim
tv_layercopy
tv_layercreate
tv_layercurrentid
tv_layercut
tv_layerdensity
tv_layerdisplay
tv_layerduplicate
tv_layerfetch
tv_layergetid
tv_layergetimage
tv_layergetpos
tv_layerhold
tv_layerimage
tv_layerinfo
tv_layerinsertimage
tv_layerinvert
tv_layerkill
tv_layermerge
tv_layermergeall
tv_layermove
tv_layerpaste
tv_layerrename
tv_layerselect
tv_layerselectinfo
tv_layerset
tv_layershift
tv_layerstencil
tv_layerstretch
tv_line
tv_listrequest
tv_loadbrush
tv_loadbrushanim
tv_loadimage
tv_loadpalette
tv_loadproject
tv_loadsequence
tv_loadspare
tv_lockcacheflush
tv_lockdisplay
tv_lockmouse
tv_magicnumber
tv_menuhide
tv_menushow
tv_mosaic
tv_noise
tv_nop

tv_panning
tv_penbrush
tv_pencil
tv_perswrap
tv_piccolor
tv_preserve
tv_propelling
tv_projectclose
tv_projectcurrentid
tv_projectduplicate
tv_projectenumid
tv_projectinfo
tv_projectnew
tv_projectselect
tv_readprojectstring
tv_oilbrush
tv_quit
tv_rangeclear
tv_rangegrab
tv_rangenoise
tv_rangeset
tv_ratio
tv_readuserstring
tv_readtextfile 
tv_recorder
tv_rect
tv_rectfill
tv_redo
tv_reqangle
tv_reqfile
tv_reqfloat
tv_reqnum
tv_reqstring
tv_request
tv_resetdisplay
tv_resizepage
tv_savebrush
tv_savebrushanim
tv_savedisplay
tv_saveimage
tv_savemode
tv_savepalette
tv_saveproject
tv_savesequence
tv_selectshapetool
tv_serialnumber
tv_setapen
tv_setbpen
tv_setcolor
tv_setpalette
tv_shadow
tv_smooth
tv_smoothdensity
tv_smoothedge
tv_spareadddensity
tv_sparecopy
tv_sparekill
tv_sparesubdensity

tv_spareswap
tv_sparetoback
tv_sparetofront
tv_specialbrush
tv_speed
tv_stacksavebin
tv_stacksave
tv_stackloadbin
tv_stackload
tv_stackexecutebin
tv_stackexecute 
tv_stackopen
tv_stackclose
tv_stackapply
tv_stackclear
tv_startframe
tv_strokepoint
tv_strokesize
tv_tcmode
tv_textbrush
tv_texttool
tv_tornado
tv_undo
tv_updateundo
tv_unlockcacheflush
tv_unlockdisplay
tv_unlockmouse
tv_version
tv_vfgetfont
tv_vfstringsize
tv_waitbutton
tv_warn
tv_warpbrush
tv_wave
tv_wetbrush
tv_writepixel
tv_writeuserstring
tv_writeprojectstring
tv_zdot
tv_zline
tv_zspline
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The main characteristics of the export formats :

You can export projects from TVPaint Animation Pro using several different file formats. 
DIP, AVI, GIF, QUICKTIME, FLI, PNG, PCX, SUNRASTER, PSD, TGA, JPG, ILBM, TIFF, FLYER 
CLIP, D1 RTV, CINEON, SGI, SOFTIMAGE, BMP, VPB.

* The FLYER CLIP file format lets you export an animation that you can use with the VideoToaster 
Flyer from Newtek. The animation is saved as a single file and has usually a resolution of 752x480.

* You can use the D1 RTV file format in order to export an animation usable with the VideoToaster 
from Newtek . The animation is saved as a single file and has a resolution of 752x486 for NTSC 
ans 720x576 for PAL

* The CINEON export format was created by the Eastman Kodak Compagny in order to be used 
with their scanners and recorders. It uses logarithmic datas (10 bits).

* The VPB format is native to the Quantel Video Paintbox. It uses 24 bits per pixels (more than 16 
millions of colors). Although the VPB format use stencils and layers, TVPaint Animation Pro does 
not translate its layers into VPB layers at this time.

The other export formats are classified in the table below.
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Export Colors Other options

File format :
Animation 
as single 

file

Image or 
Image 

sequence

8 bits :

256 colors

24 bits

16.777.216 
colors

Save 
Opacity

Save 
Layers Compression

TVP 
(AUR MIR)

-

DIP -

AVI -

GIF
une couleur 
transparente

QUICKTIME -

FLI

PNG

PCX -

SUNRASTER -

PSD -

TGA -

JPG -

BMP -
in TVPaint

ILBM -

TIFF -

SGI -

SOFTIMAGE -

   

= Disponible / possible pour ce 
format de fichier

               

= Non disponible ou non 
recommandé pour ce format de 
fichier

A-6 Appendix



The available keyboard shorcuts and commands

The available keyboard shorcuts and commands

[Commands]

0 = Tools: Right Mouse Button
1 = Undo: Multi Redo
2 = Undo: Last Action
3 = Color: Pick
4 = Color: Pick B Color
5 = TVPaint Animation: Magic Number
6 = TVPaint Animation: Help
7 = Image Buffer: Hold
8 = Image Buffer: Fetch
9 = Spare: Copy To
10 = Spare: Exchange
11 = Clipboard: Save Image
12 = Clipboard: Load Image
13 = Clipboard: Save Brush
14 = Clipboard: Load Brush
15 = File Project: New
16 = File Project: Load
17 = File Project: Save
18 = File Project: Save As
19 = File Project: Close
20 = TVPaint Animation: Quit 
21 = TVPaint Animation: No Border
22 = TVPaint Animation: Iconify
23 = Printer: Config
24 = Printer: Print
25 = Twain: Acquire
26 = File Import: Sequence
27 = File Import: Brush
28 = File Export: Sequence
29 = File Export: Brush
30 = Interface: Open Main Panel
31 = Interface: Open Menu Panel
32 = Interface: Toggle Tools Panel
33 = Interface: Open Tools Panel
34 = Interface: Close Tools Panel
35 = Interface: Toggle FX Panel
36 = Interface: Open FX Panel
37 = Interface: Close FX Panel
38 = Interface: Open Time Line Panel
39 = Interface: Open XSheet Panel
40 = Interface: Open Project Panel
41 = Interface: Toggle LightTable Panel
42 = Interface: Open LightTable Panel
43 = Interface: Close LightTable Panel
44 = Interface: Toggle Palette Panel
45 = Interface: Open Palette Panel
46 = Interface: Close Palette Panel
47 = Interface: Toggle Layer Panel
48 = Interface: Open Layer Panel
49 = Interface: Close Layer Panel
50 = Interface: Toggle Navigator Panel
51 = Interface: Open Navigator Panel
52 = Interface: Close Navigator Panel
53 = Interface: Toggle Remote Panel
54 = Interface: Open Remote Panel
55 = Interface: Close Remote Panel
56 = Interface: Toggle Gradient Panel
57 = Interface: Open Gradient Panel
58 = Interface: Close Gradient Panel
59 = Interface: Toggle Coordinates Panel
60 = Interface: Open Coordinates Panel
61 = Interface: Close Coordinates Panel
62 = Interface: Toggle Paper Panel
63 = Interface: Open Paper Panel
64 = Interface: Close Paper Panel
65 = Interface: Toggle Guides Panel
66 = Interface: Open Guides Panel

67 = Interface: Close Guides Panel
68 = Interface: Toggle Grid Panel
69 = Interface: Open Grid Panel
70 = Interface: Close Grid Panel
71 = Interface: Open Video Grabber Panel
72 = Interface: Open Preview Settings Panel
73 = Interface: Open Preferences Panel
74 = Interface: Open Display Panel
75 = Interface: Open Shape Settings Panel
76 = Interface: Open Path Manager Panel
77 = Interface: Open Pixel Tracker Panel
78 = Interface: Open Path Recorder Panel
79 = Interface: Open Connection Panel
80 = Interface: Open Custom Panel
81 = File Project: Resize
82 = Interface: Configure Keyboard
83 = TVPaint Animation: About
84 = Interface: Close Window
85 = Interface: Next Cursor
86 = Layer: Pick Layer
87 = Layer: Merge Display
88 = Layer: Merge visible
89 = Layer: Merge Selected
90 = Layer: Make Anim
91 = Layer: Rename
92 = Layer: Select All
93 = Layer: Select Image From Keys
94 = Layer: Delete
95 = Layer: Duplicate
96 = Layer: New
97 = Layer: New Layer From Selected Images
98 = Layer: Insert Single Image Before Current 

Image
99 = Layer: Insert Single Image After Current 

Image
100 = Layer: Duplicate Single Image
101 = Layer: Insert Images Before Current 

Image
102 = Layer: Insert Images After Current Image
103 = Layer: Duplicate Image
104 = Project: Insert Images
105 = Project: Append Images
106 = Project: Duplicate Image
107 = Project: Insert Single Image
108 = Project: Append Single Image
109 = Project: Duplicate Single Image
110 = Project: Hide Other
111 = Project: Show All
112 = Project: Hide
113 = Project: Show
114 = Layer: Insert Tween Image
115 = Layer: Insert Tween Images
116 = Layer: Retime
117 = Project: Split
118 = Project: Duplicate
119 = Layer: Select All Images
120 = Layer: Delete Image
121 = Project: Delete Image
122 = Project: Previous
123 = Project: Next
124 = Layer: First Layer
125 = Layer: Last Layer
126 = Layer: Previous Layer
127 = Layer: Next Layer
128 = Layer: First Layer with Selection
129 = Layer: Last Layer with Selection
130 = Layer: Previous Layer with Selection
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131 = Layer: Next Layer with Selection
132 = Layer: Move Layer Up
133 = Layer: Move Layer Down
134 = Layer: First Image
135 = Layer: Last Image
136 = Layer: Next Image
137 = Layer: Prev Image
138 = Layer: First Image with Selection
139 = Layer: Last Image with Selection
140 = Layer: Next Image with Selection
141 = Layer: Prev Image with Selection
142 = Layer: Next Key
143 = Layer: Prev Key
144 = Layer: Next Key with Selection
145 = Layer: Prev Key with Selection
146 = Layer: Create Key
147 = Layer: Delete Key
148 = Layer: Toggle Auto Key
149 = Layer: Select All Keys
150 = Layer: Toggle Display All
151 = Layer: Toggle Stencil
152 = Layer: Invert Stencil
153 = Layer: Show All
154 = Layer: Hide All
155 = Layer: Clear All Stencil
156 = Layer: Invert All Stencil
157 = Image: Flip Horizontally
158 = Image: Flip Vertically
159 = Image: Flip Both Axis
160 = Layer: Time Zoom In
161 = Layer: Time Zoom Out
162 = Layer: Light Table Mode
163 = Layer: Toggle Frames/Time Code
164 = Layer: Toggle Background Mode
165 = Layer: Background Mode None
166 = Layer: Background Mode Color
167 = Layer: Background Mode Check
168 = Preview: Play
169 = Preview: Flip Book
170 = Preview: Flip Previous Frame
171 = Layer Sound: Load
172 = Layer Sound: Delete
173 = Layer: Fit To Project
174 = Layer: Fit To Selection
175 = Layer: Fit To Layer
176 = Layer: Fit To Key
177 = Layer: Fit To Sound
178 = Layer: Fit To Frame
179 = Layer: Reverse Selection
180 = Layer: Split
181 = Layer: Join Selected Layers
182 = Layer: Link
183 = Layer: Align Left
184 = Layer: Align Right
185 = Layer: Slide
186 = Layer: Slide To
187 = Layer: Goto Image
188 = Layer: Expand / Collapse
189 = Layer: Select Current Image
190 = Layer: Select Current Layer
191 = FX Stack: Apply
192 = FX Stack: Reset All
193 = FX Stack: Delete All
194 = Zoom: New Zoom window
195 = Zoom: Toggle Aspect
196 = Zoom: Toggle Video
197 = Zoom: Center
198 = Zoom: In
199 = Zoom: Out
200 = Zoom: Fit
201 = Zoom: Fit Project Panel
202 = Zoom: 100%

203 = Zoom: Rotation Reset
204 = Zoom: Rotate +15 (counter clockwise)
205 = Zoom: Rotate -15 (clockwise)
206 = Zoom: Shake
207 = Zoom: Show full page
208 = Interface: Full Screen
209 = Zoom: Scroll Up
210 = Zoom: Scroll Up Left
211 = Zoom: Scroll Left
212 = Zoom: Scroll Down Left
213 = Zoom: Scroll Down
214 = Zoom: Scroll Down Right
215 = Zoom: Scroll Right
216 = Zoom: Scroll Up Right
217 = Interface: Toggle windows display
218 = Zoom: Next Zoom window
219 = Zoom: Prev Zoom window
220 = Tools: Draw Dot
221 = Tools: Toggle Stencil
222 = Tools: Toggle Paper
223 = Tools: Toggle Transparency
224 = Tools: Toggle Red
225 = Tools: Toggle Green
226 = Tools: Toggle Blue
227 = Tools Brush: Increase Size
228 = Tools Brush: Increase Size 2
229 = Tools Brush: Decrease Size
230 = Tools Brush: Decrease Size 2
231 = Tools Brush: Change size
232 = Tools Brush: reset
233 = Layer: Clear
234 = Tools Mode: Next
235 = Tools Mode: Prev
236 = Tools Mode: Default
237 = Drawing Mode: 01 (Color)
238 = Drawing Mode: 02 (Behind)
239 = Drawing Mode: 03 (Erase)
240 = Drawing Mode: 04 (Panto)
241 = Drawing Mode: 05 (Merge)
242 = Drawing Mode: 06 (Shade)
243 = Drawing Mode: 07 (Light)
244 = Drawing Mode: 08 (Colorize)
245 = Drawing Mode: 09 (Tint)
246 = Drawing Mode: 10 (Grain)
247 = Drawing Mode: 11 (Smooth)
248 = Drawing Mode: 12 (Noise)
249 = Drawing Mode: 13 (Negative)
250 = Drawing Mode: 14 (Sharp)
251 = Drawing Mode: 15 (Emboss)
252 = Drawing Mode: 16 (Solarize)
253 = Drawing Mode: 17 (Saturate)
254 = Drawing Mode: 18 (UnSaturate)
255 = Drawing M ode: 19 (Add)
256 = Drawing Mode: 20 (Sub)
257 = Drawing Mode: 21 (Multiply)
258 = Drawing Mode: 22 (Screen)
259 = Tools Brush: Air
260 = Tools Brush: Pen
261 = Tools Brush: Oil Paint
262 = Tools Brush: Water Color
263 = Tools Brush: Propelling
264 = Tools Brush: Pencil
265 = Tools Brush: Warp
266 = Tools Brush: Special
267 = Tools Brush: Text
268 = Tools Brush: CustomBrush
269 = Tools Brush: Previous
270 = Tools Brush: Next
271 = Tools Brush: Toggle Display
272 = Brush: Toggle CutBrush
273 = Brush: Cut Rectangle
274 = Brush: Cut Magic Wand
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275 = Brush: Cut Poly
276 = Brush: Cut Freehand
277 = Brush: Double Size
278 = Brush: Halve Size
279 = Brush: Toggle Handle Corner
280 = Brush: Move Handle Corner
281 = Brush: Outline
282 = Brush: Double Width
283 = Brush: Double Height
284 = Brush: Halve Height
285 = Brush: Halve Width
286 = Brush: Flip Horizontally
287 = Brush: Flip Vertically
288 = Brush: Rotate 90°
289 = Brush: Rotate -90°
290 = Brush: Rotate
291 = Brush: Resize
292 = Brush: Optimize
293 = Brush: Optimize Source
294 = Brush: Toggle Transparency
295 = Brush: Next Animbrush
296 = Brush: Previous Animbrush
297 = Brush: Toggle Stamp/Brush
298 = Shape: Apply
299 = Shape: Freehand Dot
300 = Shape: Single Dot
301 = Shape: Freehand
302 = Shape: Freehand Fill
303 = Shape: Circle
304 = Shape: Circle Fill
305 = Shape: Line
306 = Shape: Poly Fill
307 = Shape: Flood Fill
308 = Shape: Spline
309 = Shape: Spline Fill
310 = Shape: Rectangle
311 = Shape: Rectangle Fill
312 = Shape Select: FreeHand
313 = Shape Select: Rectangle
314 = Shape Select: Ellipse
315 = Shape Select: MagicWand
316 = Shape Select: Spline
317 = Shape Select: Clear
318 = Shape Select: Invert
319 = Shape Select: Copy To CustomBrush
320 = Shape Select: Cut To CustomBrush
321 = Shape Select: Copy To New Layer
322 = Shape Select: Cut To New Layer
323 = Shape Transform: Pan
324 = Shape Transform: Position
325 = Shape Transform: Warp
326 = Tools Pantograph: Set
327 = Tools Healing: Set
328 = Tools: Crop
329 = Tools: Zoom
330 = TVPaint Animation: Copy Selection
331 = TVPaint Animation: Paste
332 = TVPaint Animation: Cut Selection
333 = TVPaint Animation: Select All
334 = TVPaint Animation: Delete Selection
335 = Color: Up
336 = Color: Down
337 = Color: Right
338 = Color: Left
339 = Color: Invert A/B
340 = Color: Hue <<
341 = Color: Hue >>
342 = Color: Saturation -
343 = Color: Saturation +
344 = Color: Luminosity -
345 = Color: Luminosity +
346 = Color: Red -

347 = Color: Red +
348 = Color: Green -
349 = Color: Green +
350 = Color: Blue -
351 = Color: Blue +
352 = Gradient: Next
353 = Gradient: Previous
354 = Gradient: Load
355 = Gradient: Save
356 = Gradient: Default
357 = Gradient: Invert
358 = Grid: Toggle
359 = Grid: Snap
360 = Grid: Display
361 = Guides : Toggle
362 = Guides : Snap
363 = Guides : Display
364 = Guides : Add
365 = Guides : Remove
366 = Display: Show SafeArea
367 = Display: Show FieldChart
368 = Display: Show Stencil
369 = Display: Show Selection
370 = Display: Show Paper
371 = Grab : Video Input
372 = Grab : Switch Modes
373 = Grab : Grab Length
374 = Grab : Increase Grab Length
375 = Grab : Decrease Grab Length
376 = BookMarks: Set
377 = BookMarks: Clear
378 = BookMarks: Toggle
379 = BookMarks: Next
380 = BookMarks: Previous
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[Shortcuts]

a = Zoom: Shake
b = Brush: Toggle CutBrush
c = Brush: Rotate
d = Shape: Freehand
e = Tools Brush: Next
f = Shape: Flood Fill
g = Grid: Toggle
h = Brush: Halve Size
i = Project: Append Images
j = Spare: Exchange
k = none
l = Shape: Line
m = Zoom: New Zoom window
n = Color: Invert A/B
o = Brush: Outline
p = Interface: Toggle Palette Panel
q = Shape: Spline
r = Shape: Rectangle
s = Shape: Freehand Dot
t = Tools Brush: Text
u = Undo: Last Action
v = Interface: Full Screen
w = Preview: Flip Book
x = Brush: Flip Horizontally
y = Brush: Flip Vertically
z = Brush: Resize
shift a = Interface: Toggle Tools Panel
shift b = Layer: Toggle Background Mode
shift c = Tools Healing: Set
shift d = Interface: Open Preferences Panel
shift e = none
shift f = Layer: Goto Image
shift g = Interface: Open Grid Panel
shift h = Brush: Double Size
shift i = Project: Insert Images
shift j = Spare: Copy To
shift k = Layer: Clear
shift l = File Project: Load
shift m = none
shift n = File Project: New
shift o = Brush: Toggle Handle Corner
shift p = Tools Pantograph: Set
shift q = TVPaint Animation: Quit 
shift r = none
shift s = File Project: Save
shift t = none
shift u = Undo: Multi Redo
shift v = Zoom: Show full page
shift w = File Project: Close
shift x = Brush: Double Width
shift y = Undo: Multi Redo
shift z = Brush: Rotate 90°
ctrl a = TVPaint Animation: Select All
ctrl b = none
ctrl c = TVPaint Animation: Copy Selection
ctrl d = TVPaint Animation: Magic Number
ctrl e = Tools Brush: Previous
ctrl f = Layer: Slide To
ctrl g = none
ctrl j = none
ctrl k = Interface: Configure Keyboard
ctrl l = Layer: Light Table Mode
ctrl n = Layer: New
ctrl o = Project: Hide Other
ctrl p = Project: Show All
ctrl q = none
ctrl r = none
ctrl s = Layer: Select Image From Keys
ctrl t = none
ctrl u = none

ctrl v = TVPaint Animation: Paste
ctrl w = none
ctrl x = TVPaint Animation: Cut 
Selection
ctrl y = Brush: Flip Vertically
ctrl z = Undo: Last Action
0 = Interface: Toggle Layer Panel
1 = Zoom: Scroll Down Left
2 = Zoom: Scroll Down
3 = Zoom: Scroll Down Right
4 = Zoom: Scroll Left
5 = Zoom: Center
6 = Zoom: Scroll Right
7 = Zoom: Scroll Up Left
8 = Zoom: Scroll Up
9 = Zoom: Scroll Up Right
ctrl pad 0 = none
ctrl pad 1 = Interface: Open Time Line Panel
ctrl pad 2 = Interface: Open XSheet Panel
ctrl pad 3 = Interface: Open Project Panel
ctrl pad 4 = none
ctrl pad 5 = none
ctrl pad 6 = none
ctrl pad 7 = none
ctrl pad 8 = none
ctrl pad 9 = none
/ = Tools Brush: Decrease Size 2
* = Tools Brush: Increase Size 2
- = Tools Brush: Decrease Size
+ = Tools Brush: Increase Size
, = Layer: Pick Layer
; = Color: Pick
: = Tools Brush: reset
! = none
< = Zoom: Out
> = Zoom: In
& = none
~ = none
" = none
# = none
' = none
( = none
braquet = Image: Flip Horizontally
| = Interface: Toggle Coordinates 

Panel
` = none
_ = none
\ = none
@ = none
) = none
] = Image: Flip Vertically
} = none
$ = none
£ = none
% = none
§ = none
. = none
equal = Layer: Toggle Display All
^ = none
¨ = none
µ = none
¤ = none
² = none
f1 = TVPaint Animation: Help
f2 = Drawing Mode: 01 (Color)
f3 = Drawing Mode: 02 (Behind)
f4 = Drawing Mode: 03 (Erase)
f5 = Drawing Mode: 04 (Panto)
f6 = Drawing Mode: 05 (Merge)
f7 = Drawing Mode: 06 (Shade)
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f8 = Drawing Mode: 07 (Light)
f9 = Drawing Mode: 08 (Colorize)
f11 = Zoom: Show full page
f12 = Interface: Toggle windows 

display
ctrl f1 = none
ctrl f2 = none
ctrl f3 = none
ctrl f4 = Interface: Close Window
ctrl f5 = none
ctrl f6 = none
ctrl f7 = none
ctrl f8 = none
ctrl f9 = TVPaint Animation: Iconify
ctrl f11 = TVPaint Animation: No Border
ctrl f12 = none
shift f1 = none
shift f2 = none
shift f3 = none
shift f4 = none
shift f5 = none
shift f6 = none
shift f7 = none
shift f8 = none
shift f9 = none
shift f11 = none
shift f12 = none
ctrl shift f1 = none
ctrl shift f2 = none
ctrl shift f3 = none
ctrl shift f4 = none
ctrl shift f5 = none
ctrl shift f6 = none
ctrl shift f7 = none
ctrl shift f8 = none
ctrl shift f9 = none
ctrl shift f11 = none
ctrl shift f12 = none
space = Tools: Right Mouse Button
tab = Project: Next
shift tab = Project: Previous
ctrl tab = Zoom: Next Zoom window
ctrl shift tab = Zoom: Prev Zoom window
home = Layer: First Image
shift home = none
ctrl home = Layer: First Layer
ctrl shift home = none

end = Layer: Last Image
ctrl end = Layer: Last Layer
shift end = none
ctrl shift end = none
del = TVPaint Animation: Delete 

Selection
shift del = TVPaint Animation: Delete 

Selection
ctrl del = none
ctrl shift del = none
insert = Zoom: Rotation Reset
shift insert = none
ctrl insert = none
ctrl shift insert = none
backspace = Layer: Clear
shift backspace = Shape Select: Clear
up = Layer: Previous Layer
shift up = Layer: Previous Layer with 

Selection
ctrl up = Layer: Move Layer Up
ctrl shift up = BookMarks: Toggle
down = Layer: Next Layer
shift down = Layer: Next Layer with Selection
ctrl down = Layer: Move Layer Down
ctrl shift down = Color: Down
left = Layer: Prev Image
shift left = Layer: Prev Image with Selection
ctrl left = Brush: Previous Animbrush
ctrl shift left = BookMarks: Previous
right = Layer: Next Image
shift right = Layer: Next Image with Selection
ctrl right = Brush: Next Animbrush
ctrl shift right = BookMarks: Next
page up = Layer: Prev Key
shift page up = Zoom: Rotate +15 (counter 

clockwise)
ctrl page up = none
ctrl shift page up = none
page down = Layer: Next Key
shift page down = Zoom: Rotate -15 (clockwise)
ctrl page down = none
ctrl shift page down = none
mmb = none
shift mmb = none
ctrl mmb = none
ctrl shift mmb = none

Appendix A-11



The initialization file (PC only)

The initialization file (PC only)

As a lot of software nowadays, TVPaint Animation Pro use an initialization file in ASCII format. This 
file contains a lot of parameters. Its name is TVPaint Animation Pro.ini and is located in the 
directory :

C:\windows\system\                  on Microsoft Windows XP
C:\WINNT\SystemRoot\            on Microsoft Windows 2000

It is possible to edit this file with any text editor like Notepad from Microsoft Windows 
Here is the content of the file TVPaint Animation Pro.ini , by default :

[STARTUP]
Last_Config=
Homedir=C:\Program Files\TVPaint Developpement\TVPaint Animation Pro
Georgedir=C:\Program Files\TVPaint Developpement\TVPaint Animation Pro\George\
Temp=D:\temp\TVPAP\
locfile=french.tvpaint.loc
language=french

It is possible to add comments after each line of this file. You only need to add the 
caracter «  ; » before writing it. For instance :

language=english     ; we will use the english language.

Here are the options that you can add and/or modify in this file :

HomeDir

This option indicates the directory containing the executable file of the software :
C:\Program Files\TVPaint Developpement\TVPaint Animation Pro\     in Microsoft 
Windows operating system

GeorgeDir

This option indicates the directory containing the George Script by default :
C:\Program Files\TVPaint Developpement\TVPaint Animation Pro\George\
in Microsoft Windows operating system.

Temp

This option indicates the directory containing the temporary files of TVPaint Animation Pro.
Although, you have chosen this directory during the install process of the software, you can 
change it here or you can use the Prerences Panel in the Edit  main menu.

Last_Config

This option allows to know the last configuration file that you have used with TVPaint 
Animation Pro.

Nosubtablet

This option allows to fix calibration problems that are sometimes encountered with old 
models of graphic tablet. (it awaits the value 0 or 1).
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Gauge

    
The line    Gauge = 0    suppress the progress bar during the rendering calculations.
The line    Gauge = 1    dislays the progress bar during the rendering calculations.

PopX=
PopY=

When you use the softawre, some panels such as progress bar, export panels,  etc ... 
use to popup at the center of the screen by default. (or at the center of your first screen if 
you have a dual screen configuration). 
This option allows you to choose where you want them to appear. For instance, if you 
want those panels to appear at the bottom of your screen, you can use those settings :
PopX = 0
PopY = - 400

ReqFileName

Let's suppose that you have entered the line     ReqFileName = Yes     .Each time you will 
have to select a file, it will make the softtware to remember the path of the last saved file.
Let's suppose that you have entered the line     ReqFileName = No      .This time, the 
software will not remember the path of the last saved file when using a requester.

DirectDraw is a DirectX library which allows to manage calculations and 2D graphics 
rendering. It allows to use the hardware acceleration of the graphic cards in order to 
display datas in real time.

DdrawEmulationOnly

On a few graphic cards, all the DirectDraw functions are not supported. In this case, it is 
necessary to unactivate the use of DirectDraw by writing the line :
DdrawEmulationOnly = 1
(The line     DdrawEmulationOnly = 0     have the reverse effect)

DDrawRgbaOnly

By default, the DirectDraw functions works with YUVA chanels.
If you want them to work with RVBA chanels, add the line :

 DdrawRgbaOnly = 1
The line   DdrawRgbaOnly = 0   gives the same result as the default setting.

Language

This option allows to select the user interface language :
The line     language = french      will make you use the french interface
The line     language = english    will make you use the english interface

Locfile

This option indicates the name of the file containing the translations of the user interface :
locfile = french.tvpaint.loc     for the french interface
locfile = tvpaint.loc                 for the english interface
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The technical support and internet resources

We did our best to provide you a detailled user-manual, with a lot of illustrated examples.
However, you may still have questions regarding the software.
You can find additionnal and helpful informations about the TVPaint technology on our website :
www.tvpaint.com

You will find :

* Lastest news, about the TVPaint Technology
* Tutorials, palettes, custom brushes, papers, scripts and plug-in.
* Some user-stories,
* Lastest demos and updates For your current Software.
* Discussion forums with a technical support in french, english and spannish language.
* A gallery where hundreds of pictures and animations will show you the possibilities given by the 
TVPaint solutions from its creation.

It's the share place ! The TVPaint forums gather the discussion of our users, 
samples of their works as well as brushes, scripts and tips for the benefit of all. Feel 
free to post your own productions and to share your techniques !

Join the TVPaint users Community !

When contacting us via email, forum, phone, ... please don't forget to give us the following 
informations :
* Your computer (PC, Macintosh, ...), its CPU (AMD, Intel, ...), it's amount of RAM
* Your operating system (apple OS-X, Microsoft windows, ...)
* The version of TVPaint animation Pro that you are running : you can find it in the about section of 
the software (see below)
* Your video hardware, if you have one.
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Here are our full coordinates :

TVPAINT DEVELOPPEMENT
Route de Marange 
57280 Maizieres les Metz 
FRANCE

Phone : +33 (0)387 173 598
Fax : +33 (0)387 173 599
Email : tvpaint@tvpaint.fr

                

              

TVPaint Developpement is located at 
Maizieres Les Metz, 10 km aways from Metz. 
Transporation means for meeting us are :
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Planes : 
Metz / Nancy Lorraine Airport - 40 Km
http://www.metz-nancy-lorraine.aeroport.fr/ 
Luxembourg Findel Aiport - 55 Km
http://www.luxair.lu/fr/airport/ 

Trains : 
Metz Railway Station
Booking / Information SNCF :
Phone : +33 (0)8 92.35.35.35
http://www.sncf.com 

Metz Taxi :
Phone : +33 (0)3 87.56.91.92

Car : 
Autoroute A31, Exit n35
For a custom itinary :
http://www.viamichelin.com 

http://www.viamichelin.com/
http://www.sncf.com/
http://www.luxair.lu/fr/airport/
http://www.metz-nancy-lorraine.aeroport.fr/
mailto:tvpaint@tvpaint.fr
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